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Preface 
Volume 1 

Welcome to the VAXmate User's Guide. This guide explains how to use the 
following VAXmate system software: 

• MS-Windows 

• VT220 and VT240 terminal emulators 

• Desktop applications 

• MS-Paint 

• MS-DOS operating system 

This software and your V AXmate workstation create a powerful tool for you 
to use to perform your everyday tasks quickly and efficiently. 

Before Reading This Guide 

You should read the VAXmate System Handbook that comes with your 
VAXmate workstation before reading this guide. Besides describing some of 
the terminology used in this guide, the VAXmate System Handbook also 
tells you how to set up your VAXmate workstation and use: 

• Your key diskette 

• MS-Windows 

• The mouse 

• The Information System 
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Conventions Used 

Follow these conventions while using this guide: 

• In examples of dialog between you and the VAXmate workstation, what 
is displayed on the screen is shown in black type; what you type from 
the keyboard is shown in color. 

• Make sure you type all spaces and punctuation marks exactly as they are 
printed. 

• A key sequence such as AIt/Tab means to hold down the AIt key while 
you press the Tab key. 

• A key sequence such as AIt/Shift/Tab means while you hold down both 
the AIt key and the Shift key, press the Tab key. 

• Wherever you see the term workstation, it means your VAXmate 
workstation. 

The Information System 

Your VAXmate system software includes an Information System. This informa
tion, found on-line, is similar to the information found in this guide. It 
differs only in that it is organized for easy access and is presented in a differ
ent format. 

The Information System is available to you as an icon when you are using 
MS-Windows on your VAXmate workstation. This rneans you can use it as a 
learning aid while you are becoming familiar with MS-Windows and the rest 
of the V AXmate system software. 

Both the VAXmate System Handbook and the MS-Windows part of this guide 
explain how to start the Information System. 

xxxvi 



Preface Volume 1 11111 

Guide Organization 

The VAXmate User's Guide is divided into two volumes. The following sec
tions describe the parts in each volume. Appendixes that refer to an individ
ual part are found at the back of the appropriate volume. 

Volume 1 

MS-Windows 

MS-Windows is your interface to the VAX mate workstation. It is the common 
connection between you and your V AXmate system software. You can use 
applications by dividing the VAXmate screen into areas called windows. 

The chapters in this part describe what a window is, how to create and size 
windows, and how to start, run, and close applications using a mouse or the 
keyboard. They also explain how to run applications outside of a window. 

Other chapters describe how to use menus and commands, files, disks, and 
directories and how to use the Control Panel to change MS-Windows features. 

Appendixes A, B, and C explain how to create alternate characters, how to 
use the WIN.lNI file, and how to use Program Information Files for your 
applications. 

Terminal Emulators 

Terminal emulators are DIGITAL applications that allow you to use your 
VAXmate workstation as either a DIGITAL VT220 or VT240 video terminal. 
The terminal emulators are started from MS-Windows. The VT240 terminal 
emulator can also be started from the MS-DOS operating system. These appli
cations are for users who are familiar with the VT220 and VT240 terminals 
and want to use the DIGITAL applications designed for those terminals. 

The chapters in this part include a description of the Set-Up utility and 
explain some special Set-Up features. These features let you create and save 
multiple Set-Up files to configure your VAXmate workstation or to use with 
various applications. You can also send or receive characters to and from the 
host. 

Appendix D explains how to use the keyboard with the VT220 terminal 
emulator. 
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Desktop Applications 

This part describes a collection of individual MS-Windows applications. 
These applications are: 

Notepad 

Cardfile 

Calendar 

Calculator 

Clock 

Reversi 

MS-Paint 

Used to write memos 

Used to sort information 

Used to keep track of appointments 

Used to perform arithmetic calculations 

Used for keeping time 

A game you can play 

MS-Paint is an MS-Windows drawing application for users who want to learn 
how to draw using the mouse. 

Appendix E describes special key actions used to modify certain MS-Paint 
operations. Appendix F explains how to use the keyboard with MS-Paint. 

Volume 2 

The second volume of the VAXmate User's Guide contains the following 
parts. 

MS-DOS 

MS-DOS is the operating system used by your VAXmate workstation. The 
information in this part is for the experienced MS-DOS user. 

The first few chapters cover everything you need to know about the oper
ating system, from creating files, directories, and paths to preparing the hard 
disk; from using command formats to using internal and external commands. 
The commands are also listed alphabetically. 
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In addition, a description is provided for the MS-DOS editing and function 
keys, use of industry standard compose sequences, batch processing, and 
DEBUG. 

Other chapters in this part explain networking, the Network File Transfer 
(NFT) commands, and the SETHOST command. The SETHOST command cre
ates an emulator session using the DEC net network software under the 
MS-DOS operating system. 

Appendixes G, H, and I explain international features (including country 
keyboard layouts), reading diskettes, and configuring your system. 

Messages 

The Messages section contains help on messages, other than informational 
ones, that may be displayed on your screen while you use the VAXmate 
system software described in this guide. The messages are listed 
alphabetically. 

AppendiX J describes additional options you can order for your V AXmate 
workstation. AppendiX K contains the system specifications for your VAXmate 
workstation. 
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Chapter 1 
Getting Started 

With MS-Windows 

MS-Windows lets you work visually by organizing your tasks in windows. 
With MS-Windows, you can have more than one window on your screen, each 
running a different application. Thus, you can simultaneously work on sev
eral tasks, such as writing a memo, updating a project status report, and 
organizing data for a monthly report. 

With MS-Windows, you switch from one application to another by clicking 
the mouse button or pressing keys. Because you never have to stop running 
an application, you can continue in any application where you left off. 

With MS-Windows, you do not have to memorize formats or type many com
mands. Each application has all the necessary commands contained in a series 
of menus; you select a command from a menu. 

MS-Windows lets you transfer information between your MS-Windows applica
tions. For example, you can copy information from a project status report to 
a monthly report while running both in the work area of your screen. 

This chapter describes how to: 

• Start MS-Windows 

• Work in MS-Windows 

• Run an application 

• Use the Information System 

• Scroll a window 

• Use menus and commands 

• Use a dialog box 

• Finish an application 

1-1 
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Starting MS-Windows 

Information on starting MS-Windows and other introductory MS-Windows 
material, including definitions for terms such as icon, work area, and mouse, 
is contained in your handbook. If you have not read the handbook, do so 
before continuing. 

Initial Window 

The first window you see when you start MS-Windows depends upon how 
MS-Windows is installed on your workstation. When MS-Windows is installed 
on your workstation, you can: 

• Run a specific application automatically in the work area each time you 
start MS-Windows 

• Load specific applications as icons 

This is desirable if you consistently use several applications. 

• Open the MS-DOS Executive window 

If you run and load applications when MS-Windows is installed, the first 
window you see is the application that is set up to run automatically. You 
also see the icons for the applications in the icon area at the bottom of the 
screen. For information about running and loading applications, see 
Chapter 3. 

If you do not run or load applications when MS-Windows is installed, the 
first window you see is the MS-DOS Executive window. You can load applica
tions into the icon area. 

Working in MS-Windows 

You work in MS-Windows by using the mouse or the keyboard to select and 
perform commands. You will probably use the mouse most often because 
you can enter most commands by pointing the mouse to the command and 
clicking the left mouse button. In general, this guide describes how to enter 
MS-Windows commands, using the mouse. For information on using the key
board to enter commands, see Chapter 6. 

If you unplug your mouse and plug it back in, the mouse will not work. To 
get your mouse to work again, exit and restart MS-Windows. 
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Table 1-1 lists the terms and actions you need to know to use the mouse. 
(These are introduced in the VAXmate System Handbook.) 

Table 1-1 Mouse Techniques 

Term Action 

Point to an object 

Click the left mouse button 

Click on an object 

Double-click on an object 

Drag an object 

Select a command 

Move the mouse until the tip of the pointer rests on 
the desired object. 

Press and release the left mouse button. 

Point to an object and click. 

Point to an object and click twice in rapid succes
sion. 

Three-step action: 

1. Point to an object. 

2. Press and hold down the left mouse button, and 
move the mouse to drag the object. 

3. At the desired location, re1.ease the mouse button. 

Three-step action: 

1. Point to a menu. 

2. Press and hold down the left mouse button. 

The menu commands are displayed in a drop
down menu. The menu is highlighted where the 
mouse points. 

3. Drag the highlight to the command you want and 
release the mouse button. 

Running an Application as an Icon 

To work with an application, it must run in a window in the work area. If 
the application does not display in your work area when you open 
MS-Windows and you did not automatically load it as an icon, you should 
load it as an icon. 

An icon is a graphic representation of an application. To turn an icon into a 
window in the work area, you expand it. 

To expand an icon, drag the icon from the icon area to the center of the 
work area. 
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To expand an icon, you can also double-click on the icon in the icon area. If 
the icon does not expand, try double-clicking the left mouse button faster, 
keeping the mouse steady. 

The newly selected application shares the work area with those windows and 
is displayed immediately above the icon area. However, the new window 
does not replace any windows already displayed in the work area. 

Expanding an icon is not the only way to run an application. For information 
on using the MS-DOS Executive window to run applications in windows, see 
Chapter 3. 

Using the Information System 

The Information System provides you with information about MS-Windows 
and your workstation. The Information System is represented by an icon in 
the icon area that you expand. Screen 1-1 shows the Information System 
application after it has been expanded. 
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~> UAXlilate Network 

Trouble Shooting: 
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Screen 1-1 Information System Application 
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In the window of the Information System you see: 

• The main menu of topics displayed in the work area 

• A group of menu names displayed in the menu bar 

To select a topic from the Information System's main menu, click on the 
topic you want to select. 

IIIII 

The highlight moves as you move the cursor up and down the menu; do not 
press any mouse buttons. 

Information about the topic you selected is displayed in the window. Some 
topics, such as MS-Windows, display additional menus. In this case, select a 
topic from these menus as you selected a topic in the main menu. 

To get additional help on using the Information System, select the Help 
menu. 

Scrolling 

Some applications have more information than fits in the window at one 
time. By using the scroll bars, you can move and display all the information. 

A window can have one or two scroll bars: 

• One is on the right side of the application window. 

• One is on the bottom of the application window. 

Either or both of the scroll bars can be used by an application, depending on 
where the additional information is: 

• If a scroll bar is on the right side of the application window, you can 
scroll up and down. For example, you can scroll this way when you run 
a word processing application with a long text file. 

• If a scroll bar is on the bottom of the application window, you can 
scroll to the right or left. For example, you may scroll this way when 
you run a spreadsheet application. 
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Table 1-2 shows the procedures for scrolling with the mouse. 

Table 1-2 Scrolling With the Mouse 

To scroll ... 

One line 

One window 

To a general lo
cation rapidly 

Do this ... 

Click on the scroll arrows at either end of the scroll bar. Each 
time you click the left mouse button, the window scrolls one 
line in the direction you selected. If you hold down the left 
mouse button, the window scrolls faster. 

Click on the shaded area on either side of the small white box 
(the scroll box) in the scroll bar. 

Drag the scroll box to a position in the scroll bar corresponding 
to the general location you want (beginning, middle, or end of 
the file). 

Using Menus and Commands 

System Menu 

The System menu contains commands for manipulating windows and is com
mon to most applications. It is represented by a box with three lines inside, 
located in the upper-left corner of the window. 

The commands in the System menu are displayed in a drop-down menu. 
Figure I-I shows the System menu commands. 
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Table 1-3 describes the commands in the System menu. 

Table 1-3 System Menu Commands 

Command Description 

Size Changes the size of a window when you have two or more 
windows in the work area. With this command, you can 
make the window larger or smaller. 

Move Moves a window to another position you select in the work 
area, when you have two or more windows in the work 
area. 

Icon 

Zoom 

Close 

About 

NOTE 

This command also expands an icon into a window in the 
work area. and shrinks a window to an icon in the icon 
area. 

Shrinks a window to an icon in the icon area. 

This command also expands an icon into a window in the 
work area. 

Enlarges a window to fill the entire screen. Selecting this 
command a second time returns the window to its original 
size and pOSition. 

Closes the window of the application, stops running the 
application, and removes the application from system 
memory. However, the application remains in your 
MS-Windows directory and on your disk. 

Displays information about the application running in the 
active (current) window. The About command is not a part 
of all applications. Also, some applications may use other 
commands, such as Help or Info, instead of the About 
command. 

Some applications may show additional commands in the System 
menu. See your application manuals for details on these 
commands. For more information on additional commands for 
these applications, see Chapter 7. 
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Application Menus 

Each application also has its own set of menus and commands. These menus 
are displayed in the menu bar at the top of the window below the applica
tion title bar. As with the System menu, each menu in the menu bar has a 
drop-down menu for displaying the list of menu commands. (Sometimes, the 
menu name is also the only command in the menu. In this case, there is no 
drop-down menu.) Some applications do not have any menus in the menu 
bar; they only have a System menu. 

You select a menu to display the menu commands in a drop-down menu. To 
execute an action, you must select a command from a menu. You can drag 
the highlight up and down the menu as long as you hold down the left 
mouse button. 

When you release the left mouse button, the MS-Windows application exe
cutes the highlighted command. However, if you release the left mouse but
ton before you drag the highlight into the menu, the drop-down menu is 
removed from the display. 

NOTE 
Some commands in a menu are displayed in a lighter shade than 
the other commands. You cannot select them because they are 
disabled. For example, if you have only one window in the work 
area, the Size command is disabled (displayed in a lighter shade), 
because you cannot change the size of a window if it is the only 
window in the work area. However, when you have more than one 
window displayed in the work area, the Size command is not 
disabled, and you can change the size of the windows. 

Using a Dialog Box 

When you select a command, MS-Windows often needs additional information 
before it can execute the command. When MS-Windows needs additional 
information, it displays a dialog box. Screen 1-2 shows a typical dialog box. 
After you provide the needed information in the dialog box, MS-Windows 
executes the command. 
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Can 
Cle 
Mow 

Open 

Cancel 

Pla~~~~~~==~-.~ ________ ~ 
Sche u e uacatlon 
Read "War and Peace" C 
Write Grandllla C 
Buy present for Martha B 
Talk to Fred B 
Take out garbage B 
Call piano tuner C 

Screen 1-2 Dialog Box 

A dialog box is a rectangle, resembling a window, which overlays a portion 
of the screen in which you select a command. If you display several windows 
in the work area, the dialog box can overlay portions of more than one 
window, depending on the size of the windows and the dialog box. 

The dialog box contains areas where you either type the information 
required by MS-Windows or select options to supply the needed information. 

Often, a dialog box is displayed with some information already in it, showing 
what you have selected on the screen or options you selected earlier. Also, 
some options may be disabled. 

After you enter information or select an option, you execute the action by 
selecting a command button in the dialog box. 
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The following sections describe the components of a dialog box. 

Text Box 

A text box is where you type information needed to carry out a command. 
Figure 1-2 shows a text box. 

F i 1 e name: t.!ll:II!!!!!!!'~:t!:!' _______ --.J 

Figure 1-2 Text Box 

What you type is displayed to the left of the blinking vertical line, called the 
insertion point. To position the insertion point in the text box, click where 
you want the insertion point moved. As you type, the insertion point moves 
to the right. 

To correct typing mistakes, press the Word Char key. Each time you press it, 
one character to the left of the insertion point is deleted. 

The text box can: 

• Be blank when the dialog box is displayed 

• Contain text if you already selected something applicable for the 
command 

• Contain a default option 

If information is already present in the text box, you can type new informa
tion. When you press the first key, any information already present is 
removed. You can also press the Word Char key to delete information already 
in the text box. 

List Box 

A list box lists the choices you can select for a command. Figure 1-3 shows a 
list box. 
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File nallle: Il!-!!!!!'!!:!"!!' ________ ...I 

C:\WIH\PCAPP 

( Open ) 
( Cancel ) 

Figure 1-3 List Box 

You can distinguish between files, drives, and directories listed in a dialog 
box. For example, in the list box shown in Figure 1-3: 

MYFILE 

[-A-] 

[ .. ] 

[MYDIR] 

Is the name of the file, MYFILE. 

Represents drive A. Brackets and hyphens surround the name 
of a drive. 

Represents the parent directory (one level up). 

Represents directory MYDIR. Brackets surround the name of a 
directory. 

To select an item in the list box, click on it. 

Option Buttons 

Option buttons let you select one option from a group. They are labeled to 

describe their functions. Figure 1-4 shows the option buttons for controlling 
the keyclick volume. 

Keyclick uolume a tio sound 
aSoft 
@ Intet'"mediate 
aloud 

Figure 1-4 Option Buttons 

To select an option from a group, click on it. 
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Check Boxes 

Check boxes represent options that you can turn ON or OFF. They are 
labeled to describe the functions of the options. When an X is displayed in 
the check box, the option is ON. Click on X again to turn the option OFF. 
You can 1Select as many check boxes as needed. Figure 1-5 shows a check 
box for a mouse option. 

Mouse Options 
~left/~ight ~ouse buttons swapped 

Figure 1-5 Check Box 

To select a check box, click on it. 

Command Buttons 

Command buttons are large rectangular buttons (with rounded corners) that 
are labeled to describe how thay affect the command you selected. Figure 
1-6 shows sample command buttons. 

( Ok ) C~ancel) 
Figure 1-6 Command Buttons 

To select a command button, click on it. 
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When you select a command button, MS-Windows executes the action imme
diately. Command buttons you see in MS-Windows include: 

• Ok or Yes 

The command is executed. Sometimes, the button that executes the 
command is labeled to describe the selected command, such as Open or 
Save. 

• Cancel or No 

The selected command is canceled. 

• Reset 

Anything you entered or changed in the dialog box is ignored. Settings 
are reset to their values before the dialog box was displayed. 

The default command button has bold borders. Usually, it is the Ok com
mand button. 

Finishing an Application 

When you finish using an application and want to remove it from the work 
area, you can do either of the following: 

• Shrink the application to an icon in the icon area. 

The application continues running. 

• Close the application. 

When you close an application, it: 

- Stops running 

Remains in the MS-Windows directory but does not take any space in 
the work area 
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Shrinking an Application to an Icon 

To shrink an application to an icon, you can: 

• Double-click on the title bar of the application you want to shrink. 

• Point to the title bar and drag the icon into the icon area. 

• Select the Icon command from the System menu. 

When you release the left mouse button, MS-Windows executes the Icon 
command,and the application runs in the icon area as an icon. The 
application runs in the icon area as an icon. 

Closing an Application 

To close an application, you can: 

• Select the Close command from the System menu. 

When you release the left mouse button, MS-Windows executes the 
Close command, and the window for the application closes. 

• Double-click on the System menu box of the application you want to 
close. 

NOTE 
When you close an application in which you opened a data file 
and made changes, a dialog box is usually displayed asking you to 
either save the changes you entered or confirm that you want to 
close the application. 
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Applications 

This chapter describes how to: 

• Run multiple applications 

• Switch and move windows 

• Change the size of a window 

• Shrink an application to an icon 

• Share information between two windows 

• Receive messages from another application 

When you use MS-Windows, you can run more than one application at the 
same time, with each application in its own window. This chapter describes 
how to work successfully with multiple applications. 

The procedures described in the chapter tell you how to run two and three 
windows at one time. As examples, this part uses three applications: 

• Notepad 

• Clock 

• Information System 

You can use any three applications or more, because the techniques are the 
same for all applications. However, you must use at least three applications 
to follow the examples. 

With MS-Windows, you can also display more than one window for the same 
application. For example, two windows can display the Notepad application, 
with each window containing a text file. One Notepad window can contain 
your monthly report, while another Notepad window can contain a memo. 
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Running Multiple Applications 

You can run as many applications as you want with MS-Windows, depending 
on your workstation's memory capacity. 

When you have a small amount of memory, MS-Windows can excessively load 
data from your disk. (Your workstation runs slower than usual.) If this 
occurs, close any applications you do not need. This gives MS-Windows more 
memory for your remaining applications. 

If you try to run an application and no memory is available, MS-Windows 
displays the message "Not enough memory to run." Use the Close command 
to stop running any unwanted applications, and try to run the application 
again. 

Displaying Multiple Windows 

You do not have to change the size of any window to make sure all windows 
fit in the work area. As you add or subtract each new window, the existing 
windows are automatically made smaller or larger to accommodate the num
ber of windows in the work area. This process is called automatic tiling. 

MS-Windows follows these general automatic tiling rules when you expand 
an icon to a window: 

• If there are no windows in the work area, the icon expands to a window 
that fills the entire work area. 

• If you place the icon within an existing window, the icon replaces the 
existing window. The existing window shrinks to an icon in the icon 
area. 

• If you place the icon on the border between two existing windows, the 
new window expands between the existing windows. 

• If you place the icon on a vertical or horizontal border of the screen, 
the new window expands between the border and any existing window. 
For example, if you place the icon on the left vertical border of the 
screen, the new window expands between the left vertical border of the 
work area and any existing window. 
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• When you expand an icon by double-clicking on it: 

- If there are no windows in the work area, the icon expands to a 
window that fills the entire work area. 

IIIII 

- If there are other windows in the work area, the newly selected 
application is displayed directly above the icon area and below the 
existing windows. 

Displaying Icon Names 

Although icons are unique for each application, you can have more than one 
icon for the same application, such as Notepad, each containing a different 
text file. Because all Notepad icons look alike, you need to display the names 
of the applications the icons represent to identify which file you want. 

To display an icon name: 

1. Point to the icon. 

2. Press and hold down the Shift key. 

The icon name is displayed above the icon. Figure 2-1 shows an icon 
with the icon name. 

Figure 2-1 Displaying the Icon Name 

For the Notepad icon, the icon name is displayed with the name of its text 
file. The icon name displayed above the icon is the same as the icon name 
displayed in the title bar when the application runs in a window. The icon 
name remains as long as you hold down the Shift key and point to the icon. 

To display the name of another application, continue to hold down the Shift 
key. 
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Running Two Applications 

Open the Information System window and display Notepad as an icon. 

To expand the Notepad icon and display it as a second window, drag the 
Notepad icon to the left border in the work area. 

When you hold down the left mouse button, you can drag the icon anywhere 
on the screen. When you release the left mouse button in the work area, the 
icon expands to a window. 

The Notepad window is now in the left half of the work area, and the Infor
mation System window is in the right half. Screen 2-1 shows both windows. 

I 

Screen 2-1 

2-4 

Information System • 
nei '. Bookmark 

Main Menu 
Welcome to the Information System. New 
Sys~eR Handbook and then select the fil 

For He. Users: 
[> Getting Started Ihth YoU!' UANmate 

General Topics: 
[>. Desktop Applications 
I> t"S-lhndows 
C.> Notes FI'om YOUI' System Administl'at 
[> Standal'd Applications 
C::> UT220 Tel'minal EmulatOi' 
C> UT240 Terminal EmulatOl" 

Advanced Topics: 
[>- ~isks and ~iskettes 
[> I1S-00S Opel"ating Systelll 
[> I1S-00S Operating Systelll Commands 
I> UAXmate Netwol'k 

Trouble Shooting: 

Displaying Two Windows 
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Running Three Applications 

To expand the Clock icon and display it as a third window, drag the Clock 
icon to the right border of the Information System window. 

The Clock icon changes to a blank rectangle when you drag it. 

The Clock window is displayed in the right quarter of the work area. Screen 
2-2 shows the Notepad, Information System, and Clock windows. 

%:jlfu% ~,®~Hotepad - (unhtled) !¥.~f '". :.. Ilnforlllatlon 81/5'. 

Screen 2-2 Displaying Three Windows 

\. 
\. 

• 

• 

ff------ • 
• 

• • • 
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Switching Windows 

Although you can run several windows simultaneously in the work area, you 
can only work in one window at a time. The window in which you work is 
called the active window. Only the active window is affected by commands 
and any other information you enter with the mouse or the keyboard. 

To make another window the active window, you switch to it. Each time you 
switch, you leave a window and the application running in it, and resume 
another where you left off. 

To switch to another window, click inside the window to which you want to 
switch. 

The window you selected becomes the active window. Its title bar is high
lighted. You can now work in this window. 

Moving Windows 

You can rearrange your windows in the work area. For example, you can 
move the the Clock window below the Notepad window to make the Infor
mation System window wider and easier to use. 

To move the Clock window: 

1. Point to the middle of the Clock window title bar. 

2-6 

When you click on the title bar, the cursor changes to the Clock icon (a 
blank rectangle). 
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2. Drag the icon down and to the left until the icon is on the lower border 
between the Notepad window and the icon area. Screen 2-3 shows mov
ing the Clock icon. 

• • • 
• 

• 

• 
• • • 

Screen 2-3 Moving the Clock Icon 
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3. Release the left mouse button. 

2-8 

The Clock window is below the Notepad window. Screen 2-4 shows the 
new location of the Clock window. 

• 

• 

• 

• • y • 
" / • 

i! 
i 

i 
./ • 

I nfo,'matlon System • 
c,o,,,,,, Rei'!:; Bookmark 

Main Men.u 
Welcome to the Information System, New 
.fyst:elll Handbook and then select the fi' 

For He. Users: 
[> Getting Sta,'ted With YoU!' UAXmate 

General Topics: 
~> Desktop Applications 
~> MS-flindows 
~> Notes From You,' System Administ,'at 
~> Standard Applications 
[>. UT220 Tet'filinal El1lulator 
I>· UT240 Tet'filinal El1lulator 

Aduanced Topics: 
[> Disks and Diskettes 

1111 MS-DOS Operating ~stem 
[> MS-DOS Ope,'ating Sjh;tem Commands 
~> UAXmate Netwo,'k 

Trouble Shooting: 

Screen 2-4 Clock Window After a Move 
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Changing the Size of a Window 

When you have more than one window in the work area, you can change 
some of the windows' sizes to better use the work area. Using the System 
menu commands and other components of a window, you can make a 
window: 

• Larger 

• Smaller 

• Fill the entire screen (zoom) 

Making a Window Larger 

To make a window larger, use: 

• The Size command from the System menu 

• The Size box in the title bar 

Using the Size Command 

To make the Notepad window larger by using the Size command: 

1. Select the Size command from the System menu of the Notepad 
window. 

The cursor changes to a small box, called the size box. 

2. Move the size box beyond the Notepad window borders until the win
dow is the size you want. You do not need to hold down the left mouse 
button to move the size box. 

Nothing happens until the size box moves beyond the borders of the 
window. After you cross the borders, a pair of lines, one vertical and 
one horizontal, show the new size of the window. 
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Screen 2-5 shows the new size for the Notepad window. 

( 
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• • 

I • • 

• ' . 
• • 

Welcome t the Infoo·mation System. He" 
Sys<en Handbook and then select the fio 

For He. Users: 
C> Gett:~ng Started Iii th Your UAXmate 

General Topics: 
t> Desktop ApplIcations 
t>, 11S-ll:i.ndo"s 
[>. Hotes From Your System Administo·at 
t> Stanolard Applications 
C> UT22fJ Terminal Emulator 
I> UT24fJ Teo·minal Emulatoo· 

Aduanced1Topics: 
[>Ois~ and Diskettes 
[>. 11S-Dl)'"S Operating System 
[> ~lS-DOS Opeo·ating System Commands 
[>, UAXmdte Het"oo·k 

Trouble Shooting: 

Screen 2-5 Defining the Larger Notepad Window 
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3. When the window is the size you want, click the left mouse button. 

MS-Windows widens the Notepad window and adjusts the size of any 
adjacent windows. Screen 2-6 shows the larger Notepad window. 

Notepad - (untitled) • 
earch 

Sys 
~ysrePl Handbook and then sele! 

F or He. Users: 
[> Getting Sta,·ted With Your 

General Topics: 
[:.> Desktop Applications 
I> MS-Ihndows 
[> Notes From Your System Ad 
[> Standard Applications 
~> UT220 Terminal Emulator 
[> UT240 Terminal Emulato,' 

~1I1I1I1I1I1I~iI~~III1I1i1111111111i1[J uanced Topics: 
t~ Disks and Diskettes 

1--- C> MS-DOS Ope"ating System 
r> 1'1S·-OOS Operating System C 
[> UAXIIlate Het~lol'k 

Trouble Shooting: 

Screen 2-6 Larger Notepad Window 

Using the Size Box 

Some windows have a size box in their upper- or lower-right corner. 

To make a window larger using the size box: 

1. Point to the size box of the window you want to change. 

2. Drag the size box beyond the window borders. 

3. When the window is the size you want, release the left mouse button. 

MS-Windows makes the window larger and adjusts the size of the other 
windows in the work area. 
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Making a Window Smaller 

To make a window smaller, use: 

• The Size command from the System menu 

• The Size box in the title bar 

Using the Size Command 

To make a window smaller by using the Size command: 

1. Select the Size command from the System menu in the window you 
want to make smaller. 

The cursor changes to the size box. 

2. Move the size box beyond the window borders and back within the 
borders. 

A pair of lines, one vertical and one horizontal, shows where the bor
ders of the new window are located. 

3. When the window is the size you want, click the left mouse button. 

MS-Windows makes the window smaller and adjusts the size of the other 
windows in the work area. 

Using the Size Box 

To make a window smaller using the size box: 

1. Point to the size box of the window you want to change. 

2. Drag the size box beyond the window borders and back within the 
borders. 

3. When the window is the size you want, release the left mouse button. 

MS-Windows makes the window smaller and adjusts the size of the other 
windows in the work area. 
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Filling the Screen With a Window 

When you are working with more than one window, you can enlarge one 
window temporarily to fill the entire screen, without moving the other win
dows to the icon area. This process is called zooming. 

To fill the screen with a window, use: 

• The Zoom command from the System menu 

• The size box 

Using the Zoom Command 

To zoom the Information System window, select the Zoom command from 
the System menu of the Information System window. The window enlarges to 
fill the entire screen, including the icon area. Screen 2-7 shows an Informa
tion System window that has been zoomed. 

Infot'lllat10n Systelll 
Find GoBack i" G',', ~,"" Bookllla"k Copy Help 

Main Menu 
Welcollle to the Info"lllation Systelll, Hew users should "ead the (11l,I'nJte 
Syst:ePl Handbook and then select the fi,'st topic frolll the Illenu below, 

For Hew Users: 
[> Getting Sta,'ted l-lith Your UAXlllate Workstation 

Gel{,-,.ral Topics: 
[> \\ Desktop Applications 
I> MS-Windows 
I> Hotes F,'olll YoU!' Systelll Adlllinist,'ato,' 
I> Standa"d Applications 
[> UT220 Terlllinal Elllulator 
[> UT240 Te"lllinal Elllulator 

Advanced Topics: 
[> Disks and Diskettes 
\:-.. > MS-DOS Operating Systelll 
~> MS-DOS Operating Systelll COllllllands 
[> UAXlllate Network 

Trouble Shooting: 
l> Systelll t1essages 

Screen 2-7 Window Filling the Entire Screen 

To restore the window to its former size, select the Zoom command again. 
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Using the Size Box 

To use the size box to zoom, double-click on the size box. 

The window enlarges to fill the entire screen, including the icon area. 

To restore the window to its former size, double-click on the size box again. 

Shrinking a Window to an Icon 

You can free space in the work area by shrinking a window into an icon. For 
example, you can shrink the Information System to an icon if you are fin
ished using it but want it available for later use. It still runs in memory but 
does not take up space in the work area. 

To shrink a window to an icon, use: 

• The Icon command 

• The title bar 

Using the Icon Command 

To shrink the Information System window into an icon using the Icon com
mand, select the Icon command from the System menu of the Information 
System window. 

The Information System shrinks to an icon, and the other windows adjust to 
fill the work area. Screen 2-8 shows an example of shrinking a window to an 
icon. 
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File Edit Sea~ch 

I 

~ 

Hotepad - (unt1tled) 

I 

• • • 
• L • 

• • 

• r • 
,I 

• • 

Screen 2-8 Shrinking a Window to an Icon 

Using the Title Bar 

To shrink the Information System window to an icon using the title bar, you 
can: 

1. Point to the middle of the Information System title bar. 

Press the left mouse button. The cursor changes to the application icon. 

Drag the Information System icon to the icon area and release the left 
mouse button. 

2. Double-click on the middle of the title bar of the window you want to 

shrink. 
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Transferring Information Between Windows 

You can transfer information within a window or between windows. You can 
move or copy information: 

• From one place in a window to another 

For example, you can move text in a report as you edit. 

• From one window to another window when both windows are running 
the same application 

For example, you can transfer information from one report being pre
pared by a word processing application into another report being pre
pared by the same word processing application. 

• From one window to another window when the windows are running 
different applications 

For example, you can transfer numbers from a spreadsheet application 
into a report being prepared with a word processing application. 

To move information, you can: 

• Retype information in a window 

• Cut or copy information from one area, then paste it into another area 

Cutting and Pasting 

To transfer larger quantities of information, use the cut (or copy) and paste 
features of MS-Windows. 

To cut and paste information, MS-Windows uses the Clipboard to hold infor
mation. The Clipboard is a temporary storage area that holds the information 
while you move it from its original location to its destination. The Clipboard 
is always available when you run MS-Windows. You do not need to run any 
program to use the Clipboard. 

Each time you cut or copy information to the Clipboard, anything already 
stored there is overwritten (the previously stored information is deleted.) 
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To transfer information to the Clipboard, use the Cut command or the Copy 
command procedure of your application. To insert information from the 
Clipboard to your application, use your application's Paste command proce
dure. Although your application may have different names for these com
mands, the commands should work as described in Table 2-1. 

Table 2-1 Cut, Copy, and Paste Commands 

Command 

Cut 

Copy 

Paste 

Description 

Deletes the selected information from the window and places it on 
the Clipboard. 

Copies the selected information and places it on the Clipboard. The 
selected information remains intact in its original location. 

Inserts information from the Clipboard into a selected location in a 
window. You can paste the same information from the Clipboard as 
many times as you want as long as it occurs in one operation. When 
you put new information into the Clipboard, the previous informa
tion is deleted. 

If you move the cursor in the window, the information is inserted 
and displayed to the left of the cursor. 

If you have marked text for selection in the receiving document, 
the information from the Clipboard replaces the selected text. For 
more information on marking text, see Chapter 7. 

Generally, ASCII text and data are stored on the Clipboard, but formatting 
commands for your text or data are not. However, this may vary with your 
application. 

Some standard applications (applications that run on your workstation) have 
commands similar to Cut, Copy, and Paste, although they do not necessarily 
use the MS-Windows Clipboard to transfer information. 
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Receiving Messages From Another Application 

When another application sends you status or error information, you hear a 
beep, and the application sending you the message flashes its title bar or 
icon. To display the message in a dialog box, switch to the flashing window 
or icon by clicking on it. 

Figure 2-2 shows an example of a message an application sends you. In this 
example, the Calendar application reminds you of an appointment. 

Please re~e~ber ... 

eetlng 

( Ok ) 
•••••••••••••••••••••••• I 

Figure 2-2 Message From Another Application 
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Chapter 3 
Using the MS-DOS 
Executive Window 

This chapter describes the MS-DOS Executive window and its components 
and tells you how to: 

• Use menus and commands 

• Load an application 

• Run an application 

• Run MS-DOS commands and programs 

• Finish your MS-DOS Windows session 

Chapter 4 discusses using the MS-DOS Executive window to work with files. 
Using the MS-DOS Executive window to work with directories and disks is 
discussed in Chapter 5. 

Defining the MS-DOS Executive Application 

You use the MS-DOS Executive application, an MS-Windows application, to 
control or manage your MS-Windows session. The MS-DOS Executive applica
tion runs when MS-Windows runs, either as a window or as an icon. (Chapter 
7 describes an exception to this rule, associated with running certain kinds 
of applications.) 

With the MS-DOS Executive application, you can perform most of the func
tions that you do by entering MS-DOS commands. 

If your key diskette is set up so that an application runs automatically in a 
window, the MS-DOS Executive application is an icon, resembling a diskette, 
in the icon area. To use this application, expand its icon into the work area. 
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If an application is not set up to run automatically, the first window you see 
is the MS·DOS Executive window. You use this window to run any applica
tion not already loaded as an icon and to load any application into the icon 
area. 

MS-DOS Executive Window Components 

Screen 3-1 identifies the components of the MS-DOS Executive window. 
Table 3-1 describes these components. 

System menu \ box Cu rsor Title bar Path name Size box 

Menu bar 
Drive icons -AI I ci I D 

Highlight +-t;]UM':' 
CALC .EXE 
CALENDAR .EXE 
CARDFILE .EXE 
CllPBRD .EXE 

Directory ~~~~:ot:~XE 
listing DOTHIS. TXT 

HSDOS .EXE 
NOTEPAD .EXE 
PAINT .EXE 
REUERS I • EXE 
SPOOLER .EXE 
UT220.EXE 

Icons 

Screen 3-1 MS-DOS Executive Window 
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Work 
area 
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Table 3-1 MS-DOS Executive Window Components 

Component 

System menu box 

Menu bar 

Title bar 

Size box 

Cursor 

Work area 

Scroll bar 

Drive icons 

Highlight 

Path 

Current directory 

Directory listing 

Description 

Contains the commands, such as Move, Zoom, and Close, 
you use to manipulate the window. This menu is common 
to most MS-Windows applications. 

Contains the three menus of the MS-DOS Executive 
application: File, View, and Special. 

Displays the name of the MS-DOS Executive application. 

Changes the size of a window. 

Is the mouse cursor you use to point to an object. 

Is the expanded window. 

Displays in the window when there is more information 
than can be displayed in one screen. 

Represent the disk drives of your workstation. The current 
drive is highlighted. 

Shows the file name or menu command that is currently 
selected. 

A hierarchy of directories. Consists of the drive letter, the 
volume name (if there is one), the directory and 
subdirectory names, then the current directory name. Each 
directory is separated by a backslash (\). 

The directory you are in now. In the path name, the 
current directory is the one at the right. 

Lists the file names in the current directory. A directory is 
a group of files stored on a disk. 
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Using Menus and Commands 

The MS-DOS Executive has four menus from which you can display and 
select commands: 

• System menu 

• File menu 

• View menu 

• Special menu 

The System menu is represented by the System menu box. The other three 
menus are in the Menu bar. When you select a menu, a drop-down menu is 
displayed, containing the menu's commands. 

System Menu 

The System menu contains commands for manipulating the windows and is 
common to most applications. Figure 3-1 shows the System menu commands. 

I Size 
· Moue 

Icon 
ZOOIll 
Close 

About ... 
Figure 3-1 System Menu Commands 

When you select the About command in the MS-DOS Executive window, 
MS-Windows displays a dialog box, showing the amount of disk space and 
memory space available on your workstation. 
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File Menu 

The File menu contains commands that let you act on the files displayed in 
the MS-DOS Executive window. When you select any of these commands, 
except for the Get Info command, MS-Windows displays a dialog box in the 
window. In the dialog box, you enter additional information needed by the 
command before MS-Windows executes the command. 

Figure 3-2 shows the File Menu. Table 3-2 describes the File menu com
mands. For more information on using the File menu commands, see 
Chapter 4. 

--- Uiew 
Run .•• 
Load .. . 
Copy . . . 
Get Info 
Delete .. . 
Print .. . 
Rename .•• 

Figure 3-2 File Menu Commands 
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Table 3-2 File Menu Commands 

Command Description 

Run Runs the application in the window. Select the Run 
command to run an application not in the current 
directory listing and to enter a program parameter for the 
selected application. 

Load 

Copy 

Get Info 

Delete 

Print 

Rename 

3-6 

Using the Run command is the preferred method of 
running an application. 

Loads the application as an icon in the icon area. Select the 
Load command to load an application not in the current 
directory listing and to enter a program parameter for the 
application. 

Copies the files to a different directory or disk, or to a 
different file name in the same directory. 

Displays the file names, file extensions, size in bytes, and 
the date and time the file was created or most recently 
changed for the selected files. 

Deletes the selected files from the directory and the disk. 

Prints the selected files or directory listing on your printer. 

Changes the name of the selected files. 
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View Menu 

The View menu contains commands that let you list the directory files. The 
commands are divided into three groups. Only one command from each 
group can be active at a time. The active command in each group is pre
ceded by a check mark. 

By selecting the commands you want, you can list the directory files in the 
way you want. The commands you select from the View menu affect any 
directory you display in the MS-DOS Executive window. 

Figure 3-3 shows the View menu. Table 3-3 describes the View menu com
mands, according to each group . 

• I~ Special 
.J Short 

long Group 1 

..JAIl 
Partial ... Group 2 

Programs 

..JOy Name 
By Date Group 3 
By Size 
By Kind 

Figure 3-3 View Menu Commands 

3-7 



IIIII TT' ., .,~ -~~ - •.. a 
IIIII uSIng IOf! iVl~-UU~ l:'.xecutlve Win ow 

Table 3-3 View Menu Commands 

Command 

Group 1: 

Short 
(default 
setting) 

Long 

Group 2: 

All 
(default 
setting) 

Partial 

Programs 

Group 3: 

3-8 

By Name 
(default 
setting) 

By Date 

By Size 

By Kind 

Description 

Lets you select how much information is displayed for each 
file. 

Displays a directory listing by file name only. 

Directory names are displayed in bold letters. 

Displays a directory listing by file name, file extension, size in 
bytes, and date and time last changed for each file listed. The 
key information by which the files are sorted (name, date, size, 
or type) is displayed in boldface. 

Directory names are listed in one column, with <DIR> to the 
right of each directory name. 

Lets you select which files are listed. 

Lists all the files in a directory. 

Lists all files with the specified file specification. 

For example, if you type' .TXT in the displaying dialog box, 
only files having the file extension .TXT are displayed. 

Lists all files that can run as programs, such as files having the 
file extension .EXE, .BAT, and .COM. 

Lets you select the key information by which the files are 
sorted and displayed. If you select the Long command from 
Group 1, the key information is displayed in boldface. 

Sorts a directory alphabetically by file name. 

Sorts a directory by the date and time each file was created or 
most recently changed. MS-Windows lists the most recent date 
and time first. 

Sorts a directory according to the size of each file in bytes. 
MS-Windows lists the files from largest to smallest. 

Sorts a directory alphabetically by file extension. MS-Windows 
sorts files with the same file extension alphabetically by name. 
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Special Menu 

The Special menu contains commands that let you: 

• Finish the MS-Windows session 

• Work with disks 

• Work with directories 

Figure 3-4 shows the Special menu. Table 3-4 describes the Special menu 
commands. For more information about the commands that let you work with 
disks and directories, see Chapter 5. 

Special 
End Session 
Create Directory .. . 
Change Directory .. . 
For~at Data Disk .. . 
Make Syste~ Disk .. . 
Set Uolu~e Na~e .. . 

Figure 3-4 Special Menu 

Table 3-4 Special Menu Commands 

Command 

End Session 

Create Directory 

Change Directory 

Format Data Disk 

Make System Disk 

Set Volume Name 

Description 

Finishes your MS-Windows session. 

Creates a new directory. 

Changes directories. 

Formats a data diskette. 

Creates a diskette containing the MS-DOS operating system 
files. 

Assigns the name you enter to a disk (also called a volume). 
This command can also change the name of an existing 
volume. 
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Loading an Application 

Use the MS·DOS Executive window to load an application as an icon in the 
icon area. 

To load an application into the icon area, use: 

• The Load command from the File menu 

• The file name 

Using the Load Command 

Use the Load command from the File menu to: 

• Load an application into memory 

• Run the application as an icon 

• Display the application icon in the icon area 

From your default directory, you can use the Load command to load any 
application, which is in your path. The default directory becomes the current 
directory for the application you are running. 

The Load command is also useful for entering a program parameter or a 
command line argument when you start the program. For example, when 
loading Notepad, you can specify a text file to edit. 

To load an application: 

1. Select the Load command from the File menu. 

3·10 

The MS·DOS Executive window displays the Load dialog box. Figure 3·5 
shows the Load dialog box. 

load: 11o.:..1 __ I ____________ --J 

( Ok ) [Cancel) 

Figure 3-5 Load Dialog Box 
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2. In the dialog box, type the file name of the application you want to 
run. 

11111 

If the application is not in the path, include the drive and directory of 
the application you want to run. 

Also type any additional information that the application needs, such as 
a command line argument. 

3. Click on the Ok command button. 

The application you selected loads into memory. If the application has 
an icon, it runs in the icon area, and its icon is displayed. Otherwise, it 
may display as a pop-up window. 

If you have an application in the current directory, you can highlight the file 
name of the application before you select the Load command from the File 
menu. This name is displayed in the dialog box, and you can add any pro
gram parameters necessary for your application. 

Using the File Name 

To load an application from the current directory into the icon area: 

1. Press and hold down the Shift key. 

2. Double-click on the file name of the application you want to load as an 
icon. 

The application you selected from the current directory loads into mem
ory. It runs in the icon area, and its icon is displayed. 

Running an Application 

To run an application in a window, using the MS-DOS Executive window, 
you can use: 

• The Run command from the File menu 

• The file name 
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Using the Run Command 

The Run command gives you more capabilities for running an application 
than when you run a program using other methods. From your default direc
tory. you can use the Run command to run any application, which is in your 
path. The default directory becomes the current directory for the application 
you are running. 

The Run command is also useful for entering a program parameter and com
mand line arguments when you start the program. For example, when run
ning Notepad, you can include the name of a text file you want to edit. 

To run an application: 

1. Select the Run command from the File menu. 

The MS-DOS Executive window displays the Run dialog box. Figure 3-6 
shows the Run dialog box. 

Run: ~II ______ I ______________________ ~ 

( Ok ) (Cancel) 

Figure 3-6 Run Dialog Box 

2. In the dialog box, type the file name of the application you want to 
run. 

If the application is not in the path, include the drive and the directory 
of the application you want to run. 

Also type any additional information that the application needs, such as 
a command line argument. 

3. Click on the Ok command button. 

The application you selected replaces the MS-DOS Executive application 
in the window. The MS-DOS Executive application changes to an icon. 

If you have an application in the current directory, you can highlight the file 
name of the application before you select the Run command from the File 
menu. This name is displayed automatically in the dialog box, and you can 
add any program parameters necessary for your application. 
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Using the File Name 

To run an application in your default directory, double-click on the file 
name of the application you want to run. 

The file name is highlighted. 

The cursor temporarily changes to an hourglass, indicating that MS-Windows 
is loading the application into memory. 

The application you selected replaces the MS-DOS Executive application in 
the window. The MS-DOS Executive application changes to an icon. 

Using Temporary Files 

Some applications that run with MS-Windows create temporary files with the 
file extension .TMP to store your work. 

The file names for temporary files begin with a tilde character and letters 
indicating the application name. For example, a temporary file for MS-Paint 
has the file name -MSP*.TMP. 

You can create a special directory on your local hard disk drive to hold 
temporary files. To send temporary files to a directory, put the SET TEMP 
command in your AUTOEXEC.BAT file. 

Do not delete these files while MS-Windows is running, because an applica
tion may be using them_ You can delete them after quitting your 
MS-Windows session. 

Running Batch Files 

You run batch files only from the MS-DOS Executive window. If you run a 
standard application from a batch file, you should create a PIF for the batch 
file. For more information about PIFs, see Appendix C. 

Set options in the batch file's PIF to be the same as the application's PIF. 
However, set the Memory Required and Memory Desired options for the 
batch file's PIF to 32K, regardless of the memory requirements for the 
application. 
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Using MS-DOS Commands and Programs 

MS-DOS commands are divided into three groups: 

• Commands you cannot use from MS-Windows 

• Commands you run from MS-Windows with COMMAND.COM 

• Commands you run from the MS-DOS Executive window 

Those commands that you cannot run from MS-Windows, you can run from 
the MS-DOS operating system prompt. Or, you can put these commands in 
your AUTOEXEC.BAT file, which runs automatically before MS-Windows 
starts. For more information on MS-DOS commands and programs, see Volume 
2 of this guide. 

The MS-DOS commands you should not run from MS-Windows are: 

APPEND 
ASSIGN 
CHKDSK 
CITY 
FONT 

GRAFTABL 
GRAPHICS 
JOIN 
KEYB 
LCOUNTRY 

MODE 
NET START 
PRINT 
RECOVER 
SELECT' 

SHARE 

The MS-DOS commands you can run in MS-Windows from the Command win
dow are: 

BREAK ECHO MORE SET 
CHDIR' ERASE' PATH SHIFT 
CLS EXIT PAUSE TIME' 
COPY' FOR PROMPT TYPE 
DATE' GOTO REM VER' 
DEL' IF REN' VERIFY 
DIR' MKDIR' RMDIR' VOL' 

The MS-DOS commands you can run from the MS-DOS Executive window are: 

ATTRIB EDLIN FORMAT' RESTORE 
BACKUP EXE2BIN LABEL SORT 
COMMAND FC LINK SUBST 
DEBUG FDISK NET SYS' 
DISKCOPY FIND PERMIT 

• These commands have an MS-Windows equivalent. 
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Running an MS-DOS Operating System Program 

To run an MS-DOS command in MS-Windows with COMMAND.COM: 

1. Select the RUN command from the File menu in the MS-DOS Executive 
window. 

2. In the dialog box, type: 

COMMAND 

3. Click on the Ok command button. 

The MS-DOS command processor starts in a window titled "Command." 

4. Type the MS-DOS command and command arguments you want at the 
MS-DOS prompt. 

5. To stop using COMMAND.COM, type: 

EXIT 

The window title is now enclosed in parentheses. 

6. Close the window. 

To run an MS-DOS command from the MS-DOS Executive window: 

1. Select the RUN command from the File menu. 

2. Type the command name and its arguments in the dialog box. 

3. Close the window. 

If the application does not stop automatically, type the Exit command 
and then close the window. 

Finishing an MS-Windows Session 

To finish an MS-Windows session: 

1. Save all files you have worked on. 

2. Exit from any standard application still running in a window or as an 
icon. 
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3. From the MS-DOS Executive window, end your MS-Windows session 
by using one of the following methods: 

• Double-click on the System menu box. 

• Select the Close command from the System menu. 

• Select the End Session command from the Special menu. 

With any method, a dialog box is displayed, indicating that this action 
ends your MS-Windows session. 

4. Click on the Ok command button. 

MS-Windows closes, and the MS-DOS operating system prompt is dis
played on the screen. 

NOTE 
You can now enter MS-DOS commands. To restart MS-Windows 
from the MS-DOS operating system prompt, type: 

WIN 

Press the Return key. The DIGITAL logo is displayed, followed by 
MS-Windows. 

5. Turn off your workstation. 

6. Remove your key diskette if you do not want anyone else to access your 
files. 

If you try to close MS-Windows while an MS-Windows application such as 
Notepad is still running, MS-Windows displays a dialog box and lets you save 
the updated data file. 

If you try to close MS-Windows while a standard application is still running, 
MS-Windows displays a dialog box indicating an application is still running. 
The name of the active application is displayed in the title bar of the dialog 
box. Close the identified application, then close MS-Windows again. 
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Chapter 4 
Working With Files 

This chapter describes how to use the MS-DOS Executive window to: 

• Use files 

• Select files 

• Copy files 

• Delete files 

• Print files 

• Rename files 

• Get information about files 

This chapter describes how to work with the file names listed in the MS-DOS 
Executive window. 

Using Files 

Your workstation stores information on a disk in files. Each file has a name, 
usually assigned by you. A file can contain a document, an application, a 
program you have written, or coded information for use by an application. 

Files in MS-Windows use MS-DOS file-naming conventions. For more informa
tion, see Chapter 30. 
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Selecting Files 

When you work with MS-Windows, you must select the file that the next 
command or action affects. The selected file is highlighted. 

With MS-Windows you can select: 

• One file 

• Multiple files 

Selecting a File 

To select a file, click on the file name you want. 

To cancel the selected file: 

1. Press and hold down the Shift key. 

2. Click on the highlighted file name. 

The highlight is removed from the file name. 

Selecting Multiple Files 

To select multiple files: 

1. Click on the first file name you want to select. 

2. Hold down the Shift key. 

3. Click on each additional file name you want to select. 

4-2 

If you select a file name by mistake, you can cancel the selection by 
clicking on it again while still holding down the Shift key. 
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4. After you select all the files you want, release the Shift key. 

If you release the Shift key and click on a file name, the file name you 
selected is highlighted, and all the highlighted files are no longer 
selected. 

Screen 4-1 shows a group of selected files. 

MS-DOS ExecutIve • 
File Uiew Special 

CALC .EXE 
CALENDAR .EXE 
CARDFILLEXE 
CLIP8RD.EXE 
CLOCK.EXE 
CONTROL.EXE 
!lI11I11""t:t~ 
MSDOS .EXE '. 
NOTEPAD.EXE 
PAINT.EXE 
REUERSI.EXE 
SPOOLER.EXE 
UT220.EXE 

Screen 4-1 Selecting Multiple Files 
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Using the File Menu Commands 

The File menu of the MS·DOS Executive window contains commands that 
affect a file. The Run and Load commands are described in Chapter 3. Figure 
4·1 shows the Fiie menu commands. 

Copying Files 

Run •.. 
Load ... 
Copy ••• 
Get Info 
Delete ... 
PI":i nt ••• 

Figure 4·1 File Menu Commands 

To copy an existing file, use the Copy command. You can use this command 
to copy: 

• An existing file into another directory 

• A file with a new name 

You can copy both single and multiple files. 
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Copying One File 

To copy one file: 

1. Click on the file name you want to copy. 

The file name is highlighted. 

2. Select the Copy command from the File menu. 

MS-Windows displays the Copy dialog box. Figure 4-2 shows the Copy 
Command dialog box. 

Copy: I DOTHIS. TXT 
To: ~II ____________________________ ~ 

( Ok ) (Cancel) 

Figure 4-2 Copy Command Dialog Box 

The file name you selected is in the Copy text box, indicating that the 
file is the source file you want to copy from. 

3. In the To text box, type the new file name, including the new drive and 
directory if applicable. 

4. Click on the Ok command button. 

A message is displayed at the bottom of the Copy dialog box, indicating 
that the file you selected is being copied. 

MS-Windows takes a few seconds to create the new file with the 
specified name. Mter MS-Windows creates the new file, the dialog box 
is removed from the window. 

The MS-DOS Executive window then displays a new list of file names, 
including the new file you created. 
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Copying More Than One File 

To copy several files at the same time to another directory or drive: 

1. Select all the file names you want to copy. 

2. Select the Copy command from the File menu. 

MS-Windows displays the Copy dialog box, containing all the selected 
file names. 

If the file name is not listed in the dialog box, type the correct one, 
including any file extension. 

3. In the To text box, type the drive and directory to which you want the 
files copied. 

NOTE 
You cannot copy more than one file to a single file. (Use the 
MS-DOS operating system to concatenate files.) However, you can 
copy multiple files to a drive or an existing directory. 

4. Click on the Ok command button. 

Deleting Files 

To delete files that are no longer useful to make space for other files, select 
the Delete command. When you delete a file, MS-Windows removes it from 
the disk permanently. 

Deleting One File 

To delete a file from the File menu: 

1. Click on the file name you want to delete. 

2. Select the Delete command from the File menu. 

MS-Windows displays the Delete dialog box, containing the name of the 
selected file. 

If the file name is not the one you want to delete, type the correct file 
name over the one displayed. You must type the entire file name, 
including any file extension. 

3. Click on the Ok command button. 
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Deleting More Than One File 

To delete more than one file at a time, select all the files you want to delete, 
then follow steps 2 and 3 in the previous section. 

Printing a Text File 

To print text files, select the Print command from the File menu. With the 
Print command, you can print any files you can display on your screen. 

NOTE 
Most applications have a command that prints files you create with 
that application. You should use the application command when 
possible. 

To print a file: 

1. Click on the file name of the text file you want to print. 

The file name you selected is highlighted. 

2. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. Figure 4-3 shows the Print 
dialog box. 

Print: Hllillil~,.t.'ti 

( Ok ) (Cancel) 

Figure 4-3 Print Dialog Box 

If the file name is not the one you want to print, type the correct file 
name over the one displayed. You must type the entire file name, 
including any file extension. 
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3. Click on the Ok command button. 

The MS-DOS Executive window displays the Print Spooler dialog box, 
telling you the file is being sent to the Spooler for the default printer. 
Figure 4-4 shows the Print Spooler dialog box. 

NOTE 

EI fitS-DOS Executl ue 

Sending 
D01HIS.1)(1 

to p~int spoole~. 

(Cancel) 

Figure 4-4 Print Spooler Dialog Box 

Printing does not start until the file has been sent to the Print 
Spooler. The length of the delay before the printer starts depends 
on the complexity and length of the file you are printing. 

For more information about the default printer and how to select it, see 
Chapter 8. 

To cancel the print request, click on the Cancel command button. 

Using the Spooler 

The MS-Windows Spooler is an application that stores files waiting to be 
printed. When you execute the Print command from the MS-DOS Executive 
or from a Desktop application: 

• The Spooler application statts. 

• The Spooler icon is displayed in the icon area. 

• A file is sent to the Spooler application. 

• The Spooler statts to print the file on your printer, if no other files are 
printing. 
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The Spooler application works in the background; therefore, you do not have 
to wait while your file prints. You can perform another task or work with 
another application while the Spooler prints your file. 

If you expand the Spooler icon in the work area, the Spooler window lists: 

• The file names in the order they are to be printed 

This listing is called a print queue. The first file name in the print 
queue is the one that is currently printing. 

The Spooler prints the files one at a time, in the order they are listed. If 
the listing scrolls off the bottom of your window, use the vertical scroll 
bar to see the entire list. 

• The printers installed on the workstation 

Screen 4-2 shows the Spooler window. 

priorit~ Controls 

README.TXT 
DOTHIS.TXT 

LPT2 [Actiue]: Digital LHH3 
LPT3 [Actiue]: Digital LASH 

Spoo]Pt· • 

Screen 4-2 Print Spooler Window With Print Queue 
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The Spooler application has two menus: 

• Priority 

• Control 

Priority Menu Commands 

The Priority menu commands specify how fast you want to print your work. 
These commands change the rate of data transfer from the Spooler to the 
printer ports. 

To specify how fast to print: 

1. To print faster, select the High command from the Priority menu. 

This setting uses more resources of your workstation for printing. The 
system slows down, and other applications you are using run more 
slowly. 

2. To print slower, select the Low command from the Priority menu. 
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This setting allows the other applications you are working with more 
resources of your workstation. 

The check mark in the menu shows the current setting. Low is the 
default setting. 
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Control Menu Commands 

The Control menu commands interrupt or cancel a print job. 

To interrupt a print job (to change a ribbon, for example): 

1. Select the Pause command to interrupt printing. 

The status of the printer changes to Paused in the Spooler window, and 
the printer stops printing. 

2. To continue printing the file, select the Resume command. 

To cancel a print job: 

1. In the Spooler window, click on the file name of the job you want to 
cancel. 

2. Select the Terminate command. 

MS-Windows displays the Terminate dialog box. 

3. Confirm the cancellation. 

4. Click on the Ok command button. 

The file name you selected is removed from the print queue. 

WARNING 
If you cancel a job while it is printing in graphics mode, you may 
need to reset your printer to ensure the buffer is cleared. For more 
information on resetting your buffer, see your printer 
documentation. 

The Spooler application sometimes displays information about the status of 
your printing jobs. For example, the printer may be out of paper. If the 
Spooler needs to display information, but the window or icon is not selected, 
the title bar or icon flashes. Select the Spooler window or icon to display the 
message. 
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Renaming a File 

To change the name of a file, use the Rename command. 

To rename a file: 

1. Click on the file name you want to rename. 

2. Select the Rename command from the File menu. 

MS-Windows displays the Rename dialog box. Figure 4-5 shows the 
Rename dialog box. 

Renallle: I DOTHIS. 1):1 

To: ~II ________________________ ~ 

( Ok ) (Cancel) 

Figure 4-5 Rename Dialog Box 

If the file name is not the one you want to rename, type the correct file 
name over the one displayed. You must type the entire file name, 
including any file extension. 

3. In the To text box, type the new file name. 

4. Click on the Ok command button. 
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Getting Information About Files 

To get more information about a particular file or group of files, use the Get 
Info command. 

To get information about a file: 

1. Click on the file names for which you want information. 

2. Select the Get Info command from the File menu. 

MS-Windows displays the Get Info dialog box, containing the file 
names, size in bytes, and the date and time it was created or last 
changed. (You may need to scroll to see all the information in the 
dialog box.) Figure 4-6 shows the Get Info dialog box. 

~ Get Info 
CALC 
CALEHDAR 
CARDFILE 
CLIPBRD 
CLOCK 

.EXE 

.EXE 

.EXE 

.EXE 

.EXE 

24992 1/11/85 
37368 9/11/85 
36528 14/11/85 
9696 23/11/85 
7921 5/11185 

Figure 4-6 Get Info Dialog Box 

1:54PM 
2:12PM 

12:48PM 
4:29PM 

11:18AM 

3. After you finish looking at the Get Info dialog box, close it by either of 
the following: 

• Select the Close command from the System menu. 

• Double-click on the System menu box. 
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Working With 

Directories and Disks 

This chapter describes how to use the MS-DOS Executive window to: 

• Work with directories 

• Work with disks 

Working With Directories 

A directory lists a group of files stored on a disk. Each directory also briefly 
catalogs the group of files it contains. A directory contains information, such 
as the name, size, type of file, and date of entry, of all its files. You can also 
have subdirectories within directories. 

Directory names are displayed at the beginning of the directory listing in the 
MS-DOS Executive window. 

When the listing is in the short form, directory names are displayed in bold 
letters. When the listing is in the long form, directory names are listed with 
<DIR> to the right of each directory name. 

The name of the current directory (the one you are in now) is the directory 
name farthest to the right in the path name at the top of the MS-DOS Execu
tive window. 

For more information about directory structures, path names, and disks, see 
Chapter 30. 

Changing Directories 

You can change directories or subdirectories to see what is in another direc
tory and to work with the files in another directory. The path name at the 
top of the MS-DOS Executive window always shows your location in the 
directory structure. 
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To change directories, us~: 

• The Change Directory command 

• The path name 

• The Word Char key 

Using the Change Directory Command 

To change directories: 

1. Select the Change Directory command from the Special menu. 

MS-Windows displays the Change Directory dialog box. Figure 5-1 
shows the Change Directory dialog box. 

Change To: I'-h_:_\_de_c_a...::...p.:....:pl~ ________ ----I 

( Ok ~ (Cancel) 

Figure 5-1 Change Directory Dialog Box 

2. Type the path name of the directory to which you want to change. 

3. Click on the Ok command button. 
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The directory you selected is displayed in the MS-DOS Executive 
window. 
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Using the Path Name 

To change directories: 

1. Click on the directory in the path name to which you want to change. 

MS-Windows displays the Change Directory dialog box. The path name 
of the directory you selected is displayed in the text box. 

2. To change to a directory other than the one displayed in the text box, 
type the path name of the directory to which you want to change. 

3. Click on the Ok command button. 

The directory you selected is displayed in the MS-DOS Executive 
window. 

Using the Word Char Key 

To change directories only when you want to go to the next higher directory 
(the directory immediately to the left of the current directory in the path 
name), press the Word Char key. 

With this method, no matter where you are or what you have selected in the 
MS-DOS Executive window, the next higher directory (if one exists) is dis
played in the MS-DOS Executive window. 
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Creating Directories 

To create a new directory or subdirectory to organize files, use the Create 
Directory command. You must create a directory before you can put files 
in it. 

To create a new directory: 

1. Select the Create Directory command from the Special menu. 

MS-Windows displays the Create Directory dialog box. Figure 5-2 shows 
the Create Directory dialog box. 

Create Directory: I~I ______________________ ~ 

( Ok ) (Cancel) 

Figure 5-2 Create Directory Dialog Box 

2. Type the name of the new directory or subdirectory. 

3. Click on the Ok command button. 

A new directory, with the name you entered, is created. The new 
directory name is displayed in the MS-DOS Executive window. 

Mter you create a directory, you can copy files into it by using the Copy 
command from the File menu. You can also use an application to create new 
files for the directory. 
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Changing How File Names Are Listed 

The View menu commands change how file names are listed in the MS-DOS 
Executive window. 

When you first start MS-Windows, the files in the MS-DOS Executive window 
are listed in alphabetical order. The directory names are at the top of the list. 

However, you can list files in a different order, such as by size or by the date 
they were created or changed. You can also list files having the same file 
extension. 

To see only files having the same file extension, you must specify the file 
extension. To specify the type of files you want to view, use the Partial 
command. 

To view a partial list of files: 

1. Select the Partial command from the View menu. 

MS-Windows displays the Partial dialog box. Figure 5-3 shows the Par
tial dialog box. 

Partial: ~II ________ ....J 

( Ok ) (Cancel) 

Figure 5-3 Partial Dialog Box 

2. In the text box, type the file names you want to see. 

Use wildcard characters (* or ?) to tell MS-Windows which kind of file 
to display. For example, to display all file names with the file extension 
.EXE, type *.EXE in the text box. 

3. Click on the Ok command button. 
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Displaying Multiple Directories 

You can display more than one MS-DOS Executive window at a time. This is 
useful for displaying two different directories at the same time, one directory 
in each MS-DOS Executive window. 

To display a second MS-DOS Executive window: 

1. Use the Run command to open the second MS-DOS Executive window. 

The file name is MSDOS.EXE. 

2. In the new MS-DOS Executive window, double-click on the directory 
path name you want to display. 

The selected directory is displayed in the second MS-DOS Executive 
window. Two different directories are displayed, one directory in each 
MS-DOS Executive window. 

If you display the same directory in multiple windows, only the directory in 
the active window is updated when you create, delete, rename, or copy a 
file. To update the listing in an inactive window, move the mouse to that 
window and click on the highlighted drive icon. 

Printing a Directory Listing 

To print a directory listing, use the Print command. The directory listing is 
printed as it is displayed in the MS-DOS Executive window. 

To print a directory listing: 

1. Click on the directory name. 

2. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. 

3. Click on the Ok command button. 

The listing of the selected directory is printed. 
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To print the current directory or a directory that is not currently listed: 

1. Select the Print command from the File menu. 

MS-Windows displays the Print dialog box. 

2. In the text box, type the directory specification. 

3. Click on the Ok command button. 

The listing of the specified directory is printed. 

Deleting a Directory 

IIIII 

To delete a directory, use the Delete command. Before you can delete a 
directory permanently from the disk, you must first delete all files in the 
directory. MS-Windows does not allow you to delete a directory containing 
files. This precaution protects you from losing files should you unintention
ally try to delete a directory that is not empty. 

To delete a directory: 

1. Make the directory to be deleted the current directory. 

2. Select all the file names in the directory. 

3. Select the Delete command from the File menu to delete them. 

4. Move to the parent directory. 

5. Select the directory name and select the Delete command from the File 
menu. 

The selected directory is deleted permanently from the disk. 
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Working With Disks and Diskettes 

You can use the MS·DOS Executive window to: 

• Prepare diskettes 

• Name a diskette 

• Display the contents of a disk 

Preparing a Diskette 

Before you can use a diskette, you must prepare it as a data diskette or a 
system diskette. A data diskette is a blank formatted diskette for storing data. 
A system diskette contains the files necessary for starting MS·DOS. You cannot 
format hard disks with MS·Windows. For more information on formatting a 
hard disk, see Chapter 29. 

To prepare a diskette so it can be used on your workstation, use the Format 
Data Disk command. 

Preparing a Data Diskette 

To make a data diskette: 

1. Insert the new diskette in the disk drive of your workstation. 

2. Select the Format Data Disk command from the Special menu. 

5·8 

MS·Windows displays the Format Data Disk dialog box. Figure 5·4 shows 
the Format Data Disk dialog box. 

Select drive to for~at 
(!> A 

( Ok ) r Cancel) 
'. . 

Figure 5-4 Format Data Disk Dialog Box 



Working With Directories and Disks 

3. Click on the option button of the disk drive containing the new 
diskette. 

4. Click on the Ok command button. 

The system displays a warning that any data on the diskette in the drive 
will be destroyed. 

5. Click on the Ok command button to continue or click on the Cancel 
command button to stop. 

Preparing a System Diskette 

A system diskette contains the files necessary for starting the MS-DOS oper
ating system. 

To prepare a system diskette: 

1. Prepare a diskette by using the Format Data Disk command. 

2. Ensure the new diskette is in the disk drive to which you want to copy. 

3. Select as your current drive a drive that contains the system files. 

4. Select the Make System Disk command from the Special menu. 

MS-Windows displays the Make System Disk dialog box. 

5. Click on the option button of the disk drive to which the MS-DOS sys
tem files are to be copied. 

6. Click on the Ok command button. 

Copying starts when you click on the Ok command button. While the 
MS-DOS system files are being copied, the dialog box remains on the 
screen and the arrow changes to an hourglass. 

When complete, the dialog box is removed from the screen, and the 
hourglass changes to the arrow. 

11111 
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Naming Disks 

To assign a name (a volume name) to a diskette, use the Set Volume Name 
command. The volume name identifies the contents of the disk. 

To name a disk: 

1. Click on the symbol of the disk drive containing the disk you want to 

name. 

2. Select the Set Volume Name command from the Special menu. 

MS-Windows displays the Volume Name dialog box, containing the cur
rent name if any exists. Figure 5-5 shows the Volume Name dialog box. 

UolulTle lialTle: '"'"" _____________ ---' 

( Ok ) (Cancel) 

Figure 5-5 Set Volume Name Dialog Box 

3. In the text box, type a name. 

Only the first twelve characters are accepted. 

4. Click on the Ok command button. 
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The new volume name for the disk is displayed to the right of the drive 
letter in the path name. 
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Displaying the Contents of Another Disk 

To display the contents of another disk, click on the symbol of the disk drive 
you want to display. 

The file names of the selected drive are listed in the MS-DOS Executive win
dow. You can change the default directory by selecting a new directory on 
the drive. 

WARNING 
When you display the contents of another directory or drive, you 
change the default directory or drive. When you run an 
application, its default drive and directory become the default 
drive and directory of the MS-DOS Executive window from which 
you invoked it. If the new default drive is read-only, you cannot 
save files, and your application cannot write temporary files to it. 

Each copy of the MS-DOS Executive window acts independently of the other, 
so you can display and work with different directories and drives in each 
window. 
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Chapter 6 
Using the Keyboard 

This chapter describes how to use the keyboard to: 

• Select menus and commands 

• Load an application 

• Run an application 

• Finish an application 

• Scroll a window 

• Work with files 

• Use more than one window 

• Print screen images 

Keyboard Features 

In the previous chapters, you used the mouse to perform the actions availa
ble to you in MS-Windows. This chapter describes how to use the keyboard 
to perform those same actions. Because details about the MS-Windows func
tions are given in previous chapters, they are not repeated here. 

Table 6-1 lists the keys you use most often with MS-Windows. Look at your 
keyboard and identify the keys listed in Table 6-1. 
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Table 6-1 MS-Windows Keys 

Keys MS-Windows Function 

Alt Lets MS-Windows know you want to select a command using 
the keyboard. If you reiease the Alt key before you press 
another key, nothing happens. It also modifies the meaning of 
certain keys used with MS-Windows. 

Arrow Moves the highlight in the menus and in the MS-DOS Execu
tive window in the same direction as the arrow: up, down, 
right, left. 

Alphabet (A-Z) 

Ctrl/Arrow 

Ctrl/Break 

Return 

Esc 

Spacebar 

Alt/spacebar 

Shift 

Shift/Tab 
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Moves the highlight in the menus and in the MS-DOS Execu
tive window. For example, when you are in the MS-DOS 
Executive window and you press the C key, the highlight 
moves to the first file name beginning with the letter C. If you 
press the C key again, the highlight moves to the next file 
name beginning with the letter C, and so on. 

Moves the cursor without making any selections, such as 
moving the highlight over the file names in the MS-DOS Exec
utive window. 

Selects the Cancel command button in a dialog box. 

Runs the selected (highlighted) application file name, or 
executes the highlighted command in menu. 

Selects the default command button in a dialog box. (See 
Spacebar) 

Cancels a command if you press it before you press the Return 
key, or before you click on the Ok command button in a 
dialog box. 

Removes a menu or a dialog box from a window. The Esc key 
is equivalent to the Cancel command button in most dialog 
boxes. 

Selects and cancels selected check boxes. (Toggles check 
boxes on and off.) 

Selects the underscored command button in a dialog box. (See 
Return) 

With the Alt key, the spacebar displays the commands in the 
System menu. 

Used with the Tab key, the Alt/Tab keys, the arrow keys, or the 
Return key to change their function, as follows: 

Used with the Tab key, Shift changes the direction of the 
cursor movement in a dialog box from left-to-right and top-to
bottom to right-to-Ieft and bottom-to-top. 
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Table 6-1 MS-Windows Keys (cont.) 

Keys 

Alt/Shift/Tab 

Shift/arrow 

Shift/Return 

Tab 

Word Char 

MS-Windows Function 

Used with the Alt/Tab keys, Shift changes the direction of win· 
dow and icon selection from left-to-right and top-to-bottom to 
right-to-Ieft and bottom-to-top. 

Used with the arrow keys, Shift allows multiple selection of 
file names in the MS-DOS Executive window. 

Used with the Return key, Shift loads into memory the applica
tion represented by the highlighted file name in the MS-DOS 
Executive window and displays its icon in the icon area. 

Moves the cursor between items in a dialog box. 

Selects an icon, a window, or a dialog box when used with the 
Alt key. 

When used in a text box, deletes a character to the left of the 
insertion point each time it is pressed. 

When used in the MS-DOS Executive window, changes the 
current directory to the next higher directory. 

Using the Alt Key 

The Alt key lets MS-Windows know you want to select a command. You can 
use the Alt key in several ways: 

• If you press the Alt key and release it before you press another key, 
nothing happens . 

• If you hold down the Alt key, select a menu, then release the Alt key 
before highlighting a command, the menu remains displayed. You can 
then highlight a command and press the Return key (or the Alt key) to 
execute the command. To close the menu, press the Esc key. 

• If you hold down the Alt key, select a menu, highlight a command, then 
release the Alt key, MS-Windows executes the command immediately. 

The next sections shows specific examples of using the Alt key when work
ing with menus. 
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Using Menus and Commands 

Using the keyboard, you can select menus and commands. 

Selecting a Menu 

To select a menu with the keyboard: 

1. Press and hold down the Alt key. 

2. Press the spacebar. 

MS-Windows displays the System menu. 

3. Release the Alt key. 

4. To select another menu, press the right arrow key until the menu you 
want is selected. 

Each time you press the right arrow key, the next menu to the right is 
selected, and its commands are displayed. Similarly, if you press the left 
arrow key, the next menu to the left is selected, and its commands are 
displayed. 

To select a menu, you can also: 

1. Press and hold the Alt key. 

2. To display a menu, press the initial letter of the menu name you want. 
To display the System menu, press the spacebar. 

If more than one menu starts with the same initial letter, use the right 
or left arrow keys to move from the highlighted menu to the menu you 
want. 

Selecting a Command From a Menu 

To select a command from a menu: 

1. Press and hold down the Alt key. 

2. Press the spacebar. 

MS-Windows displays the System menu. 
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3. Release the Alt key. 

4. To display the commands of another menu, press the right or the left 
arrow key until the menu you want is displayed. 

5. Press the initial letter of the command you want, or press the down 
arrow key until the highlight moves to the command you want. 

When you press the initial letter of the command, the highlight moves 
to the first command with the initial letter you pressed. If two com
mands start with the same letter, press the letter twice to move the 
highlight to the second command. 

The highlighted command is selected. 

6. Press the Return key. 

The command you selected is executed. 

You can cancel a command or remove a menu by pressing the Esc key. 
However, you must do this before you press the Return key. 

To select a command from a menu, you can also: 

1. Press and hold down the Alt key. 

2. Press the initial letter of the menu you want to select (to display the 
System menu, press the spacebar). Continue to hold down the Alt key. 

3. Press the initial letter of the command you want. 

When you press the initial letter of the command, the highlight moves 
to the first command with the initial letter you pressed. If two com
mands start with the same letter, press the letter twice to move the 
highlight to the second command. 

The highlighted command is selected. 

4. Release the Alt key. 

The command you selected is executed. 

You can cancel a command or remove a menu by pressing the Esc key. 
However, you must do this before you release the Alt key. 
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Loading an Application 

To load an application as an icon using the keyboard, use: 

• The Load command 

• The file name 

Using the Load Command 

To load an application using the Load command: 

1. Select the Load command from the File menu. 

MS-Windows displays the Load dialog box. 

2. In the dialog box, type the file name of the application you want to 
load. 

Also type any additional information needed, such as path name or pro
gram parameters. 

3. Select the Ok command button by pressing the Return key. 

The application you select loads as an icon. 

Using the File Name 

To load an application using the file name: 

1. Press the up arrow or down arrow key until the file name of the appli
cation you want is highlighted. 

2. Press and hold down the Shift key. 

3. Press the Return key. 

The selected application loads as an icon. 

Running an Application 

To run an application in a window using the keyboard, use: 

• The Icon command 

• The Move command 

• The Run command 

• The file name 
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Using the Icon Command 

To expand an icon into the work area using the Icon command: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the icon you want is highlighted. The name of 
the application is displayed above the highlighted icon. 

3. Press the spacebar. 

4. Release the Alt key. 

5. Select the Icon command from the System menu, and press the Return 
key. The icon you selected expands into a window in the work area. 

When you use the Icon command, you have little control over exactly where 
the icon expands into a window in the work area. Where it expands depends 
on how many windows are already in the work area and the arrangement of 
those windows. To control where the icon expands into a window in the 
work area, use the Move command. 

Using the Move Command 

The Move command provides more control over where the icon expands into 
the work area. 

To expand an icon into the work area using the Move command: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the icon you want is highlighted, indicating it is 
selected. 

3. Press the spacebar. 

4. Release the Alt key. 

5. Select the Move command from the System menu, and press the Return 
key. The icon you selected is displayed in the work area above the icon 
area. 

6. Press the arrow keys until the icon is where you want the window to be 
displayed. 

7. To complete the move, press the Return key. The window expands 
where you positioned its icon. 
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Using the Run Command 

To run an application using the Run command: 

1. Select the Run command from the File menu. 

MS-Windows displays the Run dialog box. 

2. In the dialog box, type the file name of the application you want to 
run. 

Also type any additional information needed, such as path name or com
mand line argument. 

3. Select the Ok command button by pressing the Return key. 

The application you select runs in a window. 

Using the File Name 

To run an application using the file name in the MS-DOS Executive window: 

1. Press the up arrow or down arrow key until the application's file name 
is highlighted. 

2. Press the Return key. 

The selected application is displayed in the work area, replacing the 
MS-DOS Executive window. 

Finishing an Application 

When you finish using an application in the work area, you can remove it by 
using the Icon command or the Close command. If you use the Icon com
mand, the application continues to run, but it is in the icon area. However, if 
you use the Close command, the application is removed from the work area, 
stops running, and is removed from memory. 
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Shrinking an Application to an Icon 

To remove an application temporarily from the work area, use the Icon com
mand to shrink the application to an icon in the icon area. 

To shrink an application to an icon: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the application you want is highlighted. 

3. Press the spacebar, but continue to hold down the AIt key. 

4. Select the Icon command from the System menu. 

5. Release the AIt key. 

The window you selected shrinks to an icon in the icon area. 

Closing an Application 

When you finish using an application and want to remove it from memory, 
use the Close command. 

To close an application: 

1. Press and hold down the AIt key. 

2. Press the Tab key until the application you want is highlighted. 

3. Press the spacebar, but continue to hold down the AIt key. 

4. Select the Close command from the System menu. 

5. Release the AIt key. 

The window you selected closes, the application is removed from mem
ory, but the application remains on the disk. 
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Using a Dialog Box 

To supply information to a dialog box, you move the cursor to items in the 
dialog box. The flashing underscore shows the location of the cursor, and 
identifies the active component in the dialog box. Table 6-2 describes the 
keyboard procedures for moving the cursor in a dialog box. 

Table 6-2 Moving the Cursor in a Dialog Box 

To move the cursor ... 

In the dialog box 

Within a group of check boxes 

Within a group of option buttons 

(Insertion point) in a text box 

From the text box to the list box 

In a list box 

Press ... 

Tab key or Shift/Tab keys 

Arrow keys, Tab key, or Shift/Tab keys 

Arrow keys 

Arrow keys 

Tab key 

Arrow keys 

Selecting Options in a Dialog Box 

To select an option in a dialog box with the keyboard: 

1. Move the cursor to the option you want to select, such as the check 
box, option button, or command button, as explained in Table 6-2. 

2. Press the spacebar. 

The option is selected. 
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Selecting Command Buttons in a Dialog Box 

There are alternative ways to select the default command button (usually the 
Ok command button) and the Cancel command button. The default com
mands buttons have bold borders. 

To select the default command button in a dialog box, press the Return key. 

MS-Windows executes the default command and removes the dialog box from 
the window. 

To select other command buttons, press the Tab key to move to the desired 
button. An underline is displayed under the selected button. To execute the 
command button, press the spacebar. 

To select the Cancel option in a dialog box, press Ctrl/Break. 

The command represented by the dialog box is canceled, and the dialog box 
is removed from the window. 

Closing a Dialog Box 

You usually do not have to close a dialog box, because it is removed when 
you select the Ok or Cancel command button. However, if a dialog box has 
no Ok or Cancel command button and has a System menu box in the title 
bar, you can use the Close command of the System menu to close the dialog 
box. You can also use the Esc key to close most dialog boxes. 
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Scrolling a Window 

How an application scrolls using the keyboard depends on the application. 

You can also use the keyboard to scroll in the MS-DOS Executive window. 
When you scroll in the MS-DOS Executive window, you move the highlight 
from one file name to another. 

Figure 6-1 shows the two sets of keys you can use for scrolling the MS-DOS 
Executive window: one set in the cursor keypad, and one set in the numeric 
keypad. The keys in the numeric keypad are available only when the Num 
Lock feature is not selected (the Num Lock light is off). Table 6-3 describes 
scrolling the MS-DOS Executive window with the keyboard. 

Table 6-3 Keyboard Scrolling in the MS-DOS Executive Window 

To scrolL._ 

Down one file name 

Up one file name 

Right one file name 

Left one file name 

Down one page in the directory 

Up one page in the directory 
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Down arrow key 

Up arrow key 

Right arrow key 

Left arrow key 

Pg On key 

Pg Up key 
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Figure 6-1 Keys Used for Scrolling 
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Working With Files 

Selecting Files 

You can select: 

• One file 

• A block of files 

• Scattered files 

Selecting One File 

To select a file in the MS-DOS Executive window, use: 

• Arrow keys 

Press the arrow keys until the file name you want is highlighted. 

• Alphabet keys 

Press the first letter of a file name. 

The highlighted file name is selected. 

For example, if you press S, the first file name beginning with S is 
highlighted. Press S again to highlight the second file name beginning 
with S, and so on. 

If no more files begin with the letter, the last file remains selected. 

Canceling One Selected File 

To cancel a selected file with the keyboard, press the spacebar. 

The highlight changes to an underscore, showing the file is no longer 
selected. 

If you press the spacebar again, the file becomes selected again. 
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Selecting a Block of Files 

To select a block of files: 

1. Press the down arrow key until the first file you want is highlighted. 

2. Press and hold down the Shift key. 

3. To select other files, move the highlight by pressing the arrow keys. 

The file names are selected as the highlight moves across them. 

4. Release the Shift key after you select all the files you want. 

All the file names you selected are highlighted. 

Selecting Scattered Files 

To select scattered files: 

1. Press the down arrow key until the first file you want is highlighted. 

2. Press and hold down the etr! key. 

3. To move the underscore across files you do not want to select, continue 
to hold down the etr! key, and press the arrow keys, until the under
score is under the next file you do want to select. 

4. Press the spacebar. 

The highlighted file is selected. 

5. Select all the files you want by repeating steps 3 and 4. 

6. After you select all the files you want, release the etr! key. 

All the file names you selected are highlighted. 
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Using More Than One Window 

You can display more than one window at a time, but only one window can 
be the active window. 

Switching Windows 

To switch to another window: 

1. Press and hold down the Alt key. 

2. Press the Tab key until the title bar of window you want to switch to is 
highlighted. 

Each time you press the Tab key, the title bar of the next window or 
icon, from top-to-bottom and left-to-right, is highlighted. 

3. Release the Alt key and the Tab key. 

The window you switched to is now the active window. Any commands 
you select or any other information you enter with the mouse or the 
keyboard affect that window. 

You can reverse the direction the highlight moves if you type the 
Shift/Alt/Tab sequence. You can move the highlight from bottom-to-top and 
right-to-Ieft if you press and hold down the Shift key before you press the 
Tab key. 

Changing the Size of a Window 

Making a Window Larger or Smaller 

To make a window larger or smaller: 

1. Switch to the window you want to make larger or smaller. 

2. Select the Size command from the System menu. 

The cursor changes to the size box. 

3. Move the size box to the window border by pressing the arrow keys. 
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Continue pressing the arrow keys to move beyond the window border to 

the size you want. A line shows where the new window's border is 
located. 

To make the window smaller, you must move the size box beyond the 
window border and back inside the window border. 

4. Press the Return key. 

MS-Windows changes the size of the window and adjusts the size of any 
adjacent windows. 

Making a Window Fill the Entire Screen 

To zoom a window so that it fills the entire screen: 

1. Switch to the window you want to fill the entire screen. 

2. Select the Zoom command from the System menu. 

The window you selected zooms and fills the entire screen including 
the icon area. 

To zoom a window, you can also: 

1. Switch to the window you want to fill the entire screen. 

2. Press the Alt/Return keys. 

The window you selected zooms and fills the entire screen including 
the icon area. 

To return the window to its former size: 

• Use the Zoom command again . 

• Press the Alt/Return keys to restore the window to its former size. 

Moving a Window 

To move a window to another position in the work area: 

1. Switch to the window you want to move. 

2. Select the Move command from the System menu. 

MS-Windows diplays the icon of the application in the middle of the 
window. 
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3. Press the arrow keys until the icon is where you want the window to be 
moved. 

4. Press the Return key. 

The window is moved to the position you selected. MS-Windows adjusts 
the size of the other windows in the work area. 

Receiving Messages From Another Application 

To see a message sent by another application, switch to the window whose 
title bar is flashing or to the flashing icon: 

1. Hold the Alt key and press the Tab key until the window or icon of the 
application sending you the message is highlighted. 

2. Release the Alt key. 

The message is displayed when you switch to the window or icon of the 
application sending you the message. 

Printing Screen Images 

With MS-Windows, you can send the information displayed on the screen to 

your printer, on LPT1. To print a screen, the GRAPHICS command must be 
loaded and run before MS-Windows starts. The key diskette runs the 
GRAPHICS command for you. For more information on the GRAPHICS com
mand see Chapter 32. 

To print your screen: 

1. If you are using a local printer, be sure your printer is attached and on 
line. 

2. Ensure the screen contains the information you want printed. Everything 
displayed on the screen is printed. 

3. Press Shift/Prt Sc. 

The screen is printed. This operation may take a few minutes. 

NOTE 
Do not press Shift/Prt Sc if LPT1 is being used by another 
application. 
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Running 

Standard Applications 

This chapter describes how to: 

• Run standard applications in a window 

• Run standard applications outside a window 

• Transfer information between standard applications 

• Run large standard applications 

• Run special applications 

Working with Standard Applications 

A standard application is an application (with a .EXE, . BAT, or .COM exten
sion) that you can use with MS-Windows, even though it was not designed 
for this use. (MS-Windows applications, such as Notepad and Clock, are spe
cifically designed to be used with MS-Windows.) 

When you run a standard application with MS-Windows, you continue to use 
the commands and functions of the application. For many standard applica
tions, MS-Windows lets you run several applications and switch from one 
application to another. 

Many standard applications can run in a window, sharing the work area with 
other applications in their own windows. However, some standard applica
tions require the entire screen and run outside a window. 

Whether a standard application runs in a window depends on how it: 

• Uses memory 

• Processes input/output (I/O) activities 
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When an application runs on your workstation, it processes I/O activities that 
use the workstation's resources. These resources include: 

• Computer memory 

• Communications ports 

• Video display screen 

• Keyboard 

If a standard application uses standard MS-DOS supplied I/O procedures and 
memory allocation, it can run in a window, because MS-Windows emulates 
the I/O activities that are compatible for MS-DOS. 

If a standard application does not use standard MS-DOS supplied I/O proce
dures or standard memory allocation, it cannot run in a window, because 
MS-Windows cannot provide the interface for I/O activities. These standard 
applications provide their own interface for I/O activities. 

NOTE 
Standard applications must run under MS-DOS Version 3.10 or later 
to run from MS-Windows. 

Using Program Information Files 

A program information file (PIF) contains information about how a standard 
application uses workstation resources. The system administrator enters this 
information into a PIF for the standard application, and the information is 
used by MS-Windows. Each standard application you use should have a PIF 
associated with it. 

Included with your MS-Windows software package are PIFs for many standard 
applications. If you try to run an application that has no PIF, MS-Windows 
uses default settings for the resources. However, the system administrator 
should create a PIF for the application. 

An application can have more than one PIF associated with it. For example, 
you can have two versions of the same application. One version can require a 
large amount of memory, because you use all the features of the application, 
while another version can require less memory, because you use only a few 
features. 
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Some applications require more than one PIF. Each file with a .EXE, .COM, 
and .BAT extension that an application runs must have a PIF associated with 
it. 

If you are running a batch file (an application with a .BAT extension) that 
redirects I/O, you must set the Directly Modifies Screen option in its PIF file 
and run it from the MS-DOS Executive window. See Appendix C for more 
information on creating PIFs for standard applications. 

NOTE 
You should not run a batch file from a COMMAND.COM window if 
the file includes redirected I/O or piping. 

You can run an application by selecting its PIF in the MS-DOS Executive 
window. When you select the PIF, MS-Windows loads and runs the applica
tion named in the PIF. 
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Running a Standard Application 

You run a standard application that runs in a window as you run 
MS-Windows applications, such as Calculator and Notepad. 

NOTE 
When you run a standard application in a window, the Special 
light in the top right of the keyboard may turn on and off. This 
means the keyboard is automatically changing modes according to 
the needs of the application. 

Shrinking a Window 

You shrink a standard application that runs in a window as you shrink 
MS-Windows applications, such as the Information System and Notepad. 

Most icons for standard applications are a plain rectangle containing a three
letter abbreviation for the application. However, some applications have cus
tom icons that are graphic representations of the application. 

NOTE 
When you drag the icon of any standard application, it becomes a 
plain rectangle, resembling the Clock icon when it is dragged. 

Closing a Window 

To close a standard application running in a window: 

1. Execute the Exit command of the application. 

This ensures a normal ending of operations for the application. 

NOTE 
Standard applications have a Quit command, an End command, or 
some other command that is equivalent to the Exit command; see 
your application documentation for using them. 

2. Observe and note any information the application displays in the 
window. 

Some standard applications display information for you to look at or 
copy. Observe the name of the application displayed in the title bar 
with parentheses around it, indicating you have successfully exited from 
the application and it has stopped running. 

3. Select the Close command from the System menu. 
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The standard application stops running, the window closes, and the 
standard application is removed from memory. 

An option in the PIF allows for a standard application window to close 
when you execute the Exit command for the standard application. If 
this option is selected, the window automatically closes when you exe
cute the Exit command of the standard application. For more informa
tion on the Close or Exit option, see Appendix D. 

Scrolling a Window 

If your standard application runs in a window, MS-Windows adds the Scroll 
command to the System menu of the application. 

To scroll a standard application, you use: 

• The Scroll command from the System menu 

• The commands and keys built into your standard application 

If using the Scroll command, you must use the keyboard to scroll. The Scroll 
command is independednt of the commands already built into your standard 
application. 

The keys you use have two functions: their normal function and their scrol
ling function. Press the Esc key to use the normal function. Press the Esc key 
again to use the scrolling function. 

If using the built-in commands and keys, use the mouse to scroll. See the 
application documentation for information on what these commands and keys 
are. 

Table 7-1 shows the keys used for scrolling standard applications that run in 
a window. 

Table 7-1 Scrolling Standard Applications That Run in a Window 

To scrolL_ 

Up one line 

Down one line 

Left one character 

Right one character 

Up one screen 
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Up arrow key 

Down arrow key 

Left arrow key 

Right arrow key 
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Table 7-1 Scrolling Standard Applications That Run in a Window (cont.) 

To scroll... 

Down one screen 

Left one screen 

Right one screen 

Press ... 

Pg Dn key 

Home key 

End key 

Finishing an MS-Windows Session 

IIIII 

You cannot finish an MS-Windows session while a standard application is still 
running. You must exit from all standard applications before you can end 
your MS-Windows session. 

If you try to end your MS-Windows session while a standard application is 
still running, MS-Windows displays a dialog box, showing a message that a 
standard application is still active. The name of the active standard applica
tion is displayed in the title bar of the dialog box. When you see this dialog 
box, execute the Exit command of the application. 

Any standard application running as an icon must also be closed before you 
try to end your MS-Windows session. For each standard application running 
as an icon, you must expand the icon into a window and execute the Exit 
command of the application. 

Running Multiple Standard Applications 

You run multiple standard applications the same as MS-Windows applica
tions, such as the Information System and Notepad. 

Running Standard Applications Outside a Window 

Some standard applications require exclusive use of the screen and cannot 
run in a window. When you run this kind of application, you no longer see 
MS-Windows features, such as the title bar, the menu bar, and the icon area. 

When you run a standard application outside a window, MS-Windows tempo
rarily removes itself from the screen. You can use the application's com
mands and functions, but you cannot use all of MS-Windows' functions. 
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Starting an Application That Runs Outside a Window 

You start a standard application that runs outside a window the same as you 
start other applications. You can: 

• Expand the icon 

• Select the Run command from the File menu of the MS-DOS Executive 
window and type the file name and path name, if needed 

• Select the file name in the MS-DOS Executive window 

When you start a standard application that runs outside a window, it fills the 
entire screen. Any applications that are displayed on the screen are removed. 
They return to the screen after you finish the application and return to 

MS-Windows. 

Returning to MS-Windows 

To return to MS-Windows from a standard application that runs outside a 
window, you can use: 

• The application's Exit command 

All applications use this method. 

• Alt/Tab keys 

Some applications use this method, depending on how they use certain 
workstation resources, as specified in each standard application's PIF. 

For example, the Alt/Tab keys cannot be used to switch windows if the 
Program Switch option is set to Prevent in the application's PIF. For 
information on the Program Switch option, see Appendix C. 

After you close the standard application, switch to the application that was 
running previously. 

To run the standard application again, expand its icon. 
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Transferring Information 

To transfer information between applications that run in windows, use: 

• Added System menu commands: 

- Mark 

- Copy 

- Paste 

These can be used only with standard applications that run in a win
dow, because these are the only standard applications that have a 
System menu. 

• AltjPrt Sc keys 

To traansfer information from an application that runs outside a window, use 
the AltjPrt Sc keys. 

Marking Information to be Transferred 

Before you can transfer information, you must mark (select) it, using the 
mouse or the keyboard. 

To use the mouse to mark information: 

1. Point to the beginning of the area you want to transfer. 

2. Drag the cursor across the area of the window you want to transfer. 

As you drag the cursor across the window, the selected information is 
highlighted. 

3. Release the mouse button. 

The information you want to transfer is now marked. 

To use the keyboard to mark information: 

1. Select the Mark command from the System menu. 

A rectangular cursor is displayed at the upper-left corner of the 
window. 

2. Press the arrow keys to move the cursor to the beginning of the area 
you want to transfer. 

3. Press and hold down the Shift key. 
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4. Press the arrow keys to define the area you want to transfer. 

The block of information you marked for transfer is highlighted. 

To cancel the selected area, press the Esc key, or the Return key. This 
removes the highlighting on the block of information you selected. 

5. Release the Shift key. 

The information you want to transfer is now marked. 

For example, to select a paragraph: 

1. Move the cursor to the first character of the paragraph. 

2. Press and hold down the Shift key. 

3. Press the right arrow key to go to the end of the line, then press the 
down arrow key to go to the last line of the paragraph. 

4. Release the Shift key. 

After you mark the information, you transfer it to the Clipboard using the 
Copy command. 

Copying Information to the Clipboard 

You must copy information to the Clipboard before you can transfer it to an 
application. To transfer marked information to the Clipboard, select the Copy 
command from the System menu. 

The information you marked is copied to Clipboard. You insert this informa
tion into another location using the Paste command. 

Pasting Information 

After the information has been copied to the Clipboard, you can transfer it to 

another location using the Paste command. You can paste the information to: 

• Applications designed to work with MS-Windows 

For example, you can paste text screens to Notepad and graphics 
screens to MS-Paint. 

• Standard applications that run in a window 

You can paste all or part of an application that runs in a window. 
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When you paste information to a terminal emulator, you must first enable 
HOSTSYNC under VMS by typing: 

$ SET TERMINAL/HOSTSYNC 

This command prevents data overruns. 

You cannot paste: 

• Information from the Clipboard to an application that runs outside a 
window 

• Graphics information from the Clipboard to any standard application 
(inside or outside a window) 

NOTE 
Text is stored in its character (ASCII) representation. When you 
use the Copy or Paste commands, the text is also transferred in this 
character representation. 

To use the Paste command: 

1. Switch to the window into which you want to paste the information. 

2. Move the cursor where you want to insert the information. 

3. Select the Paste command from the System menu. 

11111 

The selected text is inserted in your application at the cursor location. 

Using the Prt Sc Key 

You can also transfer information to the Clipboard by using the Alt/Prt Sc 
keys. To copy a standard application's window to the Clipboard: 

1. To copy from a standard application that runs in a window, make sure 
the window is the active window. (Switch to the window you want to 
copy if it is not the active window.) 

2. Press the Alt/Prt Sc keys. 

For a standard application that runs outside a window, the screen con
tents are copied to the Clipboard. For a standard application that runs 
in a window, the active window is copied, as if it filled the entire 
screen, to the Clipboard. Other windows in the work area are not 
copied. 
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A block of information, 80 columns by 2S lines, is transferred from the 
selected window to the Clipboard, regardless of the number of columns 
and lines displayed in the window. 

After the information has been copied to the Clipboard, you can paste it to 

other applications with the Paste command. 

Running Large Standard Applications 

To run multiple standard applications efficiently, run the largest application 
first. 

If you run more than one application and try to run a new application that 
requires more memory than is available, MS-Windows displays the message 
"Not enough memory to run." 

If you see this message, close an application that you do not currently need 
and try to run the standard application again. 

If you are closing a standard application, you should first execute the Exit 
command of the application. 

The application runs after enough memory has been freed by closing other 
applications. If the MS-DOS Executive window is the only application run
ning, the application you selected runs because MS-Windows and the MS-DOS 
Executive application step aside and give the application most of the availa
ble memory. A small amount of memory is retained for restoring 
MS-Windows. 

When you finish using the large application, close it. After you close the 
application, the MS-DOS Executive window returns to the work area. Any 
application defined in the WIN.INI file to load or run is started. 

NOTE 
Do not use a large standard application in the WIN.INI file's RUN= 
line. 

Running Special Applications 

Some applications remain in memory after you load them. These special 
applications are sometimes called "memory resident," "terminate and stay 
resident," or "pop-up" programs. 

You must load special applications before you start MS-Windows. 
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You run special applications from MS-DOS outside MS-Windows. You can also 
run special applications while using standard applications that both: 

• Do not run in a window 

• Have Directly Modifies Memory set in their PIFs 

You cannot run special applications from COMMAND.COM in MS-Windows. 

NOTE 
The PIF for a special application should have the Directly Modifies 
Memory option enabled. If you then try to run a special 
application, a system warning displays. Select CANCEL. If you 
select Ok, the special application can cause system problems. 

Some special applications prevent you from switching back to MS-Windows. 
To return to MS-Windows, stop the special application by using its EXIT 
command. 
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Chapter 8 
Using the Control Panel 

This chapter describes how to use the Control Panel application to: 

• Change the date and time 

• Change the mouse cursor blink rate 

• Change the mouse double-click rate 

• Add and remove printers 

• Add and delete display fonts 

• Change printer ports 

• Change the default printer and its output modes 

• Change communications ports 

• Change network terminal services 

• Change screen shades 

• Change keyboard settings 

• Exchange mouse button functions 

• Change country settings 

Running the Control Panel 

The Control Panel is an application that lets you change the settings for 
MS-Windows. MS-Windows saves the Control Panel changes you make in the 
WIN.INI file, which is stored in your personal directory. Each time 
MS-Windows starts, it uses the settings in the WIN.INI file. For more informa
tion on the WIN.INI file, see Appendix B. 
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To run the Control Panel: 

1. In the MS-DOS Executive window, select the Run command from the 
File menu. 

The MS-DOS Executive window dispiays the Run command diaiog box. 

2. In the dialog box, type: 

8-2 

CONTROL 

The MS-DOS Executive window displays the Control Panel window with 
a dialog box in the window and three menu names in the menu bar. 
Screen 8-1 shows the Control Panel window. 

COllt .. ,,} Pdll"} 
Installation Setup Preferences 

rTillle 
L 112:53:37 PM 

Cursor Blink
Slol11 Fast 
I .. Wiii',,;i,l Hiiii:ii!!iiiilU-+1 

I 

rDate::-=-l 
L 03l17I86J 

Double Click---
Slolll Fast 
1 .. 1i""'iiiii:!;I_liiHii"iil"+l 

I TEST I 

Screen 8-1 Control Panel Window 
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The Control Panel dialog box, in the center of the window, lets you change: 

• Time 

• Date 

• Cursor blink rate 

• Double-click rate 

The three menu names in the menu bar are: 

• Installation 

• Setup 

• Preferences 

Using the Control Panel Dialog Box 

Changing the Time 

The time you set from the Control Panel is used in many applications, such 
as Clock or Calendar. 

To change the time using the mouse : 

1. Click on the part of the time (hours, minutes, or seconds) you want to 

change. Figure 8-1 shows changing the time. 

,-._------------------------

1~l1le 11"1 
~{ 14: 23 At'1 r±l 

',I 

reut-SOt' Blink-
Fast 

bYI ... 1 

Figure 8-1 Changing the Time 

The part of the time you selected is highlighted. An up arrow and a 
down arrow are displayed to the right of the time. 
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2. Click on the up arrow to increase the number; click on the down arrow 
to decrease the number. 

To change the time using the keyboard: 

1. Press the Tab key to move the cursor, dispiayed as an underscore, to the 
Time section. 

2. Press the right arrow and left arrow keys to highlight the part of the 
time (hour, minutes, or seconds) you want to change. 

The selected time is highlighted. An up arrow and a down arrow are 
displayed to the right of the time. 

3. Press the up arrow key to increase the number; press the down arrow 
key to decrease the number. 

Changing the Date 

You change the date the same way that you change the time. 

To change the date with a mouse, click on the part of the date (month, day, 
or year) you want to change, then use the same procedure for changing the 
time. Figure 8-2 shows changing the date. 

rTifl)e 
"9: "9 : 34 At1 

-Cut'SOt' 
Slm" 

Blink---
Fast 

[ijt. ~ 
,,/17186 ! 

-Double Click---
Slow Fast 
I+- lin!!!!!!!!!! k!!!!!!!iniil ... 1 

I TEST I 

Figure 8-2 Changing the Date 

To change the date with the keyboard, press the Tab key to move the cursor, 
displayed as an underscore, to the Date section, then use the same procedure 
for changing the time. 
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Changing the Cursor Blink Rate 

Some applications have a cursor that blinks. The cursor is usually an under
score or insertion point that blinks. The blink rate is the frequency at which 
the cursor flashes. 

To change the cursor blink rate with the mouse, do one of the following: 

• Click on the right or left scroll arrow. 

The scroll box moves as you click on an arrow. 

• Drag the scroll box within the scroll bar to the right or to the left. 

The vertical cursor below the scroll bar shows the new cursor blink 
rate. As you scroll, the blink rate of the vertical cursor changes. The 
farther right you scroll, the faster the cursor blinks. The cursor blink 
rate stays in effect until you change it again. 

To change the cursor blink rate with the keyboard: 

1. Press the Tab key to move the cursor to the Cursor Blink section. 

2. Press the left arrow or the right arrow key to scroll to the setting you 
want. 

Changing the Mouse Double-Click Rate 

You can double-click to execute many commands. MS-Windows interprets 
this action either as a double-click or as two individual clicks, depending on 
how soon one click follows another. If you do not double-click fast enough, 
MS-Windows interprets the action as two individual clicks of the left mouse 
button, instead of a double-click. 

To change the mouse double-click rate, do one of the following: 

• Click on the right or left scroll arrow in the Double-Click section. 

• Drag the scroll box within the scroll bar. 

The farther right you scroll, the faster MS-Windows expects a double
click. 

You can test the new double-click setting by double-clicking on the TEST 
button in the dialog box. If MS-Windows interprets your clicking as a double
click, the TEST button shade changes from dark to light, or from light to 
dark. If the TEST button shade does not change, try double-clicking faster or 
reducing the double-click rate. 
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Using the Installation Menu 

The Installation menu has four commands: 

• Add New Printer, which adds a printer to the list of available printers 

• Delete Printer, which removes a printer from the list of available 
printers 

• Add New Font, which adds a font to the list of available fonts 

• Delete Font, which removes a font from the list of available fonts 

Figure 8-3 shows the Installation menu commands. 

~~~~~I~ Setu 
Add Hew Printer .. . 
Delete Printer .. . 
Add Hew Font .. . 
Delete Font .. . 

Figure 8-3 Installation Menu Commands 

Adding and Removing a New Printer 

When you first set up MS-Windows, you select the printer or printers you 
want to use. To change this selection, use the Add New Printer and the 
Delete Printer commands from the Installation Menu. 

On the network, you can connect to print servers that generate output in 
either landscape or portrait mode. Using the Control Panel, you can select 
the default printer mode: landscape or portrait. The printer mode you select 
overrides the current mode of the printer. 

When you use the Control Panel to add or remove a printer to MS-Windows, 
you are actually adding or removing the name of the printer driver file to the 
other printer drivers already named in the WIN.lNI file of MS-Windows. Only 
printers that have their printer driver files named in the WIN .INI file can be 
used by MS-Windows and its applications. 
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After MS-Windows is set up, you can add a printer driver file to MS-Windows 
when you want to install: 

• An existing printer driver file 

The printer driver file is included in the network directory 
H:\ WIN\UTIL, which stores printer driver files. 

• A new printer driver file 

The printer driver file is not in the network directory H:\WIN\UTIL. 
You install the printer driver file by copying it from the distribution 
diskette of a new application to the network directory H:\ WIN\UTIL. 

After you add a new printer to your system, you must let MS-Windows know 
which communications port the printer is connected to before you can use 
the printer. To define the communications port, use the Connections com
mand in the Setup menu of the Control Panel. 

Adding an Existing Printer Driver File 

To add an already existing printer driver file to your system: 

1. Select the Add New Printer command from the Installation menu. 

MS-Windows displays the Add Printer dialog box. Figure 8-4 shows the 
Add New Printer dialog box. 

Add Pt"inter 
Insert the disk with the printer file 
you wish to add into drive A. or choose 
an alternative drive/directory: 
1 1j&.1" U .. 'II II 1 

( Ok ) (Cancel) 

Figure 8-4 Add Printer Dialog Box 

2. In the text box, you type the location of the printer driver file, 
typically: 

H:\WIN\UTIL 
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3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available in the 
directory you specify. 

4. From the list box, select a printer. 

The name of the corresponding printer driver file is displayed in the 
Printer File text box of the dialog box. 

See Table 8-1 for information on selecting the LA75 and the LN03 PLUS 
printers. 

5. Select the Add command button. 

MS-Windows displays a dialog box. 

6. Select the No command button. 

Selecting the No command button is the normal procedure. However, if 
you want to duplicate this printer driver file, type the drive or name of 
an existing directory you want, and select the Yes command button. 

MS-Windows updates the WIN.INI file to include information for the 
new printer driver. However, only the WIN.INI file used when you start 
MS-Windows is updated. If the printer is added to the network and is 
used by more than one user, the WIN.INI file of each user needs to be 
updated. 

Table 8-1 Selecting Printers 

Type of Printer 

LA7S 

LNO 3 PLUS with CG· Times Cartridge 

LN03 PLUS with ISO/PC Cartridge 

LA7S to emulate IBM Proprinter 

LN03 PLUS with ISO/PC Cartridge to 
emulate IBM Proprinter 
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Digital LA7SDEC 

Digital LN03PLUS 

Digital LN03DEC 

LA7SSTD 

Digital LN03STD 

Driver filename 
is ... 

LASO.DRV 

LN03PLUS.DRV 
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LA7S.DRV 

LA7S.DRV 
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Adding a New Printer Driver File 

Your system administrator adds new printer driver files from the distribution 
diskette that comes with a new printer. This section includes information 
your system administrator needs to add a new printer driver file. 

To add a new printer driver file to the directory containing the other 
MS-Windows printer driver files: 

1. Select the Add New Printer command from the Installation menu. 

MS-Windows displays a dialog box that prompts you to insert into Drive 
A the diskette with the printer driver file you want to add, or to select 
an alternate drive/directory. It displays H:\ WIN\UTIL in the text box. 
Select Drive A by typing in the text box: 

A:\ 

2. Insert the diskette with the printer files. 

See the printer hardware documentation to determine which diskette 
and which directory contains the printer driver files (.DRV). 

3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available on the 
diskette. 

4. From the list box, select a printer. 

After you select a printer, the name of the corresponding printer driver 
file displays in the printer file text box at the right. 

5. Select the Add command button. 

A dialog box prompts you for the name of the drive or directory to 
which you want to copy the printer driver file. 

6. In the text box, type the alias for H:\ WIN\UTIL, the drive and directory 
to which the printer driver file is to be copied. Drive H: must be 
connected to the read/write alias for the system files. 

7. Select the Yes command button. 

MS-Windows updates the WIN.INI file to include information for the 
new printer driver. However, only the WIN.INI file used by 
MS-Windows when you started MS-Windows is updated. If the printer is 
added to the network, and is used by more than one user, the WIN.INI 
file of each user needs to be updated. 
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Removing a Printer 

To remove a printer from MS-Windows: 

1. Select the Delete Printer command from the Installation menu. 

MS-Windows displays the Delete Printer dialog box. The list box shows 
all the printers currently in your WIN.INI file. Figure 8-5 shows the 
Delete Printer dialog box. 

Delete Printer 

LHI3DEC LPT3: 

Printer File: 
1" 

LASI.DRU 

( Delete) ( Cancel) 

Figure 8-5 Delete Printer Dialog Box 

2. Select the printer you want to remove from the list box. 

The file name of the corresponding printer driver file is displayed in 
the text box. 

3. Select the Delete command button. 

MS-Windows displays a dialog box. 

4. Select the No command button. 
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deleted from the WIN.INI file, but the printer driver file is not. By 
selecting the No command button, you can use the procedure 
discussed in "Adding an Existing Printer Driver File," because the 
printer driver is still stored in the directory. 
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It is recommended that you do not delete the printer driver file. If 
you select the Ok command button, the printer driver file is 
deleted from the network directory H: \ WIN\ UTIL. To add the 
printer driver file again, you must follow the more complicated 
procedure discussed in "Adding a New Printer Driver File." 

Some printer drivers support more than one printer model. In this case, the 
printers share the print driver file. If other printers share the printer driver 
file that is displayed in the Delete Printer dialog box, that printer driver file 
is not deleted, because it is still used by the other printers. 

In this case, MS-Windows displays a dialog box, indicating the shared printer 
driver file is not deleted. However, it is disassociated from the selected 
printer in the WIN.INI file. 

Adding a New Font 

To add a font file (.FON) to MS-Windows, use the Add New Font command 
from the Installation menu. This command works Similarly to the Add New 
Printer command. 

When you select the Add New Font command (or the Delete Font command), 
you must specify where the font files are located. MS-Windows lists the avail
able fonts, including the font names, the font sizes, and the set numbers. 

The set number is based on the devices that the font is primarily designed to 
be used with. 

Set 1 

Set 1 fonts are stroke fonts. They can be used for the screen, a printer, or a 
plotter device of any resolution. 

Set 2 

Set 2 fonts are raster fonts. They are designed for a screen resolution of 640 
X 200, such as a workstation with the IBM Color Graphics Adapter or com
patible adapter card. 
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Set 3 

Set 3 fonts are raster fonts. They are designed primarily for a screen resolu
tion of 640 X 350, such as a workstation with an IBM Enhanced Color 
Graphics Adapter or Hercules Graphics Card. These fonts are also used by 
VAXmate. 

Set 4 

Set 4 fonts are raster fonts. They are designed primarily for printers in 60 dpi 
resolution: 

• LA75 in STn mode (landscape mode) 

• Okidata 92,93, 192, 193, standard models (portrait mode) 

• Okidata 92, 93, 192, 193, standard and IBM-compatible models (land-
scape mode) 

• Epson MX-BO, FX-BO, and compatibles (landscape mode) 

• IBM Graphics (landscape mode) 

• IBM Proprinter (landscape mode) 

• Star Micronics SG-I0 (landscape mode) 

Set 5 

Set 5 fonts are raster fonts. They are designed for printers in the 120 dpi 
resolution: 

• LA75 in STn mode (portrait mode) 

• Okidata 92, 93, 192, 193, IBM-compatible models (portrait mode) 

• Epson MX-BO, FX-BO, and compatibles (portrait mode) 

• IBM Graphics (portrait mode) 

• IBM Proprinter (portrait mode) 

• Star Micronics SG-I0 (portrait mode) 

In addition to these fonts, an application can list device fonts. These are the 
fonts provided by a device. For example, on print-wheel printers, font names 
correspond to wheel names. These fonts cannot be added or deleted with the 
Control Panel, but they can be listed when the output device is selected. 
When a raster font does not correspond to the screen, MS-Windows can sub
stitute a screen font in the· same class. 
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NOTE 
Because applications handle fonts differently, some applications 
may not list all fonts. 

Fonts have names that represent their different characteristics. Table 8-2 lists 
and describes the fonts that are included on H:\ WIN\UTIL. 

Table 8-2 Fonts on the Fonts Disk 

Font Description 

DECterm (Raster font.) A fixed-width font (characters having uniform widths) 
without serifs. 

Helv (Raster font.) A proportional font (characters having varying widths) 
without serifs. 

Courier (Raster font.) A fixed-width font with serifs. 

Tms Rmn (Raster font.) A proportional font with serifs. 

Roman (Stroke font.) A proportional font with serifs. 

Modern (Stroke font.) A proportional font without serifs. 

Script (Stroke font.) A proportional font of slanted characters formed from 
nearly continuous curved lines. 

Table 8-3 describes the fonts that are not included on H:\ WIN\UTIL, but you 
can see them in some applications. These fonts cannot be added or deleted. 

Table 8-3 Fonts Not on the Fonts Disk 

Font Description 

System (Raster font.) A fixed-width font designed for the screen. 

Terminal (Raster font.) A fixed-width font that is the same as the font your work
station displays from MS-DOS. 

Deleting a Font 

To delete a font file to MS-Windows, use the Delete Font command from the 
Installation menu. This command works Similarly to the Delete Printer 
command. 
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Using the Setup Menu 

The Setup menu has four commands: 

• Connections, which lets you assign or change printer port connections 

• Printer, which lets you select the default printer 

• Communications Port, which lets you select a serial communications 
port and select parameters, such as baud rate, word length, parity, and 
stop bits 

• Network Terminal Services, which lets you select network services for 
your communication ports 

Figure 8-6 shows the Setup menu commands. 

Communications Port ... 
Network Terminal Services ... 

Figure 8-6 Setup Menu Commands 

Changing Printer Connections 

MS-Windows needs to know to which communications port your printer is 
connected. To set or change the port for your printers, use the Connections 
command. 

For example, to move your printer from the communications port LPTl to 
LPT2, use the Control Panel to change the printer connections setting. 
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To change printer connections: 

1. Select the Connections command from the Setup menu. MS-Windows 
displays the Connections dialog box. Figure 8-7 shows the Connections 
dialog box. 

Printer Connection 
~~~~~~~~ ..... ~~ ~~--------~~ 

LH03DEC LPTJ: 
lilill LPTJ: 

~ ________________________ ~~~ ~C~O~M~1~: __________ ~~~ 

( Ok ) (Cancel ) 

Figure 8-7 Connections Dialog Box 

2. From the Printer list box, select the printer you want to change. The 
current communications port assignment for the selected printer is 
displayed in the Connection list box, located at the right. 

3. From the Connections list box, select one of the communications ports. 

4. Select the Ok command button. 

NOTE 
You can redirect an LPT port only to the SPP (Serial Printer Port) 
or to a network print device. 

Changing the Default Printer 

When you execute a Print command, MS-Windows prints the file on the 
default printer. To select the default printer and to set its output modes, use 
the Printer command. 

Printer output modes are printer-specific settings, such as portrait mode 
(normal vertical page orientation) or landscape mode (horizontal page orien
tation). The Printer command is useful when you have both local and remote 
printers, or both dot matrix and character printers, connected to your com
munications ports. 
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To change the default printer: 

1. Select the Printer command from the Setup menu. 

MS-Windows displays the Default Printer dialog box. It lists all the avail
able printers and their current communications port connections. Figure 
8-8 shows the Default Printer dialog box. 

Default Printer 
I 

LHU3DEC LPT3: 
( Ok ) 

(Cancel) 

Figure 8-8 Default Printer Dialog Box 

2. From the list box, select the printer name. 

3. Select the Ok command button. 

MS-Windows displays the Output Mode dialog box, containing the mode 
settings specific to the printer you selected. 

4. To select another output mode, select from the options for printer 
output or answer the questions in the dialog box. 

5. Select the Ok command button. 

The printer you select becomes the default printer. 

Changing the Communications Port 

To select COM! and COM2 settings, including baud rate, stop bits, parity, 
word length, and the retry (print/send) option, use the Communications Port 
command. 

For example, MS-Windows' print spool uses these settings to configure the 
communication port before printing. (COM! and COM2 are serial communi
cations ports and can be used only with serial printers and serial communica
tion deVices.) 
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To select a communications port: 

1. Select the Communications Port command from the Setup menu. 

MS-Windows displays the Communication Settings dialog box. Figure 
8-9 shows the Communications Settings dialog box. 

CORRunications Settings 

Port @ k!ll!.1.;. 0 COM2: 

Baud Rate: [12110 [ 

Word length 04 05 06 0 7 @ 8 

Parity 

Stop Bits 

o Even 0 Odd 

@1 01.5 

@Hone 

02 
Handshake 0 Hardware @ Hone 

( Ok (Cancel) 

Figure 8-9 Communications Settings Dialog Box 

2. Select the communications port COM1 or COM2. 

The settings for the selected communications port are displayed in the 
dialog box. 

3. Select the rest of the settings. 

The settings for baud rate, word length, stopbits, and handshake 
(protocol) should be the same as those set for your printer or device. 
The protocol, "Hardware," is equivalent to XONjXOFF. See your 
printer or device documentation for the proper communications port 
settings. 

4. Select the Ok command button. The communications port you select is 
set up. 

NOTE 
This command does not configure or set up the communication 
hardware. It gives information about the communication hardware 
settings to MS-Windows and the applications using the 
communications ports. When you set up a communications device 
or printer, make sure the communications port settings are 
configured according to the serial communications instructions 
supplied by your printer or device manufacturer before you try to 
print. 
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Selecting Network Terminal Services 

To select terminal services for the workstation's communication ports, use 
the Network Terminal Services command. This command lets you redirect the 
COMl and COM2 communications ports to the selected terminal services. 
Any application using COMl or COM2 is redirected over the local area net
work to the specified network terminal service. 

To select a network terminal service: 

1. Select the Network Terminal Services command from the Setup menu. 

MS-Windows displays a Network Terminal Services dialog box. It lists 
the currently available network services. Figure 8-10 shows the Network 
Terminal Services dialog box. 

lietl~OI"k Terminal Services 

You can assign communications ports 1 and 2 to the services listed 
below_ These are the only currently available set"vices. Pt"eviously 
assigned services may be unavailable at this time. 

Port Set"vices 

~mwe o :-Aft ER i 1~~¥~kR 
iiiilirl ~ 
I~~¥~~~ ~ RAIiGER 

( Ok ) r Reset 1 I Cancel) 
---' 

Figure 8-10 Network Terminal Services Dialog Box 

NOTE 
For most systems, you can access a maximum of 10 services. A 
warning box is displayed if the service table has overflowed. 

To add more services, you must change the table size in the 
Network Terminal Services (LAT) driver. 

2. From the Port list box, select the COM1 or COM2 communications port. 

The current terminal services for that port are displayed. 
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3. From the Services list box, select a terminal service. 

4. Select the Ok command button. 

You can redirect communications ports to a network terminal service for any 
standard application that runs in a window, such as, the VT220 terminal 
emulator. Using the configuration shown in Figure 8-10, you can connect the 
VT220 emulator to the COM2 port; however, all communications for the 
VT220 emulator will use the network terminal service called RANGER. For 
more information about network terminal services, see Chapter 9. 

When you run an application that uses COMI or COM2, the selected termi
nal service is redirected if the following conditions are met: 

• The Network Terminal Service driver (LAT) was installed prior to start
ing MS-Windows. This driver lists all available services, normally 
assigned by the key diskette. 

• The redirected port is COM! or COM2. Only COMI and COM2 can be 
redirected. 

• The mode of transmission is computer to computer, and does not use a 
modem. Only applications that do not use modem control signals to 
control the flow of data can be redirected. 

• No more than four Network Terminal Services are active, including redi
rected and direct connections. 

• A terminal services name is present in the WIN.INI file for the serial 
communication device being used. You cannot select a terminal service 
not listed in the Services list box. 

• The terminal service is available. This availability is dynamic. If a termi
nal service is selected for a communications port, the terminal service 
is assigned to that communications port only as long as terminal service 
is available to the network. If the terminal service becomes unavailable 
to the network, it is no longer assigned to the communications port. 

NOTE 
Even if COMI and COM2 hardware is not installed, redirection 
over the local area network can occur, because the redirection is 
done by software. 
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Using the Preferences Menu 

The Preferences menu has four commands: 

• Screen Colors, which lets you adjust shades on your screen 

• Keyboard Settings, which lets you change settings such as keyc1ick and 
autorepeat 

• Mouse, which lets you swap the function of the left and right mouse 
buttons 

• Country Settings, which lets you select country-specific user preferences 

Figure 8-11 shows the Preferences menu commands. 

Screen Colot·s ... 
Keyboard Settings ... 
Mouse ... 
C 

Figure 8-11 Preferences Menu Commands 

Changing Screen Colors 

To adjust the shades of the components in a window, use the Screen Colors 
command. These components are: 

• Window background 

• Window text 

• Scroll bars 

• Active (selected) title bar 

• Inactive (unselected) title bar 

• Title bar text 

• Window frame (the thin border around the outside of the window) 
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• Menu bar 

• Menu text 

• Screen background (including the icon area) 

To change the shade of a component in a window: 

1. Select the Screen Colors command from the Preferences menu. 

MS-Windows displays the Screen Colors dialog box. Figure 8-12 shows 
the Screen Colors dialog box. 

NOTE 
Set your screen to have contrasting text and background colors. 
Otherwise, your screen could look blank. 

Screen Colors 
19m. I 

!~lnlJ!lW !ext 
Scroll Bars 
Actiue Title Bar 
Inactiue Title Bar 

Hue 

Bright 

Color 

Figure 8-12 

SalQple 
Actlve 

Screen Colors Dialog Box 

2. From the Screen Colors list box, select the part of the screen for which 
you want to change the shade. 

The current settings for Hue, Bright, and Color of the selected 
component in the window are displayed in the scroll bars. The mixture 
of these three settings for the selected component result in the current 
shade displayed in the Sample area. 

To change the shade of a component in the window, change the settings 
for Hue, Bright, and Color. 
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3. To change a setting for Hue, Bright, or Color: 

a. Move the cursor to the scroll bar by clicking on the scroll bar or by 
pressing the Tab key until the scroll box blinks in the desired scroll 
bar. 

b. Scroll to the right or to the left to change the setting. 

With the mouse, click on the arrows or drag the scroll box in the 
scroll bar. 

With the keyboard, press the right and left arrow keys to change 
settings in small increments, or press the Pg Up or Pg Dn keys to 
move across the scroll bar more quickly. 

As you scroll, the Sample area dynamically shows the changing shade 
of the selected window component. 

c. Select another scroll bar until the desired shade is displayed in the 
Sample area. 

d. Change the shades of all other items in the Screen Colors dialog box. 

e. When you finish changing screen colors, select the Ok command 
button. 

When you select the Ok command button, the settings are recorded in 
the WIN.INI file, and the dialog box is removed from the screen. 

Changing Keyboard Settings 

To change keyboard features, use the Keyboard Settings command. These fea
tures include: 

• Keyclick volume (No sound, Soft, Intermediate, Loud) 

The default setting is Intermediate. 

• Autorepeat (enable or disable) 

The default setting is autorepeat enabled. 

• Lock selection (Caps Lock or Shift Lock) 

The default setting is Caps Lock. 

This selects the function of the Lock key. 
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When you type a key with the Caps Lock selected, uppercase letters are 
used for the alphabetic keys, but the lower character on the 
numeric/symbolic keys are used. To clear the lock function momenta
rily, press the Shift key. 

When you type a key with the Shift Lock selected, uppercase letters are 
used for the alphabetic keys, and the top character on the 
numeric/symbol keys are used. 

In either case, pressing the Lock key turns on the keyboard lock indica
tor light. To override the lock function, press the Lock key again. The 
lock indicator light turns off. 

To change keyboard settings: 

1. Select the Keyboard Settings command from the Preferences menu. 

MS-Windows displays the Keyboard Settings dialog box. Figure 8-13 
shows the Keyboard Settings dialog box. 

Keyboa~d Settings 

Keyboa~d in use: U.S.A. 

Keyclick uolullle a Ho sound 
a Soft 
@ I nterlllediate 
aloud 

Autorepeat @ Enabled 
a Disabled 

lock selection @ Caps 
a Shift 

( Ok ) ( Reset) (Cancel ) 

Figure 8-13 Keyboard Settings Dialog Box 

2. Select the settings you want. 
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3. Select the Ok command button. 

The keyboard settings for the keyclick volume and autorepeat are in 
effect for your workstation, even when you are not running 
MS-Windows. 

When you change a keyboard feature, the new selection affects the 
keyboard, and MS-Windows enters the new selection into the WIN.INI 
file. The changes are effective immediately and remain in effect until 
you change them. 

The default settings are used when: 

• You run MS-Windows for the first time and have not made any changes 
to the keyboard preference features. 

• The WIN .INI file is not present, or the information about the keyboard 
preference features has been removed from the WIN .INI file with a text 
editor. 

Changing Mouse Settings 

To swap the function of the left and right mouse buttons, use the Mouse 
command. The default setting is the left mouse button for performing the 
mouse actions of clicking, double-clicking, and dragging. 

To swap the functions of the left and right mouse buttons: 

1. Select the Mouse command from the Preferences menu. 
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MS-Windows displays the Mouse Options dialog box. Figure 8-14 shows 
the Mouse Options dialog box. 

Mouse Options 

~ left/right 

( Ok 

~ouse buttons swapped 

) (Cancel) 

Figure 8-14 Mouse Options Dialog Box 
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2. Click on the check box. 

An X is displayed in the check box, showing that the functions of the 
right and left mouse buttons will be swapped. 

3. Click on the Ok command button. 

The functions of the left and right mouse buttons are swapped. Until 
you swap the functions of the left and right mouse buttons again, and 
remove the X from the check box, you must use the right mouse button 
when using any mouse action. 

Changing Country Settings 

To specify country-specific information, such as the formats for date and 
time, use the Country Settings command. This information can then be used 
by the MS-Windows applications you run. 

NOTE 
All applications you run do not automatically access this 
information. Access depends on how the application interfaces 
with MS-Windows. 

To change country settings: 

1. Select the Country Settings command from the Preferences menu. 

MS-Windows displays the Country Settings dialog box. Figure 8-15 
shows the Country Settings dialog box. 
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Country Settings 
11_ .... ' ~ r Time Format 
Itrance r- @ 12 hour 11 :59®CJ 23:59~ Spain ~ Italy P- 024 hoUl" Separator: [J 
Switzerland "-
Date Format Number Format 
(!JMDY ODMY () YMD 1000: GJ Decimal digits:C[J 
Separator: [ZJ Decimal: [J 

List: GJ o Leading Zero 

( Ok ) t Reset ) (Cancel) r CUI"rency F orlllat 
_ Symbol: U ,~\ Prefix () Suffix 

Figure 8·15 Country Settings Dialog Box 

2. From the list box, select a country. 

The default settings for the selected country are shown in the dialog 
box. 

3. Select the setting you want to change. 

If necessary, enter the sign you want to use. 

For example, the default setting for the date format in the U.S. country 
setting is month/day/year. You can use day/month/year or day-month
year. 

4. Select the Ok command button. 

The country settings you selected are in effect. 
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Chapter 9 
Using Terminal 
Emulators With 

Your Workstation 

This chapter provides a brief overview of three methods of connecting your 
workstation to a host computer: 

• VT220 terminal emulator 

• VT240 terminal emulator 

• SETHOST MS-DOS command 

A terminal emulator is an application that lets you use your workstation to 
access a host computer as if you were using a terminal. When you use a 
terminal emulator, your workstation keyboard and screen behave like a 
DIGITAL terminal. 

The VT220 and VT240 terminal emulator applications behave like VT52, 
VT100, or VT200 7 and 8-bit control terminals that support both DEC and 
ISO Latin-l character sets. 

The MS-DOS SETHOST command is a network utility that performs terminal 
emulation of a VTI02 7-bit control terminal that only supports the line draw
ing character set. 
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Table 9-1 compares the three emulators and their features. 

Table 9-1 Workstation Emulator Comparison Table 

Feature VT220 VT240 SETHOST 

ReGIS Graphics No Yes No 

Runs in a window(s) Yes No No 

Supports multiple simultaneous sessions No' Yes No 

Accesses hosts on a local area network+ Yes Yes Yes 

Accesses hosts on a wide area DEC net No No Yes 
network+ 

Can use a serial port Yes Yes No 

• Single session only. but can run multiple copies of VT220 emulators simultaneously in differ· 
ent windows. 

t Uses the ThinWire Ethernet port. 
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Using the VT220 

Terminal Emulator 

The VT220 terminal emulator is an MS-Windows application that offers many 
Set-Up parameters or selections you can change or set depending on your 
needs. These selections can be saved in a file the emulator reads when it 
starts. 

Wherever the words VT220 emulator are used, it means the VT220 terminal 
emulator for the workstation. 

The VT220 emulator allows you to: 

• Put the VT220 emulator application on temporary hold while you 
switch to another application 

• Receive or send information to or from a host using files 

• Save and recall Set-Up selection settings using Set-Up configuration files 

• Use MS-Windows Clipboard commands 

This chapter covers: 

• Starting the VT220 emulator 

• Using the VT220 emulator window 

• Leaving the VT220 emulator 
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Starting the VT220 Emulator 

Start the Vf220 emulator either by: 

• Expanding the VT220 emulator icon (a small terminal) in the icon area 
into the work area 

• Using the Run command from the File menu in the MS-DOS Executive 
window 

To do this: 

1. Select the Run command. 

2. Type VT220 in the dialog box. 

3. Click on the Ok command button. 

Your workstation is emulating a VT220 terminal, and your host login 
information is displayed. 

NOTE 
If your login information is not displayed, see your system 
administrator. 

Using Multiple VT220 Emulators 

You can run more than one VT220 emulator. You might want to do this if 
you are: 

• Editing a file in one Vf220 emulator and want to access or monitor 
your mail using another Vf220 emulator 

• Compiling a program in one Vf220 emulator and want to edit a memo 
using another VT220 emulator 

When you start another VT220 emulator, the title bar displays square brack
ets next to the VT220 emulator title. A number is displayed in these brackets 
to indicate the emulator session you are running. These brackets only display 
if you are using more than one VT220 emulator. 

10-2 



Using the VT220 Terminal Emulator 

Scrolling in the Emulator Window 

If you need to view more information than can be displayed in an emulator 
window, use these keys: 

( Clrl/Find ) 

( Clrl/Selecl ) 

( Clrl/Prev ) 

( Ciri/Nexi ) 

To scroll to the left 

To scroll to the right 

To scroll up 

To scroll down 

Using the VT220 Emulator System Menu Commands 

The VT220 emulator adds the following commands to the standard System 
menu commands: 

• Set-Up 

• Mark 

• Copy 

• Paste 

• About 

The Set-Up Command 

IIIII 

You can start or exit from the VT220 emulator Set-Up utility by selecting the 
Set-Up command. Chapter 12 discusses the Set-Up utility. 
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The Mark, Copy, and Paste Commands 

The Vf220 emulator lets you transfer information between itself and the 
MS-Windows Clipboard application. You copy the information from the emu
lator to the Clipboard or paste information from the Clipboard to the emula
tor as if you typed it. When you send information to the Clipboard, the 
characters are interpreted as ISO Latin -1 characters. 

To copy text to the Clipboard: 

1. Select Mark from the Vf220 System menu. 

The word "Mark" is displayed in parentheses next to the VT220 
emulator title in the title bar. A special vertical bar, the insertion point, 
is also displayed in the window. 

2. Drag the insertion point across the text you want to copy. This marks 
the text. 

3. Select Copy to move the marked text to the Clipboard. 

NOTE 
Marking is disabled whenever a key is typed, or when Mark is 
selected a second time. 

You can paste from the Clipboard at any time. The pasted text is sent to the 
host. Text is not displayed in the window unless the host echoes it, or Local 
Echo is enabled in Set-Up. 

The About Command 

The About command displays the version number of the VT220 emulator 
application. 

Leaving the VT220 Emulator 

To leave the VT220 emulator select one of the following commands from the 
Vf220 System menu: 

• The Icon command 

Selecting the Icon command shrinks the VT220 emulator to an icon 
without exiting from the emulator application. 

• The Close command 

Selecting the Close command exits you from the Vf220 emulator. 
Before using this command, you should log off the host system. 
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This chapter: 

Chapter 11 
Using the VT220 

Emulator Keyboard 

• Shows a diagram of the workstation keyboard. 

• Describes the differences between the workstation keyboard for the 
VT220 emulator and an actual VT220 terminal keyboard. 

The VT220 Emulator Keyboard 

The layout of the VT220 emulator keys on a workstation keyboard is identi
cal to the emulated terminal except for: 

• Labels for some keys 

• Location of the' , -, <, and >, and Compose key 

The labels referred to are those on the standard United States legend strip. All 
countries are supplied with a separate emulator legend strip and should 
ensure that this is used with the VT220 emulator. 
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Labels 

Some labels for the workstation top-row function keys differ from those on a 
VT220 terminal keyboard. These keys are indicated in Figure 11-1. 

DDDDD 
~ 

DDDD 

DDDDDDDDDDDDDD 
DDDDDDDDDDDDDO 

DDDDDDDDDDDDDD 
c:::JDDDDDDDDDDDCJ 

DDD 
DDD 

D 
DDD 

DDDD 
DDDD 
DODD 
rgBO CJI I 

Figure 11-1 Workstation Keyboard 

The VT220 emulator keys function exactly as they do for the VT220 terminal. 
However, the workstation keyboard has and uses the Alt key. 

For more information about the Alt key, see Appendix D. 

Top-Row Function Keys 

Most of the top-row function keys have functions assigned to them by your 
application software. Refer to your application software documentation for 
their use. 

This section describes keys with fixed meanings for the VT220 emulator. The 
labels in parentheses refer to the labels on the standard United States legend 
strip. 

Fl (Hold) 

11-2 

Pressing the Fl (Hold) key freezes the screen display and 
stops any new characters from being displayed. Pressing 
the Fl (Hold) key again returns the emulator to normal 
operation. 

Pressing the F2 (Print Screen) key sends the screen text 
to the printer. 

Pressing Ctrl/F2 (Print Screen) sets or resets Auto Print 
Mode. 



F3 (Set-Up) 

F4 (Data/Talk) 

F5 (Break) 

FIl (ESC) 

F12 (BS) 

F13 (LF) 

l !sing fhl' VT .2.2() Emulator KI'),board IIIII 

Pressing the F3 (Set-Up) key allows you to enter and exit 
Set-Up. 

Used when the optional integral modem is installed or if 
an external modem is used. For more information, refer 
to the VAXmate Modem User's Guide. 

Note: The integral modem may not be available for your 
country. 

Pressing the F5 (Break) key transmits a break if you ena
bled Break in Set-Up. You may use it with other key 
combinations when the optional integral modem is in
stalled. For more information, refer to the VAXmate 
Modem User's Guide. 

Pressing the Shift/F5 keys initiates a communications line 
disconnect. 

Pressing the Ctrl/F5 keys sends an answerback message as 
defined in Set-Up. 

Note: The integral modem may not be available for your 
country. 

Pressing FIl (ESC) generates an escape character when 
in VT52 and VT100 modes. In VT200 modes, Fll is a 
function key. 

Pressing F12 (BS) generates a backspace character when 
in VT52 and VT100 modes. In VT200 modes, F12 is a 
function key. 

Pressing F13 (LF) generates a line feed character when in 
VT52 and VT100 modes. In VT200 modes, F13 is a func
tion key. 
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Chapter 12 
Using Set-Up With 

the VT220 Emulator 

This chapter describes: 

• How to enter and exit Set-Up 

• How to make or change Set-Up settings 

• Each Set-Up screen and all the settings 

Entering Set-Up 

The VT220 emulator offers several Set-Up selections that affect such settings 
as tab stops, screen background, or column width. 

To enter Set-Up either: 

• Press the F3 (Set-Up) key 

• Select the Set-Up command from the Set-Up System menu 
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Understanding the VT220 Set-Up Screens 

Mter you enter Set-Up the VT220 emulator displays Screen 12-1, the Actions 
Screen, the first of eight Set-Up screens. For this discussion the Actions 
Screen is being treated as a general example of all eight screens. 

Receive File: Idle 
Send File: I dIe 

Printer: None 
Modem: Not Selected 

Tabs 

Set Default Set-Up Parameters 
Send File 
Receive File 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Communications: Comm Port 1 - Data Leads Only 

Screen 12-1 VT220 Set-Up 

Each Set-Up screen displays: 

• A title bar with a Set-Up System menu in the first line. 

• A menu bar in the next two lines of the screen with the name of the 
currently selected screen highlighted. You select a screen by clicking 
on its name. 

• The current selections and settings in the mid-section of the screen. 
Some selections are actions that can be taken, while others represent 
settings with different values. These selections vary depending on the 
selected screen. 

• A status section in the bottom half of the the screen. 
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Table 12-1 describes each of the Set-Up screens. 

Table 12-1 VT220 Set-Up Screens 

Set-Up Screen 

Actions 

Communications 

Display 

General 

Keyboard 

Printer 

Tabs 

Telephone 

Description 

Contains selections relating to clearing the screen and resetting 
the emulator, saving and recalling Set-Up settings, and sending 
or receiving files. 

Contains selections for defining the communications environ
ment, such as speed, parity, and disconnect. 

Contains selections for defining screen display, such as col
umns, cursor style, and background. 

Contains commonly used general operating selections, such as 
local echo, character sets, and terminal ID. 

Contains selections for defining keyboard operating characteris
tics, such as margin bell, break, and answerback. 

Contains selections for defining printer operations, such as 
print size or type of printer. 

Contains selections for defining the tab settings. 

Lets you determine how telephone answering is done. You can 
also emer the telephone numbers you want to use with the 
modem. 

From each Set-Up screen you can: 

• View the current selections and settings 

• Change the current settings to suit your needs 

• Access any of the other Set-Up screens from the menu 

All settings can be saved in or recalled from Set-Up files. You can also recall 
the factory default settings. 
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The VT220 Status Section 

The status section displays information relating to the state of operations you 
initiate through various Set-Up selections. 

Ail screens for the VT220 emulator have a bottom section displaying the 
current status for: 

• Receiving or sending a file 

- Idle or In Progress 

• Printer 

- Printer type and Mode 

• Modem usage (valid only if the optional integral modem is installed, 
and you selected Modem Control) 

- Selected or Not selected 

• Telephone modes (valid only if the optional integral modem is 
installed, and you selected Modem Control) 

- Manual or Automatic Answer 

• Insert/Replace mode 

• Communications 

- Comm Port 1, Comm Port 2, or Network Terminal Service 

NOTE 
The VT220 status area is a reporting area only. 

Changing Settings in VT220 Set-Up 

You can use either the mouse or the keyboard in VT220 Set-Up. This section 
describes only how to use the mouse. For information on how to use the 
keyboard to change settings, see Appendix D. 
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Using the Mouse in Set-Up 

To select a Set-Up screen and change a setting: 

1. Select the desired screen from the menu area. 

2. After the desired Set-Up screen is displayed, click on the selection you 
want to view or change. 

If a drop-down menu is displayed, go to the next step; otherwise release 
the mouse button. 

3. Drag the pointer to the desired setting and release the mouse button. 

NOTE 
Some settings take effect immediately; others take effect when you 
exit Set-Up. 

Exiting Set-Up 

To exit Set-Up either: 

• Press the F3 (Set-Up) key again 

• Select the Close command from the Set-Up System menu 

Using Set-Up Table Information 

The following sections describe the Set-Up screens and the settings you can 
change. 

The information for each Set-Up screen is organized as follows: 

• A description of the Set-Up screen 

• The VT220 screen 

• A table containing: 

- Selection definitions 

- Setting descriptions for each selection 

- Default settings 
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Actions Screen 

Whenever you enter VT220 Set-Up, it displays the Actions Set-Up screen. 

/-----------------------------------------------------------------------
UT221l EfIlulatot· "-"" - - " •. ' -. 

Receiue File: Idle 
Send File: Idle 

Printer: Hone 
Modefll: Hot Selected 

Set Default Set-Up Paraflleters 
Send File 
Receiue File 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
COfllfllunications: COfllfll Port 1 - Data Leads Only 

Screen 12-2 VT220 Actions 

Table 12-2 defines the Actions Set-Up selections. 
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Table 12-2 VT220 Actions Set-Up 

Selection Function 

Reset Terminal 

Clear Display 

Clear 
Communications 

Recall Set-Up 
Parameters 

Save Set-Up 
Parameters 

Set Default Set-Up 
Parameters 

Resets many terminal operating settings to the power up de
fault state. 

Does not affect communication, NRC (National Replacement 
Characters) and multinational modes, or user-defined keys. It 
takes effect immediately. 

Clears and sends the cursor to the upper-left corner of the 
screen. 

Clears communication lines immediately and stops any print 
operation in progress. It also exits printer controller mode. 

Does not affect LAT communications. 

Replaces all existing settings with values you saved in a de
fault file called DEFAULT.220 or in a file you created. 

Clears the dialog box from the Actions Set-Up screen and 
returns the cursor to the upper-left corner of the Actions 
Set-Up screen. 

Saves the Set-Up settings in a default file called 
DEFAULT.220 or in a file you can specify. 

Clears the dialog box from the Actions Set-Up screen and 
returns the cursor to the upper-left corner of the Actions 
Set-Up screen. 

Replaces all current Set-Up settings with factory default 
settings. 

Clears the dialog box from the Actions Set-Up screen and 
returns the cursor to the upper-left corner of the Actions 
Set-Up screen. 
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Table 12-2 VT220 Actions Set-Up (cont.) 

Selection Function 

Send File Allows you to send characters to a host from an MS-DOS text 
file as though you entered them from a keyboard. 

Open File 

Close File 

Receive File 

Open File 

Open File and 
Append 

Close File 

On 

Off 

12-8 

Displays a dialog box and asks you to enter a file name. 
When you open a file from the dialog box, sending begins 
after you select Ok and exit Set-Up. When the file is opened 
this setting is displayed in a lighter shade until the file is 
closed. 

Displayed in a lighter shade until YOll open a file. Closes and 
saves the file. 

Controls the receiving of characters from a host into a speci
fied file. 

Displays a dialog box and asks YOll to enter the name of the 
file that is to receive the characters. If a file of the same 
name already exists, it is replaced. 

This is identical to Open File except that text is appended to 
a file of the same name if it exists. If not, a new file is 
created. 

File logging is ended and the file is closed. 

File logging resumes. 

File logging is suspended but the file remains open. 
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Communications Screen 

The Communications Set-Up screen lets you define the communications envi
ronment between the terminal and the host. 

Normally a terminal can only connect to a host using a serial port. Your 
workstation VT220 emulator allows you to connect to a host using either: 

• A serial port 

• Network Terminal Services/the ThinWire Ethernet port 

Pot'tltietwot-k 
fh~t udYi,; 

Disconnect Delay 
XOFF Point 

Receiue File: Idle 
Sef,d File: Idle 

Printet-: tione 
Modem: tiot Selected 

Speed 
Data Bits and Parity 
Stop Bits 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Communications: Comm POt-t 1 - Data Leads Only 

Screen 12-3 VT220 Communications 

Table 12-3 defines the Communications Set-Up selections and, where appli
cable, the settings. 
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Table 12-3 VT220 Communications Set-Up 

Selection Function 

Port/Network 

Comm Port 1: Data 
Leads Only (default) 

Comm Port 1: Full 
Modem Control 

Comm Port 2: Data 
Leads Only 

Comm Port 2: Full 
Modem Control 

Comm Port 2: 
Integral Modem 

Network 
Communication 
Port 
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Selects the type of port used for communication with a 
host, either serial or Network Terminal Services commu· 
nications. 

If you select serial communications, Network Terminal 
Service is displayed in a lighter shade on your screen. 

Select when you connect to the host using serial commu
nications. 

Select if your workstation is connected to the host 
through the communications port and an external modem 
requiring modem control is used. 

Select when you connect to the host using serial commu
nications. 

Select if your workstation is connected to the host 
through the communications port and an external modem 
requiring modem control is used. 

Note: The VT220 emulator may not function correctly 
with certain external modems due to inconsistencies of 
timing under MS-Windows. To avoid problems using 
external modems, use the VT240 emulator. 

Select if the optional integral modem is installed, and the 
workstation uses it to communicate with the host. 

Note: The integral modem may not be available for your 
country. 

Selects connection to Network Terminal Services. You 
must be connected to the Network in order to access 
these services. 

If you have not selected a Network Terminal Service, a 
dialog box is displayed listing the available workstation 
services. For more information on defining the table size 
for these services in the MSNET.lNI, see the VAXmate 
System Administrator's Guide. 

Click on the service you want to access, then click on 
the Ok command button. 
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Table 12-3 VT220 Communications Set-Up (cont.) 

Selection Function 

Network Terminal 
Services 

Disconnect Delay 

2 second delay 
( default) 

60 Millisecond 
delay 

XOFF Point 

XOFF at 64 
(default) 

Disabled 

Speed 

Data Bits and Parity 

Stop Bits 

If displayed in a lighter shade. you are lIsing serial com
munications. 

If you set the Network selection under Port/Network, all 
items relating to serial communications are displayed in a 
lighter shade, and you are connected to services available 
under Network Terminal Services. 

Selects (when modem control is used) the amount of 
time before the workstation disconnects from the com
munications line if the carrier detect is lost. 

Most countries, except the United Kingdom, use the two
second delay. 

The 60 millisecond delay is for use in the United King
dom. 

Selects the XOFF point or disables the automatic 
XON/XOFF tlow control. 

For most applications you should set XOFF at 64 or 256. 
If you set XOFF greater than 256 and have a buffer over
now problem, set XOFF to the next lower value. 

The choices for XOFF are: 64 (default), 256, 512, and 
1024. 

Characters are received continuously from the host. Some 
characters may be lost. 

Selects the rate at which characters are received or trans
mitted. The default is 9600. 

Selects the character format used for communication with 
the host computer. The default is 8 bits - No Parity. 

Selects the number of stop bits (lor 2) required for use 
by the host port. The default is 1 stop bit. 
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Display Screen 

The Display Set-Up screen lets you define screen display characteristics. 

~--------------------------------------------------------------------

Receiue File: Idle 
Send File: Idle 

Printer: Hone 
Moden: Hot Selected 

Blink 
Font Size 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Connunications: Conn Port 1 - Data leads Only 

Screen 12-4 VT220 Display 

Table 12-4 defines the Display Set-Up selections and, where applicable, the 
settings. 

Table 12-4 VT220 Display Set-Up 

Selection 

Columns 

80 Columns 
(default) 

132 Columns 

12-12 

Function 

Selects an 80- or 132-column screen for text. 

Selects an 80-column screen. 

Selects a 132-column screen. 
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Changing the Cursor Blink Rate 

Some applications have a cursor that blinks. The cursor is usually an under
score or insertion point that blinks. The blink rate is the frequency at which 
the cursor Hashes. 

To change the cursor blink rate with the mouse, do one of the following: 

• Click on the right or left scroll arrow. 

The scroll box moves as you click on an arrow. 

• Drag the scroll box within the scroll bar to the right or to the left. 

The vertical cursor below the scroll bar shows the new cursor blink 
rate. As you scroll, the blink rate of the vertical cursor changes. The 
farther right you scroll, the faster the cursor blinks. The cursor blink 
rate stays in effect until you change it again. 

To change the cursor blink rate with the keyboard: 

1. Press the Tab key to move the cursor to the Cursor Blink section. 

2. Press the left arrow or the right arrow key to scroll to the setting you 
want. 

Changing the Mouse Double-Click Rate 

You can double-click to execute many commands. MS-Windows interprets 
this action either as a double-click or as two individual clicks, depending on 
how soon one click follows another. If you do not double-click fast enough, 
MS-Windows interprets the action as two individual clicks of the left mouse 
button, instead of a double-click. 

To change the mouse double-click rate, do one of the following: 

• Click on the right or left scroll arrow in the Double-Click section. 

• Drag the scroll box within the scroll bar. 

The farther right you scroll, the faster MS-Windows expects a double
click. 

You can test the new double-click setting by double-clicking on the TEST 
button in the dialog box. If MS-Windows interprets your clicking as a double
click, the TEST button shade changes from dark to light, or from light to 
dark. If the TEST button shade does not change, try double-clicking faster or 
reducing the double-click rate. 
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Using the Installation Menu 

The Installation menu has four commands: 

• Add New Printer, which adds a printer to the list of available printers 

• Delete Printer, which removes a printer from the list of available 
printers 

• Add New Font, which adds a font to the list of available fonts 

• Delete Font, which removes a font from the list of available fonts 

Figure 8-3 shows the Installation menu commands. 

~~ __ ~~I~ Setu 
Add Hew Printer .. . 
Delete Printer .. . 
Add Hew Font .. . 
Delete Font .. . 

Figure 8-3 Installation Menu Commands 

Adding and Removing a New Printer 

When you first set up MS-Windows, you select the printer or printers you 
want to use. To change this selection, use the Add New Printer and the 
Delete Printer commands from the Installation Menu. 

On the network, you can connect to print servers that generate output in 
either landscape or portrait mode. Using the Control Panel, you can select 
the default printer mode: landscape or portrait. The printer mode you select 
overrides the current mode of the printer. 

When you use the Control Panel to add or remove a printer to MS-Windows, 
you are actually adding or removing the name of the printer driver file to the 
other printer drivers already named in the WIN.INI file of MS-Windows. Only 
printers that have their printer driver files named in the WIN.INI file can be 
used by MS-Windows and its applications. 
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After MS-Windows is set up, you can add a printer driver file to MS-Windows 
when you want to install: 

• An existing printer driver file 

The printer driver file is included in the network directory 
H:\ WIN\UTIL, which stores printer driver files. 

• A new printer driver file 

The printer driver file is not in the network directory H:\ WIN\UTIL. 
You install the printer driver file by copying it from the distribution 
diskette of a new application to the network directory H:\WIN\UTIL. 

After you add a new printer to your system, you must let MS-Windows know 
which communications port the printer is connected to before you can use 
the printer. To define the communications port, use the Connections com
mand in the Setup menu of the Control Panel. 

Adding an Existing Printer Driver File 

To add an already existing printer driver file to your system: 

1. Select the Add New Printer command from the Installation menu. 

MS-Windows displays the Add Printer dialog box, which prompts you to 
insert the diskette containing the new printer driver file into Drive A, or 
select an alternate drive/directory. Figure 8-4 shows the Add New 
Printer dialog box. 

Add Pt'inter 
Insert the disk with the printer file 
you wish to add into drive A, or choose 
an alternative drive/directory: 

I~ 

( Ok ) 

Figure 8-4 Add New Printer Dialog Box 
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2. In the text box, you typically type the location of the printer driver file: 

H:\WIN\UTIL 

3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available in the 
network directory H: \ WIN\ UTIL. 

4. From the list box, select a printer. 

The name of the corresponding printer driver file is displayed in the 
Printer File text box of the dialog box. 

5. Select the Add command button. 

MS-Windows displays a dialog box. 

6. Select the No command button. 

8-8 

A dialog box prompts you to type the name of the drive or directory to 
which you want to copy the printer driver file. The default directory, in 
this case A:\WIN\STD, is displayed in the text box. This directory 
contains the MS-Windows run-time executables. 

Selecting the No command button is the normal procedure. However, 
to duplicate a separate file containing this printer driver file, type the 
drive or name of an existing directory you want, and select the Yes 
command button. 

MS-Windows updates the WIN.lNI file to include information for the 
new printer driver. However, only the WIN.INI file used when you start 
MS-Windows is updated. Each user's WIN.lNI file needs to be updated 
when a printer is added, even if it is added to the network. 
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Adding a New Printer Driver File 

Your system administrator, if you have one, adds a new printer driver file 
from the distribution diskette of a new application. 

Otherwise, to add a new printer driver file from the distribution diskette of a 
new application to your system: 

1. Select the Add New Printer command from the Installation menu. 

MS-Windows prompts you with a dialog box to insert the diskette with 
the printer driver file you want to add into Drive A, or select an alter
nate drive/directory. 

2. Insert the diskette with the printer files. 

Consult your application documentation to determine which diskette 
and which directory contains the printer driver (.DRV) files. 

3. Select the Ok command button. 

MS-Windows displays a dialog box, listing the printers available on the 
diskette. 

4. From the list box, select a printer. 

Mter you select a printer, the name of the corresponding printer driver 
file is displayed in the Printer File text box at the right. 

S. Select the Add command button. 

A dialog box prompts you to type the name of the drive or directory to 
which you want to copy the printer driver file. The text box displays 
the default network directory A:\ WIN\STD. 

The printer driver file should be copied to the H:\ WIN\UTIL directory. 
However, this a read only directory. Copy the printer driver file to this 
directory by using a read/write alias. 

6. In the text box, type the read/write alias for H:\ WIN\UTIL, the drive 
and directory to which the printer driver file is to be copied. 

7. Select the Ok command button. 

8. When prompted, select the Yes command button. 

MS-Windows updates the WIN.INI file to include information for the 
new printer driver. However, only the WIN.INI file used by 
MS-Windows when you started MS-Windows is updated. 
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Removing a Printer 

To remove a printer from MS-Windows: 

1. Select the Delete Printer command from the Installation menu. 

MS-Windows displays the Delete Printer dialog box. The list box shows 
all the printers currently in your WIN.INI file. Figure 8-5 shows the 
Delete Printer dialog box. 

Delete Printer 

LPT2: 

Printer File: 
.... 

LA7S.DRU 

( Delete) ( Cancel ) 

Figure 8-5 Delete Printer Dialog Box 

2. Select the printer you want to remove from the list box. 

The file name of the corresponding printer driver file is displayed in 
the text box. 

3. Select the Delete command button. 

MS-Windows displays a dialog box. 

4. Select the No command button. 

IMPORTANT 
When you select the No command button, the printer name is 
deleted from the WIN.INI file, but the printer driver file is not 
deleted from the network directory H:\ WIN\UTIL. By selecting the 
No command button, you can use the procedure discussed in 
"Adding an Existing Printer Driver File," because the printer driver 
is still stored in the directory. 
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It is recommended that you do not delete the printer driver file. If 
you select the Ok command button, the printer driver file is 
deleted from the network directory H:\ WIN\UTIL. To add the 
printer driver file again, you must follow the more complicated 
procedure discussed in "Adding a New Printer Driver File." 

Some printer drivers support more than one printer model. In this case, the 
printers share the print driver file. If other printers share the printer driver 
file that is displayed in the Delete Printer dialog box, that printer driver file 
is not deleted, because it is still used by the other printers. 

In this case, MS-Windows displays a dialog box, indicating the shared printer 
driver file is not deleted. However, it is disassociated from the selected 
printer in the WIN .INI file. 

Adding a New Font 

To add a font file (.FON) to MS-Windows, use the Add New Font command 
from the Installation menu. This command works similarly to the Add New 
Printer command. 

Two types of fonts are provided: raster fonts and stroke (also known as vec
tor) fonts. Raster fonts are generally used only for devices such as dot-matrix 
printers or the screen. They are available only in fixed sizes. Raster fonts 
look better and may be faster than stroke fonts when drawn on raster devices. 
Stroke fonts are typically used if your output is printed. 

When you select the Add New Font command (or the Delete Font command), 
you must specify where the font files are located. MS-Windows lists the avail
able fonts, including the font names, the font sizes, and the set numbers. 

The set number is based on the devices that the font is primarily designed to 

be used with. 

Set 1 

Set 1 fonts are stroke fonts. They can be used for the screen, a printer, or a 
plotter device of any resolution. 

Set 2 

Set 2 fonts are raster fonts. They are primarily designed for a screen resolu
tion of 640 X 200, specifically for the IBM Color Graphics Adapter or a 
compatible adapter card. 
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Set 3 

Set 3 fonts are raster fonts. They are designed for a screen resolution of 640 
X 350, specifically for the IBM Color Graphics Adapter and the Hercules 
Graphics Card. These fonts are also used by the printer erTOR 8510 (por· 
trait mode). 

Set 4 

Set 4 fonts are raster fonts. They are designed primarily for printers in 60 dpi 
resolution: 

• Okidata 92, 93, 192, 193, standard models (portrait mode) 

• Okidata 92, 93, 192, 193, standard and IBM-compatible models (land-
scape mode) 

• Epson MX-80, FX-80, and compatibles (landscape mode) 

• IBM Graphics (landscape mode) 

• IBM Pro printer (landscape mode) 

• Star Micronics SG-10 (landscape mode) 

• LA75 in STD mode (landscape mode) 

Set 5 

Set 5 fonts are raster fonts. They are designed for printers in the 120 dpi 
resolution: 

• Okidata 92,93, 192, 193, IBM-compatible models (portrait mode) 

• Epson MX-80, FX-80, and compatibles (portrait mode) 

• IBM Graphics (portrait mode) 

• IBM Proprinter (portrait mode) 

• Star Micronics SG-10 (portrait mode) 

• LA75 in STD mode (portrait mode) 

In addition to these fonts, an application can list device fonts. These are the 
fonts provided by a device. For example, on print-wheel printers, font names 
correspond to wheel names. These fonts cannot be added or deleted with the 
Control Panel, but they can be listed when the output device is selected. 
Because a raster font may not correspond to the screen, MS-Windows usually 
substitutes a screen font in the same class. 
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NOTE 
Because applications handle fonts differently, some applications 
may not list all fonts. 

Fonts have names that represent their different characteristics. Table 8-1 lists 
and describes the fonts that are included on your MS-Windows Fonts disk. 

Table 8-1 Fonts on the Fonts Disk 

Font Description 

Helv (Raster font.) A proportional font (characters having varying 
widths) without serifs. 

Courier (Raster font.) A fixed-width font (charcters having uniform 
width) with serifs. 

Tms Rmn (Raster font.) A proportional font with serifs. 

Roman (Stroke font.) A proportional font with serifs. 

Modern (Stroke font.) A proportional font without serifs. 

Script (Stroke font.) A proportional font of slanted characters formed 
from nearly continuous curved lines. 

Table 8-2 describes the fonts that are not included on the Fonts disk, but you 
can see them in some applications. These fonts cannot be added or deleted. 

Table 8-2 Fonts Not on the Fonts Disk 

Font Description 

System (Raster font.) A fixed-width font designed for the screen. 

Terminal (Raster font.) A fixed-width font that is the same as the font 
your workstation displays from MS-DOS. 

Deleting a Font 

To delete a font file to MS-Windows, use the Delete Font command from the 
Installation menu. This command works similarly to the Delete Printer com
mand. 
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Using the Setup Menu 

The Setup menu has four commands: 

• Connections, which lets you assign or change printer port connections 

• Printer, which lets you select the default printer 

• Communications Port, which lets you select a serial communications 
port and select parameters, such as baud rate, word length, parity, and 
stop bits 

• Network Terminal Services, which lets you select network services for 
your communication ports 

Figure 8-6 shows the Setup menu commands. 

Communicatlons Port ... 
Network Terminal Services ... 

Figure 8-6 Setup Menu Commands 

Changing Printer Connections 

MS-Windows needs to know to which communications port your printer is 
connected. To set or change the port for your printers, use the Connections 
command. 

For example, to move your printer from the communications port LPTI to 
LPT2, use the Control Panel to change the printer connections setting. 
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To change printer connections: 

1. Select the Connections command from the Setup menu. MS-Windows 
displays the Connections dialog box. Figure 8-7 shows the Connections 
dialog box. 

Connection 

. 
UIU3 lPT2: 

( Ok ) (Cancel) 

Figure 8-7 Connections Dialog Box 

2. From the Printer list box, select the printer you want to change. The 
current communications port assignment for the selected printer is 
displayed in the Connection list box, located at the right. 

3. From the Connections list box, select one of the communications ports. 

4. Select the Ok command button. 

NOTE 
You can redirect an LPT port only to the SPP (Serial Printer Port) 
or to a network print device. 

Changing the Default Printer 

When you execute a Print command, MS-Windows prints the file on the 
default printer. To select the default printer and to set its output modes, use 
the Printer command. 

Printer output modes are printer-specific settings, such as portrait mode 
(normal vertical page orientation) or landscape mode (horizontal page orien
tation). The Printer command is useful when you have both local and remote 
printers, or both dot matrix and character printers, connected to your com
munications ports. 
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To change the default printer: 

1. Select the Printer command from the Setup menu. 

MS-Windows displays the Default Printer dialog box. It lists all the avail
abie printers and their current communications port connections. Figure 
8-8 shows the Default Printer dialog box. 

Default Printer 

. . 
( Ok ) 

(Cancel) 

Figure 8-8 Default Printer Dialog Box 

2. From the list box, select the printer name. 

3. Select the Ok command button. 

MS-Windows displays the Output Mode dialog box, containing the mode 
settings specific to the printer you selected. 

4. To select another output mode, select from the options for printer 
output or answer the questions in the dialog box. 

5. Select the Ok command button. 

The printer you select becomes the default printer. 

Changing the Communications Port 

To select COM1 and COM2 settings, including baud rate, stop bits, parity, 
word length, and the retry (print/send) option, use the Communications Port 
command. 

For example, MS-Windows' print spool uses these settings to configure the 
communication port before printing. (COM1 and COM2 are serial communi
cations ports and can be used only with serial printers and serial communica
tion devices.) 
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To select a communications port: 

I. Select the Communications Port command from the Setup menu. 

MS-Windows displays the Communication Settings dialog box. Figure 
8-9 shows the Communications Settings dialog box. 

Communications Settings 

Port @~ OCOM2: 

Baud Rate: 112110 1 

Word length 04 05 06 07 @ 8 

Parity 

Stop Bits 

o Euen 

@1 

OOdd 

01-5 
@Hone 

02 
Handshake 0 Hard",are @ Hone 

( Ok (Cancel) 

Figure 8-9 Communications Settings Dialog Box 

2. Select the communications port COMI or COM2. 

The settings for the selected communications port are displayed in the 
dialog box. 

3. Select an option. See your printer or device documentation for the 
proper communications port settings. 

4. Select the Ok command button. The communications port you select is 
set up. 

NOTE 
This command does not configure or set up the communication 
hardware. It gives information about the communication hardware 
settings to MS-Windows and the applications using the 
communications ports. When you set up a communications device 
or printer, make sure the communications port settings are 
configured according to the serial communications instructions 
supplied by your printer or device manufacturer before you try to 

print. 
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Selecting Network Terminal Services 

To select terminal services for the workstation's communication ports, use 
the Network Terminal Services command. This command lets you redirect the 
COMI and COM2 communications ports to the selected terminal services. 
Any application using COMI or COM2 is redirected over the local area net
work to the specified network terminal service. 

To select a network terminal service: 

I. Select the Network Terminal Services command from the Setup menu. 

MS-Windows displays a Network Terminal Services dialog box. It lists 
the currently available network services. Figure 8-10 shows the Network 
Terminal Services dialog box. 

NehlOl"k Terminal Services 

You can assign communications ports 1 and 2 to the services listed 
below. These are the only currently available services. PI·eviously 
assigned services may be unavailable at this time. 

Port Sel"vices 

~rwe i 1~1?~E~R 1-o : RA-ER :::; 
II'· 

I~~¥~~~ t RANGER 

( Ok ) I Reset ) (Cancel :1 

Figure 8-10 Network Terminal Services Dialog Box 

NOTE 
For most systems, you can access a maximum of 10 services. A 
warning box is displayed if the service table has overflowed. 

To add more services, you must change the table size in the 
Network Terminal Services (LAT) driver. 

2. From the Port list box, select the COMI or COM2 communications port. 

The current terminal services for that port are displayed. 
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3. From the Services list box, select a terminal service. 

4. Select the Ok command button. 

You can redirect communications ports to a network terminal service for any 
standard application that runs in a window, such as, the VT220 terminal 
emulator. Using the configuration shown in Figure 8-10, you can connect the 
VT220 emulator to the COM2 port; however, all communications for the 
VT220 emulator will use the network terminal service called RANGER. For 
more information about network terminal services, see Chapter 9. 

When you run an application that uses COMI or COM2, the selected termi
nal service is redirected if the following conditions are met: 

• The Network Terminal Service driver (rAT) was installed prior to start
ing MS-Windows. This driver lists all available services, normally 
assigned by the key diskette. 

• The redirected port is COMI or COM2. Only COMI and COM2 can be 
redirected. 

• The mode of transmission is computer to computer, and does not use a 
modem. Only applications that do not use modem control signals to 
control the now of data can be redirected. 

• No more than four Network Terminal Services are active, induding redi
rected and direct connections. 

• A terminal services name is present in the WIN.INI file for the serial 
communication device being used. You cannot select a terminal service 
not listed in the Services list box. 

• The terminal service is available. This availability is dynamiC. If a termi
nal service is selected for a communications port, the terminal service 
is assigned to that communications port only as long as terminal service 
is available to the network. If the terminal service becomes unavailable 
to the network, it is no longer assigned to the communications port. 

NOTE 
Even if COMI and COM2 hardware is not installed, redirection 
over the local area network can occur, because the redirection is 
done by software. 
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Using the Preferences Menu 

The Preferences menu has four commands: 

• Screen Colors, which lets you adjust shades on your screen 

• Keyboard Settings, which lets you change settings such as keyclick and 
autorepeat 

• Mouse, which lets you swap the function of the left and right mouse 
buttons 

• Country Settings, which lets you select country-specific user preferences 

Figure 8-11 shows the Preferences menu commands. 

Screen Colot·s ... 
Keyboard Settings ... 
Mouse ... 
Countr Settin s ... 

Figure 8-11 Preferences Menu Commands 

Changing Screen Colors 

To adjust the shades of the components in a window, use the Screen Colors 
command. These components are: 

• Window background 

• Window text 

• Scroll bars 

• Active (selected) title bar 

• Inactive (unselected) title bar 

• Title bar text 

• Window frame (the thin border around the outside of the window) 
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• Menu bar 

• Menu text 

• Screen background (including the icon area) 

To change the shade of a component in a window: 

1. Select the Screen Colors command from the Preferences menu. 

MS-Windows displays the Screen Colors dialog box. Figure 8-12 shows 
the Screen Colors dialog box. 

Screen Colors 
I I. 

~1n!lO'" !ext 
Scroll Bars 
Actiue Title Bar 
Inactiue Title Bar 

Hue 

Bright 

Color 

Figure 8-12 

Salllple 
Actlue 

Screen Colors Dialog Box 

2. From the Screen Colors list box, select the part of the screen for which 
you want to change the shade. 

The current settings for Hue, Bright, and Color of the selected 
component in the window are displayed in the scroll bars. The mixture 
of these three settings for the selected component result in the current 
shade displayed in the Sample area. 

To change the shade of a component in the window, change the settings 
for Hue, Bright, and Color. 
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3. To change a setting for Hue, Bright, or Color: 

a. Move the cursor to the scroll bar by clicking on the scroll bar or by 
pressing the Tab key until the scroll box blinks in the desired scroll 
bar. 

b. Scroll to the right or to the left to change the setting. 

With the mouse, click on the arrows or drag the scroll box in the 
scroll bar. 

With the keyboard, press the right and left arrow keys to change 
settings in small increments, or press the Pg Up or Pg Dn keys to 

move across the scroll bar more quickly. 

As you scroll, the Sample area dynamically shows the changing shade 
of the selected window component. 

c. Select another scroll bar until the desired shade is displayed in the 
Sample area. 

d. Change the shades of all other items in the Screen Colors dialog box. 

e. When you finish changing screen colors, select the Ok command 
button. 

When you select the Ok command button, the settings are recorded in 
the WIN.INI file, and the dialog box is removed from the screen. 

Changing Keyboard Settings 

To change keyboard features, use the Keyboard Settings command. These fea
tures include: 

• Keyclick volume (No sound, Soft, Intermediate, Loud) 

The default setting is Intermediate. 

• Autorepeat (enable or disable) 

The default setting is autorepeat enabled. 

• Lock selection (Caps Lock or Shift Lock) 

The default setting is Caps Lock. 

This selects the function of the Lock key. 
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When you type a key with the Caps Lock selected, uppercase letters are 
used for the alphabetic keys, but the lower character on the 
numeric/symbolic keys are used. To clear the lock function momenta
rily, press the Shift key. 

When you type a key with the Shift Lock selected, uppercase letters are 
used for the alphabetic keys, and the top character on the 
numeric/symbol keys are used. 

In either case, pressing the Lock key turns on the keyboard lock indica
tor light. To override the lock function, press the Lock key again. The 
lock indicator light turns off. 

To change keyboard settings: 

1. Select the Keyboard Settings command from the Preferences menu. 

MS-Windows displays the Keyboard Settings dialog box. Figure 8-13 
shows the Keyboard Settings dialog box. 

Keyboard Settings 

Keyboard in use: U.S.A. 

Keyclick uolume 0 Ho sound 
o Soft 
@ Intermediate 
Oloud 

Autorepeat @ Enabled 
o Disabled 

Lock selection @ Caps 
o Shift 

( Ok ) ( Reset) (Cancel) 

Figure 8-13 Keyboard Settings Dialog Box 

2. Select the settings you want. 
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3. Select the Ok command button. 

The keyboard settings for the keyclick volume and autorepeat are in 
effect for your workstation, even when you are not running 
MS-Windows. 

When you change a keyboard feature, the new selection affects the 
keyboard, and MS-Windows enters the new selection into the WIN.INI 
file. The changes are effective immediately and remain in effect until 
you change them. 

The default settings are used when: 

• You run MS-Windows for the first time and have not made any changes 
to the keyboard preference features. 

• The WIN.INI file is not present, or the information about the keyboard 
preference features has been removed from the WIN.INI file with a text 
editor. 

Changing Mouse Settings 

To swap the function of the left and right mouse buttons, use the Mouse 
command. The default setting is the left mouse button for performing the 
mouse actions of clicking, double-clicking, and dragging. 

To swap the functions of the left and right mouse buttons: 

1. Select the Mouse command from the Preferences menu. 
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MS-Windows displays the Mouse Options dialog box. Figure 8-14 shows 
the Mouse Options dialog box. 

Mouse Options 
~ Left/right 

( Ok 

mouse buttons swapped 

) (Cancel) 

Figure 8-14 Mouse Options Dialog Box 
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2. Click on the check box. 

An X is displayed in the check box, showing that the functions of the 
right and left mouse buttons will be swapped. 

3. Click on the Ok command button. 

The functions of the left and right mouse buttons are swapped. Until 
you swap the functions of the left and right mouse buttons again, and 
remove the X from the check box, you must use the right mouse button 
when using any mouse action. 

Changing Country Settings 

To specify country-specific information, such as the formats for date and 
time, use the Country Settings command. This information can then be used 
by the MS-Windows applications you run. 

NOTE 
All applications you run do not automatically access this 
information. Access depends on how the application interfaces 
with MS-Windows. 

To change country settings: 

1. Select the Country Settings command from the Preferences menu. 

MS-Windows displays the Country Settings dialog box. Figure 8-15 
shows the Country Settings dialog box. 
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Country Settings 

~ rYaitce 
U.S.A. 

Spain 
Italy 
S~,itzet"land 

rTilTle FOt"lTIat __ I 
(!:' 12 hoUl" 11 :59 ~ 23 :59 ["pW] 
() 24 hout" Separator: [J 

[

NUlTlbet" F ot"lTIat 

1000: GJ D - 1 d - - f2l - D eCIlTla Igl ts: l-=.J 
DecIlT1al: . 
List:. GJ 0 Leading Zet"o 

( Ok ) r- Reset -'I (" Cancel") I~un"ency Fot"lTIa:" " 
'-----'- '- -'" - ~lTIbol: [i:=J ':!) Pt"ehx () Suffix 

Figure 8-15 Country Settings Dialog Box 

2. From the list box, select a country. 

The default settings for the selected country are shown in the dialog 
box. 

3. Select the setting you want to change. 

If necessary, enter the sign you want to use. 

For example, the default setting for the date format in the U.S. country 
setting is month/day/year. You can use day/month/year or day-month
year. 

4. Select the Ok command button. 

The country settings you selected are in effect. 
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Chapter 9 
Using Terminal 
Emulators With 

Your Workstation 

This chapter provides a brief overview of three methods of connecting your 
workstation to a host computer: 

• VT220 terminal emulator 

• VT240 terminal emulator 

• SETHOST MS-DOS command 

A terminal emulator is an application that lets you use your workstation to 
access a host computer as if you were using a terminal. When you use a 
terminal emulator, your workstation keyboard and screen behave like a 
DIGITAL terminal. 

The VT220 and VT240 terminal emulator applications behave like VT52, 
VT100, or VT200 7 and 8-bit control terminals that support both DEC and 
ISO Latin-1 character sets. 

The MS-DOS SETHOST command is a network utility that performs terminal 
emulation of a VT102 7 -bit control terminal that only supports the line draw
ing character set. 

9-1 



IIIII Using Terminal Emulators With Your Workstation 

Table 9-1 compares the three emulators and their features. 

Table 9-1 Workstation Emulator Comparison Table 

Feature VT220 VT240 SETHOST 

ReGIS Graphics No Yes No 

Runs in a window(s) Yes No No 

Supports multiple simultaneous sessions No' Yes No 

Accesses hosts on a local area networkt Yes Yes Yes 

Accesses hosts on a wide area DECnet No No Yes 
networkt 

Can use a serial port Yes Yes No 

• Single session only, but can run multiple copies of VT220 emulators simultaneously in differ
ent windows. 

t Uses the ThinWire Ethernet port. 
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Chapter 10 
Using the VT220 

Terminal Emulator 

The VT220 terminal emulator is an MS-Windows application that offers many 
Set-Up parameters or selections you can change or set depending on your 
needs. These selections can be saved in a file the emulator reads when it 
starts. 

Wherever the words VT220 emulator are used, it means the VT220 terminal 
emulator for the workstation. 

The VT220 emulator allows you to: 

• Put the VT220 emulator application on temporary hold while you 
switch to another application 

• Receive or send information to or from a host using files 

• Save and recall Set-Up selection settings using Set-Up configuration files 

• Use MS-Windows Clipboard commands 

This chapter covers: 

• Starting the VT220 emulator 

• Using the VT220 emulator window 

• Leaving the VT220 emulator 
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Starting the VT220 Emulator 

Start the VT220 emulator either by: 

• Expanding the VT220 emulator icon (a small terminal) in the icon area 
into the work area 

• Using the Run command from the File menu in the MS-DOS Executive 
window 

To do this: 

1. Select the Run command. 

2. Type VT220 in the dialog box. 

3. Click on the Ok command button. 

Your workstation is emulating a VT220 terminal, and your host login 
information is displayed. 

NOTE 
If your login information is not displayed, see your system 
administrator. 

Using Multiple VT220 Emulators 

You can run more than one VT220 emulator. You might want to do this if 
you are: 

• Editing a file in one VT220 emulator and want to access or monitor 
your mail using another VT220 emulator 

• Compiling a program in one VT220 emulator and want to edit a memo 
using another VT220 emulator 

When you start another VT220 emulator, the title bar displays square brack
ets next to the VT220 emulator title. A number is displayed in these brackets 
to indicate the emulator session you are running. These brackets only display 
if you are using more than one VT220 emulator. 
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Scrolling in the Emulator Window 

If you need to view more information than can be displayed in an emulator 
window, use these keys: 

( Clrl/Find ) 

( Clrl/Selecl ) 

( Clrl/Prev ) 

( Clrl/Nexl ) 

To scroll to the left 

To scroll to the right 

To scroll up 

To scroll down 

Using the VT220 Emulator System Menu Commands 

The VT220 emulator adds the following commands to the standard System 
menu commands: 

• Set-Up 

• Mark 

• Copy 

• Paste 

• About 

The Set-Up Command 

You can start or exit from the VT220 emulator Set-Up utility by selecting the 
Set-Up command. Chapter 12 discusses the Set-Up utility. 
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The Mark, Copy, and Paste Commands 

The VT220 emulator lets you transfer information between itself and the 
MS-Windows Clipboard application. You copy the information from the 
emulator to the Clipboard or paste information from the Clipboard to the 
emulator as if you typed it. When you send information to the Clipboard, the 
characters are interpreted as ISO Latin -1 characters. 

To copy text to the Clipboard: 

1. Select Mark from the VT220 System menu. 

The word "Mark" is displayed in parentheses next to the VT220 emula
tor title in the title bar. A special vertical bar is also displayed in the 
window. 

2. Drag the vertical bar to mark the text to be copied. 

3. Select Copy to move the marked text to the Clipboard. 

NOTE 
Marking is disabled whenever a key is typed, or when Mark is 
selected a second time. 

You can paste from the Clipboard at any time. The pasted text is sent to the 
host. Text is not displayed in the window unless the host echoes it, or Local 
Echo is enabled in Set-Up. 

The About Command 

The About command displays the version number of the VT220 emulator 
application. 

Leaving the VT220 Emulator 

To leave the VT220 emulator select one of the following commands from the 
VT220 System menu: 

• The Icon command. 

Selecting the Icon command shrinks the VT220 emulator to an icon 
without exiting from the emulator application. 

• The Close command. 
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Selecting the Close command exits you from the VT220 emulator. 
Before using this command, you should log off the host system. 



This chapter: 

Chapter 11 
Using the VT220 

Emulator Key board 

• Shows a diagram of the workstation keyboard. 

• Describes the differences between the workstation keyboard for the 
VT220 emulator and an actual VT220 terminal keyboard. 

The VT220 Emulator Keyboard 

The layout of the VT220 emulator keys on a workstation keyboard is identi
cal to the emulated terminal except for: 

• Labels for some keys 

• Location of the' , -, <, and >, and Compose key 

The labels referred to are those on the standard United States legend strip. All 
countries are supplied with a separate emulator legend strip and should 
ensure that this is used with the VT220 emulator. 
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Labels 

Some labels for the workstation top-row function keys differ from those on a 
VT220 terminal keyboard. These keys are indicated in Figure 11-1. 

DDDDD 
I 

DDDD 

DDDDDDDDDDDDDD 
DDDDDDDDDDDDDO 

DDDDDDDDDDDDDD 
CJDDDDDDDDDDDCJ 

DDD 
DDD 

D 
DDD 

DDDD 
DDDD 
DODD 

~BD c==J1 I 

Figure 11-1 Workstation Keyboard 

The VT220 emulator keys function exactly as they do for the VT220 terminal. 
However, the workstation keyboard has and uses the Alt key. 

For more information about the Alt key, see Appendix D. 

Top-Row Function Keys 

Most of the top-row function keys have functions assigned to them by your 
application software. Refer to your application software documentation for 
their use. 

This section describes keys with fixed meanings for the VT220 emulator. The 
labels in parentheses refer to the labels on the standard United States legend 
strip. 

FI (Hold) 
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Pressing the Fl (Hold) key freezes the screen display and 
stops any new characters from being displayed. Pressing 
the Fl (Hold) key again returns the emulator to normal 
operation. 

Pressing the F2 (Print Screen) key sends the screen text 
to the printer. 

Pressing CtrljF2 (Print Screen) sets or resets Auto Print 
Mode. 



F3 (Set-Up) 

F4 (Data/Talk) 

F5 (Break) 

Fll (ESC) 

F12 (BS) 

F13 (LF) 

(!sing thl' VT .!.!() Emlilator KI')!board IIIII 

Pressing the F3 (Set-Up) key allows you to enter and exit 
Set-Up. 

Used when the optional integral modem is installed or if 
an external modem is used. For more information, refer 
to the VAXmate Modem User's Guide. 

Note: The integral modem may not be available for your 
country. 

Pressing the F5 (Break) key transmits a break if you ena
bled Break in Set-Up. You may use it with other key 
combinations when the optional integral modem is in
stalled. For more information, refer to the VAXmate 
Modem User's Guide. 

Pressing the Shift/F5 keys initiates a communications line 
disconnect. 

Pressing the Ctrl/F5 keys sends an answerback message as 
defined in Set-Up. 

Note: The integral modem may not be available for your 
country. 

Pressing Fll (ESC) generates an escape character when 
in VT52 and VT100 modes. In VT200 modes, Fl1 is a 
function key. 

Pressing F12 (BS) generates a backspace character when 
in VT52 and VT100 modes. In VT200 modes, F12 is a 
function key. 

Pressing F 13 (LF) generates a line feed character when in 
VT52 and VT100 modes. In VT200 modes, F13 is a func
tion key. 
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Chapter 12 
Using Set-Up With 

the VT220 Emulator 

This chapter describes: 

• How to enter and exit Set-Up 

• How to make or change Set-Up settings 

• Each Set-Up screen and all the settings 

Entering Set-Up 

The VT220 emulator offers several Set-Up selections that affect such settings 
as tab stops, screen background, or column width. 

To enter Set-Up either: 

• Press the F3 (Set-Up) key 

• Select the Set-Up command from the Set-Up System menu 
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Understanding the VT220 Set-Up Screens 

After you enter Set-Up the VT220 emulator displays Screen 12-1, the Actions 
Screen, the first of eight Set-Up screens. For this discussion the Actions 
Screen is being treated as a general example of all eight screens. 

COllllllunications 
Printer Tabs Telephone 

Set Default Set-Up Parallleters 
Send File 

Receiue File: Idle 
Send File: Idle 

Printer: tlone 
Modelll: tlot Selected 

Receiue File 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
COllllllunications: COIllIll Port 1 - Data Leads Only 

Screen 12-1 VT220 Set-Up 

Each Set-Up screen displays: 

• A title bar with a Set-Up System menu in the first line. 

• A menu bar in the next two lines of the screen with the name of the 
currently selected screen highlighted. You select a screen by clicking 
on its name. 

• The current selections and settings in the mid-section of the screen. 
Some selections are actions that can be taken, while others represent 
settings with different values. These selections vary depending on the 
selected screen. 

• A status section in the bottom half of the the screen. 
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Table 12-1 describes each of the Set-Up screens_ 

Table 12-1 VT220 Set-Up Screens 

Set-Up Screen 

Actions 

Communications 

Display 

General 

Keyboard 

Printer 

Tabs 

Telephone 

Description 

Contains selections relating to clearing the screen and resetting 
the emulator, saving and recalling Set-Up settings, and sending 
or receiving files. 

Contains selections for defining the communications environ
ment, such as speed, parity, and disconnect. 

Contains selections for defining screen display, such as col
umns, cursor style, and background. 

Contains commonly used general operating selections, such as 
local echo, character sets, and terminal rD. 

Contains selections for defining keyboard operating characteris
tics, such as margin bell, break, and answerback. 

Contains selections for defining printer operations, such as 
print size or type of printer. 

Contains selections for defining the tab settings. 

Lets you determine how telephone answering is done. You can 
also enter the telephone numbers you want to use with the 
modem. 

From each Set-Up screen you can: 

• View the current selections and settings 

• Change the current settings to suit your needs 

• Access any of the other Set-Up screens from the menu 

All settings can be saved in or recalled from Set-Up files. You can also recall 
the factory default settings. 
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The VT220 Status Section 

The status section displays information relating to the state of operations you 
initiate through various Set-Up selections. 

Ali screens for the VT220 emulator have a bottom section displaying the 
current status for: 

• Receiving or sending a file 

- Idle or In Progress 

• Printer 

- Printer type and Mode 

• Modem usage (valid only if the optional integral modem is installed, 
and you selected Modem Control) 

- Selected or Not selected 

• Telephone modes (valid only if the optional integral modem is 
installed, and you selected Modem Control) 

- Manual or Automatic Answer 

• Insert/Replace mode 

• Communications 

- Comm Port 1, Comm Port 2, or Network Terminal Service 

NOTE 
The VT220 status area is a reporting area only. 

Changing Settings in VT220 Set-Up 

You can use either the mouse or the keyboard in VT220 Set-Up. This section 
describes only how to use the mouse. For information on how to use the 
keyboard to change settings, see Appendix D. 
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Using the Mouse in Set-Up 

To select a Set-Up screen and change a setting: 

1, Select the desired screen from the menu area. 

2. After the desired Set-Up screen is displayed, click on the selection you 
want to view or change. 

If a drop-down menu is displayed, go to the next step; otherwise release 
the mouse button. 

3. Drag the pointer to the desired setting and release the mouse button. 

NOTE 
Some settings take effect immediately; others take effect when you 
exit Set-Up. 

Exiting Set-Up 

To exit Set-Up either: 

• Press the F3 (Set-Up) key again 

• Select the Close command from the Set-Up System menu 

Using Set-Up Table Information 

The following sections describe the Set-Up screens and the settings you can 
change. 

The information for each Set-Up screen is organized as follows: 

• A description of the Set-Up screen 

• The VT220 screen 

• A table containing: 

- Selection definitions 

- Setting descriptions for each selection 

- Default settings 
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Actions Screen 

Whenever you enter VT220 Set-Up, it displays the Actions Set-Up screen. 

Receiue File: Idle 
Send File: Idle 

Printer: Hone 
Mode~: Hot Selected 

Set Default Set-Up Para~eters 
Send File 
Receiue File 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Co~~unications: Co~~ Port 1 - Data Leads Only 

Screen 12-2 VT220 Actions 

Table 12-2 defines the Actions Set-Up selections. 
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Table 12-2 VT220 Actions Set-Up 

Selection Function 

Reset Terminal 

Clear Display 

Clear 
Communications 

Recall Set-Up 
Parameters 

Save Set-Up 
Parameters 

Set Default Set-Up 
Parameters 

Resets many terminal operating settings to the power up de
fault state. 

Does not affect communication, NRC (National Replacement 
Characters) and multinational modes, or user-defined keys. It 
takes effect immediately. 

Clears and sends the cursor to the upper-left corner of the 
screen. 

Clears communication lines immediately and stops any print 
operation in progress. It also exits printer controller mode. 

Does not affect LAT communications. 

Replaces all existing settings with values you saved in a de
fault file called DEFAULT.220 or in a file you created. 

Clears the dialog box from the Actions Set-Up screen and 
returns the cursor to the upper-left corner of the Actions 
Set-Up screen. 

Saves the Set-Up settings in a default file called 
DEFAULT.220 or in a file you can specify. 

Clears the dialog box from the Actions Set-Up screen and 
returns the cursor to the upper-left corner of the Actions 
Set-Up screen. 

Replaces all current Set-Up settings with factory default 
settings. 

Clears the dialog box from the Actions Set-Up screen and 
returns the cursor to the upper-left corner of the Actions 
Set-Up screen. 
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Table 12-2 VT220 Actions Set-Up (cont.) 

Selection 

Send File 

Open File 

Close File 

Receive File 

Open File 

Open File and 
Append 

Close File 

On 

Off 
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Function 

Allows you to send characters to a host from an MS-DOS text 
file as though you entered them from a keyboard. 

Displays a dialog box and asks you to enter a file name. 
When you open a file from the dialog box, sending begins 
after you select Ok and exit Set-Up. When the file is opened 
this setting is displayed in a lighter shade until the file is 
closed. 

Displayed in a lighter shade until you open a file. Closes and 
saves the file. 

Controls the receiving of characters from a host into a speci
fied file. 

Displays a dialog box and asks you to enter the name of the 
file that is to receive the characters. If a file of the same 
name already exists, it is replaced. 

This is identical to Open File except that text is appended to 
a file of the same name if it exists. If not, a new file is 
created. 

File logging is ended and the file is closed. 

File logging resumes. 

File logging is suspended but the file remains open. 
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Communications Screen 

The Communications Set-Up screen lets you define the communications envi
ronment between the terminal and the host. 

Normally a terminal can only connect to a host using a serial port. Your 
workstation VT220 emulator allows you to connect to a host using either: 

• A serial port 

• Network Terminal Services/the ThinWire Ethernet port 

Port/lietwork 
N(~Y \:~\('A<t 1 n i rn.1 ~:;(q ~yi, l>~ 

Disconnect Delay 
:-:OFF Point 

Receiue File: Idle 
Sef1d File: Idle 

Printer: lione 
Modem: liot Selected 

Speed 
Data Bits and Parity 
Stop Bits 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Communications: Comm POI-t 1 - Data Leads Only 

Screen 12-3 VT220 Communications 

Table 12-3 defines the Communications Set-Up selections and, where appli
cable, the settings. 
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Table 12-3 VT220 Communications Set-Up 

Selection Function 

Port/Network 

Comm Port 1: Data 
Leads Only (default) 

Comm Port 1: Full 
Modem Control 

Comm Port 2: Data 
Leads Only 

Comm Port 2: Full 
Modem Control 

Comm Port 2: 
Integral Modem 

Network 
Communication 
Port 
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Selects the type of port used for communication with a 
host, either serial or Net\vork Terminal Serv"ic-es commu
nications. 

If you select serial communications, Network Terminal 
Service is displayed in a lighter shade on your screen. 

Select when you connect to the host using serial commu
nications. 

Select if your workstation is connected to the host 
through the communications port and an external modem 
requiring modem control is used. 

Select when you connect to the host using serial commu
nications. 

Select if your workstation is connected to the host 
through the communications port and an external modem 
requiring modem control is used. 

Note: The VT220 emulator may not function correctly 
with certain external modems due to inconsistencies of 
timing under MS-Windows. To avoid problems using 
external modems, use the VT240 emulator. 

Select if the optional integral modem is installed, and the 
workstation uses it to communicate with the host. 

Note: The integral modem may not be available for your 
country. 

Selects connection to Network Terminal Services. You 
must be connected to the Network in order to access 
these services. 

If you have not selected a Network Terminal Service, a 
dialog box is displayed listing the available workstation 
services. For more information on defining the table size 
for these services in the MSNET.INI, see the VAXmate 
System Administrator's Guide. 

Click on the service you want to access, then click on 
the Ok command button. 
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Table 12-3 VT220 Communications Set-Up (COllt.) 

Selection Function 

Network Terminal 
Services 

Disconnect Delay 

2 second delay 
(default) 

60 Millisecond 
delay 

XOFF Point 

XOFF at 64 
(default) 

Disabled 

Speed 

Data Bits and Parity 

Stop Bits 

If displayed in a lighter shade, you are using serial com
munications. 

If you set the Network selection under Port/Network, all 
items relating to serial communications are displayed in a 
lighter shade, and you are connected to services available 
under Network Terminal Services. 

Selects (when modem control is used) the amount of 
time before the workstation disconnects from the com
munications line if the carrier detect is lost. 

Most countries, except the United Kingdom, use the two
second delay. 

The 60 millisecond delay is for use in the United King
dom. 

Selects the XOFF point or disables the automatic 
XON/XOFF flow control. 

For most applications you should set XOFF at 64 or 256. 
If you set XOFF greater than 256 and have a buffer over
flow problem, set XOFF to the next lower value. 

The choices for XOFF are: 64 (default), 256, 512, and 
1024. 

Characters are received continuously from the host. Some 
characters may be lost. 

Selects the rate at which characters are received or trans
mitted. The default is 9600. 

Selects the character format used for communication with 
the host computer. The default is 8 bits - No Parity. 

Selects the number of stop bits (lor 2) required for use 
by the host port. The default is 1 stop bit. 
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Display Screen 

The Display Set-Up screen lets you define screen display characteristics. 

. UT220 fflllllato,' . • .• 1 

Receiue File: Idle 
Send File: Idle 

Printel": Hone 
Mode~: Hot Selected 

Blink 
Font Size 

Telephone: Talk Mode - Manual Answel" 
Insel"t/Replace: Replace 
Co~unications: Co~~ POl"t 1 - Data leads Only 

Screen 12-4 VT220 Display 

Table 12-4 defines the Display Set-Up selections and, where applicable, the 
settings. 

Table 12-4 VT220 Display Set-Up 

Selection 

Columns 

80 Columns 
(default) 

132 Columns 

12-12 

Function 

Selects an 80- or 132-column screen for text. 

Selects an 80-column screen. 

Selects a 132-column screen. 
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Table 12-4 VT220 Display Set-Up (cont_) 

Selection 

Text Cursor 

Visible 
(default) 

Invisible 

Auto Wrap 

On 

Off 
(default) 

Cursor Style 

Block 
(default) 

Underline 

Background 

Light 
(default) 

Dark 

Blink 

Font Size 

Function 

Selects whether to display a text cursor. 

Displays the cursor. 

Does not display the cursor. 

Selects whether text automatically wraps on the screen. 

Causes characters that reach the right margin to automatical
ly be displayed in the first character position of the next 
line. 

Causes characters that go beyond the right margin to over
write the last character position of the current line. 

Selects the text cursor style. 

Displays block cursor. 

Displays underline cursor. 

Selects the screen display type. 

Selects reverse video screen display (dark text on a light 
background) . 

Selects a dark screen display (light text on a dark back
ground). 

Blinking display is not implemented for the VT220 emulator. 

You have a choice of displaying characters with blinking at
tributes as either normal video (default), reverse video, or 
underscore. 

Changes the font size of characters displayed on the screen. 
The settings are: Normal (default), Small, or Automatic. 

If you are using applications that display more than 80 col
umns, use the Automatic or Small setting. 
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General Screen 

The General Set-Up screen lets you define a group of commonly used general 
operating settings. 

Receiue File: Idle 
Send File: I dIe 

Printer: None 
Modem: Not Selected 

Terminal Emulation 

User Defined Keys 
User Features 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Communications: Comm Port 1 - Data leads Only 

Screen 12-5 VT220 General 

Table 12-5 defines the General Set-Up selections and, where applicable, the 
settings. 
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Table 12-5 VT220 General Set-Up 

Selection Function 

Line Mode Lets you select the mode of operation. 

On Line Lets the workstation communicate with a host 
(default) computer. 

Off Line Puts a host computer on hold. Data entered at the key
board goes directly to the workstation screen. 

Local Echo Enables or disables the local echo selection. 

On Directs characters from the keyboard to the screen as 
well as to the host computer. It is used when the host 
does not send the characters back to the screen. 

Off Directs characters from the keyboard to the host com-
(default) puter only. The host in turn mayor may not send the 

characters back to the screen. 

New Line Selects whether the Return key generates a carriage re
turn only or a carriage return and a line feed. 

Enabled 
(Return = CR/LF) 

Disabled 
(Return = CR) 
(default) 

Multinational Mode 

NRC 

Multinational 
(default) 

Generates a carriage return and a line feed. Received 
carriage returns cause a new line operation. When 
autotyping, any line feeds in an autotyped file are sent. 
When using Clipboard, any pasted lines are separated 
by carriage returns and line feeds. 

Generates a carriage return only. Received carriage re
turns do not cause a new line operation. When 
auto typed or Clipboard pasted lines are separated by 
carriage returns, line feeds are not sent. 

Note: When the VT220 emulator is in numeric keypad 
mode, this setting affects the Enter key in the same way 
it does the Return key. 

Determines character set mappings used by the termi
nal. 

Selects the 7-bit NRC (National Replacement Character) 
mode. The NRC set depends on the country keyboard 
which is determined during MS-Windows configuration 
Set-Up. 

Selects the 8-bit MCS (Multinational Character Set), in
cluding the 7 -bit ASCII character set. 

Note: This selection is disabled when you select NRC 
mode. 

12-15 



IIIII Using ,',et- Up With the VT220 Emulator 

Table 12-5 VT220 General Set-Up (cant.) 

Selection Function 

Multinational Character Set Allows you to choose either the ISO Latin-lor the DEC 
Multinational character set. 

ISO Latin-l Selects the 8-bit ISO Latin-l character set. 

DEC Multinational Selects the 8-bit DEC Multinational character set. 
(default) 

Terminal Emulation Determines how the VT220 emulator acts. It can act 
like a VT52, VT100, VT200 with 7-bit controls (de
fault), or VT200 terminal with 8-bit controls. 

TerminalID Identifies your terminal as a VT220 (default), VTI02, 
VTI01, or VT100 terminal. 

User Defined Keys 

Locked 

Unlocked 
(default) 

User Features 

Locked 

Unlocked 
( default) 
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Terminal ID can only be selected when emulation is set 
for VT100 mode. It is displayed in a lighter shade (not 
selectable) if you are in VT52 or VT200 mode. 

Selects whether a host can change user-defined key 
(UDK) definitions. 

Prevents new UDKs from being changed. 

Allows new UDKs to be changed. 

Selects whether a host can change certain user features. 

Prevents a host from changing certain user features. 

Lets a host change certain user features. 

The user features are: Light/Dark Screen, Tab Stops, and 
Keyboard Lock. 

Note: Some applications expect to control these user 
settings. If this applies to your application, select Un
locked. 
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Keyboard Screen 

The Keyboard Set-Up screen lets you define keyboard operating features. 

UT220 Emulator Set-Up 
Actions Communications Display 

~~. f!j.lt!.!.II!J • ., •• Printer Tabs 
Genet'al 
Telephone 

Keypad 110de 
Cursor Keys 
Margin Bell 
!Iarning Bell 

Break 
Auto Answerback 
Answerback Concealed 
Answerback String 

Receiue File: Idle 
Send File: Idle I 

Printer: Hone I 
Modem: Hot Selected 

Telephone: Talk Mode - Manual Answer I 
Insert/Replace: Replace 

'----~c_o_m_m_u_n_i_c_a_t_io_n_s_:~c_o_m_m_p_o_r_t~1~-_D_a_t_a~l_e_a_d_s_O_n_l_y~~~~~ ______ _ 

Screen 12-6 VT220 Keyboard 

Table 12·6 defines the Keyboard Set-Up selections and, where applicable, the 
settings. 
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Table 12-6 VT220 Keyboard Set-Up 

Selection 

Keypad Mode 

Numeric 
(default) 

Application 

Cursor Keys 

Normal Control 
(default) 

Application 
Control 

Margin Bell 

Enabled 
(default) 

Disabled 

Warning Bell 

Enabled 
(default) 

Disabled 

Break 

Enabled 
(default) 

Disabled 
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Function 

Sets the terminal keypad for using either numbers or control 
codes. 

Sends numbers from the numeric keypad. 

Sends escape sequences from the numeric keypad. 

Selects the kind of control codes sent by the cursor keys. It 
is disabled if the terminal is in VT52 mode. 

Sends ANSI cursor control sequences for cursor keys (up, 
down, left, and right). 

Sends application program control functions for cursor keys. 

Determines whether the terminal sounds a bell tone when 
the text cursor approaches the right margin. 

Turns on the margin bell setting. 

Turns off the margin bell setting. 

Determines whether the terminal generates a bell tone, such 
as for operating errors, mail messages, or system messages. 

Turns on the warning bell setting. 

Turns off the warning bell setting. 

Enables or disables the Break key function. 

Turns on the Break key function. 

Turns off the Break key function. 
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Table 12-6 VT220 Keyboard Set-Up (cont.) 

Selection 

Auto Answerback 

Enabled 
( default) 

Disabled 

Answerback 
Concealed 

Concealed 

Not Concealed 
(default) 

Answerback String 

Function 

Selects whether the answerback message is automatically 
sent to a host computer after a communication line connec
tion. 

Turns on the answerback message. 

Turns off the answerback message. 

Selects whether your answerback message entry is displayed 
on the screen. 

Your answerback message is not displayed on the screen. 

You can only reset this setting to Not Concealed by entering 
a new answerback message. 

Displays the answerback message as entered. 

Allows you to enter an answerback message. A dialog box 
displays and asks for the answerback string. 

The emulator sends an answerback message when it receives 
an ENQ (enquiry control character), or if you or the host 
send a Ctrl/Break. In the case of ENQ, the message you enter 
is sent to a host without affecting screen data or requiring 
further operator action. 

You can enter any keyboard character, up to a 30 character 
limit. 
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Printer Screen 

The Printer Set-Up screen lets you select printer (or auxiliary device) opera
tions for the emulators. 

~ UTnll [Illulato,' ' ~ '::W" ~ • 

Actions 
Keyboar-d l{Dili!iii~.iI Display Tabs 

Pr-int Extent 
Pr-int Size 
Pr-int Mode 

Receiue File Idle 
Send File Idle 

Pr-inter- Hone 
Modelll Hot Selected 

Telephone Talk Mode - Manual Answer
Inser-t/Replace Replace 
COllllllunications COIllIll Por-t 1 - Data Leads Only 

Gener-al 
Telephone 

Screen 12-7 VT220 Printer 

Table 12-7 defines the Printer Set-Up selections and, where applicable, the 
settings. 
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Table 12-7 Printer Set-Up 

Selection 

Print Extent 

Full Page 
(default) 

Scroll Region 

Print Size 

Normal 
(default) 

Compressed 

Print Mode 

Normal 
(default) 

Auto 

Controller 

Function 

Determines how much of the screen is printed during a text 
print operation. 

Prints the full screen. 

Prints only the scrolling region. 

Determines the size of the printed characters. 

Prints 80 characters a line. 

Prints 132 characters a line. 

Selects the operating mode for the printer. 

Only sends information to the printer when you invoke print 
functions from the keyboard. 

Prints the current text line when the terminal receives a Ii II'· 
feed, form feed, or vertical tab code from a host. 

Causes the printer port to treat the device connected to it as 
a terminal, while the VT220 emulator monitors traffic. (The 
printer and host computer transfer data without displaying 
the data on the screen.) 
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Tabs Screen 

The Tabs Set-Up screen lets you set the terminal tab stop interval settings. 

,----------------------------------------------------------------------

UT220 E~ulator Set-Up 
Actions 
Keyboard 

COllllllunications ~Dl.· s, la~ Genet-al 
Printer Ii~~.~" •••• Telephone 

o 
Clear All Tabs 
Set 8 Colullln Tabs 
Set Tab Interual 
Manually Set Tabs 

Receiue File 
Send File 

Printer 
Modelll 

Telephone 
I nset-tiReplace 
COIII~unications 

Idle 
Idle 
None 
Not Selected 
Talk Mode - Manual Answer 
Replace 
COIIIIII Port 1 - Data Leads Only 

Screen 12-8 VT220 Tabs 

Table 12-8 defines the Tab Set-Up selections and, where applicable, the 
settings. 

Table 12-8 VT220 Tab Set-Up 

Selection 

Clear All Tabs 

Set 8 Column Tabs 

Set Tab Interval 

Manually Set Tabs 
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Function 

Clears all tab settings. 

Sets tabs every 8 columns, starting with column 9. 

Displays a dialog box containing the current tab stop setting. 
You enter a new interval in the dialog box by typing the 
desired number. 

Allows you to change individual tab stops. The tab intervals 
are updated in a displayed ruler. 



Using Set-Up With the VT220 Emulator IIIII 

Setting VT220 Tabs Manually 

To manually set tabs for the VT220 emulator: 

1_ Click on the Manually Set Tabs selection_ 

A tabs ruler and blinking cursor are displayed below the Tabs Set-Up 
screen where the Icon area was_ Screen 12-9 shows the current tab 
settings_ 

= - I 

Actions 
Keyboal-d 

Communications Display General 
Printer •• iI,,~,ll!Iiii ••••• Telephone 

Clear All Tabs 
Set 8 Column Tabs 
Set Tab Interual 
Manually Set Tabs 

Receiue File: Idle 
Send File: Idle 

Printer: Hone 
Modem: Hot Selected 

Telephone: Talk Mode - Manual Answer 
Insert/Replace: Replace 
Communications: Comm Port 1 - Data leads Only 

23456 7891 .... I!LI).U.:pII123456 789IUILI).'TiT.:WI123456 789IU"'LI).W:Pl!123456 789IU"'1I1;W':PII ! T T T T T T T T T 

T T T T T T 
12345678911 ..... LI).U.:pI1123456789IU ... LI).1i!'.:pIl123456789U (Ok) r Cancel) 

Screen 12-9 Manually Setting VT220 Tabs 
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2. To move the blinking cursor to the desired tab setting, use the mouse 
pointer. 

3. Click on the desired tab setting. 

A "T" is displayed where you clicked. 

To erase a tab stop, click on the "T". 

4. Repeat steps two and three until you have marked all desired tab stops. 

NOTE 
To cancel the tab settings you made and leave the tab settings 
unchanged, click on the Cancel command button. 

S. To exit the tabs ruler and save the tab settings, click on the Ok com
mand button. 

You are returned to the Tabs Set-Up selections. 
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Telephone Screen 

The telephone Set-Up screen lets you store and display telephone numbers 
for automatic dialing. 

To use the Telephone selections, you should have: 

• Installed the integral modem option (This is not available for all 
countries.) 

• Selected and saved from the Communications screen: 

The Integral Modem selection 

The appropriate transmit and receive speeds 

For more information on telephone settings, refer to the VAXmate Modem 
User's Guide. 

Actions 
Keyboard 

UT220 Emulator Set-Up 
Communications Display 
Printer Tabs 

Modem Answer 
Telephone Numbers 

Receive File: Idle 
Send File: I dIe 

Printer: None 
Modem: Not Selected 

Telephone: Talk Mode - Manual Ans\~e.
Insert/Replace: Replace 
Communications: Comm Port 1 - Data Leads Only 

Screen 12-10 VT220 Telephone 
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Table 12-9 defines the Telephone Set-Up selections and, where applicable, 
the settings. 

Table 12-9 VT220 Telephone Set-Up 

Selection Function 

Modem Answer 

Manual 
(default) 

Automatic 

Telephone Numbers 
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Selects automatic telephone answering by the terminal or 
manual telephone answering by the user. 

Leaves the integral modem in talk mode after disconnecting 
from the host and allows you to answer the incoming call. 
Manual answer is required for normal telephone operation. 

Leaves the integral modem in data mode after disconnecting 
from the host and allows the terminal to automatically an
swer the incoming call. 

Displays a dialog box requesting you to enter phone num
bers. Any previously entered phone numbers (A-J) are 
remembered and displayed. 

To enter phone numbers, click to the right of the desired 
letter. An insertion point is displayed indicating where to 
type in the phone number. 

Type in a phone number or type over an existing phone 
number. 

Repeat the process until you have entered or changed all the 
desired phone numbers. 

After you type the phone number(s), click on the Ok com
mand button. You save these settings by using the Save Pa
rameters selection before exiting Set-Up. 



Chapter 13 
Using VT220 

Special Features 

This chapter tells you how to: 

• Use configuration files 

• Save and recall Set-Up selections 

• Receive and autotype characters using files 

Using Configuration Files 

The VT220 emulator allows you to save Set-Up settings in a Set-Up configura
tion file. You can have several of these files, each specifying different 
settings. 

What the VT220 Emulator Does 

When you start the VT220 emulator, it looks for the default Set-Up configura
tion file named DEFAULT. 220. When found, this file configures your VT220 
emulator with the initial values of all Set-Up selections. 

If the VT220 emulator does not find the DEFAULT.220 file, it configures your 
VT220 emulator with the factory default settings instead. 

What You Can Do 

When starting the VT220 emulator, you can direct it to run a Set-Up config
uration file other than DEFAULT.220. 

You can also run configuration files after you start the VT220 emulator. To 
do this, use the Recall Set-Up Parameters as described in this chapter. 

13-1 



IIIII Using VT220 SPecial Features 

These Set-Up configuration files need not reside in the current directory. You 
can precede configuration file names with a directory path. For more infor
mation about appropriate file naming, see Chapter 30. 

Specifying Set-Up Configuration Files on Startup 

To specify a Set-Up configuration file when you start the VT220 emulator, do 
one of the following: 

• Select the Run command. 

A dialog box requests the name of the application you want to run. 

Type VT220 followed by a space and the name of the desired configura
tion file. The .220 is the default extension if none is given. 

Click on the Ok command button. 

• The standard WIN.INI file distributed with your system associates the 
file extension .220 with the VT220 emulator. This lets you run Set-Up 
configuration files with a .220 extension as if they were the VT220 
emulator. 

You click on the Set-Up configuration file in the MS-DOS Executive 
window and start the emulator with the settings contained in that 
Set-Up configuration file. 

You can also save or start Set-Up configuration files after you start the VT220 
emulator. To do this, use either the Save Set-Up Parameters or the Recall 
Set-Up Parameters selection from the Action screen. 

Saving and Recalling Set-Up Files 

After you select the desired Set-Up settings, you can save and recall them 
from the default file, DEFAULT.220, or a file you specify. 

When you start the VT220 emulator, it looks for one of these files and initial
izes the emulator to the values contained in that file. 

Saving VT220 Selection Settings 

To save your VT220 Set-Up selections: 

1. Select on the Actions screen. 

2. Click on the Save Set-Up Parameters. 
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A dialog box asking for a file name is displayed. The dialog box either 
displays the default file name or the last file name you entered. You 
may edit this file name or replace it. 

NOTE 
If you select a currently displayed file, any settings you made 
replace any existing settings in that file. 

3. To save your settings in the new or selected file, click on the Ok com
mand button. 

Recalling VT220 Selection Settings 

To recall VT220 selection settings under Set-Up: 

1. Select the Actions screen. 

2. Click on the Recall Set-Up Parameters. 

A dialog box is displayed asking for a file name. It will also either 
display the default file name or the last file name you entered. You may 
edit this file name or replace it. 

3. To recall saved settings from the selected file, click on the Ok com
mand button. 

Receiving Characters From the Host Into a File 

The status portion of your screen indicates whether session logging is active 
or idle during this process. 

To receive or log characters from a host into a file using session logging: 

1. Select the Actions screen. 

2. Click on the Receive File selection. 

A drop-down menu displays the Receive .File options. 

3. Select the Open File or the Open and Append File option. 

A dialog box asks for the name of the file you want to receive the 
characters. 

4. Type in the file name. 

5. To begin receiving characters into the file, click on the Ok command 
button. 
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6. To stop receiving and close the file, select Close File from the Receive 
File menu. 

To suspend reception of characters without closing the file, you can 
alternately select On and Off from the Receive File menu. 

Autotyping Characters to the Host 

The status portion of your screen indicates whether autotyping is active or 
idle during this process. 

When a file is autotyped to VMS, you must enable HOSTSYNC under VMS by 
typing: 

$ SET TERMINAL/HOSTSYNC 

This prevents data overruns on a VMS host. 

To autotype characters to the host from a file as if you entered them from the 
keyboard: 

1. Select the Actions screen. 

2. Select Send File. 

3. Select the Open File option. 

A dialog box is displayed asking for the name of the file you want to 
autotype. 

4. Type in the file name. 

S. To begin autotyping the specified file to the host, click on the Ok 
command button. 

File autotyping stops when the end of the file is reached. 

You can also stop autotyping the file by selecting Close File from the 
Send File menu. 
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Using the VT240 

Terminal Emulator 

The VT240 terminal emulator is a standard MS-Windows application that 
offers many Set-Up parameters or selections that you can change or set 
depending on your needs. These selections are saved in a file the emulator 
reads when it starts. 

The VT240 terminal emulator replaces the MS-Windows Executive window 
with a full screen and offers you two video modes: Fast Text Only and Text 
and Graphics. The Text and Graphics mode is used for ReGIS graphics appli
cations such as DECslide and DECgraph. 

Wherever the words VT240 emulator are used, it means the VT240 terminal 
emulator for the workstation. 

The VT240 emulator allows you to: 

• Run host applications including ReGIS applications 

• Receive or send information to or from a host using files 

• Save and recall Set-Up selection settings using Set-Up configuration files 

The chapter covers: 

• Starting the VT240 emulator 

• Exiting from the VT240 emulator 
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Starting the VT240 Emulator 

Start the VT240 emulator either by: 

• Using the Run command from the File menu in the MS-DOS Executive 
window 

• Typing the name of the appropriate VT240 file at the MS-DOS operating 
system prompt 

Using the Run Command to Start 

The following VT240 files are used with the Run command to start your 
VT240 emulator: 

• VT240 if you want to use the Network Terminal Services 

• VT240CMl if you want to use serial communications port 1 

• VT240CM2 if you want to use serial communications port 2 (integral 
modem) 

NOTE 
When you make a selection of VT240CM2, you cannot change to 
another port selection in Set-Up. 

To start the VT240 emulator using the Run command: 

1. Select the Run command from the File menu. 

2. Type in the name of the desired VT240 emulator file. 

Your workstation is now emulating a VT240 terminal, and your host 
login information is displayed. 
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NOTE 
If your host login information is not displayed, see your system 
administrator. 
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Starting From the MS-DOS Operating System 

Mter the MS-DOS operating system prompt, type in the appropriate VT240 
file name using the following format: 

VT240 [comm type] [Network Terminal Service (1-4)][/S-configuration file] 

Where: 

• VT240 comm type is either: 

- COMI: if you want to use serial communications port 1 

- COM2: if you want to use serial communications port 2 (integral 
modem) 

IIIII 

- NET: if you want to use a Network Terminal Service. You must spec
ify the service name in Set-Up. 

NOTE 
When you make a selection of COM2, you cannot change to 
another port selection in Set-Up. 

• Network Terminal Service (1-4) specifies the services which will be 
defined in the Communications Set-Up screen. When you enter the 
VT240 emulator the first service named becomes active. You can spec
ify up to four services. 

• jS=configuration file allows you to select a Set-Up configuration file 
containing settings tailored for your particular needs. 

Mter you have typed in the VT240 file name, your host login information is 
displayed. 

NOTE 
If your host login information is not displayed, see your system 
administrator. 
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Exiting the VT240 Emulator 

To exit from the VT240 emulator: 

1. Log off the host system. 

2. Press: 

~ 

FlO is labeled the Exit key on your workstation legend strip. 
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This chapter: 

Chapter 15 
Using the VT240 

Emulator Keyboard 

• Shows a diagram of the workstation keyboard. 

• Describes the differences between the workstation keyboard for the 
Vf240 emulator and an actual Vf240 terminal keyboard. 

The VT240 Emulator Keyboard 

The layout of the Vf240 emulator keys on a workstation keyboard is identi
cal to the Vf240 keyboard except for: 

• Labels for some keys 

• Location of the " -, <, and >, and Compose key 

The labels referred to are those on the standard United States legend strip. All 
countries are supplied with a separate emulator legend strip and should 
ensure that this is used with the Vf240 emulator. 

Labels 

Some labels for the workstation top-row function keys differ from those on a 
Vf240 terminal keyboard. These keys are indicated in Figure 15-1. 
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I o 0 0 C 

••••• DDDDD •••• Dc:=:J DODD 

DDDDDDDDDDDDDD DDD DDDD 
DDDDDDDDDDDDDO DDD DDDD 

DDDDDDDDDDDDDD D DDDD 
c:=JDDDDDDDDDDDc=J DDD DDDO 

CJI I CJD 
Figure 15-1 Workstation Keyboard 

Except for the Alt and Compose keys, the VT240 emulator keys function 
exactly as they do for the VT240 terminal. The Alt key on your keyboard lets 
you access special VT240 emulator features. For more information about the 
Alt key, see Chapter 17. 

Activating the Compose key for the VT240 emulator involves using KEYB. For 
more information, see Chapter 32. 

Top-Row Function Keys 

Most of the top-row function keys have functions assigned to them by your 
application software. Refer to your application software documentation for 
their use.· 

This section describes keys with fixed meanings for the VT240 emulator. The 
labels in parentheses refer to the labels on the standard United States legend 
strip. 

F1 (Hold) 
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Pressing the Fl (Hold) key freezes the screen. It also 
lights the Hold indicator. When the light is on, none of 
the characters you type are displayed on the screen until 
you press the Fl (Hold) key again. 



F3 (Set-Up) 

F4 (Data/Talk) 

F5 (Break) 

FlO (Exit) 

FII (ESC) 

Using the VT2,jO Emulator Keyboard IIIII 

Pressing the F2 (Print Screen) key sends the screen text 
to the printer. 

Pressing the Shift/F2 (Print Screen) keys sends the screen 
image to the printer. You can print both text and graph
ics with the VT240 emulator. 

Pressing the Ctrl/F2 (Print Screen) keys sets or resets 
Auto Print Mode. 

Pressing the F3 (Set-Up) key allows you to enter and exit 
Set-Up. 

Used when the optional integral modem is installed or if 
an external modem is used. For more information, refer 
to the VAXmate Modem User's Guide. 

Note: The integral modem may not be available for your 
country. 

Pressing the F5 (Break) key transmits a break if you 
enabled Break in Set-Up. You may use it with other key 
combinations when the optional integral modem is in
stalled. For more information, refer to the VAXmate 
Modem User's Guide. 

Pressing the Shift/F5 keys initiates a communications line 
disconnect. 

Pressing the Ctrl/F5 keys sends an answerback message as 
defined in Set-Up. 

Note: The integral modem may not be available for your 
country. 

Pressing the FlO (Exit) key while you hold down the 
Ctrl key ( Clrl/Exil »), exits you from the VT240 emulator. 
This action also returns you to the MS-Windows screen 
you were in if you started the emulator under 
MS-Windows. 

Pressing FIl (ESC) generates an escape character when 
in VT52 and VT100 modes. In VT200 modes, FII (ESC) 
is a function key. 

15-3 



IIIII Using the VT240 Emulator Keyboard 

F12 CBS) 

F13 (LF) 
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Pressing F12 (BS) generates a backspace character when 
in VT52 and VT100 modes. In VT200 modes, F12 (BS) is 
a function key. 

Pressing F13 (LF) generates a line feed character when in 
VT52 and VT100 modes. In VT200 modes, F13 (LF) is a 
function key. 



Chapter 16 
Using Set-Up With 

the VT240 Emulator 

This chapter describes: 

• How to enter and exit Set-Up 

• How to make or change Set-Up settings 

• Each Set-Up screen and all the settings 

Entering Set-Up 

The VT240 emulator offers several Set-Up selections that affect such settings 
as tab stops, screen background, or cursor style. 

To enter Set-Up, press the F3 (Set-Up) key. 

Understanding the VT240 Set-Up Screens 

After you enter Set-Up, the VT240 emulator displays Screen 16-1, the Actions 
Screen, the first of eight Set-Up screens. For this discussion the Actions 
Screen is being treated as a general example of all eight screens. 
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/' 

ACTIONS 

R~;i~C1r Terminal 
Clear Display 

Communications. 
Pr~nter 

Clear Communications 
Recall Set-Up Parameters 
Save Set-Up Parameters 
Set Default Set-Up Parameters 
Show Status 
To MS-DOS 
EJ<it VT240 

Press: Next ..... D1splay next screen 
Prey .Display previous screen 
Set-Up Exit Set-Up 

Screen 16-1 

Display 
Tabs 

General 
Telephone 

Down arrow ... Move down aline 
Up arrow ..... Move up a line 
Select. .Make a sele~tion 

VT240 Set-Up 

Each Set-Up screen displays: 

• A screen menu in the first two lines of the screen with the currently 
selected screen highlighted. You change screens by pressing the Next or 
Previous Screen keys. 

• The current selections (left column) and settings selections (right col
umn) in the mid section of the screen. Some selections are actions that 
can be taken, while others represent settings with different values. 
These selections vary depending on the selected screen. 

NOTE 
You do not see the right column setting selections in any of the 
example screens. They display only when you highlight a selection 
from the left column. 

• The keys used in VT240 Set-Up at the bottom of the screen. 

Table 16-1 describes each of the Set-Up screens. 
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Table 16-1 VT240 Set-Up Screens 

Set-Up Screen 

Actions 

Communications 

Display 

General 

Keyboard 

Printer 

Tabs 

Telephone 

Description 

Contains selections relating to clearing the screen and resetting 
the emulator, saving and recalling Set-Up settings, and showing 
status. 

Contains selections for defining the communications environ
ment, such as speed, parity, and disconnect. 

Contains selections for defining screen display, such as col
umns, cursor style, and background. 

Contains commonly used general operating selections, such as 
local echo, character sets, and terminal 10. 

Contains selections for defining keyboard operating characteris
tics, such as margin bell, break, and answerback. 

Contains selections for defining printer operations, such as 
print size, type of printer, and form feed. 

Contains selections for defining the tab settings. 

Lets you determine how telephone answering is done. You can 
also enter the telephone numbers you want to use with the 
modem. 

From each Set-Up screen you can: 

• View the current selections and settings 

• Change the current settings to suit your needs 

• Use the Next or Previous Screen keys to access any of the other Set-Up 
screens 

All settings can be saved in or recalled from Set-Up files. You can also recall 
the factory default settings. 
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Using the Keyboard in VT240 Set-Up 

You make selections in the VT240 emulator by using the keyboard. Once you 
are running the VT240 emulator you can no longer use the mouse. 

A description of the keys used in theVT240 Set-Up scr-eens is at the bottom 
of each VT240 Set-Up screen. Figure 16-1 shows these keys. 

DDDDD DDDD D~ DODD 

DDDDDDDDDDDDDD 
DDDDDDDDDDDDDD 

DDDDDDDDDDDDDD 
c:=JDDDDDDDDDDDCJ 

CJI I 
Figure 16-1 VT240 Set-Up Keys 

The Next and Prey Keys 

DDDD 
DODD 
DODD 
0001 CJD 

Pressing the Next key displays the next Set-Up screen. Pressing the Prev key 
displays the previous Set-Up screen. 

The Select Key 

Pressing the Select key lets you make a selection from either side of the 
Set-Up screens depending on which side of the screen the highlight bar is on. 

The Arrow keys 

Pressing the up and down arrow keys moves you up or down the list of 
settings and selections in either of the columns on the Set-Up screens. 
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Changing Settings in VT240 Set-Up 

To choose a Set-Up screen and change a setting: 

1. Use the Next or Prev keys to select the desired Set-Up screen. 

2. Mter the desired screen is displayed, to view selections, use the up or 
down arrow key. 

The current settings are displayed in the left column. The setting selec
tions are displayed in the right column. As noted earlier the example 
screens do not display the right column. 

NOTE 
The Actions Set-Up screen displays a set of prompts or directions 
instead of settings in the right column. Follow those directions. 

3. To select a setting, move to the right column by pressing the Select key. 

The selection in the left column is now bolded to indicate what selec
tion you are setting. 

4. To highlight the desired setting, use the up or down arrow key. 

S. To enter the setting, press the Select key. 

The new setting is now highlighted in the left column. 

NOTE 
Some settings take effect immediately; others take effect when you 
exit Set-Up. 

Exiting Set-Up 

To exit Set-Up, press the F3 (Set-Up) key again. 
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Using Set-Up Table Information 

The information for each Set-Up screen is organized as follows: 

• A description of the Set-Up screen 

• The VT240 screen 

• A table containing: 

- Selection definitions 

- Setting descriptions for each selection 

- Default settings 
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Actions Screen 

Whenever you enter VT240 Set-Up, it displays the Actions Set-Up screen. 

UAci~i.M" 
Keyboard 

Il~T;!PN,~; 

Reset Terminal 
Clear DispLay 

Communications 
Printer 

Clear Communications 
Recall Set-Up Parameters 
Save Set-Up Parameters 
Set Default Set-Up Parameters 
Show Status 
To MS-DOS 
Exit VT240 

Press: Next ..... Display next screen 
Prevo .... Display previous screen 
Set-Up ... Exit Set-Up 

Display 
Tabs 

General 
Telephone 

Down arrow ... Move down a line 
Up arrow ..... Move up a line 
Select. .Make a selection 

Screen 16-2 VT240 Actions 

Table 16-2 defines the Actions Set-Up selections. 

16-7 



11111 Using Set-Up With the VT240 Emulator 

Table 16-2 VT240 Actions Set-Up 

Selection Function 

Reset Terminal 

Clear Display 

Clear 
Communications 

Recall Set-Up 
Parameters 

Save Set-Up 
Parameters 

Set Default Set-Up 
Parameters 

Show Status 

To MS-DOS 

Exit VT240 

16-8 

Resets many operating settings to power up default state. 
Exits ReGIS. 

Does not affect communication, NRC (National Replacement 
Characters) and multinational modes, and user-defined keys. 

Clears the screen and sends the cursor to home position 
when you exit Set-Up. 

Clears communication lines immediately and stops any print 
operation in progress. It also exits printer controller mode. 

Does not affect LAT communications. 

Replaces all existing Set-Up settings with values you saved in 
a default file called DEFAULT.240 or in a file you specify. 

Saves the Set-Up settings in a default file called 
DEFAULT.240 or in a file you specify. 

Replaces all current Set-Up settings with factory default set
tings. 

Displays information on the state of such items as modems, 
file sending or receiving, and communications ports. 

Lets you temporarily leave the VT240 emulator while you 
use the MS-DOS -operating system. 

If there is not enough memory to run COMMAND.COM, a 
message is displayed. If there is enough memory to run 
COMMAND.COM, but not enough memory to use other 
MS-DOS commands, you are returned to the emulator 
Set-Up. 

To return to the emulator you must type the MS-DOS EXIT 
command. 

Allows you to .exit the emulator and return to MS-Windows. 
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The VT240 Show Status 

Status is available only from the VT240 Actions screen. It is a reporting area 
only. When selected, the Show Status selection displays the following 
information: 

• Receiving or sending a file 

- Idle or In Progress 

• Printing 

- Normal Print Mode, Auto Print Mode, Printer Controller Mode 

• Modem usage (valid only if the optional integral modem is installed, 
and you selected the integral modem) 

- DSR or No DSR 

• Telephone modes (valid only if the optional integral modem is 
installed, and you selected the integral modem) 

- Manual or Automatic Answer 

• Insert/Replace mode 

• Keyboard 

- KEYB file in use 

For more information on KEYB, see Chapter 32. 

• Character Set 

- Character sets in use 

• Communications 

- Comm Port 1, Comm Port 2, or Network Terminal Service 
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Communications Screen 

The Communications Set-Up screen lets you define the communications envi
ronment between the terminal and host. 

Normally a terminal can only connect to a host using a serial port. Your 
workstation Vr240 emulator allows you to connect to a host using either: 

• A serial port 

or 

• Network Terminal Services/the ThinWire Ethernet port 

Comm Port 1: Data Leads Only 
Disconnect, 2 second delay 
XOFF at 64 
Speed = 9600 
8 Bits - No Parity 
1 Stop Blt 
Transmit = Receive 

F'ress: Next. .I:risplay next screen 
Prev ..... Display previous screen 
Set-Up .. Exit Set-Up 

Display 
Tab$. 

General 
Telephone 

Down arrow ... Move down aline 
Up arrow ..... Move up a line 
Select. . .. Make a selection 

Screen 16-3 VT240 Communications 
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Table 16-3 defines the Communications Set-Up selections and, where appli
cable. the settings. 

Table 16-3 VT240 Communications Set-Up 

Selection Function 

Network You must be connected to the Network to use Network 
Communications Port 

Comm Port I: Data 
Leads Only (default) 

Comm Port I: Full 
Modem Control 

Comm Port 2: Data 
Leads Only 

Comm Port 2: Full 
Modem Control 

Comm Port 2: 
Integral Modem 
Port 

communications. 

When selected. a list of services ( 1-4) is displayed in the 
left column. You select or change a service by using the 
Select, up. or down arrow keys to highlight a items listed 
on the screen. 

For more information about selecting services, see the 
section following this table. 

Select when you connect to the host using serial commu· 
nications. 

Select if your workstation is connected to the host 
through the communications port and an external modem 
requiring modem control is used. 

Select when you connect to the host using serial commu· 
nications. 

Select if your workstation is connected to the host 
through the communications port and an external modem 
requiring modem control is used. 

Select if the optional integral modem is installed, and the 
workstation uses it to communicate with the host. 

Note: The integral modem may not be available for your 
country. 
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Table 16-3 VT240 Communications Set-Up (cont.) 

Selection 

Disconnect Delay 

Disconnect, 2 
second delay 
(default) 

Disconnect, 60 ms 
delay 

XOFF Point 

XOFF at 64 
(default ) 

No XOFF 

Speed 

Data Bits and Parity 

Stop Bits 

Transmit = Receive 

16-12 

Function 

Selects (when modem control is used) the amount of 
time before the workstation disconnects from the com
munications line if the carrier detect is lost. 

Most countries except the United Kingdom use the two
second delay. 

The 60 millisecond delay is for use in the United King
dom. 

Selects the XOFF point or disables the automatic 
XON/XOFF now control. 

For most applications you should set XOFF at 64 or 256. 
If you set XOFF greater than 256 and have a buffer over
now problem, set XOFF to the next lower value. 

The settings for XOFF are: 64 (default), 256, 512, and 
1024. 

Characters are received continuously from the host. Some 
characters may be lost. 

Selects the rate at which characters are received or trans
mitted. The default is 9600 baud. 

Selects the character format used for communication with 
a host computer. The default is 8 bits - No Parity. 

Selects the number of stop bits (lor 2) used for commu
nicating with the host. The default is 1 stop bit. 

Characters will either be received and transmitted at the 
same or differing transmit and receive rates. These set
tings are usually equal. 

As a default, the transmit rate is set equal to the receive 
rate (speed setting). Otherwise, transmit can be set to 
1200. 
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Selecting a Network Terminal Service 

To access Network Terminal Service 1: 

1. Move to Service 1 in the left column. 

IIIII 

The right column prompts you to press the Select key to display a list of 
available services. 

2. To display the available services, press the Select key. 

3. Highlight the service you want to access in the right column. 

4. To enter it as an assigned service, press the Select key. 

The service is displayed in the left column. 

The service is marked as inactive until you exit Set-Up at which time 
the service becomes active and is available for use. 

5. Repeat these steps to select any other services you desire up to a limit 
of four. 

Services should be assigned in the order in which you want to access them. 
When you exit Set-Up, Service 1 is always the first one activated. To change 
services, press the Shift/Next or Shift/Prev keys. 

For more information on defining the table size for these services in the 
MSNET.lNI, see the VAXmate System Administrator's Guide. 
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Display Screen 

The Display Set-Up screen lets you define screen display characteristics. 

/' 
Actions 
Keyboard 

c~~~~~ 
80 Columns 
Auto Wrap Off 
Dark Background 
Block Cursor 
Visibl. Cur".ior 
Monochrome: 
1'10: Black 
Ml: Ma;enta 
1'12: Cyan 
1'13: White 

Communications 
Printer 

Fast Text Only Video Mode 

Press: Next ..... Display next screen 
Prevo .... Display previous screen 
Set-Up ... Exit Set-Up 

Tab. 
General 
Telephone 

Down arrow. , .Move down a line 
Up arrow. . .Move up a line 
Select ....... Make a selection 

Screen 16-4 VT240 Display 

Table 16-4 defines the Display Set-Up selections and, where applicable, the 
settings. 
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Table 16-4 VT240 Display Set-Up 

Selection Function 

Columns Selects an 80- or I 32-column screen for text. A change to 
this setting takes effect on exiting Set-lip. 

80 Columns 
(default) 

132 Columns 

Auto Wrap 

Auto Wrap On 

Auto Wrap Off 
(default) 

Background 

Dark Background 
( default) 

Light Background 

Cursor Style 

Block Cursor 
(default ) 

Underline Cursor 

Text Cursor 

Visible Cursor 
( default) 

No Cursor 

Selects an 80-column screen. 

Selects a 132-column screen. Fast Text can only display 
80 columns at a time so the screen must be panned to 
display the rest of the data. In Graphics Mode the font 
size changes so that all 132 columns can be seen. 

Selects whether text automatically wraps on the screen. 

Causes characters that reach the right margin to automati
cally be displayed in the first character position of the 
next line. 

Causes characters that go beyond the right margin to 
overwrite the last character position of the current line. 

Selects the screen display type. 

Selects a normal screen display (light text on a dark 
background) . 

Selects reverse video screen display (dark text on a light 
background) . 

Selects the text cursor style. 

Displays block cursor. 

Displays underline cursor. 

Selects whether to display the text cursor in text mode. 

Displays the cursor. 

Does not display the cursor. 
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Table 16-4 VT240 Display Set-Up (cont.) 

Selection 

Monochrome 

Color 

MO 

M1 

M2 

M3 

Video Mode 

Fast Text Only Video 
Mode (default) 

Text & Graphics 
Video Mode 
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Function 

Selects the type of monitor you have. 

Selects the degree of intensity for character display; black 
being the darkest and intense white the lightest. 

One of the four degrees of gray used in text and graphics 
mode. When Monochrome is the setting, this is the shade 
of your text background. 

One of the four degrees of gray used in text and graphics 
mode. For both Monochrome and Color settings, this is 
the shade for dimmed or reverse video. 

One of the four degrees of gray used in text and graphics 
mode. When Monochrome is the setting, this is what 
shade your text is. 

When Color is the setting, this is the shade for bolded 
text. 

One of the four degrees of gray used in text and graphics 
mode. When Monochrome is the setting, this is the shade 
for bolded text. 

When Color is the setting, this is what shade your text is. 

Determines how characters are displayed on your screen. 

Selects 80 X 25 text mode. 

Selects 800 by 250 ReGIS graphics mode. Upon selection 
it offers you the following additional settings: 

A visible or invisible graphics cursor. 

Sending or not sending the contents of a macro report in 
response to the ReGIS Report Macrograph command 
R(M ... ). 

Printing or not printing the background color. It has no 
effect on monochrome print mode. 

A selection of: a compressed print image of 6 by 3 
inches; expanded print image of 12 by 8 inches; or an 
image printed in 8 by 12 inches and rotated 90 degrees. 
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Using VT240 Video Modes 

The Fast Text Only mode operates faster than the ReGIS Text and Graphics 
mode. However, there are differences in the way each displays: 

• ReGIS 

• 132 columns 

• Some of the line attributes 

When operating the VT240 emulator in Text & Graphics mode, 132-column 
displays appear exactly as they would on a VT240 Terminal. 

When operating the VT240 emulator in the Fast Text Only mode, all 132 
columns cannot be viewed at the same time. Only the first 80 of the 132 
columns are displayed. 

To view the rest of the columns: 

( Shift/right arrow) 

( Shift/left arrow) 

Displays the columns 53-132 

Displays columns 1-80 

Displaying Line Attributes 

When using the VT240 emulator in the Text & Graphics mode, all line attrib· 
utes are displayed as they would on a VT240 Terminal. 

When using the VT240 emulator in Fast Text Only mode, some line attributes 
are displayed differently for double width and double height/double width. 
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Double Width Lines for Fast Text Only 

When using double width characters in the Fast Text Only mode, they are 
displayed as that character followed by a space. For example: 

t est 

Double Height/Double Width Lines for Fast Text Only 

When using double height/double width characters in the Fast Text Only 
mode, they are displayed as that character followed by a space with a blank 
line inserted before the next line of characters. 

For example, entries of the word "test" on two separate lines would display 
as: 

t est 

t est 

Since double height takes up two lines the text is on the first line followed 
by a blank line on the second line. 

Displaying Character Attributes 

All of the character attributes for a VT240 Terminal are supported. The 
exception: 

When operating in the Fast Text Only mode, characters intended to be under· 
lined will be displayed without the underlining. 
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General Screen 

The General Set-Up screen lets you define a group of commonly used general 
operating settings. 

Actions 
Keyboard 

CURRENT SETTINGS 

On-Line 
Local Echo 011 
No New Line 

Communications 
Printer 

DEC Multinational Character Set 
VT2C)O - 7 bit controls 
User Defined Keys Unlocked 
User Features Unlocked 

Press: Next ..... D splay next screen 
Prev. . .. 0 sp lay prey ious screen 
Set-Up ... E it Set-Up 

Display 
Tab,,;, 

General 
Telephone 

Down arrow ... Move down a line 
Up arrow ..... Move up aline 
Select. . .Make a selection 

Screen 16-5 VT240 General 

Table 16-5 defines the General Set-Up selections and, where applicable, the 
settings_ 
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Table 16-5 VT240 General Set-Up 

Selection Function 

Line Mode Lets you select the mode of operation. 

On·Line Lets the workstation communicate with a host computer. 
(default) 

Local Puts a host computer on hold. Data entered at the key
board goes directly to the workstation screen only. 

Local Echo Enables or disables the local echo setting. 

Local Echo Off 
(default) 

Local Echo On 

New Line 

No New Line 
(default) 

New Line 

Multinational Character 
Set 

ISO Latin·l 
Character Set 

DEC Multinational 
Character Set 
(default) 

16-20 

Directs characters from the keyboard to a host computer 
only. The host in turn mayor may not send the charac· 
ters back to the screen. 

Directs characters from the keyboard to the screen as 
well as to the host computer. It is used when the host 
does not send characters back to the screen. 

Selects whether the Return key generates a carriage re
turn only or a carriage return and a line feed. 

Generates a carriage return only. Received carriage reo 
turns do not cause a new line operation. 

Generates a carriage return and a line feed. Received car
riage returns cause a new line operation. 

Note: When the VT240 emulator is in numeric keypad 
mode, this setting affects the Enter key in the same way it 
does the Return key. 

Allows you to choose either the ISO Latin· I or the DEC 
Multinational character set. 

Selects the 8-bit ISO Latin-I character set. 

Selects the 8-bit DEC Multinational character set. 

Note: This selection is disabled when you select NRC 
mode. 
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Table 16-5 VT240 General Set-Up (cont.) 

Selection Function 

Multinational Mode 

NRC 

Multinational 
( default) 

Terminal Emulation 

User Defined Keys 

User Defined Keys 
Locked 

User Defined Keys 
Unlocked (default) 

User Features 

User Features 
Locked 

User Features 
Unlocked (default) 

Determines character set mappings used by the terminal. 

Selects the 7-bit NRC (National Replacement Character) 
mode. The NRC set depends on the keyboard loaded by 
KEYB. For more information on KEYB, see Chapter 32. 

Selects the 8-bit MCS (Multinational Character Set, in
cluding the 7 -bit ASCII character set. 

Note: This selection is disabled when an MCS or ISO 
Latin-! keyboard is loaded. 

Identifies your terminal as a VT52, VT100, VT200 with 
7-bit controls (default), or VT200 terminal with 8-bit 
controls. 

Selects whether a host can change user-defined key 
(UDK) definitions. 

Prevents new UDKs from being changed. 

Allows new UDKs to be changed. 

Selects whether a host can change certain user features. 

Prevents a host from changing certain user features. 

Lets a host change certain user features. 

The following user features are at1"ected by this feature: 
Auto Repeat, Light/Dark Screen, Tab Stops, and Keyboard 
Lock. 

Note: Some software applications expect to control these 
user features. If this applies to your particular software 
application, select User Features Unlocked. 

16-21 



IIIII Using Set-Up With the VT240 Emulator 

Keyboard Screen 

The Keyboard Set-Up screen lets you define keyboard operating features. 

Actions 

. "'" ":":!!,;!I¥ji!l;<~'iit.·"r'· ..• 
CURRENT SETTINGS 

o ;:';'~' X :,i~; <0 t;;,' >/;;<r:~"J / 
Numeric keypad 
Normal Cursor Keys 
Margin Bell 
Warning Bell 
Break 

Communications 
Printer 

Auto AnswerbacK 
Answerback Not Concealed 
Answerback String 
Cap''; Lock 
Fast Auto Repeat 
Normal keyclick 

Press: Next " .Display next screen 
Prevo .. Display previou$ screen 
Set-Up ... Exit Set-Up 

Display 
Tab.,; 

General 
Telephone 

Down arrow. Move down a line 
Up arrow .... Move up a line 
Select ...... Make a selection 

Screen 16-6 VT240 Keyboard 

Table 16-6 defines the Keyboard Set-Up selections and, where applicable, the 
settings. 
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Table 16-6 VT240 Keyboard Set-Up 

Selection 

Keypad Mode 

Numeric Keypad 
( default) 

Application 
Keypad 

Cursor Keys 

Normal Cursor 
Keys 
(defau It) 

Application 
Cursor Keys 

Margin Bell 

Margin Bell 
( default) 

No Margin Bell 

Warning Bell 

Warning Bell 
(default) 

No Warning Bell 

Break 

Break 
(default) 

No Break 

Function 

Sets the terminal keypad for using either numbers or con· 
trol codes. 

Sends numbers from the numeric keypad. 

Sends escape sequences from the numeric keypad. 

Selects the kind of control codes sent. It is disabled if the 
terminal is in VT52 mode. 

Sends ANSI cursor control sequences for cursor keys (up, 
down, left and right). 

Sends application program control functions for cursor 
keys. 

Determines whether the terminal sounds a bell tone 
when the text cursor approaches the right margin. 

Selects the margin bell setting. 

Turns off the margin bell setting. 

Determines whether the terminal generates a bell tone 
such as for operator errors, mail messages, or system 
messages. 

Turns on the warning bell setting. 

Turns off the warning bell setting. 

Enables or disables the Break key function. 

Turns on the Break key function. 

Turns off the Break key function. 
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Table 16-6 VT240 Keyboard Set-Up (cont_) 

Selection Function 

Auto Answerback 

No Auto 
Answerback 

Auto Answerback 
( default) 

Answerback 

Answerback 
Concealed 

Answerback Not 
Concealed 
( default) 

Answerback String 
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Selects whether the answerback message is automatically 
sent to a host -computer after a communi-cation line con
nection. 

Turns off the answerback message. 

Turns on the answerback message. 

Selects whether your answerback message entry is dis
played on the screen. 

Your answerback message is not displayed on the screen. 
so it will not be revealed. You cannot reset the setting to 
Not Concealed, except by entering a new answerback 
message. 

Displays the answerback message as entered. 

Allows an answerback message entry. 

The emulator sends an answerba('k message when it re
ceives an ENQ (enquiry control character), or if you or 
the host send a Ctrl/llreak. In the case of ENQ, the mes
sage you enter is sent to a host without affecting screen 
data or requiring further operator action. 

When you make this selection, a cursor displays in the 
right column. You can enter any keyboard character, lip 
to a 30-character limit. 
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Table 16-6 VT240 Keyboard Set-Up (cont.) 

Selection 

Caps Lock 

Shift Lock 

Auto Repeat 

No Auto Repeat 

Fast Auto Repeat 
(default) 

Keyclick 

Normal Keyclick 
(default) 

No Keyclick 

Function 

Determines the function of the Lock key. Pressing the 
Lock key turns on the Lock indicator on the keyboard. To 
clear the lock function, simply press the Lock key again. 

Sends uppercase characters only for the alphabetic keys. 

The alphabetic keys send uppercase characters, and the 
numeric/symbol keys send the top characters only. 

Determines whether keystrokes automatically repeat 
when you press and hold down a key. 

Sends only one character when you press and hold down 
a key. 

Sends the character repeatedly if you press and hold it 
down. Sending stops when the key is released. You can 
select Slow, Normal, or Fast. 

Note: If you are in VT100 mode, running EDT under 
VMS, and hold down a key, autorepeating stops. It 
resumes only when you release the key, and then press it 
again. To prevent this from happening, after the VMS 
prompt type: 

$ SET TERMINAL/DEVICE=VT200 
$ SET TERMINAL/INQUIRE 

Determines the volume of your keyclicks. 

The settings here are Soft, Normal, and Loud. 

Keyclicks do not sound. 
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Printer Screen 

The Printer Set-Up screen lets you define printer (or auxiliary device) opera
tions with the emulators. 

/ 
Actions 
Keyboard 

Print Full Page 
[lEC Printer 
Print File Name 
Normal Print Mode 
Print Terminator: Form Feed 

Press: Next ..... Display next screen 
Prevo .... Display previous screen 
Set-Up ... Exit Set-Up 

Display 
Tabs 

General 
Telephone: 

Down arrow ... Move down a line 
Up arrow ..... Move up a line 
Select ....... Make a selection 

Screen 16-7 VT240 Printer 

Table 16-7 defines the Printer Set-Up selections and, where applicable, the 
settings. 
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Table 16-7 VT240 Printer Set-Up 

Selection Function 

Print Extent Determines how much of the screen is printed dur
ing a text print operation_ 

Print Full Page 
(default) 

Print Scroll Region 

Printer Type 

DEC Printer 
( default) 

Print File Name 

Print Mode 

Normal Print Mode 
(default ) 

Auto Print Mode 

Printer Controller 
Mode 

Print Terminator 

Print Terminator: None 

Print Terminator: 
Form Fced 
(default) 

Prints the full screen_ 

Prints only the scrolling region_ 

Lets you select the printer you want to use_ 

The selections arc: DEC and Other. Other would be 
any non-DIGITAL printer. 

Used when you want to send the text on your 
screen to a file. When selected you are prompted to 
select either the default PRN file or to enter the 
name of the file. 

After you exit Set-Up. you press the Print Screen key 
to send the text to the file. 

Selects the operating mode for the printer. 

Only sends information to the printer when you in
voke print functions from the keyboard. 

Prints the current text line when the terminal re
ceives a line feed. form feed, or vertical tab code 
from a host. 

Causes the printer port to treat the device connect
ed to it as a terminal, while the VT240 emulator 
monitors traffic. (The printer and host computer 
transfer data without displaying the data on the 
screen.) 

Selects whether a form feed terminator is sent at the 
end of a print screen operation. 

Selects no terminator. 

Selects the form feed terminator. 
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Tabs Screen 

The Tabs Set-Up screen lets you set the terminal tab stop settings. 

/ 

Actions 
Keyboard 

TABS 
~~ 
Clear All Tabs 
Set e Column Tabs 
Set Tab Int.rval 
Manually Set Tabs 

Communications 
Printer 

Press; Next ..... Display next screen 
Prevo .... Di.play previou. $crean 
Bet-Up ... Exit Set-Up 

Display General 
Telephone 

Down arrow ... Move down a line 
Up arrow ..... Move up a line 
Select. . .Make a selection 

Screen 16-8 VT240 Tabs 

Table 16-8 defines the Tab Set-Up selections and, where applicable, the 
settings. 
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Table 16-8 VT240 Tab Set-Up 

Selection 

Clear All Tabs 

Set 8 Column Tabs 

Set Tab Interval 

Manually Set Tabs 

Function 

Clears all tab settings. 

Sets tabs every 8 columns, starting with column 9. 

When selected, the right column displays an Interval prompt 
with the default value of eight. A tabs ruler is also displayed. 

The default is changed by typing a new value in and pressing 
the Select key. 

Allows you to change individual tab stops. The tab intervals 
are updated in a displayed ruler. 

Setting VT240 Tabs Manually 

To manually set tabs for the VT240 emulator: 

1. Select the Manually Set Tabs option using the up or down arrow key. 

2. Press: 

A blinking cursor is now in the tabs ruler at the bottom of your Tabs 
Set-Up screen. 

See Screen 16-9 the Manually Setting Tabs screen. 
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/ 

TABS 

Actions 
Keyboard 

Clear All Tabs 
Set 8 Cel~ Tabs 
Set Tab Interval 
~~ 

General 
Telephone. 

ifitil~1i~ii~i2~~~~~~~}&~~~~~rb~~~ 

~;g;~~:rB~~~.y~'i~~~~i~~~:~~~J~'; 
Press: NeKt. .Display next screen Down arrow ... Move down a line 

Prevo ... . Display previous screen Up arrow .. .. . Move up a line 
Set-Up-... Exit Set-Up Select ....... Make a selection 

Screen 16-9 Manually Setting VT240 Tabs 

3. To position the cursor on the desired tab stop setting, use the right or 
left arrow key. 

NOTE 
If you want to erase a tab stop, position the cursor on the tab 
setting using the left or right arrow key, then press the Enter key. 

4. To set the tab, press: 

S. To exit manual tab setting, press: 
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Telephone Screen 

The Telephone Set-Up screen lets you store and display telephone numbers 
for automatic dialing. 

To use the Telephone selections, you should have: 

• Installed the integral modem option (This is not available for all 
countries. ) 

• Selected and saved from the Communications screen: 

The Integral Modem selection 

The appropriate transmit and receive speeds 

For more information on telephone settings, see the VAXmate Modem User's 
Guide. 

/ 

Actions 
Keyboard 

CURRENT SETTINGS -- , 
::: ""',:., " < ,', 

Manual Answer 
A = 
B = 
C = 
D = 
E = 
F = 
G = 
H = 
I 
J = 

Communications 
Printer 

PreS$: Next. Display next screen 
Prey .Display previous screen 
Set-Up ... Exit Set-Up 

Display 
Tabs 

General 
',::" ::rel"",lI"ne,,;, 
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Table 16-9 defines the Telephone Set-Up selections and, where applicable, 
the settings. 

Table 16-9 Telephone Set-Up 

Selection 

Modem Answer 

Manual Answer 
(default) 

Auto Answer 

A-J = 

16-32 

-----------------------------------------
Function 

Selects automatic telephone answering by the emulator, or 
manual telephone answering by the user. 

Leaves the integral modem in talk mode after disconnecting 
from the host and allows you to answer the incoming call. 
Manual answer is required for normal telephone operation. 

Leaves the integral modem in data mode after disconnecting 
from the host and allows the terminal to automatically an
swer the incoming call. 

Indicates that ten telephone numbers (A-J) can be stored for 
automatic dialing. 

Each time you select a letter from the left column, the right 
column prompts you to enter a phone number. 

To change or enter a phone number, move to the right col
umn and type over the old one. 

Repeat this process until you enter or change all the desired 
phone numbers. 

When you return to the left column, the phone numbers are 
displayed in the left column along with their respective 
letter A-J. 

You save these settings by using the Save Parameters selec
tion before exiting Set-Up. 



Chapter 17 
Using VT240 

Special Features 

This chapter tells you how to: 

• Use configuration files 

• Save and recall Set-Up selections 

• Send or autotype characters to a host 

• Receive characters from a host into a file using session logging 

Using Configuration Files 

The VT240 emulator allows you to save Set-Up settings in a Set-Up configura
tion file. You can have several of these files each specifying different 
settings. 

What the VT240 Emulator Does 

When you start the VT240 emulator, it looks for the default Set-Up configura
tion file named DEFAULT.240. When found, this file configures your VT240 
emulator with the initial values of all Set-Up selections. 

If the VT240 emulator does not find the DEFAULT.240 file, it configures your 
VT240 emulator with the factory default settings instead. 

What You Can Do 

When starting the VT240 emulator, you can direct it to run a Set-Up config
uration file other than DEFAULT. 240. 

You can also run configuration files after you start the VT240 emulator. To 
do this use the Recall Set-Up Parameters selection as described in this 
chapter. 
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These Set-Up configuration files need not reside in the current directory. You 
can precede configuration file names with a directory path. For more infor
mation about appropriate file naming, see Chapter 30. 

You can also save or start Set-Up configuration files after you start the VT240 
emulator. To do this, use either the Save Set-Up Parameters or the Recall 
Set-Up Parameters selection from the Action Set-Up screen. 

Saving and Recalling Set-Up Files 

After you select the desired Set-Up settings, you can save and recall them 
from the default file, DEFAULT.240, or a file you specify. 

When you start the VT240 emulator, it looks for one of these files and initial
izes the emulator to the values contained in that file. 

The VT240 emulator also lets you create files in which you save Set-Up 
settings. After making the desired Set-Up changes, you select the Save Set-Up 
Parameters selection from the Actions screen. You can then create Set-Up 
files with settings tailored to your: 

• User preferences 

• Applications 

You can select any of these files while running the VT240 emulator by 
choosing the Recall Set-Up Parameters selection from the Actions screen. 

Saving VT240 Selection Settings 

To save all your VT240 Set-Up selections: 

1. Select the Actions screen. 

2. Select the Save Set-Up Parameters. 

3. To make a selection from the right column, press: 

17-2 

Either the default file name DEFAULT.240 or the name of the most 
recently created save file is displayed in the right column. 
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4. To save your selections, do one of the following: 

• Select the DEFAULT.240 file 

• Select the currently displayed file 

• Type in a new file name 

NOTE 
If you select a currently displayed file, the new values you set 
replace the existing values in that file. 

5. To save your selections in the new or selected file, press: 

Recalling VT240 Selection Settings 

. To recall VT240 selection settings under Set-Up: 

1. Select the Actions screen. 

2. Select the Recall Set-Up Parameters. 

3. To make a selection from the right column, press: 

Either the default file name DEFAULT.240 or the name of the most 
recently created save file is displayed in the right column. 

4. To recall your selections, do one of the following: 

• Select the DEFAULT.240 file 

• Select the currently displayed file 

• Type in a file name to contain Set-Up values 

5. To recall your saved Set-Up selections from the selected file, press: 
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Receiving Characters From the Host Into a File 

Show Status in the Actions screen indicates whether session logging is active 
or idle. 

To receive or log characters from the host into a file using session logging: 

1. Press: 

The following prompt is displayed on the bottom line: 

Receive filename: 

2. Type in a file name into which characters logged in from a host will be 
stored. 

If the file name already exists, another prompt is displayed on the 
bottom line asking you to do one of the following: 

- Replace an existing file. 

- Append to an existing file. 

- Cancel the file logging. 

3. To stop characters from logging into the file, press: 

If you press these keys again, logging resumes. Pressing the Alt/Fll keys 
is like using an on and off switch. You can use it to be selective about 
the parts of a file you want to log. 

4. To close the Receive file, press: 
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Autotyping Characters to the Host 

Show Status in the Actions screen indicates whether autotyping is active or 
idle. 

When a file is autotyped to VMS, you must first enable HOSTSYNC under VMS 
by typing: 

$ SET TERMINAL/HOSTSYNC 

This prevents data overruns on a VMS host. 

To autotype characters to the host from a file as if you entered them from the 
keyboard: 

1. Press: 

The following prompt is displayed on the bottom line: 

Send filename: 

2. Type in the name of the file which will be autotyped to the host. 

File autotyping stops when the end of the file is reached. 

You can also press the Alt/F 12 keys again to stop autotyping the file. 
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Chapter 18 
Using Notepad 

MS-Windows Notepad is a desktop application that lets you create, modify, 
and display text files. Although you usually use Notepad to write notes or 
short memos, you can also create and edit batch files. 

This chapter contains information on how to: 

• Start Notepad 

• Type and format text 

• Scroll 

• Edit Notepad text 

• Work with Notepad files 

Starting Notepad 

To start Notepad when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Notepad: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

MS-Windows displays a dialog box. 

2. Type: 

NOTEPAD 
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3. Select the Ok command button. 

When you start Notepad, it creates an empty, untitled window in which you 
can type text. Figure 18-1 shows the Notepad window. 

Flashing insertion point 

Note ad - (untltled) ::I 

Figure 18-1 Notepad Window 

Typing Text 

You can type in the Notepad window whenever it is active. Notepad enters 
text at the insertion point, which initially is displayed in the upper-left cor
ner of the Notepad window. It moves to the right as you type. 

Text is encoded in its ANSI representation. For more information about ANSI 
text representations, see Appendix G. 
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Formatting Text 

To format text with Notepad, type the text as you want it to display. Figure 
18-2 shows how to format text with the Return and Tab keys. 

Press the Return key 
twice to insert a space 
between paragraphs. 

COMpany t1eeting 
Friday, DeceMber 7 
8:00 PM 

Press the Return 
key to end a line. 

Note ad - MEMO. TXT :I 

Pancho I s Uilla Restaurant 

At our Quarterly cOMpany Meeting this Friday, the following eMployees 
will receive a special award for perforMance in the last Quarter: 

Lisa La FlaMMe Sales 

R&D 

Press the Tab key to indent 
a line. 

SOx over Quota 

New Technique 

Press the Tab key to insert 
tab stops. 

Figure 18-2 Formatting With the Return and the Tab Keys 

You can also wrap text automatically at the right edge of the window to 

continue to the next line. To wrap text, use the Word Wrap command from 
the Edit menu. To cancel wrapping, use the Word Wrap command again. 
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Scrolling 

If you have not set text to wrap and you type beyond the borders of the 
window, Notepad automatically scrolls the text, to the left or lip, so the 
insertion point remains visible in the window. 

When text is too long or too wide to be displayed at one time, you can scroll 
through the file to view the text. 

To scroll a Notepad file, use scroll bars. Figure 18-3 shows the scroll bars. 

The position of the scroll box corresponds to where 
you scroll in the file. To scroll to the middle of your 
file, drag the scroll box to the middle of the scroll bar. 

At our Quarterly cOl'lpany I'Ieeting this Friday, the following el'lployees 
will receive a special award for perforMance in the last QUal'ter: 

lisa LaFlal'll'le 

Jal'les Gregory 

Chuck Silvers 

Sales 

R&D 

Service -

50/, over Quota 

New Technique 

20 years 

I hope you will join I'Ie in congratulating these individuals for their 
achievel'lents, and in the festivities to follow, 

Click in the gray area to scroll one screen. 

Click on the up or down scroll arrow to scroll one line. 

Click on the left or right scroll arrow to scroll one character. 

Figure 18-3 Scrolling 

To use the keyboard, press the arrow keys to move the insertion point in the 
direction you want to scroll. When you reach the edge of the window, press 
the arrow key again to scroll the window in that direction. Press the Pg Up 
key to scroll lip one screen; press the Pg Dn key to scroll down one screen. 
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Editing in Notepad 

To edit text in the Notepad window, use commands from the Edit menu. You 
can delete text, move or copy text to a new location, and search for text 
within a Notepad file. 

You can also transfer text between Notepad and other applications using the 
Clipboard. When you delete or copy text with the Notepad Cut or Copy 
command, Notepad puts the text in the Clipboard. The Notepad Paste com
mand copies information from the Clipboard back into your Notepad file. 

The following sections describe how to: 

• Move the insertion point 

• Select text 

• Edit text using the commands from the Edit menu. 

Moving the Insertion Point 

When you open a Notepad window, an insertion point is displayed. When 
you work in another window and return to Notepad, the insertion point is 
displayed where you left: it in the Notepad window. 

You can move the insertion point whenever there is text or spaces. To move 
the insertion point, click on the location where you want it. 

To use the keyboard, press the arrow keys. Pressing the up or down arrow 
keys once moves the insertion point up or down one line. Pressing the right 
or left arrow keys once moves the insertion point one character to the right 
or left. 
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Selecting Text 

Before selecting a command from the Edit menu, first select the text you 
want the command to affect. You select text either with the mouse or the 
keyboard or with the Select All command fmm the Edit menu. Figure 18-4 
shows selected text. 

EI Note ad - 11Etl0, TXT :'I 

Subj ect: COMpany Meeting 
Friday, DeceMber 7 
8:00 PM 
Pancho I s Villa Restaurant 

At our Quarterly cOMpany Meeting this Friday, the following eMPloyees 
will receive a special award for perforMance in the last Quarter: 

Lisa La Fl aMMe Sales S0X over Quota 

JaMes Gregory R&D New Technique 

Chuck ~ilvers Service - 20 years 

individuals for their 

Figure 18-4 Selected Text 

Selecting Text With the Mouse or Keyboard 

To select text: 

1. Point to the beginning of the text you want to select. 

2. Drag the mouse over the text you want to select. 

Notepad highlights the selected text. 
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To use the keyboard: 

1. Press the arrow keys to move the insertion point to one end of the text 
you want to select. 

2. While holding the Shift key, press the arrow keys to move the insertion 
point to the other end of the text you want to select. 

Notepad highlights the selected text. 

Selecting Text with the Select All Command 

To select all the text in the file, use the Select All command from the Edit 
menu. 

Canceling an Edit 

To cancel the most recent edit you made, use the Undo command from the 
Edit menu. You must use this command immediately after the edit and before 
you perform any other editing function. 

Deleting Text 

To delete text: 

1. Select the text you want to delete. 

2. Select the Clear command from the Edit menu. 

To use the keyboard, press the Shift/Del keys. 

Notepad deletes the selected text. 

You can also delete text by copying it to the Clipboard. However, each time 
you put text in the Clipboard, the new text replaces any information already 
in the Clipboard. You can copy or paste this text later. 

To delete text from Notepad and copy it to the Clipboard: 

1. Select the text you want to delete. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

Notepad copies the text to the Clipboard. 
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To paste text from the Clipboard into any part of any document: 

1. Move the insertion point where you want the text. 

2. Select the Paste command. 

To use the keyboard, press the Ins key. 

Notepad pastes the text at the insertion pOint. 

Moving Text 

To move text: 

1. Select the text you want to move. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

Notepad moves the selected text to the Clipboard. 

3. Move the insertion point where you want the text. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Notepad places the text at the insertion point. 

Copying Text 

To copy text: 

1. Select the text you want to copy. 

2. Select the Copy command from the Edit menu. 

Notepad copies the selected text to the Clipboard. 

3. Move the insertion point where you want the copied text. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Notepad displays the text at the insertion point. 
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Finding Text 

You can find and change text in a Notepad file with the commands from the 
Search menu. When you use a Search menu command, you can start search
ing for text at any point. You can also specify whether Notepad matches 
uppercase and lowercase characters. The Search menu commands do not 
search for text in the index line. 

To find text: 

1. Move the insertion point where the search begins. 

2. Select the Find command from the Search menu. 

To use the keyboard, press CtrljF. 

Notepad displays the Find dialog box. Figure 18-5 shows the Find dia
log box. 

Search for: 

o Match Case Ok] 

(Cancel ) 

Figure 18-5 Find Dialog Box 

3. In the Search For text box, type the text you want Notepad to find. 

Notepad ignores capitalization when it searches for text unless you tell 
it otherwise. 

To find occurrences of text that have the same arrangement of 
uppercase and lowercase letters, select the Match Case command. 

4. Select the Ok command button to start searching. 

Notepad searches forward from the insertion point and highlights the 
first occurrence of the specified text. Notepad tells you if the text does 
not occur after the insertion point. 

5. To find further occurrences of the specified text, use the Find Next 
command from the Search menu. 

To use the keyboard, press the F3 key. 
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If you use the Find Next command, Notepad immediately searches for the 
last specified text. With the Find Next command, you can find and edit 
repeated occurrences of the text you specified with the Find command. 

NOTE 
If you use the Find Next command without first using the Find 
command, Notepad displays the Find dialog box. Type the text you 
want Notepad to find. 

Working With Notepad Files 

With commands from the File menu in the Notepad window, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a file 

You delete files with commands from the File menu in the MS-DOS Executive 
window. The following sections describe how to use Notepad files. 

File Size 

As you edit a file, Notepad records how large it is. Notepad shows the size of 
the file as the percentage of remaining free space. When a file has less than 
10 percent free space, you should separate the file into smaller files. 

NOTE 
Free space does not refer to the amount of available memory. It 
refers only to the amount of text you can have in a file. 

To see how much free space remains, use the About command from the 
System menu. 

Notepad displays the amount of free space. 
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Opening a File 

You can open new or existing files in the Notepad window. If you open a 
Notepad file when another file is already open, Notepad closes the file that 
was already opened. If you have changes that are not saved in the file that 
was already open, Notepad asks you if you want to save them before it closes 
the file. Table 18-1 shows what you can reply to Notepad and what the 
resulting action is. 

Table 18-1 Replies for Opening a File 

Reply Action 

Yes Saves the changes 

No Discards the changes 

Cancel Continues working in the current file 

Opening a New File 

To open a new, blank Notepad file, use the New command from the File 
menu. 

Notepad opens a new file in the Notepad window. 

Opening an Existing File 

You should only open text (ASCII) files in the Notepad window. Text files 
generally have one of the following file extensions: .TXT, . BAT, or .IN!. If 
you do not specify a file extension, Notepad appends a default file extension. 
To override the default, you must end the file name with".". For example, 
to open the file C:\TESTCHAR, you must type: 

C;\TESTCHAR. 

You can open an existing file from either the Notepad window or from the 
MS-DOS Executive window. 

If you try to open a file that is not a text file, Notepad sends the message 
"Not a valid Notepad file." 
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To open an existing file with the Notepad Open command: 

1. Select the Open command from the File menu. 

Notepad displays the Open dialog box. Directories and drives are 
enclosed in brackets. Figtii'e 18-6 shows the Open dialog box. 

File name 

~ CU".n' d;""o,y 

File naMe: IJUltJ I 
I~E~OI IXI' +: \windows 
I-A-I~ [ -B-] 

]1 
( I [-C-] Open 

[., ] 
( ) Cancel 

/ + 

path 

Drives 
Parent directory 

Figure 18-6 Open Dialog Box 

2. From the list of file names, select the file name you want to open, or 
type a path name and a file name in the text box at the top of the 
dialog box. 

The file name can include wildcard characters. 

You can also double-click on the file name you want to open. 

3. Select the Open command button. 

Notepad opens the specified file. 

To open an existing file from the MS-DOS Executive window, double-click on 
the file name you want to open or select the file name and press the Return 
key. 

MS-Windows starts Notepad and opens the file. 
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Creating a Time Log File 

Notepad can create a time log file to keep track of how you spend your time 
during the day. To create a time log file, type .LOG as the first line in a 
Notepad file and save the file. Notepad automatically appends the current 
date and time to the end of the file every time you open it. 

To add the current date and time to a file you already have open, use the 
Time/Date command from the Edit menu. 

To use the keyboard, press the FS key. 

To create an accurate log of how you spend your time, edit the file to add 
text after each date and time. 

Viewing Files in Other Directories 

Initially, Notepad displays only text files (.TXT), as well as drives and direc
tories. You can view files other than text files in other directories or drives. 

To view files in other directories: 

1. Select the Open command from the File menu. 

Notepad displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want to read. 

For example, you can type· .BAT to list all the files having the file 
extension .BAT. 

To move between directories, you can also double-click on the drive 
letter symbols, the directories, or the [oO] symbol. 

3. Select the Open command button. 

Notepad lists the specified files. 

The Open dialog box remains on the screen until you open a specific 
file or cancel the command. 
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Saving a File 

When you create a new file or when you finish editing a file, you can save it 
and open it later. To save a Notepad file, you can use one of two commands 
from the File menu: 

• Save As - Saves and names a new file 

• Save - Saves a current file 

Saving a New File 

The Save As command names and saves a new file. It can also save the cur
rent file under a new file name and retain the original copy of the file on the 
disk under the old file name. 

To save a new file: 

1. Select the Save As command from the File menu. 

Notepad displays the Save As dialog box. Figure 18-7 shows the Save As 
dialog box. 

Save file as: C:\windows 
IL.;.;ME;;;.;MO~ ____ -JI [ Save) 

( Cancel ) 

Figure 18·7 Save As Dialog Box 

2. Type a name for the file. 

If you do not type a file extension, Notepad automatically adds .TXT to 
the file name. 
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3. Select the Save command button. 

Notepad saves the file on the disk. The file remains on the screen so 
that you can continue editing it. Notepad displays the name of the file 
in the title bar of the Notepad window. 

NOTE 
If you type the name of a file that already exists, Notepad asks if 
you want to replace the existing file with the file you are saving. 
To replace the existing file, select the Yes command button. 
Otherwise, select the No command button and type a different file 
name. 

Saving Changes 

The Save command saves your changes to the current tile on the disk. To 
save changes to the current file, use the Save command from the File menu. 
Notepad replaces the file on the disk with the current file. 

Printing a File 

The Print command prints your Notepad files. To print a file, use the Print 
command from the File menu. 

Deleting a File 

You can delete a Notepad file when you no longer want it or to make room 
for other files on your disk. To delete a file, use the Delete command from 
the File menu. 
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Chapter 19 
Using Cardfile 

MS-Windows Cardfile is a desktop application that organizes information such 
as names, addresses, phone numbers, and directions. Cardfile operates on a 
file of cards that are organized alphabetically. As you use Cardfile, the cards 
sort themselves automatically to remain alphabetized. 

This chapter describes how to: 

• Start Cardfile 

• Create a card file 

• Move through a card file 

• Edit cards in a card file 

• Work with card files 

Starting Cardfile 

To start Cardfile when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Cardfile: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 
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2. Type: 

CARDFILE 

3. Select the Ok command button. 

When you start Cardfile, it displays an untitled window in which you create 
cards and edit them. Figure 19-1 shows the Cardfile window. 

Flashing insertion point Index line 

Figure 19-1 Cardfile Window 
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Creating a Card File 

Cardfile displays a new file as a single, blank card. This section describes: 

• Index line 

• Typing text 

• Formatting text 

• Adding new blank cards 

Index Line 

The index line is a bar at the top of each card. Cardfile uses the text you 
place in the index line to sort the cards alphabetically. 

To place text in the index line: 

1. Select the Index command from the Edit menu, or double-click on the 
card's index line. 

Cardfile displays the Index dialog box. Figure 19-2 shows the Index 
dialog box. 

Index Line: ... 11 ___________ ...... 

[ Ok ] ( Cancel) 

Figure 19-2 Index Dialog Box 

2. Type text in the text box. 

3. When you finish editing the text, select the Ok command button. 

The text becomes the index line. 
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Typing Text 

After you create an index line, you can add text to a card; however, the 
Cardfile window must be active. When you have more than one card in your 
file, Cardfile places the text on the front card. 

Cardfile enters text at the insertion point, which initially is displayed at the 
upper-left corner of the card. The insertion point moves to the right as you 
type. 

Text is encoded in its ANSI representation. For more information about ANSI 
text representations, see Appendix G. 

Formatting Text 

Type the text as you want it to display. Figure 19-3 shows how to format text 
with the Return and Tab keys. 

Press the Tab key to indent a line. 
Press the Return key to end a line. 

-Great food 
-Reasonable prices 
-Conference and party facilities 
-Uery authentic atMosphere 

Figure 19-3 Formatting With the Return and Tab Keys 
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Adding a Card 

You can add a new card to a file at any time. To add a new card: 

1. Select the Add command from the Card menu. 

Cardfile displays the Add dialog box. 

2. Type the text for the new card's index line. 

3. Select the Ok command button. 

Cardfile adds the new card to your file in alphabetical order and scrolls 
the file to display the new card at the front. 

Moving Through a File 

Cardfile commands affect only the front card. To look at or act upon a card, 
you must move the card to the front of the file. 

To move through the file, you can: 

• Scroll 

• Move a specific card directly to the front 

• Search for a specific occurrence of text 

Cardfile, however, always keeps the cards in alphabetical order. 
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Scrolling 

The Cardfile window has a horizontal scroll bar at the bottom of the window. 
Figure 19-4 shows how to scroll through a file. 

127-1958 for reservations 
-Gmt food 
-Reasonable prices 
-Conference facilities 
-Uery authentic atMosphere 

Click here with the 
mouse or press the 
Pg Up key to 
display the previous 
card. 

Drag the scroll box 
with the mouse to 
move within the file. 

Click here with the 
mouse or press the 
Pg Dn key to 
display the next card 

Figure 19-4 Scrolling Through a File 

The scroll box in the horizontal scroll bar shows your relative pOSition in the 
file. When the first card of the file is displayed in front, the scroll box is 
displayed at the far left of the scroll bar. When the last card is displayed at 
the front, the scroll box is displayed at the far right. 
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Moving a Card to the Front 

To move a specific card to the front of a file: 

1. Select the Go To command from the Search menu. 

Cardfile displays the Go To dialog box. Figure 19-5 shows the Go To 
dialog box. 

Goto: 1,,-1 ___ ---' 

[ Ok ] (Cance 1 ) 

Figure 19-5 Go To Dialog Box 

2. In the text box, type the index line for the card you want to move to 
the front. 

You only have to type enough text to distinguish the card from the 
other cards. 

3. Select the Ok command button. 

The card moves to the front of the file. 

If you can see a card's index line, you can move the card to the front of the 
file by clicking on the index line. 

To use the keyboard, press the Ctrl key to move a card to the front. When 
you press the Ctrl key and a letter on the keyboard, Cardfile scrolls to dis
play the first card that has that letter as the first letter of its index line. 

Changing the Index Line 

To change the text in the index line: 

1. Move the card you want to change to the front of the file. 

2. Select the Index command from the Edit menu, or double-click on the 
card's index line. 

Cardfile displays the Index dialog box with the text from the current 
index line in the text box. 
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3. Type the new text. 

4. Select the Ok command button. 

The new text becomes the card's index line. 

Cardfile automatically replaces the card in the correct alphabetical order in 
the file, then scrolls the file to display the card at the front. 

Editing Cards 

You edit text in a card with commands from the Edit menu. You can change 
or delete text, or move or copy text to a new location. 

You can also transfer text between Cardfile and other applications by using 
the Clipboard and the Cut, Copy, and Paste commands. 

The following sections describe how to move the insertion point, select text, 
and edit cards. 

Moving the Insertion Point 

When you open a card file, an insertion point is displayed. When you work 
in another window, then return to the card file, the insertion point is dis
played where you left it in the Cardfile window. 

To move the insertion point, point where you want it and click the mouse 
button. 

To use the keyboard, press the arrow keys. Pressing the up and down arrow 
keys moves the insertion point up or down one line. Pressing the right and 
left arrow keys moves the insertion point one character to the right or left. 
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Selecting Text 

Before you use a command from the Edit menu, first select the text you want 
the command to affect. Figure 19-6 shows selected text. 

Corner of H,E, 8th and Main streets 
in Bellevue 

Figure 19-6 Selected Text 

To select text: 

1. Point to the beginning of the text you want to select. 

2. Drag to the end of the text you want to select. 

Cardfile highlights the selected text. 

To use the keyboard: 

1. Press the arrow keys to move the insertion point to the beginning of the 
text you want to select. 

2. While holding the Shift key, press the arrow keys to move the insertion 
point to the end of the text you want to select. 

Cardfile highlights the selected text. 
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Canceling an Edit 

To cancel the most recent edit you made, use the Undo command from the 
Edit menu. You must use this command immediately after the edit. 

Deleting Text 

To delete text from a card: 

1. Select the text you want to delete. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

Cardfile deletes the text. 

The deleted text is placed in the Clipboard. Each time you place text in the 
Clipboard, however, the text replaces the previous information. 

To replace deleted text, use the Paste command. To use the keyboard, press 
the Ins key. 

Moving Text 

You can move text from one place to another in a card by first deleting it, 
then pasting it into its new location. You can move text within the same card 
or to another card. 

Moving Text Within the Same Card 

To move text on the same card: 

1. Select the text you want to move. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

3. Move the insertion point where you want the text to be moved. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile moves the text to the insertion point. 
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Moving Text to Another Card 

To move text to another card: 

1. Select the text you want to move. 

2. Select the Cut command from the Edit menu. 

To use the keyboard, press the Del key. 

3. Move the card on which you want to place the text to the front. 

4. Move the insertion point where you want to place the text. 

5. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile moves the text to the new card. 

Copying Text 

To copy text more than once in a file, copy the text to the Clipboard, then 
paste the text where and as often as you want it. 

Copying Text to the Same Card 

To copy text to the same card: 

1. Select the text you want to copy. 

2. Select the Copy command from the Edit menu. 

Cardfile copies the selected text to the Clipboard. 

3. Move the insertion point where you want the copied text. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile copies the text at the insertion point. 

Copying Text to Another Card 

To copy text to another card: 

1. Select the text you want to copy. 

2. Select the Copy command from the Edit menu. 
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If you use the Find Next command, Cardfile immediately searches for the last 
specified text. With the Find Next command, you can find and edit repeated 
occurrences of the text specified with the Find command. 

Adding Information From Other Applications 

Cardfile can transfer both text and artwork between a card and another appli
cation. For example, you can create a small map in MS-Paint, then transfer it 
to a card containing a friend's address. The amount of information you can 
transfer is limited by the size of the card. 

To add information from other applications: 

1. Place the information in the Clipboard. 

Usually, you select the Cut or Copy command from the Edit menu of 
the other application. 

2. If you are transferring artwork, move to the Cardfile window and select 
the Picture command from the Edit menu. 

If you transfer a picture, you must use the Text command from the Edit 
menu to process text again. 

3. On the card, move the insertion point where you want the information. 

4. Select the Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Cardfile moves the information to the insertion pOint. 

Restoring a Card 

You can restore a card to its original condition as long as it remains at the 
front of the file. Once you scroll, you cannot reverse any changes. 

To restore a card, use the Restore command from the Edit menu. 
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Deleting a Card 

You can delete a card from a file. However, you can only replace a deleted 
card by retyping the entire card. 

To delete a card: 

1. Move the card you want to delete to the front of the file. 

2. Select the Delete command from the Card menu. 

Cardfile deletes the front card. 

Copying a Card 

To copy the information in a card to another card: 

1. Move the card you want to copy to the front of the file. 

2. Select the Duplicate command from the Card menu. 

Cardfile appends an exact copy of the front card to the front of the file. 

Working With Card Files 

With commands from the File menu, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a card or a file 

• Merge files 

You delete files with the File menu in the MS-DOS Executive window. 

File Size 

As you edit a file, Cardfile records its size. Cardfile shows the size of a file as 
the number of cards in the file. 

To find out how many cards are in a file, use the About command from the 
System menu. 

Cardfile displays the number of cards in the file. 
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Opening a File 

You can open a new or existing file in the Cardfile window. If you open a 
file when another is already open, Cardfile closes the current file. If you 
have changes that are not saved in the current file, Cardfile asks if you want 
to save them before it closes the file. Table 19-1 shows what you can reply 
to Cardfile and what the resulting action is. 

Table 19-1 Replies for Opening a File 

Reply 

Yes 

No 

Cancel 

Action 

Saves the changes 

Discards the changes 

Continues working in the current file 

Opening a New File 

To create a new file from the Cardfile window, use the New command from 
the File menu. 

Cardfile opens a new file in the Cardfile window. The name "untitled" is 
displayed in the title bar of the window. 

Opening an Existing File 

You can open an existing file from either the Cardfile window or from the 
MS-DOS Executive window. 

To open an existing file from the Cardfile window, use the Open command 
or double-click on the file name in the list box. Usually, these files have the 
file extension .CRD. 
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To open an existing file with the Open command: 

1. Select the Open command from the File menu. 

Cardfile displays the Open dialog box. Directories and drives are 
enclosed in brackets. Figure 19-8 shows the Open dialog box. 

File name 

~u'''nt d;""o" 

File naMe: [iii IiI!l I 
, CKIV + : \windows 

[-A-] 

path 

[ -C-] 
~: I I [" ] .' Open 

BIN] !ii::; 
iii:!: ( Cancel ) 
+ 

Drives 

Parent director y 

Figure 19-8 Open Dialog Box 

2. From the list of file names, select the file name you want to open, or 
type a path name and a file name in the text box at the top of the 
dialog box. 

3. Select the Open command. 

Cardfile opens the specified file. 

To open an existing file from the MS-DOS Executive window, double-click on 
the file name you want to open or select the file name and press the Return 
key. Generally, you can open files with the file extension .CRD. 
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Viewing Files in Other Directories 

Initially, Cardfile displays only the names of the card files as well as drives 
and directories. You can view files, other than card files, in other directories 
or drives. 

To view files in other directories or drives: 

1. Select the Open command from the File menu. 

Cardfile displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want to read. 
For example, you can type' . TXT to read all the files having the file 
extension .TXT. 

To move between directories, you can also double-click on the drive 
letter symbols, the directories, or the [ .. ) symbol. 

3. Select the Open command. 

Cardfile lists the specified files. 

The Open dialog box remains on the screen until you open a specific file or 
cancel the command. 
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Saving a File 

When you create a new file, or when you finish editing a file, you can save it 
and open it later. To save a card file, you can use one of two commands: 

.. Save As - Saves and names a new file 

• Save - Saves a current file 

Saving a New File 

The Save As command names and saves a new file. It can also save the cur
rent file under a new file name and retain the original copy of the file on the 
disk under the old file name. 

To save a new file: 

1. Select the Save As command from the File menu. 

Cardfile displays the Save As dialog box. Figure 19-9 shows the Save As 

dialog box. 

Save File as: C:\windows 
ImBU::":SI:O::::HE'l:':SS-------.1 [ Save] 

(Cancel ) 

Figure 19-9 Save As Dialog Box 

2. Type a name for the file. 

If you do not type a file extension, Cardfile automatically adds .CRD to 
the file name. 

3. Select the Save command button. 

Cardfile saves the file on the disk. The file remains on the screen so 
that you can continue editing it. Cardfile displays the name of the file 
in the title bar of the Cardfile window. 

19-18 



Using Cardfile 11111 

NOTE 
If you type the name of a file that already exists, Cardfile asks if 
you want to replace the existing file with the file you are saving. 
To replace the existing file, select the Yes command button. 
Otherwise, select the No command button and type a different file 
name. 

Saving Changes 

The Save command saves the changes to the current file on the disk. 

To save changes to the current file, use the Save command from the File 
menu. 

Cardfile replaces the file on the disk with the current file. 

Printing in Cardfile 

You can print a single card or an entire file (all the cards). 

Printing a Card 

To print a single card: 

1. Move the card you want to the front of the file. 

2. Select the Print command from the File menu. 

Cardfile prints the card on the default MS-Windows printer. 

Printing an Entire File 

To print an entire file (all the cards), select the Print All command from the 
File menu. 

Cardfile prints the file on the default MS-Windows printer. 

Deleting a File 

You can delete a card file when you no longer want it or when you want to 
make room for other files on your disk. To delete a cardfile, use the Delete 
command from the File menu. 

19-19 



11111 Using Cardfile 

Merging Files 

To consolidate your information, you can merge another file into the current 
file. 

To merge two files: 

1. Select the Merge command from the File menu. 

Cardfile displays the Merge dialog box. Figure 19-10 shows the Merge 
dialog box. 

Filf nallf: I Z!i!.!l I 
[-A-] 

.CRD + C: \windows r 
[-Co] 

I [ ] [.. ] HU9f 
[BIN] 

( ) Caned 
+ 

Figure 19-10 Merge Dialog Box 

2. Select the file you want to merge with the current file. 

3. Select the Merge command. 

Cardfile merges the cards from the other file with the cards in the 
current file and sorts all the cards alphabetically. 

Viewing a File as a List 

You can view a file as a list as well as a series of cards. When the cards are 
listed, Cardfile displays the index line of every card in the file. For example, 
you can create a phone directory by including a name and phone number in 
the index line of each card in a file, then display the file as a list. 

To display the file as a list, use the List command from the View menu. 

19-20 



Using Cardfile IIIII 

Automatic Dialing 

Automatic dialing works through a DIGITAL PC50-MA or a Hayes-compatible 
modem. These may not be available in your country. 

If you have a DIGITAL PC50-MA or a Hayes-compatible modem, Cardfile can 
dial a number for you. 

To dial a number: 

1. Select the entry you want. 

You can display a list of the file or move the card you want to the front 
in the Card view. 

2. Select the Autodial command from the Card menu. 

Cardfile displays the Autodial dialog box. Figure ] 9-11 shows the 
Autodial dialog box. 

Dial:l~ 

Dial T,pe @Tone o Pulse 

Port @COH1 OCOH2 

Baud Rate @1298 03110 

(I) [Cancel) 

Figure 19-11 Autodial Dialog Box 

3. Change the dialog box options if necessary. 

Table 19-2 describes the dialog box options. 

4. Select the Ok command button. 

Cardfile dials the number in the Dial text box. 
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Table 19-2 Autodial Options and Functions 

Option 

Baud rate 

Dial 

Dial Type 

Port 

19·22 

Function 

Represents the speed of transmission for your telephone. The baud 
rate is determined by your modem and the communications Hne or 
network. For the correct setting, consult the owner's manual for your 
modem. 

Searches for a phone number in the specified card, beginning with 
the index line, then places the first phone number found into the 
Dial text box. 

To locate a number other than the first number on the card, select 
the number before you select the Autodial command. To change the 
number in the Dial text box, retype or edit the number. 

Selects the dial type of your phone. If you normally hear a tone for 
each number you dial, you have a tone telephone. If you .hear a 
clicking sound, you probably have a pulse telephone. Generally, push 
button telephones have tone dialing; rotary dial telephones have 
pulse dialing. 

Selects the port to which your modem is connected. 



Chapter 20 
Using Calendar 

MS-Windows Calendar is a desktop application that resembles a desktop cal
endar or an appointment book. Calendar gives you two views of time. In the 
Day view, you enter, display, or edit your appointments for each day. In the 
Month view, select the day for which you want to see appointments. 

You can maintain more than one Calendar file; for example, you can view or 
edit more than one person's appointments. You can also set alarms to remind 
you of particular appointments. 

This chapter describes how to: 

• Start Calendar 

• Edit the day view 

• Set the alarm for your calendar 

• View different times or days 

• Customize your calendar 

• Work with Calendar files 

Starting Calendar 

To start Calendar when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 
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To start Calendar: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog bux. 

2. Type: 

CALENDAR 

3. Select the Ok command button. 

When you start Calendar, the daily appointment window (the Day view) is 
displayed for the current date. Calendar uses the date and time set when you 
started your workstation. Figure 20-1 shows the Day view that is displayed 
when you open the Calendar window. 

You can reset the date and time using the Control Panel. 

Click on an arrow to view the appointments 
for the next or previous day. 

Date line 

Appointment area 

Figure 20-1 Calendar Window: Day View 
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Editing the Day View 

You enter appointments in the Day view. If you are in the Month view, use 
the Day command from the View menu. 

Selecting a Time 

The Day view initially lists times at one-hour intervals, beginning with 8 a.m. 
Before typing the description of an appointment, you must select the 
appointment time. 

To select a time: 

1. Point to the desired time. 

2. Click on the mouse button. 

Calendar highlights the selected time. 

To use the keyboard, press the down arrow key to move to the next hour. 
Press the up arrow key to move to the previous hour. 

To schedule an appointment for a time not displayed on the screen, scroll 
the display before selecting the time. For details on scrolling, see "Viewing 
Different Times" in this chapter. 

Entering an Appointment 

To enter an appointment in the Day view: 

1. Select the time of the appointment. 

2. Type a description of the appointment. 

You are limited to 40 characters. 

For example, you can type: 

Lunch with Lydia 

3. Press the Return key to select the time for the next appointment you 
want to enter. 

Text is encoded in its ANSI representation. For more information about ANSI 
text representations, see Appendix G. 
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Selecting Text 

You can change any existing entry for an appointment. However, manyedit
ing features require that you first select the text of the entry. 

To select text: 

1. Point to the first character of the text to be selected. 

2. Drag to the end of the text. 

Calendar highlights the selected text. 

To use the keyboard: 

1. Press the arrow keys to move the insertion point to the beginning of the 
text you want to select. 

2. While holding the Shift key, press the arrow keys to move the insertion 
point to the end of the text you want to select. 

Calendar highlights the selected text. 

Editing an Entry 

You can edit an existing entry that is selected. To edit the text of an entry: 

1. Select the text of an entry. 

2. Type the new text. 

Calendar deletes the old entry when you type the first character of the 
new one. 

Copying an Entry 

To place the same entry more than once in a calendar, copy the text to the 
Clipboard, then paste the text where you want it in the calendar. You can 
copy text from either the appointment area or the scratch pad. 

To copy text: 

1. Select the text. 

2. Select the Copy command from the Edit menu. 

Calendar copies the text to the Clipboard. 
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3. Move the insertion point where you want the copied text. 

You can move it to a time in the appointment area or to the scratch 
pad. 

4. Select the Paste command from the Edit menu. 

Calendar displays the text at the insertion point. 

Deleting an Entry 

You can delete text from either the appointment area or the scratch pad. You 
replace a deleted entry only by retyping it. 

To delete an entry: 

1. Select the text. 

2. Select the Cut command from the Edit menu. 

Calendar copies the text to the Clipboard, then deletes it from 
Calendar. 

Setting the Alarm 

You can set the alarm for as many appointments in your calendar as you 
want. The alarm sounds at the time you specify. 

Turning On the Alarm 

To set the alarm: 

1. Select the time at which you want an alarm to ring. 

2. Select the Set command from the Alarm menu. 

Calendar sets the alarm. 

The alarm clock symbol, a small bell, is displayed to the left of the selected 
time. When the alarm sounds, Calendar displays a dialog box reminding you 
of the appointment. If the Calendar window is inactive, the title bar at the 
top of the Calendar window flashes. If Calendar is an icon when the alarm 
sounds, the icon flashes .. 
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Setting the Alarm for Sound 

You can control whether the alarm makes a sound. Initially, the alarm is set 
for sound; it rings unless you set it to be silent. 

To turn otJ the sound or to reset the sound for an alarm: 

1. Select the Controls command from the Alarm menu. 

2. Select the Sound option. 

3. Select the Ok command button. 

If the alarm is set for sound, Calendar sets it for silence. If you select 
the Sound option again, Calendar resets the sound. 

Setting the Alarm to Ring Early 

To set the alarm to ring early: 

1. Select the Controls command from the Alarm menu. 

2. Select the Early Ring text box. 

3. Type a number between 0 and 10. This number represents the number 
of minutes before your appointment that the alarm rings. 

4. Select the Ok command button. 

Calendar sets the alarm. 

Turning Off the Alarm 

When the Calendar box is active, Calendar displays the Alarm Dialog box. If 
the Calendar window is inactive, the title bar flashes. If Calendar is an icon, 
the icon flashes. 

You can turn off an alarm, letting the time remain set. You can turn on the 
alarm again later. 

To turn off the alarm: 

• If the Calendar window is active, select the Ok command button in the 
Alarm dialog box. 

• If the window is inactive, or if Calendar is an icon, select the window 
or icon. 

Mter Calendar displays the Alarm dialog box, select the Ok command 
button. 
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To use the keyboard: 

• If the Calendar window is active, press the Return key. 

• If the window is inactive, or if Calendar is an icon, press Alt/Tab until 
Calendar is selected. 

After Calendar displays the Alarm dialog box, press the Return key. 

Removing an Alarm 

To remove an alarm: 

1. Select the time the alarm is set for. 

2. Select the Cancel command from the Alarm menu. 

Calendar cancels the alarm. 

Viewing Different Times or Dates 

You can move through Calendar to display the appointments you have 
entered or to select a day other than the one currently displayed in the Day 
view. 

Viewing Different Times 

The Day view displays only a few of the day's appointments. Therefore, to 
see a particular appointment, scroll through the Day view. Table 20-1 
describes how to scroll to view different times with the mouse and keyboard. 

Table 20-1 Scrolling to View Different Times 

To view_ .. 

Different appoint
ments 

The next screen 

The previous 
screen 

With the Mouse ... 

Click on the arrows at the 
end of the scroll bar 

The list of appointments 
scroll in the direction the ar
row points. 

Click below the scroll box 

Click above the scroll box 

With the Keyboard ... 

Press the up and down arrow 
keys 

When you reach the last visi
ble appointment, press the up 
or down arrow key to scroll 
the window to the next ap
pointment. 

Press the Pg On key 

Press the Pg Up key 
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Viewing Different Dates 

To change the date or month that is displayed, use the commands from the 
Show menu. These commands apply to dates when in the Day view, and to 
months when in the Month view. Table 2{}-2 describes how to scroll to view 
different dates. 

Table 20-2 Scrolling to View Different Dates 

To display... With the Mouse ... 

Current date or month Select the Today command 
from the Show menu 

Previous date or month Select the Previous com· 
mand from the Show menu 

Next date or month Select the Next command 
from the show menu 

With the Keyboard ... 

Press the Home key 

Press Ctrl/Pg Up 

Press Ctrl/Pg Dn 

Viewing Different Dates Using the Month View 

In the Month view, select the day for which you want to enter, edit, or 
display appointments. 

To display the Month view, use the Month command from the View menu or 
click on the date line. 

Table 20·3 describes how to move in the Month view and select with the 
mouse a day you want to view. 

Table 20-3 Moving in Month View With the Mouse 

To select ... 

Another day 

Next month 

Previous month 

Next year 

Previous year 

20-8 

Click on ... 

Desired day 
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Scroll arrow at the top of the vertical scroll bar 

Gray area below the scroll box 
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Table 20-4 describes how to move in the Month view and select with the 
keyboard a day you want to view. 

Table 20-4 Moving in Month View With the Keyboard 

To Select ... 

Next date 

Previous date 

Date directly below the current date 

Press ... 

Right arrow key 

Left arrow key 

Down arrow key 

IIIII 

If the current date is in the bottom row of the 
calendar, pressing the down arrow key selects 
the next month. 

Date directly above the current date Up arrow key 

If the current date is in the top row of the 
calendar, pressing the up arrow key selects 
the previous month. 

Next month 

Previous month 

Pg Dn key 

Pg Up key 

Once you select the day you want, you return to the Day view by double
clicking on the selected day, pressing the Return key, or using the Day com
mand from the View Menu. 

Viewing a Specific Date 

To display a specific date: 

1. Select the Date command from the Show menu. 

2. In the text box, type the date you want Calendar to display. 

3. Select the Ok command button. 

Calendar displays the date. 

You can type any date between January 1, 1980 and December 31, 2099. 
Type dates in the following format: mm/dd/yyyy or mm-dd-yyyy. You do not 
need to type leading zeros for days or months. 

NOTE 
You can specify the date format that is prevalent in your country 
through the Control Panel. 
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If you type a two-digit number for the year, Calendar assumes the 20th cen
tury. Table 20-5 shows acceptable entries 

Table 20-5 Acceptable Entries for Dates 

Date Typed Representation 

January 19, 1985 

November 7, 1985 

January 1, 2010 

1/19/85 

11-7-85 

1/1/2010 

Customizing Your Calendar 

You can customize the Day view of your calendar with commands from the 
Options menu. For example, you can change the day settings or add notes to 
your appointments. 

Changing Day Settings 

The day settings control the display of the Day view. 

To change the day settings: 

1. Select the Day Settings command from the Options menu. 

Calendar displays the Day Settings dialog box. Figure 20-2 shows the 
Day Settings dialog box. 

Da, Settings 

Interval 015 039 @iB 
Hour Fomat @ 12 0 24 

Starting Tille: I 8: I18aM 
lOkI 
(Cancel ) 

Figure 20-2 Day Settings Dialog Box 

2. Select the options you want: Interval, Hour Format, or Starting Time. 

Interval controls the interval for daily appointments. You can select 15-
minute, 30-minute, or 60-minute intervals. 
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Hour Format represents the Calendar clock: a standard 12-hour clock or 
a 24-hour clock. 

Starting Time is the earliest listed time when the Day view is displayed. 

3. Select the Ok command button. 

Calendar changes the day setting to the option you specified. 

Using Special Times 

You can enter appointments for special times. A special time is any time that 
falls between the intervals set with the Day Settings command on the Options 
menu. For example, 11: 1 0 is a special time. 

Adding Special Times 

To add a special time: 

1. Select the Special Time command from the Options menu. 

Calendar displays the Special Time dialog box. 

2. Type the desired time in the text box. 

3. Select the Insert command. 

Calendar adds the new time. 

Deleting Special Times 

To delete a special time: 

1. Select the time you want to delete. 

2. Select the Special Time command from the Options menu. 

Calendar displays the Special Time dialog box with the selected time in 
the text box. 

3. Select the Delete command. 

Calendar deletes the selected time. 
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Adding Notes 

The daily appointment window has a scratch pad, located at the bottom of 
the Calendar window, to which you can add notes. 

To add notes: 

1. Move the insertion point to the scratch pad area and click. 

To use the keyboard, press the Tab key. 

Calendar displays an insertion point. 

2. Type your notes. 

3. To return to the appointment area, move the insertion point. To use the 
keyboard, press the Tab key to move the insertion point. 

Calendar displays the notes in the scratch pad. 

Marking Dates 

You can mark dates in the Month view. For example, you can mark dates of 
special occasions. 

Marking a Date 

To mark a date in the Month view: 

1. Point to the date you want to mark and click, or press the arrow keys to 
move to the date. 

2. Select the Mark command from the Options menu. 

Calendar puts a small box around the number. 
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Unmarking a Date 

When a marked date is highlighted, the Mark command from the Options 
menu has a check mark next to it. 

To unmark a marked date: 

1. Select the date you want to unmark. 

2. Select the Mark command from the Options menu. 

Calendar removes the box around the number. 

Working With Calendar Files 

With commands from the File menu in the Calendar window, you can: 

• Open a file 

• View files in other directories 

• Save a file 

• Print a file 

• Remove appointment dates 

You delete Calendar files with commands from the File menu in the MS-DOS 
Executive window. 

Opening a File 

You can have many different Calendar files. For example, you can have two 
files to record two different people's appointments. 

Opening a New File 

To create a new calendar file, use the New command from the File menu. 
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Opening an Existing File 

You can open an existing file from either the Calendar window or from the 
MS-DOS Executive window. 

To open an existing file with the Open command: 

1. Select the Open command from the File menu. 

Calendar displays the Open dialog box. Directories and drives are 
enclosed in brackets. Figure 20-3 shows the Open dialog box. 

File naMl!: 

I Open] 

Cancel 

Figure 20-3 Open Dialog Box 

2. From the list of file names, select the file name you want to open, or 
type a path name and a file name in the text box at the top of the 
dialog box. 

You can also double-click on the file name you want to open. 

3. Select the Open command button. 

Calendar opens the specified file. 

To open an existing file from the MS-DOS Executive window, double-click on 
the file name you want to open or select the file name and press the Return 
key. Usually, these files have the file extension .CAL. 

MS-Windows starts Calendar and opens the file you selected in the MS-DOS 
Executive window. 
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Viewing Files in Other Directories 

Initially, Calendar displays only the names of the calendar files as well as 
drives and directories. You can view files, other than calendar files, in other 
directories or drives. 

To view files in other directories: 

1. Select the Open command from the File menu. 

Calendar displays the Open dialog box. 

2. In the text box, type the directory, drive, or file name you want to read. 
For example, you can type' .TXT to list all the files having the file 
extension .TXT. 

To move between directories, you can also double-click on the drive 
letter symbols, the directories, or the [ .. ] symbol. 

3. Select the Open command. 

Calendar lists the specified files. The Open dialog box remains on the 
screen until you open a specific file or cancel the command. 

Saving a File 

When you create a new file, or when you finish editing a file, you can save it 
and open it later. To save a command file, use one of two commands from 
the File menu: 

• Save As - Saves and names a new file 

• Save - Saves a current file 
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Saving a New File 

The Save As command names and saves a new file. It can also save the cur· 
rent file under a new file name and retain the original copy of the file on the 
disk under the old file name. 

To save a new file: 

1. Select the Save As command from the File menu. 

Calendar displays the Save As dialog box. Figure 20·4 shows the Save As 
dialog box. 

Saue file as: C: \lIindows 
..... IJOH=HS=ON:-::------,It Saue ] 

(Cancel ) 

Figure 20-4 Save As Dialog Box 

2. Type a file name for the file. If you do not type an file extension, 
Calendar adds .CAL to the file name. 

3. Select the Save command button. 

Calendar saves the file on the disk. The file remains on the screen so 
that you can continue editing it. Calendar displays the name of the file 
in the title bar of the Calendar window. 

NOTE 
If you type the name of a file that already exists, Calendar asks if 
you want to replace the existing file with the file you are saving. 
To replace the existing file, select the Yes command button. 
Otherwise, select the No command button and type a different file 
name. 
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Saving Changes 

To save changes to the current file, use the Save command from the File 
menu. 

Calendar replaces the file on the disk with the current file. 

Printing Appointments 

To print appointments: 

1. Select the Print command from the File menu. 

Calendar displays the Print dialog box. Figure 20-5 shows the Print dia
log box. 

Print Appointments 

F r 0111: IlrMI,,:r;1 ( Ok ) 
To: ( Cancel) 

Figure 20-5 Print Dialog Box 

2. In the From text box, type the first date you want to print. 

3. Press the Tab key to move the cursor to the To text box. 

4. Type the last date you want to print. 

To print a single date's appointments, leave the To text box blank. 

5. Select the Ok command button. 

Calendar prints the text for the selected dates. 
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Removing Appointment Dates 

You can delete a single date or a range of dates to make room for other dates 
on your disk. 

To remove appointment dates: 

1. Select the Remove command from the File menu. 

Calendar displays the Remove dialog box. Figure 20-6 shows the 
Remove dialog box. 

Re",ove Appoint",ents 

Fro",: Inm I ( Ok ) 

To: '--_---'I (Cancd) 

Figure 20-6 Remove Dialog Box 

2. In the From text box, type the first date you want to remove. 

3. In the To text box, type the last date you want to remove. 

To remove a single date's appointments, leave the To text box blank. 

4. Select the Ok command button. 

Calendar removes the text for the dates you selected. 

Deleting a File 

You can delete a file to make room for other files on your disk. To delete a 
file, use the Delete command from the File menu. 
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Chapter 21 
Using Calculator 

The MS-Windows Calculator is a desktop application that works as a hand
held calculator. It has many basic arithmetic functions and a memory. 

This chapter describes how to: 

• Start Calculator 

• Use Calculator 

Starting Calculator 

To start Calculator when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Calculator: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

CALC 

3. Select the Ok command button. 
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When you start Calculator, it creates a window with a calculator in it. Figure 
21-1 shows the Calculator window. 

Figure 21-1 Calculator Window 
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Using Calculator 

Calculator performs standard calculations. It also has access to the Clipboard. 

To use Calculator, point to the keys in the Calculator window and click. 

To use the keyboard, use the keys shown in Figure 21-2. You can type the 
digits 0 through 9 and the plus, minus, multiplication, division, and equal 
signs on the keyboard or on the numeric keypad. If you use the numeric 
keypad, the Num Lock key must be enabled. 

M and C 

M and R 

M and + 

M and-

Q 

% 

C 

Figure 21-2 Using Calculator With the Keyboard 

Using the Memory 

Calculator has its own memory, which initially is set to zero. You can add to 
or subtract from this value. You can also display or clear the memory. Table 
21-1 shows the mouse and keyboard procedures for using memory. 

Table 21-1 Using Memory With the Mouse and Keyboard 

To... With the Mouse ... 

Clear the memory Click on MC 

Display the value in memory Click on MR 

Add the displayed value to mem- Click on M+ 
ory 

Subtract the displayed value Click on M-
from memory 

With the Keyboard ... 

Press MjC 

Press MjR 

Press Mj+ 

Press Mj-
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Using the Clipboard 

You can use the Clipboard to copy numbers from other applications into the 
Calculator display, and from the Calculator display into other applications. 

Copying to the Clipboard 

To copy the displayed value to the Clipboard, use the Copy command from 
the Edit menu. 

Calculator copies the displayed value to the Clipboard. 

Copying from the Clipboard 

To add data from the Clipboard to the displayed Calculator value, use the 
Paste command from the Edit menu. 

To use the keyboard, press the Ins key. 

Calculator adds the data from the Clipboard to the displayed Calculator 
value. If the Clipboard does not contain a number, Calculator does nothing. 
If the Clipboard contains a formula, that is, a legitimate series of calculatory 
entries such as 2X3-4, Calculator pastes the result of the formula. 
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Chapter 22 
Using Clock 

The MS-Windows Clock is a desktop application that acts as a standard clock 
and shows the current time. 

This chapter describes how to: 

• Start Clock 

• Set Clock 

Starting Clock 

To start Clock when it is neither in a window nor set aside as an icon in the 
icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Clock: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

L 

3. Select the Ok command button. 
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When you start Clock, it displays a window that contains a clock. Figure 22-1 
shows the Clock window. 

- Clock :I 

•• • 

• • 

• • 

• • 
•• 

Figure 22-1 Clock Window 

Setting the Clock 

Clock displays the time from your hardware clock or the time you entered 
when you started your workstation. You can reset the Clock from the Control 
Panel. 

Clock continues to show the correct time even if you shrink it into an icon. 
When Clock is an icon, you can display the current time without using any 
of the screen's workspace. 
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Chapter 23 
Using Reversi 

MS-Windows Reversi is a desktop application that is a game you play with 
your workstation. To win Reversi, you try to finish the game with more 
squares of your color on the board than the workstation has of its color. 

This chapter describes how to: 

• Start Reversi 

• Follow the rules of Reversi 

• Play Reversi 

• Use Reversi's hints 

• Start a new game of Reversi 

Starting Reversi 

To start Reversi when it is neither in a window nor set aside as an icon in the 
icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start Reversi: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

EIJE!?SI 
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3. Select the Ok command button. 

When you start Reversi, it displays a window that contains the Reversi game. 
Figure 23-1 shows the Reversi window. 

E3 Revel'si • 

Figure 23-1 Reversi Window 

With a black and white screen, your squares are white; the workstation's 
squares are black. The following sections describe how to play Reversi using 
the black and white screen. 

Rules of the Game 

The rules of Reversi are: 

• You try to turn black squares white by trapping them between two 
white squares. To trap a black square, the three squares must form a 
straight line: horizontal, vertical, or diagonal. 

• If you can trap a black square, you must do so. 

• If you cannot move, select the Pass command from the Game menu. 

• When neither you nor the workstation can move, the game is over. 

The one with the most squares wins. 
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Playing Reversi 

To play Reversi: 

1. Select one of the four skill levels from the Skill menu. 

Skill levels range from Beginner, the easiest, to Master, the hardest. The 
higher the skill level, the longer your workstation spends calculating its 
moves. 

2. Point or press the arrow keys to move to a gray square. 

The mouse cursor displays as a cross when you can make a move. 

3. Click on the mouse button or press the spacebar to make your move. 

4. Wait for the workstation to make its move. 

The mouse cursor may change to an hourglass while the workstation 
calculates its move. 

Reversi Hints 

You can ask Reversi for hints. When you use the Hint command from the 
Game menu, Reversi shows you where it would move if it had your turn. 
You can accept the hint or move somewhere else. 

Starting a New Game 

You can start a new game at any time, even in the middle of the current 
game. 

To start a new game, use the New command from the Game menu. 
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Chapter 24 
Introducing MS-Paint 

This chapter describes: 

• MS-Paint 

• Preliminary information 

• Paint definitions 

Defining MS-Paint 

MS-Paint is a drawing tool designed for use with MS-Windows. With MS-Paint, 
you can create, enhance, save, and print artwork. 

MS-Paint helps you create art that best suits your needs. Whether you create 
flow charts or freehand illustrations, you can find all the tools you need on 
MS-Paint's tools and shapes palette. Special commands such as Zoom In, 
Copy, and Invert let you enhance your work. You can transfer text and graph
ics from other programs to MS-Paint for alteration and enhancement, or cre
ate MS-Paint graphics to use in other applications such as Cardfile. 

You don't need to memorize complex commands or instructions. With MS
Paint, you can create art quickly. Although MS-Paint is designed for use with 
a mouse, you can use it with the keyboard. For more information on using 
the keyboard, see Appendix F. 

Preliminaries 

Before using MS-Paint, you should become familiar with your workstation, its 
operating system, and MS-Windows. 
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Definitions 

The following definitions are helpful for learning MS-Paint: 

• The canvas is the area available for a drawing. It matches the maximum 
printable surface area of your printer or display device. Figure 24-1 
shows an MS-Paint canvas for a printer in portrait mode. 
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Paint - HORSU1SP' v • 

_______ 1 ______ _ 

Icanvas 
Figure 24-1 MS-Paint Canvas 

Figure 24-2 shows an MS-Paint canvas that is displayed on your screen. 
This canvas is called the MS-Paint window. 
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Current status box 
Tool 

i Paint pattern 

i I Tools and shapes palette 

Brush shape 
Drawing window 

Punt - HORSE.MS 

I 
Title. bar 

I Menu bar 
i 

I l--~ 

Figure 24-2 MS-Paint Window 

• The drawing window frames the portion of a canvas that is displayed on 
the screen. 

• The title bar contains the title of your canvas. 

• The menu bar contains the names of MS-Paint's command menus. 

• The tools and shapes palette contains the implements for drawing and 
refining your artwork. 

• The current status box shows the tool, paint pattern, brush shape, and 
line width that MS-Paint uses when you draw. 

• The mouse cursor selects menus, commands, tools, and shapes. The 
mouse cursor changes shape in the drawing area whenever you select a 
tool or a shape. 
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Chapter 25 
MS-Paint Tools 

and Shapes Summary 

This chapter describes: 

• The functions of MS-Paint's tools 

• The functions of MS-Paint's shapes 

This chapter shows the icons for the tools and shapes that are located in the 
tools and shapes palette. You use these icons to follow the procedures in 
Chapter 26 and Chapter 27. 
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Tools 

~ Selection 
U Rectangle 

Defines a rectangular area 
for editing. . ... .. 

l 
I" 1 Selection 

Net 

Defines a nonrectangular 
area for editing. /~ 

. /r'l,~ .... 
,L.J . 
"-----------/ 

ITI Text 

Enters text in the selected 
font, size, and style. 

~ ANTIQUE 
TOY 

COMPANY 

I~I Fill 

Fills an enclosed area with 
the current pattern. 

25-2 

1+1 Scroll 

Slides the canvas under the 
drawing window. 

rn Pencil 

Draws a thin line . 

Eraser 

Erases the features of a draw
ing along the pointer path. 

1001 Curve 

Creates a curved line. 

Vl 
L-J Line 1"-."/ ... 
I_f ! Brush 

Paints in the current pattern. 

[i] 3-D 

Displays axes to follow when 
creating 3-D drawings. 

1 fi:'1 Airbrush 

Sprays paint in the current 
pattern. 



Shapes 

IDI Box 

Draws a box with square 
corners. 

1 0 1 Rounded 
Box 

Draws a box with rounded 
corners. ~/1I1I1I1I1I1I1I1/1/l11I1"1J1I1I/~ 

~ - -"". ~ 
~11""I""I""""t"/j 

101 Circle 

Draws a circle. 

-:-

MS-Paint Tools and Shapes Summary IIIII 

10 1 Oval 

Draws an oval. 

-:-(~n 

Gl:!-0 
rcr Freehand 
~ Polygon 

Draws shapes that are closed 
with a straight line upon 
release of the mouse button. 

16.1 Polygon 

Draws a polygon. 
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Chapter 26 
Getting Started 
With MS-Paint 

This chapter contains the information you need to: 

• Start MS-Paint 

• Draw with MS-Paint 

• Save a canvas 

• Use MS-Paint's palettes 

• Print a canvas 

• Finish MS-Paint 

Starting MS-Paint 

To start MS-Paint when it is neither in a window nor set aside as an icon in 
the icon area, you must start it from its file name. 

You use the MS-DOS Executive window, which is available either as an icon 
or in a window. If it is not a window, you must first expand its icon into a 
window. 

To start MS-Paint: 

1. Select the Run command from the File menu in the MS-DOS Executive 
window. 

The MS-DOS Executive window displays a dialog box. 

2. Type: 

p~\ I NT 
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3. Select the Ok command button. 

MS-Paint creates an untitled canvas and opens the drawing window 
over it. 

Before you begin drawing, if you intend to print your canvas, select the For 
Printer command from the Options menu. If this command is not selected, 
you will not be able to print any of your screens. The canvas is intended for 
the printer that is the default when you create the canvas. 

You can print on other printers, but the output may look different. 

Select the For Screen command from the Options menu if you have no 
printer, no printer is selected, you only want to display the drawing, or you 
want to transfer the canvas to other MS-Windows applications. 

Once you select a For Printer or For Screen command, you cannot change the 
setting unless you use the New command from the File menu. 

Drawing 

You draw by selecting the drawing tools from the tools and shapes palette. 
The default tool, the Pencil, draws thin lines for sketches. The Brush paints 
an area with the current pattern. You erase segments of your drawing with 
the Eraser. 
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Drawing With the Pencil 

To use the Pencil: 

1. Select the Pencil from the tools and shapes palette if it is not the cur
rent tool. 

The Pencil is displayed in the current tool status box. 

2. Drag the Pencil within the drawing window to sketch. 

Figure 26-1 shows an example of the Pencil drawing Old Man Winter. 

Pencil cursor 

Figure 26-1 Drawing With the Pencil 
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Drawing With the Brush 

To draw with the Brush: 

1. Select the Brush from the tools and shapes palette. 

The Brush is displayed in the current tool status box. 

2. Drag the mouse cursor within the drawing window to draw. 

Figure 26-2 shows an example of the Brush giving Old Man Winter dark hair. 

Brush cursor 

Figure 26-2 Drawing With the Brush 
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Using the Eraser 

You erase mistakes and parts of the drawing that you no longer want with the 
Eraser. 

To use the Eraser: 

1. Select the Eraser from the tools and shapes palette. 

The Eraser is displayed in the current status box. 

2. Drag the mouse cursor within the drawing window to erase. 

Figure 26-3 shows the Eraser erasing some of Old Man Winter's hair. 

Eraser cursor 

Figure 26-3 Using the Eraser 
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Saving a Canvas 

The Save As command saves the contents of your canvas. 

To save your canvas: 

1. Select the Save As command from the File menu. 

A dialog box prompts you to name your canvas. The text box is empty 
when your canvas is untitled. 

Figure 26-4 shows the Save As dialog box. 

Save File As: C:\windows 

I I ( $iIVi! ) 

(Cancel ) 

Text box 

Insertion p oint 

Figure 26-4 Save As Dialog Box 

2. Type a name for your canvas. MS-Paint adds the file extension .MSP if 
you don't provide one. 

3. Select the Save command button. 

MS-Paint writes the contents of your canvas to your disk. 

Once you have created MS-Paint files that have the file extension .MSP, you 
can start MS-Paint by double-clicking on the file name in the MS-DOS Execu
tive window. This loads both MS-Paint and the file. 
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Using MS-Paint's Palettes 

To specify patterns, line widths, and brush shapes in MS-Paint, select options 
from the Palette menu. 

For example, to change the current MS-Paint pattern: 

1. Select the Patterns command from the Palette menu. 

The pattern palette is displayed in the drawing window and highlights 
the current pattern. 

Figure 26-5 shows the patterns palette. 

PaInt - (untitled) • 

•••• ~mmDrm~ 
D r:::::::l~r71717IrTTlrmlWiJ~m 

I.:.:w:JliiiiiiiiaiJrlULiJWI.U.I~ll..lJI~ 

•• mm[!]D~~ LW 
D[]]§§Drltl~ 1m 

Patterns palette Current pattern 

Figure 26-5 Patterns Palette 

2. Select the pattern you want. 

The pattern palette vanishes, and the new pattern is displayed in the 
current pattern status box. 

Once a palette is displayed on the screen, you must make a selection before 
you can return to your canvas. If you decide not to change the selection, 
select the item currently highlighted. 
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Printing a Canvas 

To print an MS-Paint canvas: 

• Your primer must be connected and turned on. 

• The For Printer command from the Options menu must be selected 
when you start MS-Paint, indicating that the printer is connected. 

To print your canvas, select the Print command from the File menu. MS-Paint 
prints the canvas on the printer. 

Finishing MS-Paint 

The System menu's Close command finishes an MS-Paint session and closes 
the drawing window. 

To finish an MS-Paint session: 

1. Select the Close command from the System menu. 

If your canvas has changed, MS-Paint displays a dialog box. 

2. Specify whether you want to save the changes before quitting. 

When MS-Paint quits, you are returned to the applications directory in MS
Windows. 
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Chapter 27 
Creating a Drawing 

This.chapter describes how to: 

• Add shapes, text, and patterns to your canvas 

• Use MS-Paint's selection tools 

• Use several of MS-Paint's editing commands 

Drawing a Box 

To draw a box: 

1. Select the Box tool from the tools and shapes palette. 

The Box is displayed in the current status box. 

2. Point to the drawing window. 

The mouse cursor is displayed as a cross. 

3. Hold down the mouse button to mark a corner, then drag the cross 
diagonally to create the box. 
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Figure 27-1 shows a box with the Box mouse cursor. 

I 
-I-

I Box cursor 

Figure 27-1 Box 

Drawing Other Shapes 

Table 27-1 describes how to use the tools that draw other shapes. 

Table 27-1 Tools for Drawing Shapes and How to Use Them 

Tool 

Line 

3-D 

Curve 

Airbrush 

Rounded Box, 
Circle, Oval 

Freehand 
Polygon 

Polygon 
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Procedure 

Drag to draw straight line segments. 

Drag along the axes that create shapes with a three-dimensional ap
pearance. 

Draw a line segment, then click to the side of it. MS-Paint turns the 
segment into a curve. 

Drag to spray paint in the current pattern. 

Drag to draw the shape. 

Drag to draw. MS-Paint closes the image with a straight line when 
you release the mouse button. 

Click to mark the corners of the image. MS-Paint draws the lines. 
Double-click on the final corner. 
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Adding Text 

The Text tool adds text to a drawing. The text's display is determined by the 
selected commands from the Font and FontSize menus. 

To add text: 

1. Select the Text tool from the tools and shapes palette. 

The Text tool is displayed in the current tool status box. 

2. Point to the drawing window. 

3. Click to mark where you want your text to begin. 

4. Type the desired text. 

Figure 27-2 shows the heading LEGEND, which labels a legend box. 

LEGEND 

Figure 27-2 Box with Text 
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Adding Patterns 

The Fill and Filled Box tools add symbolic patterns to a drawing. 

Drawing a Filled Box 

To create a filled box: 

1. Select the Patterns command from the Palette menu. 

2. Select a pattern for the filled box. 

The pattern is displayed in the current status box. 

3. Select the Filled Box tool from the tools and shapes palette. 

The Filled Box is displayed in the current status box. 

4. Draw a box. 

The pattern fills the box when you release the mouse button. 

Figure 27-3 shows a filled box that is drawn and labeled to represent rain. 

LEGEND 

Wjrain 

Figure 27-3 Filled Box 
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Filling a Shape 

To fill a shape: 

1. Select the Patterns command from the Palette menu. 

2. Select a pattern to fill the shape. 

The pattern is displayed in the current status box. 

3. Select a tool from the tools and shapes palette to draw the shape. For 
example, you can select the Box or the Polygon tools. 

The tool is displayed in the current status box. 

4. Draw a shape. 

5. Select the fill tool from the tools and shapes palette, place the tip of 
the pouring paint in the empty shape, and click on the mouse. 

The pattern fills the shape when you release the mouse button. 

Figure 27-4 shows a box that is labeled and filled to represent hail. 

Fill cursor 

LEGEND 

hail 

Figure 27-4 Filling a Shape 
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Editing a Selection 

You can edit a selection of a drawing. The following sections describe how 
to select part of a drawing, and how to edit with special effects and in detail. 

Making a Selection 

To edit a drawing, you must define areas of your canvas with the Selection 
Rectangle and the Selection Net tools. 

To select an area of a drawing: 

1. Select the Selection Rectangle tool or the Selection Net tool from the 
tools and shapes palette. 

2. Drag the cursor to enclose a selection of your drawing. 

The selected area is enclosed within a box if you are using the Selection 
Rectangle tool. The selected area is enclosed within a net if you are 
using the Selection Net tool. 

Figure 27-5 shows a selected butterfly wing . 

. ________ .l ~~I_ection rectangle 

I ' 
....... - ........ - ...... I ~I:! 

LI. 

Figure 27-5 Selection Rectangle 
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Copying a Selection 

Once you select an area of the canvas, you can copy it to the Clipboard, 
leaving the original still displayed. After you paste the area back to the can
vas, you can move it to where you want. 

To copy a selection: 

1. Select the Copy command from the Edit menu. 

The selected area is copied to the Clipboard. 

2. Select the Paste command from the Edit menu. 

The Clipboard contents are copied to the canvas inside a Selection 
Rectangle. 

The mouse cursor changes to an arrow, indicating that you can drag the 
selection. 

3. Drag the Selection Rectangle inside the drawing window, then release 
the mouse button. 

Editing With Special Effects 

The special effects commands from the Edit menu enhance a selected area of 
your drawing. 

For example, the Flip Horizontal command mirrors the selected area. For 
descriptions of other special effects commands, see Chapter 26. 

To mirror and paste a selection: 

1. Select an area or object. 

2. Select the Flip Horizontal command from the Edit menu. 

The selected area, still enclosed in the Selection Rectangle, flips from 
left to right. 

3. Drag the selected area into position. 

4. Move the cursor out of the Selection Rectangle, then click the mouse 
button. 

The Selection Rectangle disappears, and the copy is pasted to your 
canvas. 
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IIIII Creating a Drawing 

Figure 27-6 shows a butterfly wing that is selected and mirrored. 

Click the mouse button outside the Selection Rectangle to paste the copied 
wing in place. 

Selected wing after Flip Horizontal 

S""t~~ ~;-"-g-h ____ ~~~~:~~ __ 
: : I : 1 
, : 1 'I 

: I I 
: 1 1 
: I I 
: I 1 

- ..... -;1 1 
: 1 1 

'_ - - - - - - - - - - - - _: 1 , I 
I .......................... _I 

Figure 27-6 Results of the Flip Horizontal Command 

Editing in Detail 

To perform detailed editing on a part of your drawing, use the Zoom In 
command and the Pencil. 

To edit a drawing in detail: 

1. Select the Pencil, then click to mark where you want to edit. 

The Pencil makes a mark at the point where you click. 

The mark is white if you click on a black area; it is black if you click 
on a white area. 

2. Select the Zoom In command from the Options menu. 

MS-Paint zooms in to where you last released the mouse button. This 
view of the screen is called a zoomed-in drawing window. 
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3. Click to remove or add paint. Drag to make larger changes. 

The results of your editing appear in the upper-left corner of your 
canvas. 

Figure 27-7 shows an example of editing in detail. 

Zoomed-in drawing window 

Palnt - CPBUTTER.t-1SP • 

Figure 27-7 Editing in Detail 

4. When you are finished editing, select the Zoom Out command from the 
Options menu. 

The regular drawing window is displayed again. 
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Scrolling the Canvas 

The Scroll tool can: 

• Move the canvas under the drawing window 

• Copy a selected area of a drawing to another part of the canvas 

To scroll to a lower area of a canvas: 

1. Select the Scroll tool from the tools and shapes palette and move the 
tool to the bottom of the drawing window. 

2. Drag the Scroll pointer upward. 

The original area of the canvas scrolls up as the lower part of the canvas 
is displayed. 

The mouse cursor is displayed whenever MS-Paint adjusts the window 
display. 

Figure 27-8 shows a butterfly that is scrolled to reveal the lower part of the 
canvas. 

I Scroll cursor 

Figure 27-8 Scrolling the Canvas 
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Chapter 28 
MS-Paint 

Command Summary 

The MS-Paint commands that help you create, illustrate, and edit your can
vasses are displayed in menus. You access menus through the menu bar near 
the top of the MS-Paint window. 

This chapter describes the command menus in the order they are displayed 
in the menu bar: 

• File 

• Edit 

• Font 

• FontSize 

• Style 

• Palette 

• Options 

File Menu 

The File menu commands create, save, and print your canvasses. Figure 28-1 
shows the File menu commands. Table 28-1 describes the commands. 
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tiew 
Open. 
Save 
Saue As. 
Pt·int 

Figure 28-1 File Menu 

Table 28-1 File Menu Commands and Descriptions 

Command Description 

New Clears the drawing window, then opens a new canvas. The status of 
the selected tool, pattern, brush shape, and line width is 
unchanged. 

Open Opens the drawing window over a previously created canvas. The 
status of the selected tool, pattern, brush shape, and line width is 
unchanged. 

Save 

Save As 

Print 

A dialog box prompts you to either select a title from the list box 
or type the title of the canvas you want. 

Saves the current canvas on disk under the existing name. This 
command prompts you for a name if the file is untitled. 

Saves the current canvas on disk. You can save either new, untitled 
canvasses or a new version of a canvas under a different name. The 
original version remains unchanged. 

Prints the canvas. The Print command is disabled if you have not 
installed a printer through the Set-Up program or on the Control 
Panel, or if you selected the For Screen command from the Options 
menu. 

Both the Open and New commands let you save any changes to the current 
canvas before proceeding. 
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Edit Menu 

The Edit menu commands let you edit a canvas. Figure 28-2 shows the Edit 
menu commands. Table 28-2 describes the commands . 

Undo . "'1 1 

,~:r"': !~.~;: 

ErCS2 

Cut 7~ : 

:}~ t 
Copy F:;? 

• b .... 

PCSt2 l Y·I~ 
.. ~: .~A 

Cl2cr 

I ilV2rt 
TrCC2 Ed92S 
F lip Horizontcl 
F lip V2rt; co l 

Figure 28-2 Edit Menu 

Except for the Erase, Undo, and Paste commands, all of the Edit menu com
mands require that you first select what you want to edit. The Selection 
Rectangle or the Selection Net tools select an area. The Paste command is 
disabled if the Clipboard is empty. 
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Several commands in the Edit menu are disabled until you select an area for 
editing. 

Table 28·2 Edit Menu Commands and Descriptions 

Command Description 

Undo Cancels the most recent drawing action or series of editing actions 
performed on a selected area. Selecting Undo a second time restores 
these actions. 

Erase Erases the contents of the drawing window. 

Cut 

Copy 

Paste 

Clear 

Invert 

Trace Edges 

Flip 
Horizontal 

Flip Vertical 

28-4 

You can also double-click on the Eraser to erase the drawing 
window. 

Removes selected material from the canvas, and places it on the 
Clipboard. 

Copies selected material to the Clipboard. 

Copies the Clipboard contents into a selection box on the drawing 
window. The items you paste remain selected (and movable) until 
you click outside the selected area, make another selection with the 
Selection Rectangle or the Selection Net, or begin to draw again. 

You can paste the contents of the Clipboard as many times as YOll 

want. 

Erases the selected item from the drawing window. 

Ch'lnges the appearance of the selected area. This command 
changes a black area to white, and a white area to black. 

Traces the edges of the patterns, text, and shapes within a selected 
area. This command acts on selections made with the Selection Rec
tangle tool. 

Flips the selected area from left to right. This command acts on 
selections made with the Selection Rectangle tool. 

Flips the selected area from top to bottom. This command acts on 
selections made with the Selection Rectangle tool. 
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Font Menu 

The Font menu contains the commands that select the text typeface. The Font 
menu commands vary according to the fonts installed for your system. 

You can change the typeface of a text sequence until you click again within 
the drawing window or select another tool. 

FontSize Menu 

The FontSize menu sets the size of your text. The FontSize menu commands 
vary according to the font sizes installed for your system. 

You can change the font size of a text sequence until you click again within 
the drawing window or select another tool. 

Style Menu 

The Style menu commands modify the appearance of text. Figure 28-3 shows 
the Style menu commands. Figure 28-4 shows the Style menu typefaces. 
Table 28-3 describes the other Style menu commands. 

Plain is the default typeface. 

You can change the style of a text sequence until you click again within the 
drawing window or select another tool. 
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28-6 

I" Plain 
Bold 
Italic 
Underline 
Outline 
Strikeout 

"Align left 
Align center 
Align right 

" Opaque 
Tt'anspat'ent 

FS 
F6 
F7 
F8 

Figure 28-3 Style Menu 

Plain Unaerline 

Bold 

Italic StriKee~t 
Figure 28-4 Style Menu Typefaces 
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Table 28-3 Style Menu Commands and Descriptions 

Command 

Align Left 

Align Center 

Align Right 

Opaque 

Transparent 

Description 

Aligns rows of text using an invisible column in the drawing 
window as a left margin. Your text moves to the right as you type. 
This is a default setting. 

Click on the text pointer to mark the location of the invisible 
column. 

Centers text evenly on both sides of the invisible column. 

Aligns text using the column as a right margin. Your text moves to 
the left as you type. 

Provides a solid white background for text. This is a default setting. 

Lets the current background pattern show through text. 

Figure 28-5 shows examples of the Align Left, Align Center, and Align Right 
commands. 

I Invisible column 

I 

~lignea left 
I 

. I 

al1gne~ center 
I 

alignea right 
I 

1 

I Text cursor 

Figure 28-5 Example Align Commands 
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Palette Menu 

The Palette menu commands select: 

• Paint patterns 

• Line widths for shapes 

• Brush shapes 

Figure 28-6 shows the Palette menu commands. 

Pcttl2rns . .. . 
Linl2 Widths .. . 
Brush Shcp~s .. . 
Too ls . .. 

Figure 28-6 Palette Menu 

The Tools command selects MS-Paint's tools when they are concealed by 
another drawing window. 
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Options Menu 

The Options menu commands: 

• Control the alignment and placement of your drawings, 

• Edit with greater detail 

• Enhance the display of patterns in the patterns palette for the current 
session 

Figure 28-7 shows the Options menu commands. Table 28-4 describes the 
commands. 

ZOOM In .~? 

ZOOM Out " ,., 
: '.) 

vNo Grid 
FinQ Grid 
MCldiuM Grid 
CocrsCl Grid 

Edit PClttClrn . .. 
", p}'"1 n';~ ~( .. :" :;;r' 
r· ~;t S:::t·~~n 

Figure 28-7 Options Menu 
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Table 28-4 Options Menu Commands and Descriptions 

Command Description 

Zoom In Zooms in on your canvas at the point where you last released the 
mouse button. Zoom In also returns a zoomed-out drawing window 
to its normal size. 

Zoom Out 

No Grid 

Fine Grid, 
Medium Grid, 
Coarse Grid 

Edit Pattern 

For Printer 

For Screen 
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MS-Paint's zoomed-in drawing window has a view finder in the 
upper-left corner. You view the effects of magnified editing on your 
canvas in this area. 

You can also double-click on the Pencil to zoom in or return from a 
zoomed-in drawing window to the normal drawing window. 

Displays the entire canvas with the current drawing window 
outlined. Zoom Out also returns a zoomed-in drawing window to its 
normal size. 

You can also double-click on the Scroll tool to zoom out to the full 
canvas or return from the full canvas to the normal drawing 
window. 

Turns off any active grid. This is the default setting. 

Lay an invisible grid on the drawing window. These commands let 
you align shapes and lines. 

Opens a dialog box to allow revision of the current MS-Paint 
pattern. 

Informs MS-Paint that the canvas is targeted for the default 
MS-Windows printer. 

Informs MS-Paint that the canvas is targeted for the screen. 
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list box 1- 1 1 
option buttons 1-11 

keyboard procedure 6-10 
System menu box 1-12 
text box 1-10 

DlR command 32-35 
Directly Modifies option C-9 
Directories 5-1 

change listing 5-5 
changing 5-1, 5-3 
creating 5-4 
current 3-3,5-1,30-4 
defined 5-1, 30-4 
deleting 5-7 
displaying information 34-21 
displaying multiple 5-6 

Index 11111 

hierarchical 30-4 
listing 3-3,5-1,5-5 
MS-DOS Executive window 5-1 
path name 5-1 
printing listings 5-6 
printing 5-6 
root 30-4 
structure 30-4 
subdirectory 5-1 

DIRECTORY command 34-21 
Disconnecting 

from a remote directory 33-12 
from a remote printer 33-12 
from a resource 33-12 

DlSKCOPY command 32-37 
DlSKCOPY.COM 3-15 
Diskettes 5-S, H-1 

data 5-S 
formatting H-1 
preparing 5-S, 5-9 
system 5-9 
using H-1 

Disks 5-1 
displaying 5-11 
drive AS-II 
drive H 5-11 
naming 5-10 

Displaying 
disks 5-11 
multiple directories 5-6 
VT240 character attributes 16-1S 

Fast Text Only mode 16-1S 
VT240 line attributes 16-17 

Fast Text Only mode 16-17 
Text & Graphics mode 16-17 

Double-click on 
action defined 1-3 

Double-click 3-15 
rate S-5 

Drag 
action defined 1-3 

Drawing 26-2 
3-D 27-2 
box 27-1 
brush 26-4 
circle 27-2 
curve 27-2 
curves F-2 
eraser 26-5 

Index-7 
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filled box 27-4 
lines F-2, 27-2 
oval 27-2 
pencil 26-3 
polygons F-2 
rounded box 27-2 
shapes F-2 
window 24-3 

Drive icons 3-3 
Drop-down menu 1-7 
DUMP command 39-8 
Duplicate command 19-14 

E 
Early ring text box 20-6 
ECHO command 32-39 
Edit menu 18-5, 18-13, 19-10,28-3 

commands 28-3 
Clear 28-5 
Copy 28-4 
Cut 28-4 
Erase 28-4 
Flip Horizontal 28-5 
Flip Vertical 28-5 
Invert 28-5 
Paste 28-4 
special effects 28-5 
Trace Edges 28-5 

Edit Pattern command 28-11 
Editing 

a selection 27-6 
detailed 27-8 
in day view 

in Calendar 20-3 
in Notepad 18-5 
keys 36-1 
PIF C-5 
special effects 27-7 
text 

in Calendar 
in Cardfile 

EDLIN command 
Emulators 

20-4 
19-8 
32-41 

comparison table 9-2, 10-1 
ReGIS graphics 14-1 

DECgraph 14-1 
DECslide 14-1 

SETHOST command 9-1 
VT220 emulator 9-1 

Index-8 

VT240 emulator 9-1 
End key 7-5 
End Session command 3-9,3-15 
ENTER command 39-10 
Entering 

appointments in Calendar 20-3 
VT220 Set-Up 12-1 

F3 (Set-Up) 12-2 
Set-Up command 12-2 

VT240 Set-Up 16-1 
Erase command 28-4 
ERASE command 32-42 
Eraser 26-5 
ESC key 6-2, 6-5 
EXE2BIN command 32-43 
EXIT command 32-45, 34-23 
Exiting 

MS-Windows 29-5 
Set-Up selections 

Exit VT240 16-9 
standard applications 3-15 
VT220 Set-Up 12-5 
VT240 emulator 14-4 
VT240 Set-Up 16-5 
VT240 

Ctrl/FlO 15-1 
15-1 

1-3 
Exit key 

Expand defined 
Extensions section 
External commands 

B-8 

characteristics 29-1 
with MS-Windows 29-2 

F 
Fast Text Only mode 

viewing columns 
Shift/left arrow 
Shift/right arrow 

FC command 32-46 
FCBS command 1-7 

16-17 
16-17 

16-17 

FDISK command 32-49 
File menu 3-4,3-5,3-6,4-4, 18-10, 

18-12, 18-13, 18-14, 19-14, 19-16, 
19-17,26-8,28-1 

commands 3-6, 28-1 
NEW 28-2 
OPEN 28-2 
Print 28-2 
Save As 28-2 



Save 28-2 
File names 6-6 

characters in 30-8 
illegal 30-8 
keyboard procedure 6-8 

File specifications 
foreign 34-5 
remote 34-5 

FILES command 1-8 
Files 4-1 

appending 34-11 
batch 3-13 
canceling selected files 6-14 
canceling selected 4-2 
concatenating 4-6 
copying 4-4, 4-5, 4-6, 34-14 
defined 4-1 
deleting 4-6,4-7,34-20 
displaying contents 34-29 
extension 

defined 3-6 
View menu 3-8 

in Calendar 20-13 
in Cardfile 19-14 
in Notepad 18-10 
keyboard procedure 6-14 
listing 5-5 
name 7-6 
naming 4-1,30-7 
printing 4-7, 34-25 
renaming 4-12 
selecting multiple 4-2 
selecting 4-2 

keyboard procedure 6-14, 6-15 
starting the emulator 

VT240 14-2 
VT240CM1 14-2 
VT240CM2 14-2 

support 30-3 
temporary 3-13 
types of 34-6 

FILL command 39-13 
Filling a shape 27-5 
Filters 38-3 
Find command 18-9, 19-12 
FIND command 32-50 
Find dialog box 18-9, 19-12 
Find Next command 18-9, 19-12 
Finding text 

in Cardfile 19-12 
in Notepad 18-9 

Fine Grid command 28-10 
Finishing 

applications 

Index IIIII 

keyboard procedure 6-8, 6-9 
MS-DOS programs 3-15 
MS-Paint 26-8 
MS-Windows 3-15 

standard applications 7-5 
Flip Horizontal command 27-7, 28-5 
Flip Vertical command 28-5 
FONT command G-3, 32-53 
Font menu 28-5 

commands 28-5 
Fonts section B-27 
FontSize menu 28-5 

commands 28-5 
Fonts 

adding 
deleting 
device 

8-11 
8-13 

8-12 
raster 8-11 
stroke 8-11 
vector 8-11 

FOR command 32-56 
FORMAT command 32-58 
Format Data Disk command 3-9, 5-8 
Formatting 

diskettes H-1 
text 

in Cardfile 
in Notepad 

the hard disk 
Freehand polygon 

G 

19-4 
18-3 

31-9 
27-2 

Get Info command 3-6, 4-4, 4-13 
Getting help 

for NIT 34-24 
on-line information system 29-4 

GO command 39-15 
Go To command 

in Cardfile 19-7 
dialog box 19-7 

GOTO command 32-61 
GRAFTABL command G-3, 32-62 
GRAPHICS command 32-63 

Index-9 
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H 
Hard disk 

copying files to 31-10 
copying system files 31-9 
formatting 31-9 
initializing 31-6 
partition sizes 31-6 
partitioning 31-6 
preparing 31-1 
repartitioning 31-10 
setting drive type 3 1-2 
setting start-up partition 31-8 
what it is 31-1 

HELP command 34-24 
Help 

Information System 29-4 
HEX command 39-17 
Hierarchical directory structure 30-4 
High command 4-10 
Highlight l-S, 3-3 
Hints for Reversi 23-3 
Home key 7-5 
Hourglass 3-13,5-9 

I 
I/O activities 7-1 
Jcon area 3-3 
Icon command 1-7, 2-14 

keyboard procedure 6-7, 6-9 
Icons 2-14, 3-3 

expanding 7 -6 
names 2-3 
shrinking 

keyboard procedure 6-9 
standard applications 7-3 

IF command 32-66 
Illegal file names 30-S 
Image file 

see Binary file 
Index command 
Index dialog box 
Index line 

34-6 
19-7 
19-3, 19-7 

in Cardfile 19-3 
Industry standard compose 36-4 
Information System 1-4, 1-5 
Initial Directory option C-7 
Initializing hard disk 31-6 
INPUT command 39-1S 
Insertion point 

Index-IO 

in Cardfile 19-5 
in Notepad lS-5 

Installation Aid C-1 
Installation menu S-3, S-6 
Internal commands 

characteristics 29-1 
with MS-Windows 29-3 

International section B-1S 
Invert command 2S-5 

J 
JOIN command 32-68 

K 
KB Desired C-S 
KB Required C-S 
Key diskette 3-1 
KEYB command G-3,32-70 
Keyboard labels 

VT220 emulator 11-2 
VT240 emulator 15-1 

Keyboard procedure 6-1 
canceling commands 6-5 
canceling selected files 6-14 
changing window sizes 6-16 
closing applications 6-9 
commands 6-4 
copying E-1 
creating multiple copies E-1 
dialog box 6-10, 6-11 

closing 6-11 
features 6-1 
finishing applications 6-S 
loading applications 6-6 
menus 6-4 
moving windows 6-17 
multiple windows 6-16 
recelvmg messages 6-1S 
removing menus 6-5 
running applications 6-7, 6-S 
scrolling 6-12, E-1 

standard applications 7-4 
selecting commands 6-4 
selecting files 6-14, 6-15 
shrinking icons 6-9 
size box 6-16 
Size command 6-16 
switching windows 6-16 
transferring information 7-7 



using MS-Paint F-1 
Zoom command 6-17 

Keyboard setting command 8-20, 
8-22 

Keyboards 
country 11-1, 15-1 
VT220 emulator 11-2 
VT240 emulator 15-1 

Keys 
Alt/F11 

VT240 emulator 17-4 
Alt/F12 

VT240 emulator 17-5 
Alt/Prt Sc 7-7,7-9 
AIt/Return 6-17 
AIt/spacebar 6-2, 6-4 
AIt/Tab/Shift 6-2 
AIt/Tab 6-2,6-7,6-9,7-6 
Alt 6-2, 6-3 
Arrow/Shift 6-3 
Arrow 6-2,6-4, 6-6, 6-8, 6-10, 
6-12,6-14,7-4 

backspace A-6 
Compose A-3, A-6 
Ctrl/Arrow 6-2 
Ctrl/Break 6-2,6-11 
Ctrl E-1 
End 7-5 
ESC 6-2,6-5 
function keys 

Ctrl/F10 15-3 
Ctrl/F2 15-3 
Ctrl/F5 11-3, 15-3 
FlO (Exit) 15-3 
F11 (ESC) 11-3, 15-3 
F12 (BS) 11-3, 15-4 
F13 (LF) 11-3, 15-4 
F2 (Print Screen) 11-2, 15-3 
F3 (Set-Up) 11-3, 15-3 
F4 (data/Talk) 11-3 
F4 (Data/Talk) 15-3 
F5 (Break) 11-3, 15-3 
Shift/F2 15-3 
Shift/F5 11-3, 15-3 
VT220 emulator 11-2 
VT240 emulator 15-2 

Home 7-5 
Line feed 34-9 
Page Down (Pg Dn) 7-5 

Page Up (Pg Up) 7-4 
Return/Shift 6-3 

Index 11111 

Return 6-2,6-6,6-8,6-10,6-11 
Shift/Ctrl F-2 
Shift/Next 

VT240 emulator 16-13 
Shift/Prev 

VT240 emulator 16-13 
Shift/Tab 6-10, F-2 

L 

Shift 4-2,6-2, A-3, E-1 
Shitf/Prt Sc 6-18 
spacebar 6-2, 6-9 
Tab 6-3,6-10,8-4, F-2 
VT240 emulator 

arrow keys 16-4 
Next screen 16-4 
Previous screen 16-4 
Select 16-4 

Word Char 5-3, 6-3 

LABEL command 32-72 
LASTDRIVE command 1-9 
LCOUNTRY command G-4,32-74 
Leaving the VT220 emulator 10-4 

Close command 10-4 
Icon command 10-4 

Left mouse button 8-24 
Lines 

drawing 
List command 
Listing 

file names 

F-2 
19-20 

5-5 
remote network connections 33-8 

Load command 3-6, 3-10,6-6 
LOAD command 39-19 
Loading applications 

keyboard procedure 6-6 
Local files 

copying to a remote node 34-8, 
34-19 

providing access 34-1 
Logical devices 33-5 
Long command 3-8 
Low command 4-10 

M 
Make System Disk command 3-9, 5-9 
Making a selection 27-6 

Index-II 
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Mark command 7·7,20·12 
Marking 

information 7·7 
dates in Calendar 20·12 

Match Case command 18·9 
MDRIVE command 32·76 
Medium Grid command 28·10 
Memory Requirements option C·8 
Memory 2·2,7·1,7·10, C-2, C·8, 

C·15 
in Calculator 21·3 

Menu bar 3·3, 24·3 
Menus 

Alarm 20·6 
Card 19·5 
Control 4·10,4.11 
drop·down 1· 7 
Edit 18·5, 18·13, 19·10,28·3 
File 3·5,4·4, 18·10, 18·12, ,18·13, 

18·14, 19·14, 19·16, 19·17,26·8, 
28·1 

Font 28·5 
FontSize 28·5 
Installation 8·3, 8·6 
MS·Paint 28·1 
Options 20·10, 28·9 
Palette 26· 7, 28·8 
Preferences 8·3, 8·20 
Priority 4·10 
Search 18·9, 19·7, 19·12 
selecting 

keyboard procedure 6·4 
Setup 8·3,8·14 
Show 20·9 
Special menu 3·4 
Special 3'9 
Style 28·5 
System menu 3·4 
System 3·4, 7·7, 18·10, 19·14, 

26·8 
View menu 3·4 
View 3·7 

Merge command 19·20 
Merge dialog box 19·20 
Merging files in Cardfile 19· 20 
Messages 40·1 

applications 2·18 
MKOIR command 32·78 
MODE command 32·79 

Index· 12 

Month command 20·8 
Month view 

in Calendar 
MORE command 

20·8 
32·90, 38·3 

Mouse 
actions defined 

click 1·3 
double·click 1·3 
drag 1·3 
point 1·3 

cursor 24·3 
settings command 8·20, 8·24 

MOVE command 39·21 
Move command 1· 7 

keyboard procedure 6· 7, 6·17 
Moving 

cards in Cardfile 19· 7 
text 

in Cardfile 19·10, 19·11 
in Notepad 18·8 

through card files 19·5 
windows 2·6 

MS·DOS commands 3·14 
ANSI 32·6 
APPEND 32·7 
ASSIGN 32·9 
ATTRIB 32·11 
BACKUP 32·13 
BREAK 32·17 
CHOIR 32·18 
CHKDSK 32·19 
CLS 32·21 
COMMAND 32·22 
COPY 32·24 
CTTY 32·31 
DATE 32·32 
DEL 32·34 
OIR 32·35 
OISKCOPY 32·37 
ECHO 32~39 

EDLIN 32·41 
ERASE 32·42 
EXE2BIN 32·43 
EXIT 32·45 
FC 32·46 
FOISK 32·49 
FIND 32·50 
FONT G·3, 32·53 
FOR 32·56 



FORMAT 32-58 
GOTO 32-61 
GRAFfABL G-3, 32-62 
GRAPHICS 32-63 
IF 32-66 
JOIN 32-68 
KEYB G-3, 16-21,32-70 

VT240 emulator 16-10 
LABEL 32-72 
LCOUNTRY G-4,32-74 
MDRIVE 32-76 
MKDIR 32-78 
MODE 32-79 
MORE 32-90 
PATH 32-93 
PAUSE 32-95,37-1 
PERMIT 32-97, 33-17 
PRINT 32-98 
PROMPT 32-102 
RECOVER 32-104 
REM 32-106,37-1 
REN 32-107 
RESTORE 32-108 
RMDIR 32-110 
SELECT G-4, 32-111 
SET 32-115 
SET HOST 9-1 
SHARE 32-117 
SHIFT 32-118 
SORT G-4, 32-120 
SUBST 32-123 
SYS 32-125 
TIME 32-127 
TYPE 32-128 
VER 32-130 
VERIFY 32-131 
VOL 32-132 

MS-DOS Executive window 3-1,3-2, 
18-12, 19-16,20-14 

changing directories 5-2, 5-3 
components 3-2, 3-3 
CONTROL.EXE 8-2 
creating directories 5-4 
cursor 3-3 
deleting directories 5-7 
directories 5-1 
disk drives 5-11 
diskettes 5-8 
displaying disks 5-11 

Index IIIII 
displaying multiple directories 5-6 
drive icons 3-3 
first window 1-2 
highlight 3-3 
icon area 3-3 
icons 3-3 
listing directories 3-3 
menu bar 3-3 
naming disks 5-10 
path name 3-3,5-1 
path 3-3 
preparing disks 5-8 
printing directory listings 5-6 
scroll bars 3-3 
size box 3-3 
System menu box 3-3 
title bar 3-3 
work area 3-3 

MS-DOS operating system 3-16 
WIN.INI 

VT220 emulator 13-2 
MS-DOS programs 3-14 
MS-Paint commands 

Align Center 28-7 
Align Right 28-7 
Align 28-7 
Clear 28-5 
Coarse Grid 28-10 
Copy 27-7, 28-4 
Create 28-1 
Cut 28-4 
Edit Pattern 28-11 
Erase 28-4 
Fine Grid 28-10 
Flip Horizontal 27-7,28-5 
Flip Vertical 28-5 
Invert 28-5 
Medium Grid 28-10 
New 28-2 
No Grid 28-10 
Opaque 28-7 
Open 28-2 
Paste 27-7,28-4 
Patterns 27-4, 27-5 
Print 28-1, 28-2 
Save As 28-2 
Save 28-1,28-2 
special effects 28-5 
Trace Edges 28-5 

Index-13 
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Transparent 28-7 
Undo 28-4 
Zoom In 27-8, 28-10 
Zoom Out 27-9, 28-10 

MS-Paint 24-1,26-1 
MS-Windows commands 

About 1-7,3-4, C-3 
Add New Font 8-6, 8-11 
Add New Printer 8-6, 8-7 
All 3-8 
By Date 3-8 
By Kind 3-8 
By Name 3-8 
By Size 3-8 
Change Directory 3-9, 5-2 
Close 1-7,3-15,4-13,6-9,7-3 

VT220 emulator 10-4 
Communications Port 8-14 
Connections 8-7, 8-14 
Copy 2-17, 3-6, 4-4, 4-5, 4-6, 5-4, 

7-7, 7-8 
VT220 emulator 10-4 

Country settings 8-20, 8-25 
Create Directory 3-9, 5-4 
Cut 2-17 
Delete Font 8-6,8-13 
Delete Printer 8-6, 8-10 
Delete 3-6, 4-4, 4-6, 5-7 
End Session 3-9, 3-15 
Format Data Disk 3-9, 5-8 
Get Info 3-6, 4-4, 4-13 
High 4-10 
Icon 1-7,2-14,6-7,6-9 

VT220 emulator 10-4 
Keyboard settings 8-20, 8-22 
Load 3-6,3-10,6-6 
Long 3-8 
Low 4-10 
Make System Disk 3-9, 5-9 
Mark (-( 

VT220 emulator 10-4 
Mouse settings 8-20, 8-24 
Move 1-7,6-7,6-17 
Network Terminal Services 8-14 
New C-5 
Partial 3-8, 5-5 
Paste 2-17, 7-7, 7-8 

VT220 emulator 10-4 
Pause 4-11 

Index-14 

Print 3-6,4-4,4-7,5-6,8-15 
Printer 8-14,8-15 
Programs 3-8 
Rename 3-6, 4-4, 4-12 
Resume 4-11 
Run 3-6,3-12,3-14, 5-6,6-8,7-6, 
8-2, C-4 

configuration files 13-2 
VT220 emulator 10-2 
VT240 emulator 14-2 

Screen colors 8-20 
selecting 

keyboard procedure 6-4 
Set Volume Name 3-9, 5-10 
Short 3-8 
Size 1-7,2-9,2-12,6-16 
Terminate 4-11 
Zoom 1-7, 2-13, 2-14,6-17 

MS-Windows 3-15 
eXiting 29-5 
finishing 3-15 

standard applications 7-5 
initialization file 18-1 
MS-DOS Executive window 18-1, 

18-12, 19-1, 19-16,20-1,20-14, 
21-1,22-1,23-1 

restarting 3 -16 
returning 7-6 
using external commands with 

29-2 
using internal commands with 

29-3 
MSDOS.EXE 5-6 

N 
NAME command 39-23 
Naming files 30-7 
NET CLEAR command 33-13 
NET CONTINUE command 33-11 
NET DEFINE command 33-13 
NET HELP command 33-4 
NET LIST command 33-14 
NET PAUSE command 33-10 
NET PRINT command 33-9 
NET START LAT command 33-15 
NET TEST command 33-15 
NET TIME command 33-16 
NET USE command 33-6 
NET.EXE 3-14 



Network commands 
NET CLEAR 33·13 
NET CONTINUE 33·11 
NET DEFINE 33·13 
NET HELP 33·4 
NET LIST 33·14 
NET PAUSE 33·10 
NET PRINT 33·9 
NET START LAT 33·15 
NET TEST 33· 15 
NET TIME 33·16 
NET USE 33·6 

Network File Transfer (NFT) utility 
34·1 

Network Terminal Services command 
8·14 

Network Terminal Services 
MSNET.INI 16·13 
VT220 emulator 12·9, 12·10 
VT240 emulator 14·3, 16·10, 

16· 11 
Network 

changing drives 33·9 
connecting 3·15, 33·4 

directory 33·7 
remote printer 33· 7 
resource 33·6 

disconnecting 3· 15 
from remote directory 33· 12 
from remote printer 33· 12 
from resources 33·1 2 

listing remote connections 33·8 
logical devices 33·5 
physical devices 33·5 
printing a file 33·9 
specifying device names 33·5 
temporarily disconnecting 33· 1 0 
what a network is 33·2 

New command C·5, 18·11, 19·15, 
20·13,23·3,28·2 

NFT commands 
APPEND 34· 11 
COpy 34·14 
DELETE 34·20 
DIRECTORY 34·21 
EXIT 34·23 
HELP 34·24 
PRINT 34·25 
SET 34·26 

SHOW 34·27 
SUBMIT 34·28 
TYPE 34·29 
using 34·8 

NFT qualifiers 
/NOCONVERT 34· 7 
for COPY 34· 14 
for DELETE 34·20 
for DIRECTORY 34·21 
for HELP 34·24 
for PRINT 34·25 
for SUBMIT 34·28 

NFT 34·1 
abbreviating 

commands 34·9 
qualifiers 34·9 

exiting from 34·2, 34·23 
getting help 34·24 
starting 34·2 

Index IIIII 

using long commands 34·9 
No Grid command 28· 1 0 
Nonstream file system 34· 7 
Notepad commands 

About 18·10 
Clear 18·7 
Copy 18·5, 18·8 
Cut 18·5, 18·8 
Delete 18· 15 
Find Next 18·9 
Find 18·9 
Match Case 18·9 
New 18·11 
Open command 18· 13 
Open 18·12 
Paste 18·5, 18·8 
Print 18·15 
Save As 18·14 
Save 18·15 
Select All 18· 7 
Time/Date 18· 13 
Undo 18·7 

Notepad files 18· 1 0 
deleting 18· 15 
file size 18· 1 0 
opening files 18· 11 
opening 18· 11 
printing 18· 15 
saving changes 18· 15 
saving 18· 14 

Index· 15 



IIIII Index 

viewing IS-13 
Notepad window IS-II 
Notepad B-3 

canceling edits IS-7 
copying text IS-S 
deieting files IS-15 
deleting text IS-7 
editing IS-5 
finding text IS-9 
formatting text IS-3 
insertion point IS-5 
introducing IS-1 
moving text IS-S 
opening files IS-II 
printing files IS-15 
saving changes IS-15 
saving files IS-14 
scroll bars IS-4 
scrolling IS-4 
selecting text IS-6, IS-7 
starting IS-1 
time log file IS-13 
typing text IS-2 
viewing files IS-13 
window IS-2 

Num Lock 6-12 

o 
Opaque command 2S-7 
Open command IS-12, IS-13, 19-16, 

19-17,20-14, 20-15, 2S-2 
Open dialog box IS-12, IS-13, 

19-16, 19-17,20-14,20-15 
Opening 

files 
in Calendar 
in Cardfile 
in Notepad 

Operating system 

20-13,20-14 
19-15 
IS-II 

commands 32-1 
Options menu 20-10, 2S-9 

commands 2S-9 
Coarse Grid 2S-10 
Edit Pattern 2S-11 
Fine Grid 2S-10 
Medium Grid 2S-10 
No Grid 2S-10 
Zoom In 2S-10 
Zoom Out 2S-10 

Index-16 

OUTPUT command 39-26 

p 

Page Down (Pg Dn) key 7-5 
Page Up (Pg Up) key 7-4 
Palette menu 26-7, 2S-S 

commands 2S-S 
Palettes 26-7 
Partial command 3-S, 5-5 
Partitioning hard disk 31-6 
Pass command 23-2 
Password 34-3 
Paste command 2-17, 7-7, 7-S, lS-5, 

IS-S, 19-10, 19-11, 19-12, 19-13, 
20-5, 21-4, 27-7, 2S-4 

Pasting 2-16 
PATH command 32-93 
Path name 3-3,5-1,30-5 

changing directories 5-3 
Paths 3-3, 30-5 

used with external commands 30-7 
Patterns command 27-4, 27-5 
Patterns 

adding 27-4 
Pause command 4-11 
PAUSE command 32-95, 37-1 
PERMIT command 32-97, 33-17 
Physical devices 33-5 
Picture command 19-13 
PIF section B-13 
PIF 7-2 

changing C-l 5 
Close Window on exit option 
closing standard applications 
contents C-13 
creating C-4 
customized C-2 
default settings C-13 
defined C-l 

C-12 
7-4 

Directly Modifies Memory option 
7-10 

Directly Modifies option C-9 
editing C-S 
editor C-3 
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Appendix A 
Creating 

Alternate Characters 

This appendix describes how to: 

• Use the CtrljAlt and CtrljAltjleft-Shift key sequences with any key that 
has three or four keycap legends 

• Create characters using: 

- Three-key compose sequence 

- Two-key compose sequence 

• Alt numeric pad sequence 

With the keyboard, you can create many alternate characters and accented 
letters that do not exist as standard keys on your keyboard. This appendix 
describes how to create alternate characters and accented letters. 

Using Keys With Three or Four Legends 

Some keys on the main keyboard have three or four keycap legends. Figure 
A-I shows an example of a three legend key. 

""".f.j'''''' = f'_ # i: .4 $ 
2: 1 3 14-............• , ......... . . . 

\ ! ..... .....• . ........ . - .... -
!~ ~=:.J jV·~ ~ 1\ 

i _a_.) 1 .1.. .. _ ~ 

Figure A-I Three Legend Key 
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For more information about which country keyboards have three or four leg
end keys, see Appendix G. 

To generate the desired key legend, use CtrI/Alt or the CtrI/Alt/left-Shift key 
sequence, depending on the country keyboard: 

• Type 1 country keyboards: U.S./United Kingdom (U.K.) 

• Type 2 country keyboards: French, German, Spanish, Italian, Swiss
French, Swiss-German, and Hebrew 

• Type 3 country keyboards: Danish, Norwegian, Swedish, Finnish, and 
Canadian 

Type 1 Country Keyboards 

On Type 1 keyboards, only the 3 key has three legends. 

On the U.S. keyboard, to display the # sign, press Shift/3. To display the £ 
sign, press the CtrI/Alt/3 key sequence. 

On the U.K. keyboard, to display the £ sign, press Shift/3. To display the # 

sign, press the CtrI/Alt/3 key sequence. 

Type 2 Country Keyboards 

On Type 2 keyboards, one or more keys contain three characters; however, 
the third character is always located in the lower-right corner of the key. 

To display the third character, press CtrI/Alt and the key. 

Type 3 Keyboards 

On Type 3 keyboards, one or more keys contain three legends; some contain 
four. 

Some characters on the multilegend keys are duplicated on different keys. 
When these characters are on the right-hand side of the key, they function as 
the U.S./U.K. keyboard keys. When you run U.S. software, you can use these 
keys to simulate a U.S. keyboard. (All the other keys have their characters in 
the same position as the U.S./U.K. keyboard.) 

To display the character in the lower-right corner, press CtrI/Alt and the key. 
To display the character in the upper-right corner, press the CtrI/AIt/left
Shift sequece and the key. 

For more information about country keyboard layouts, see Appendix G. 
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Using Compose Sequences 

You can create and display alternate characters and accented letters that do 
not exist as standard keys on your keyboard by using a compose sequence. 
The compose sequence consists of typing either a three-key sequence or a 
two-key sequence. 

NOTE 
You can only create compose sequences on applications designed 
for MS-Windows. This sequence does not work for standard 
applications that run in a window. 

With the three-key sequence, you use the Compose key, located at the top 
left of your keyboard. With the two-key sequence, you do not use the Com
pose key. 

In both the three-key and the two-key sequences, to select an uppercase 
character or symbol, press the Shift key before you press the keyboard 
character. 

Table A-2 list all valid compose sequences. Different countries use different 
keyboards. Therefore, the resultant compose characters listed in column 1 
can be created in several ways, according to your keyboard: 

• Use a standard key, if available on the keyboard. 

• Use a two-key compose sequence. 

This is available only if the nons pacing diacritical mark, initiating a 
two-key compose sequence, is available on the keyboard and is defined 
by the keyboard's nationality. 

• Use a three-key compose sequence. 

This is available on all keyboards. 

You cancel a compose sequence by pressing the backspace key. 
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Using the Two-Key Compose Sequence 

The two-key sequence can be used on all keyboards having a nonspacing 
diacritical mark that initiates a two-key compose sequence. Nonspacing dia
critical marks are available on all keyboards except the U.S.jU.K. keyboards. 

The diacritical marks that initiate a two-key compose sequence vary among 
the keyboards according to the nationality of the keyboard. Only the diacriti
cal marks associated with the nationality of the keyboard initiate the two-key 
compose sequence. For example, pressing the umlaut key on a German key
board initiates a two-key compose sequence, while pressing the tilde key 
does not, even though it is on the keyboard. This is because the umlaut is a 
German language diacritical while the tilde is not. To see which diacritical 
marks are available according to the keyboard's nationality, see Appendix G. 

Table A-2 lists all valid two-key compose sequences. 

To use the two-key compose sequence: 

1. Locate in Column 1 of Table A-2 the character you want to create and 
verify from Column 2 that the character can be created using the two
key sequence. 

2. Press the nonspacing key with the diacritical mark shown in Column 2. 

This is not displayed on the screen. 

3. Type the second character shown in Column 2. 

The composed character is displayed. 

The characters in a two-key compose sequence must by typed in the order 
shown in Table A-2. 

If you type an invalid compose sequence, the keyboard bell rings once, and 
the compose sequence is terminated. Check the table carefully and repeat 
the steps to compose a character. 
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Using the Three-Key Compose Sequence 

The three-key sequence can be used on all keyboards. Table A-2 lists all valid 
three-key compose sequences. 

To use a three-key sequence: 

1. Locate the character you want to create in Column 1 of Table A-2. 

2. Press the Compose key. 

3. Type the two characters from Column 3 that correspond to the charac
ter you want to create. 

The characters you type after pressing the Compose key are not dis
played. After you type the two characters, the composed character is 
displayed at the cursor. 

Output characters are case dependent. 

The order in which you enter required characters does not matter unless 
otherwise indicated in Table A-2. 

If you type an invalid compose sequence, the keyboard bell rings once, and 
the compose sequence is terminated. If this happens, check the table care
fully and repeat the steps to compose a character. 

If you use a diacritical mark in a three-key sequence, it is treated as its 
equivalent character. Table A-I describes the mark and its equivalent 
character. 

Table A-I Diacritical Mark in a Three-Key Sequence 

Diacritical Mark 

Dieresis (umlaut mark) 

Acute accent 

Grave accent 

Circumflex accent 

Tilde mark 

Ring mark 

Equivalent Character 

Double Quote II 

Apostrophe' 

Single quote' 

Circumflex character ~ 

Tilde character -

Asterisk • or degree sign 0 
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Finishing or Restarting a Compose Sequence 

If you enter the compose mode by mistake, or to end the compose sequence, 
press the backspace key and exit from the compose mode. 

If you press the Compose key during a compose sequence, a new three-key 
sequence is started from that point. The previous sequence is ended. 

NOTE 
Table A-2 contains all possible compose sequences for applications 
that run under MS-Windows. However, no single application can 
create all of these compose characters. There are two different sets 
of compose characters. An application can use only one set of 
compose characters at a time. 

Applications use either the International Standards Organization 
(ISO) Latin-1 character set or the DEC Multinational Character Set 
(DEC MCS). Both sets contain all of the compose sequences except 
those listed with a single asterisk C) or a double asterisk (") in 
Column 1. A single asterisk C) identifies the compose characters 
in the ISO Latin-1 character set only, while a double asterisk C') 
identifies the compose characters in the DEC MCS set only. 

For standard applications that run outside a window, use the 
MS-DOS operating system to use compose sequences. 

Table A-2 Valid Compose Sequences 

Character 

# (number sign) 

@ (commercial at) 

[ (opening bracket) 

\ (backslash) 

1 (closing bracket) 

{ (opening brace) 

I (vertical line) 

: (broken vertical bar) , 

l (closing brace) 
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Two-Key 
Sequence Three-Key Sequence 

++ 

aa 

« 
1< or II 

» 
-( 

!' 
: I or I/ 

)-



Table A-2 Valid Compose Sequences (cont.) 

Character 

« (angle quotes left) 

» (angle quote right) 

NBSP (No Break Space) • 

j (inverted !) 

i, (inverted ?) 

o ( degree sign) 

© (copyright sign) 

® (reg. trademark) • 

¢ (cent sign) 

£ (pound sign) 

" (general currency) 

Y (yen sign) 

- (soft hyphen) • 

.. (macron sign) • 

!1 (micro sign) 

, (logical NOT sign) 

± (plus/minus sign) 

X (multiply sign) 

-7- (divide sign) 

1 (superscript 1) 

2 (superscript 2) 

3 (su perscri pt 3) 

~ (paragraph sign) 

§ (section sign) 

~ (feminine ordinal) 

Q (masculine ordinal) 

• ( middle dot) 

Two-Key 
Sequence 

Creating Alternate Characters 11111 

Three-Key Sequence 

« 

» 

(sp)(sp) (Two spaces) 

!! 

?? 

co 

ro 

c/ or cI 

1- or 1= 

xo 

y- or y= 

/u 

-, (order sensitive) 

+-

xx 

-: (order sensitive) 

1/ 

21' 

!p 

so or s! 
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Table A-2 Valid Compose Sequences (cont.) 

Character 

1/4 (fraction one-quarter) 

1/2 (fraction one-half) 

3/4 (fraction three-quarters) • 

13 (German sharp s) 

i) (cap Icelandic Eth) • 

" (sm Icelandic Eth) • 

(j) (0 slash) 

~ (0 slash) 

p (cap Icelandic Thorn) • 

p (sm Icelandic Thorn) • 

- (tilde character) 

. (grave accent) 

, (apostrophe) 

, (acute accent) • 

A (circumflex character) 

II (double quote) 

.. (dieresis) • 

, ( cedilla) • 

A (A grave) 

it (a grave) 

A (A acute) 

a (a acute) 

a (a circumflex) 

A (A tilde) 

a (a tilde) 
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Two-Key 
Sequence 

- (sp) 

(sp) 

, (sp) 

1\ (sp) 

II (sp) 

'A 

'a 

'A 

'a 

Three-Key Sequence 

14 (order sensitive) 

12 (order sensitive) 

34 (order sensitive) 

ss 

-D 

-d 

0/ 

0/ 

TH (order sensitive) 

th (order sensitive) 

- (sp) 

. (sp) 

, (sp) 

A (sp) 

dieresis (sp) 

1111 

A' 

a' 

A' 

a' 

a-



Table A-2 Valid Compose Sequences (cont.) 

Character 

A (A umlaut) 

a (a umlaut) 

A (A ring) 

a (a ring) 

JE (AE ligature) 

<e (ae ligature) 

<:: (C cedilla) 

~ ( c cedilla) 

E (E grave) 

e (e grave) 

E (E acute) 

e (e acute) 

E (E circumflex) 

e (e circumflex) 

E (E umlaut) 

e (e umlaut) 

i (I grave) 

i (i grave) 

i (I acute) 

i (i acute) 

I (I circumflex) 

i (i circumflex) 

i' (I umlaut) 

i" (i umlaut) 

N (N tilde) 

Ii (n tilde) 

Two-Key 
Sequence 

"A 

"a 

'A or 'A 

,C 

,c 

'E 

'e 

'E 

'e 

/\e 

liE 

lie 

'I 

'i 

'I 

'i 

/\1 

"I 
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Three-Key Sequence 

A" 

a" 

A' or N (degree sign) 

a' or a' (degree sign) 

AE (order sensitive) 

ae (order sensitive) 

C, 

c, 

E' 

e' 

E' 

e' 

E/\ 

e/\ 

E" 

e" 

I' 

i' 

I' 

i' 

1/\ 

I" 

i" 
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Table A-2 Valid Compose Sequences (cont.) 

Character 

b (0 grave) 

o (0 grave) 

6 (0 acute) 

6 (0 acute) 

6 (0 circumflex) 

o (0 circumflex) 

6 (0 tilde) 

6 (0 tilde) 

o (0 umlaut) 

6 (0 umlaut) 

(E (OE ligature) 

re (oe ligature) .. 

U (U grave) 

u (u grave) 

U (U acute) 

u (u acute) 

U (U circumflex) 

u (u circumflex) 

U (U umlaut) 

ii (u umlaut) 

Y (Yacute) • 

y (yacute) . 

Y (Y umlaut) .. 

y (y umlaut) 

A-IO 

Two-Key 
Sequence 

'0 

'0 

'0 

'0 

-0 

"0 

"0 

'U 

'u 

'U 

'u 

"U 

"u 

'Y 

'y 

"Y 

"y 

Three-Key Sequence 

0' 

0' 

0' 

0' 

0-

0" 

0" 

OE 
(order sensitive) 

oe 
(order sensitive) 

U' 

u' 

U' 

u' 

U" 

u" 

Y' 

y' 

Y" 

y" 
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Alt Numeric Pad Sequence 

To use the Alt numeric pad seqeunce: 

1. Press and hold down the Alt key. 

2. Press three numeric keypad number keys. 

3. Release the Alt key. 

The numbers act as an index for the application's currently selected charac
ter set. 

For example, to compose an uppercase C cedilla and the currently selected 
font is STn (IBM): 

1. Press the Alt key. 

2. Press 1, 2, and 8 on the numeric keypad. 

3. Release the Alt key. 

An uppercase C cedilla is composed. 

If the currently selected font is ISO Latin-I, the output for ALT 1,2,8 is not a 
displayable character, and the output is displayed as a solid block. To pro
duce an uppercase C cedilla when the ISO font is selected, you must type 
1,9,9 while holding down the Alt key. 

The output for this compose sequence is not remapped from STn to ANSI. 
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AppendixB 
Information About 

the WIN.INI File 

This chapter describes the WIN.INI file, which contains some applications 
and settings for many MS-Windows features and applications. MS-Windows 
checks the WIN .INI file and uses these settings each time you start 
MS-Windows or an MS-Windows application. 

NOTE 
You rarely need to change the WIN.INI file. The Configuration 
Aide creates the WIN.INI file on the key diskette. This appendix 
provides the instructions primarily for special system 
customization. The settings in your WIN.INI can vary from those 
shown here. 

You should print a copy of the WIN.INI file before you change it, using the 
Print command from the MS-DOS Executive window. 

MS-Windows searches for the WIN.INI file in the directory from which you 
start MS-Windows. If MS-Windows does not find the WIN.INI file in that 
directory, MS-Windows searches the directories given in the path. 

You can place comments in the WIN.INI file by making the first nonspace 
character a semicolon (;). Comments cannot contain equal signs. 
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Table B-1 describes the sections of the WIN.lNI file that affect MS-Windows 
settings. 

Table B-1 Sections of the WIN_INI File 

Section Setting 

Windows Controls the loading of the spooler. 
Sets double-click speed. 
Sets cursor blink rate. 
Specifies the file extensions listed in the MS-DOS Executive 
window with the Programs command. 
Defines the name for the null port. 
Starts applications as icons. 
Starts applications in windows. 
Defines default printer device. 
Swaps the action of the mouse buttons. 

Extensions Starts an application when you select a file with the specified 
file extension. 

Colors Specifies the shades of gray in the MS-Window's display screen. 

PIF (Program 
Information File) 

Ports 

International 

DecLAT 

DecKeybd 

DecInfo 

Devices 

Fonts 
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Defines swap disk and swap size. 
Specifies program information entries for applications used 
with MS-Windows. 

Defines the communication ports you can use. 

Defines MS-Windows for operation in foreign countries. 

Redirects the communications ports to a network terminal ser
vice. 

Sets the keyboard operation settings. 

Defines the location of the on-line Information System. 

Defines the output devices recognized by MS-Windows. 

Defines the display fonts MS-Windows can use. 
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Changing the WIN .INI File 

Before you change the WIN.INI file, you should be familiar with MS-Windows 
and MS-Windows applications such as Notepad. 

To change the WIN.INI settings, use: 

• The MS-Windows Control Panel 

This is the preferred method for making changes, because MS-Windows 
edits the file for you. Any changes made with the Control Panel take 
effect immediately. 

• The Notepad application to edit the WIN.INI file 

Any changes made with an editor do not take effect until MS-Windows is 
restarted. 

NOTE 
You can use any text editor that produces an ASCII file to edit the 
WIN.INI file. Do not use any editors that include special 
formatting characters in addition to the standard ASCII formatting 
commands. 

Edits made with a text editor do not take effect until MS-Windows 
is restarted. 

The following sections describe the sections of the WIN.INI file. 

B-3 



IIIII In/ormation About the WIN.lNI File 

Windows Section 

Purpose 

The Windows section contains settings that take effect when MS-Windows is 
started. 

NOTE 
In the Windows section, you change some settings with the 
Control Panel and some with an editor. To change the double-click 
speed, cursor blink rate, default device, and swap mouse button 
settings, use the Control Panel. To change the programs, load, run, 
spooler, and null port settings, use Notepad. 

Format 

[windows] 
spooler=setting 
DoubleClickSpeed=speed 
CursorBlinkRate=speed 
programs=list 
NullPort=port 
load=list 
run-list 
device=name,driver,port 
SwapMouseButtons=setting 

Where: 

spooler=setting 

Determines whether the spooler is used when printing. The setting 
can be: 

Yes The spooler is used when printing. 

No The spooler is not used when printing. 

DoubleClickSpeed=speed 
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Sets the speed in milliseconds for the double-click operation of the 
mouse. Speed can be 0 to 65535 ms. 
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CursorBlinkRate=speed 

Sets the speed in milliseconds for the cursor blinking action. Speed can 
be 0 to 65535 ms. 

programs=list 

Specifies the files displayed in the MS-DOS Executive window when you 
select the Programs command from the View menu. The list contains 
the file extensions without the period. Separate the file extensions with 
spaces. 

N ullPort=port 

Defines the name for the null port to a specified port. The Control 
Panel, Spooler, and other applications use this port when an output 
device is installed, but is not connected to any port. 

load=list 

Starts the specified applications as icons when you start MS-Windows. 
The list contains the application file names as they are displayed in the 
MS-DOS Executive window without the file extension. (For example, 
Calculator is CALC, because CALC.EXE is the application file name.) 
Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

To start the MS-DOS Executive window as an icon when you first start 
MS-Windows, you must specify another application to start in a window. 
Use run= to start an application in a window and to start the 
MS-Executive window as an icon. 

You can also start an application as an icon and open a file for that 
application by adding the file name and the file extension to the load 
setting. 

To use this option, you must define the application in the Extensions 
section of the WIN.INI file. 

For example, DOTHIS.TXT starts Notepad because .TXT is in the Exten
sions section, starting the Notepad application. 
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run=list 

Starts the specified applications in windows when you start 
MS-Windows. You list the file names exactly as they are displayed in the 
MS-DOS Executive window without the file extension. 

When you specify an application to start in a window when you start 
MS-Windows, the MS-Executive window automatically starts as an icon. 

Include a space between the file names. MS-Windows first searches the 
current drive, the directory, then the path. Otherwise, specify a path 
name. 

You should not specify a file name either for a special application or 
for an application that uses a large amount of memory; otherwise, you 
will enter an endless loop when you exit from the application. 

You can arrange windows by using spaces to designate windows within 
the same column, and commas to designate a new column. 

You can start an application and open a data or text file in a window 
when you start MS-Windows by adding the file name and the file exten
sion in the run setting. To use this option, you must define the applica
tion in the Extensions section of the WIN.INI file. 

device=name,driver,port 

Defines the default printer ( or plotter): 

name 

driver 

port 

Is the name of the default device. You must also specify 
this default device in the Devices section. 

Is the file containing the device's printer file name with
out the file extension. 

Is the port to which the device is connected. You must 
also specify this port in the Ports section. 

SwapMouseButtons=setting 
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Swaps the functions performed by the left and right mouse buttons. 
Setting can be: 

No The left mouse button controls the mouse functions. This is 
the default. 

Yes The right mouse button controls the mouse functions. 
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Windows Section Example 

The following Windows section: 

• Enables the spooler when printing. 

• Sets the mouse double-click speed to 900 ms. 

• Sets the cursor blink rate to 550 ms. 

• Specifies that files with the .COM, .EXE, and .BAT file extensions are 
displayed in the MS-DOS Executive window when you use the Programs 
command. 

• Specifies None as the null port. 

• Using no file specifications, starts Notepad and Calculator as icons, and 
starts Notepad with the text file ONGOING.TXT. 

• Statts Clock in the first window of the first column, Calculator in the 
second window of the first column, Notepad in the first window of the 
second column, and Notepad with the file specification 
K\MEMOS\ONGOING.TXT in the second window of the second 
column . 

• Sets the default printer to a DIGITAL LA75, which is connected to the 
LPTl: port. 

• Does not switch the left and right mouse buttons. 

Example 

[window51 
5pooler=ye5 
DoubleClickSpeed=900 
Cur50rBlinkRate=550 
program=com exe bat 
NullPort=None 
load=notepad calc ongoing. txt 
run=clock calc,notepad K:\memo5\ongoing.txt 
device=LA75DEC,LA75,LPT1: 
SwapMou5eButton5=No 
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Extensions Section 

Purpose 

In the Extensions section, you can specify file extensions that let you start an 
. applicaHon and open a me in a single operation. When yQU select a file with 

the specified extension, MS-Windows starts the application and opens the file 
in one step. 

NOTE 
To change the Extensions section, use the Notepad application. 

Format 

[exten5ion51 

exten5ion=application[parameterl 

Where: 

extension 

application 

parameter 

B-B 

Is the file extension that starts the application. 

Is the name of the application that is started. You must in
clude the application's extension (.EXE). 

Is the name and extension of the file (optional) for the ap
plication to open. You can use a caret C') to represent any 
file with that extension (for example, J\ • TXT) . Then you can 
select any file with the specified extension, and MS-Windows 
starts the application with that file. 
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Extensions Section Example 

The following Extensions section: 

• Starts the Notepad application when you specify a file containing a .TXT 
file extension. Notepad opens the file. 

• Starts the Notepad application when you specify a file containing an 
.INI file extension. Notepad opens the file. 

• Starts the MS-Paint application when you specify a file containing an 
.MSP file extension. Paint opens the file. 

Example 

[extensions] 

txt=notepad.exe A.txt 

ini=notepad.exe A.ini 

msp=paint.exe A. msp 
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Colors Section 

Purpose 

The Colors section specifies the shading for various components of the 
MS-Windows screen. 

NOTE 
To change the Colors section, use the Control Panel. Set your 
screen to have contrasting text and background colors. Otherwise, 
your screen could look blank. 

Format 

[color5] 

component=redvalue greenvalue bluevalue 

Where: 

component 

Specifies the component of the MS-Windows screen. The component 
can be: 

Window 

WindowText 

Scrollbar 

ActiveTitle 

InactiveTitle 

TitleText 

WindowFrame 

Menu 

MenuText 

Background 

B-JO 

Is the nontextual background of the window 
work area. 

Is the textual display in the window work area. 

Is the scroll bar. 

Is the background of the active title bar. 

Is the background of the inactive title bar. 

Is the application title's text. 

Is the set of lines that form the frame of the win
dow and the nontextual part of the application's 
title background. 

Is the nontextual background of the menu area. 

Is the textual display in the menu area. 

Is the icon area and screen background. 
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redvalue 

Is a number that specifies the intensity of red used. The number can be 
o to 255. 

greenvalue 

Is a number that specifies the intensity of green used. The number can 
be 0 to 255. 

bluevalue 

Is a number that specifies the intensity of blue used. The number can 
be 0 to 255. 

NOTE 
Because you have a monochrome screen, the redvalue, greenvalue, 
and bluevalue settings affect the gray scale of the MS-Windows 
components. The low end of the gray scale is 0, and the high end 
of the gray scale is 255. Therefore, if all three settings are 0 
(setting=O 0 0), the color is black. If all three settings are 255 
(setting=255 255 255), the color is white. Settings between 0 and 
255 produces varying shades of gray. 

Colors Section Example 

The following Colors section: 

• Sets the nontextual background of the window work area to white. 

• Sets the textual display in the window work area to black. 

• Sets the scroll bar to a shade of gray. 

• Sets the active title bar background color to black . 

• Sets the inactive title bar background color to a shade of gray. 

• Sets the application title to white. 

• Sets the lines that form the frame of the window and the nontextual 
part of the application's title background to black. 

• Sets the nontextual background of the menu area to white. 

• Sets the textual display in the menu area to black. 

• Sets the icon area and screen background to a shade of gray. 
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Example 

[color5] 
Window=255 255 255 
W-i nd-owTex-t-O -0- 0 

Scrollbar=192 192 192 
ActiveTitle=O 0 0 
InactiveTitle=128 128 128 
TitleText=255 255 255 
WindowFrame=O 0 0 
Menu=255 255 255 
MenuText=O 0 0 
Background=128 128 128 
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PIF Section 

Purpose 

The PIF section lists the information that MS-Windows uses to swap programs 
to disk. MS-Windows uses the swap area to swap applications that cannot 
operate in a window. Two settings (SwapDisk and SwapSize) determine 
where MS-Windows swaps an application and the minimum swap space. 

The PIF section creates a program information entry for standard applications 
used in a window. MS-Windows uses the program information entry rather 
than a program information file (PI F). The preferred method is to create a 
PIF. For more information on PIFs, see Appendix C. 

NOTE 
To change the PIF section, use Notepad. 

Format 

[pH 1 

swapdisk=setting 
swapsize=setting 
program=memory 

Where: 

SwapDisk=setting 

Is the disk to which MS-Windows swaps the application. The setting 
can be: 

Swaps to the first fixed disk on the system. This is the 
default. 

dry Swaps to that drive. Drv is any valid drive letter. 

o Disables swapping. 

NOTE 
Do not set a diskette drive as the swap disk. 
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SwapSize=setting 

Is the amount of memory MS-Windows uses to swap an application. The 
setting can be: 

o Is the amount of memory based on the size of the first appli
cation that MS-Windows swaps. You should start the largest 
application first. This is the default. 

size Is the reserved minimum amount of memory in Kbytes that 
MS-Windows uses to swap applications. When you determine 
the size, consider the application size, the space for screen 
exchange, the space for screen switching, and 2K bytes of 
overhead for saving information about the application's cur
rent state. 

progra01=01e01ory 

Is the application name for which you want to create a program infor
mation entry. Memory is the amount of memory in Kbytes required to 
start the application. See the application documentation to find the 
memory requirements for the application. 

When memory is 1, it indicates a special application. 

MS-Windows assumes the following default settings for a program infor
mation entry: 
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Program Title 

Initial Directory 

Parameters 

Memory Required 

Memory Desired 

Screen Exchange 

Program Switch 

Directly Modifies 

Close Window on Exit 

File name without extension 

None 

None 

Specified to the right of the equal sign 

Same as memory required 

Text 

Text 

None 

No 
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PIP Section Example 

The following PIF section: 

• Sets the swap disk to the default. 

• Sets the swap size to the default. 

• Creates a program information entry for COMMAND.COM with a 32K 
byte memory requirement. 

Example 

[pif] 

5wapdi5k=? 
5wap5ize=O 
command.com=32 
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Ports Section 

Purpose 

The Ports section lists the available communication ports for a workstation 
and-defines-the default modes or settings. The Ports section can include up 
to eight entries. 

NOTE 
To change the Ports section, use the Control Panel. 

Format 

[ports] 
port:=baudrate,parity,wordlength,stopbits,[retry] 
filename.PRH= 

Where: 

port: 

Is the name of the available port. Port can be LPTl:, LPT2:, LPT3:, 
COMl:, or COM2:. 

If the port is COMl: or COM2:, you must specify in order the: 

B·16 

baud rate 

parity 

word length 

stop bits 

retry 

Is the port's baud rate. 

Is the parity setting: 0 (odd), e (even), or 
n (none). 

Is the length of a word, in bits. 

Is the number of stop bits. 

Controls continuous retry on a timeout. This op
tion is used if the port is used only for a serial 
printer. If you leave this option blank, the cur
rent setting does not change. 

The retry options are: 

p which enables continuous retry on a tim out 

which disables continous retry on a timeout 
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filename.PRN= 

Sends printer output to a file rather than to a printer device. 
MS-Windows prints the information in the file name you specify. You 
must include the .PRN file extension. MS-Windows overwrites the file 
with each print job. 

Ports Section Example 

The following Ports section: 

• Defines the LPTl: communication port. 

• Defines the LPT2: communication port . 

• Defines the COMl: communication port with 9600 baud rate, no parity 
check, 8 bit word length, 1 stop bit, and enabled retry. 

• Defines the COM2: communication port with 2400 baud rate, no parity 
check, 8 bit word length, 1 stop bit, and disabled retry. 

• Defines OUTPUT.PRN as a file for printer output. 

Example 

[ports] 
LPT1: .. 
LPT2:= 
COM1:-9600,n,8,1,p 
COM2:-2400,n,8,1 
OUTPUT.PRH-

B-17 



IIIII Information About the WIN.lNI File 

International Section 

Purpose 

The imernationai section teUs MS-Windows how to display dates, times, dol
lar amounts, and other items in countries other than the United States. 

NOTE 
To change the International section, use the Control Panel. 

Format 

[intlJ 
dialog-5etting 
itemname-5etting 

Where: 

dialog=setting 

Allows changes to the Ir.ternational section through the Control Panel. 
The setting can be: 

Yes Enables the international dialog box. 

No Disables the international dialog box. 

itemname 

Is the item you want to set. The setting can be: 
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iCountry 

iDate 

iCurrency 

Defines the country code. 

Defines the format for the date where: 

o for month-day-year 
1 for day-month-year 
2 for year-month-day 

Defines the format for currency where: 

o for currency symbol prefix, no separation 
1 for currency symbol suffix, no separation 
2 for currency symbol prefix, 1 character 

separation 
3 for currency symbol suffix, 1 character 

separation 
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iDigits Defines the number of significant decimal digits in 
the currency. 

iTime 

iLzero 

s1159 

s2359 

sCurrency 

sThousand 

sDecimal 

sDate 

sTime 

sList 

'Defines the format for the time where: 

o for 12-hour clock 
1 for 24-hour clock 

Defines the use of leading zeros where: 

o for no leading zeros 
1 for leading zeros 

Defines trailing string from 0:00 to 11:59. 

Defines trailing string from 12: 00 to 23: 5 9. 

Defines currency symbol. 

Defines thousands separator. 

Defines decimal separator. 

Defines date separator. 

Defines time separator. 

Defines list separator. 

International Section Example 

The following International section: 

• Allows changes to the International section through the Control Panel. 

• Defines the country as the U.S. 

• Defines a month-day-year date format. 

• Defines a 0 currency symbol prefix with no separation for the currency 
format. 

• Defines two significant decimal digits in the currency . 

• Defines a 12-hour clock. 

• Defines the use of no leading zeros. 

• Defines an AM to be attached to time from 0:00 to 11:59. 

• Defines a PM to be attached to time from 12:00 to 23:59. 
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• Defines $ as the currency symbol. 

• Defines , as thousand separator. 

• Defines . as decimal separator. 

• D~fines / as date separator. 

• Defines: as time separator. 

• Defines , as list separator. 

Example 

[intl] 
dlelog"'ye5 
iCountry-1 
10ete-O 
lCurrency-O 
iOigi h-2 

i Time-O 
lLzero-O 
5115S"AM 
5235S·PM 
5Currency-S 
5Thou5end-, 
50eclmal-. 
50ate-' 
5Tlme-: 
5L15t-, 
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DecLAT Section 

Purpose 

The DecLAT section redirects the communication ports to a network terminal 
service. 

NOTE 
To change the DecLAT section, use the Control Panel. 

Format 

CDecLATl 

port=5ervice 

Where: 

port Is the communication port that you want to redirect. Port can be 
COM!: or COM2:. Service is the network terminal service to 
which you want to connect. You do not have to specify a partic
ular network terminal service. 

DecLAT Section Example 

The following DecLAT section: 

• Defines the COMl: communication port. It is not redirected to any net
work terminal service. 

• Defines the RANGER network terminal service to the COM2: communi
cation port. 

Example 

[DecLATl 

COM1:= 
COM2:=RANGER 
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DecKeybd Section 

Purpose 

The DecKeybd section specifies the keyboard settings. 

NOTE 
To change the DecKeybd section, use the Control Panel. 

Format 

[DecKeybdl 
keyclick=5etting 
repeat=5etting 
lock=5etting 

Where: 

keydick=setting 

Specifies the volume of sound generated by the keyboard. The setting 
can be from 0 to 3 where 0 is no volume and 3 is maximum volume. 
The default is 2. 

repeat=setting 

Specifies whether the repeat key feature is used. The setting can be: 

o Turns off the repeat key feature. 

1 Turns on the repeat key feature. 

lock=setting 

Specifies the caps lock or shift lock feature of the keyboard. The setting 
can be: 

o Sets the caps lock feature, which capitalizes the letters on the 
keyboard when you press the Lock key. 
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1 Sets the shift lock feature, which acts as if the Shift key is always 
pressed. 
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DecKeybd Section Example 

The following DecKeybd section: 

• Sets the key click to medium volume. 

• Turns on the repeat key feature. 

• Sets the caps lock feature. 

Example 

[DecKeybdl 
keyclick=2 
repeat=1 
lock=O 
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Declnfo Section 

Purpose 

The DecInfo section specifies to MS-Winoows the location of the on-line 
Information System files. You should not need to change any of these 
settings. 

NOTE 
To change the DecInfo section, use the Notepad application. 

Format 

[Declnfol 
DBpath=pathname 
DBname=databa5e 
BMpath=pathname 

Where: 

DBpath 

DBname 

BMpath 
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Specifies the location of the on-line Information System 
database files by the specified path name. 

Specifies the name of the on-line Information System 
database. 

Specifies the location of user specific information regarding 
the on-line Information System by the specified path name. 
For example, the Bookmark file contains information specific 
to you. 



In/ormation About the WIN.lNI File IIIII 

Declnfo Section Example 

The following DecInfo section: 

• Defines the location of the on-line Information System data files as drive 
H in the DECAPP subdirectory. 

• Defines the name of database as INFOUSER. 

• Defines the location of your specific information regarding the on-line 
Information System as drive I. 

Example 

[Declnf9] 
DBpath=H:\DECAPP 
DBname=II'IFDU5ER 
BMpath=I:\ 
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Devices Section 

Purpose 

The Devices section identifies a workstation's output devices, the printer 
files, and the port connections. 

NOTE 
To change the Devices section, use the Control Panel. 

Format 

[device51 
device=driver,port[,portl 

Where: 

device Is the name of the output device where: 

driver 

port 

Is the file name of the device's printer driver. 

Is the name of the communication port or print file to 
which the device is connected (optional). Port can be 
LPTl, LPT2, LPT3, COMl, or COM2. If a device is not 
currently connected, the port should be the port speci
fied in the NullPort setting of the Windows section. 

Devices Section Example 

• Defines the DIGITAL LN03 printer as connected to the null port and to 
the LPT3:communication port. 

• Defines the IA75DEC printer as connected to the LPTl :communication 
port. 

• Defines the IBM Graphics printer as the null port. 

Example 

[device51 
Digital LN03=LN03,None,LPT3: 
LA7SDEC=LASO,LPT1: 
IBM Graphic5=IBMGRX,None 
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Fonts Section 

Purpose 

The Fonts section identifies one or more font types that MS-Windows applica
tions can use for display. 

NOTE 
To change the Fonts section, use the Control Panel. 

Format 

[font5] 

fontname=fontfile 

Where: 

fontname Is the descriptive name of a font. The fontfile is the name of 
the file containing the font resources. Do not use the file 
extension. 

Fonts Section Example 

The following Fonts section: 

• Defines the Courier font. 

• Defines the Helvetica font. 

Example 

[font5] 

Courier 8,10,12 (Set H3)=CDURC 
Helv 8,10,12(SetH3)=HELVC 
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Appendix C 
Program 

Information Files 

This appendix describes how to: 

• Use Program Information Files (PIFs) 

• Use the PIF editor 

• Select PIF options 

• Use default settings 

• Decide what to put in a PIF 

• Change PIFs 

• Give applications more memory 

Using Program Information Files 

A program information file (PIF) is a file that contains information about a 
standard application. It has the file extension .PIF. When you run a standard 
application, MS-Windows looks for a PIF to configure the application. 

PIFs for most popular standard applications are included with your 
MS-Windows software package. During setup, the Installation Aide installs 
PIFs in the PIF subdirectory to establish a PIF library. You probably will not 
enter information into a PIF unless you use a standard application that does 
not have a PIF. 
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NOTE 
If you try to run a standard application that does not have a PIF, 
MS-Windows automatically uses a set of default application 
characteristics. MS-Windows displays a dialog box asking if it 
should "Continue with default settings." You should create a PIF, 
using the correct values from your application documentation. 

If you run an application by selecting the file name of the application (files 
that have the file extension .EXE, .COM, or .BAT), the PIF must have the 
same file name and the file extension .PIF. For example, if you use dBASE II, 
its application file name is DBASE.EXE, and its PIF must be DBASE.PIF. 

You can also run an application by selecting its PIF in the MS-DOS Executive 
window. This automatically loads and runs the application named in the PIF. 
In this case, the PIF does not have to have the same file name as the 
application. 

The preferred method is to run a standard application by selecting its PIF. 
This allows you to have customized PIFs, which are several PIFs containing 
different settings for the same application. Therefore, you can customize an 
application to the needs of different users, each with their own specific 
MS-Windows environment. 

For example, one version, APPLARGE.PIF, may need a large amount of mem
ory for those that use all of its features, and a second version, APPSMALL.PIF, 
may need less memory for those who use only a few of its features. 

Additionally, each user can have customized values for the Program Parame
ters or Initial Directory fields in their PIFs. Customized PIFs must be in the 
user's personal directory. 

The PIF must be in your directory or in your path. It should be copied from 
the PIF subdirectory to the directory from which you run the application. 
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In some cases, different applications use the same file name to start up. 
Therefore, some PIFs can have names that differ from their applications. If 
you are not sure which application a PIF works with, run the PIF editor and 
open the PIF to see which application the PIF was designed for, then copy 
the PIF to the appropriate drive and directory, and rename the file. 

Some applications can have more than one .EXE, .COM, or .BAT file on their 
disk. You need a separate PIF for each file. 

Using the PIF Editor 

To create or edit a PIF, use the PIF editor. For example, you can change the 
application settings to increase the amount of memory available to the appli
cation or to set its initial directory. 

To get on-line help about using the PIF editor: 

1. Select the About command from the System menu. 

A dialog box is displayed that lists topics about PIFs. 

2. Select a topic from the list box. 

3. Select the Help command button. 

Information about the selected topic is displayed in the dialog box. You 
may need to scroll to see all the information. 

By using the command buttons in the dialog box, you can obtain infor
mation about other PIF topics. 

When you finish using the PIF help feature, select the Cancel command 
button. 
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Creating a PIF 

To create a new PIF: 

I. Use the Run command in the MS-DOS Executive window to start the PIF 
editor application. The file name of the PIF editor is PIFEDIT.EXE. 

The Program Information Editor window is displayed. Screen C-I shows 
the Program Information Editor window. 

aa.J.',i"Mm,"p"Fi"uIM,n, .. 
File 

P,-ogralll Hallle: I 
P,-og,-alll Title: ~I =============~ 

Progralll Parallleters: ~I ==============; 
Initial Directory: L.I _____________ ~ 

Nelllo,-y Requirements: @IJ KB ReQui,-ed @IJ KB Desired 

Di,-ectly Nodifies [2J Screen 0 com 0 Nelllo,-y 

Prog,-am S"litch 
Screen Exchange 

o Keyboard 0 Cm12 
Co Prevent @) Text 
o Hone (~, Text 

Close Hindm!1 on exit 0 

r=, Graphics/Nultiple Text 
() G,-aphics/Text 

Screen C-l Program Information Editor Window 

[. 
" 

2. Type the file name of the application to be associated with the PIF in 
the Program Name text box. Include the file extension (.EXE, .COM, or 
.BAT). 

3. Select the options or values that apply to the application. (For more 
information, see the section "Selecting PIF Options" in this appendix.) 

4. Select the Save command from the File Menu to save the new PIF. 
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To create another PIF, select the New command from the File Menu to reset 
the PIF editor screen. 

Editing PIFs 

To edit an existing PIF: 

1. Use the Run command in the MS-DOS Executive window to start the PIF 
editor. The file name of the PIF editor is PIFEDIT.EXE. 

2. Select the Open command from the File Menu. 

3. Select the PIF you want to change from the list box or type the name of 
the PIF in the text box. 

4. Select the Open button. 

5. Make the desired changes by selecting the PIF options you want. 

6. Select the Save command from the File Menu to save the changes. 

Selecting PIF Options 

PIF options are organized into these categories: 

• Program Name 

• Program Title 

• Program Parameters 

• Initial Directory 

• Memory Requirements 

• Directly Modifies 

• Program Switch 

• Screen Exchange 

• Close Window on exit 
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Program Name 

Every application (program) must have a file name assigned. 

Type the path and file name of the application, including the file extension 
.EXE, . BAT, or .COM. Eor example, DBASE.COM isa file for theappHcation 
DBASE. What you enter is displayed in the MS-DOS Executive window 
directory. 

Program Title 

You can enter a descriptive title for the application to help the user identify 
it on the screen. 

What you enter is displayed in the title bar of the window, if the application 
runs in a window. This same title is also displayed above the icon of the 
application when you highlight the icon in the icon area. 

NOTE 
The PIF editor lets you enter 37 characters in the text box; 
however, only 29 characters are displayed in the title box. 

Program Parameters 

The Program Parameters option lets you pass information to an application 
when you start it. In the Program Parameters text box, you can type either of 
the following: 

• Question mark 

If you type a question mark, MS-Windows displays a dialog box when 
you start the application. The dialog box prompts you for application 
parameters. You can enter up to 126 characters in the dialog box; how
ever, the application interprets no more than 126 characters. If you 
enter more than 126 characters, MS-Windows does not beep to indicate 
an error. 

e Specific program parameters 

If you type specific parameters, those application parameter values are 
used every time the application is started. You can enter up to 37 char
acters in the Program Parameters text box. 

You should not redirect input and output or use piping. 

If your application requires no parameters, or if you are uncertain, leave this 
option blank. 
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Initial Directory 

If you have several directories, this option changes to a specific directory 
when the application starts. 

Type the drive and directory you want MS-Windows to change to when you 
start the application. This directory is usually the location of the applica
tion's data files. 

You can use the Initial Directory field and the Program Name field to make a 
customized PIF for applications shared on a file server. In the Program Name 
field, enter the drive and directory of the application. In the Initial Directory 
field, enter the drive and name of your personal directory. (Complete the 
other PIF fields as needed.) Make sure this customized PIF is in your per
sonal directory. 

When you select the customized PIF to run an application, MS-Windows cop
ies the application from its drive and directory and starts it in your personal 
directory where the data files are. The application can then use the data files. 
When you close the application, the updated data files remain in your per
sonal directory. 

If the data files are in the same directory as the application, leave this option 
blank. In this case, MS-Windows does not change the directory when you 
start the application. 
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Memory Requirements 

Two fields for Memory Requirements allocate memory for your applications: 

• KB Required 

Type the minimum amount of memory required (in kilobytes) by your 
application. 

Memory requirements for your application should be in the application 
documentation. 

If you do not know how much memory is required, use the default 
setting of 52K bytes. 

If MS-Windows cannot provide the specified amount of memory, and if 
no application is running other than the MS-DOS Executive application, 
MS-Windows reduces its space requirements so that the application has 
room to operate. In this case, you cannot switch back to MS-Windows 
with the Alt/Tab keys; you must execute the application's Exit com
mand, or its equivalent, to return to MS-Windows. 

• KB Desired 
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Type the maximum amount of memory your application can use. Some 
applications run better if you assign more memory. 

The value entered in this field should at least equal the value entered in 
the KB Required field. If the application allocates memory, you should 
increase the value in the KB Desired field, and you may also need to 
increase the value in the KB Required field. 

If you enter zero (0), MS-Windows allocates all available MS-Windows 
memory to the application. 

If you leave this field blank, MS-Windows uses the default setting of 
52K bytes. 

CAUTION 
You should not run the CHKDSK (Check Disk) utility program 
from MS-Windows; otherwise, it can provide invalid messages 
about memory availability. If you select the /F qualifier of 
CHKDSK, you can destroy all data stored on your workstation 
network disk. 
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Directly Modifies 

Some applications use workstation resources such that applications cannot 
share them. Select any options that apply to your application: 

• Screen 

Select this box if the application writes directly to the screen (video 
buffer) or if the application has a .BAT extension and uses redirected 
I/O. Ail standard applications that display graphics write directly to the 
screen. 

Selecting this option gives the application exclusive access to the full 
screen, rather than running it in a window. If you are uncertain, select 
this option. 

• Keyboard 

Select this box if the application accesses the keyboard buffer. This 
buffer saves keystrokes until they can be processed. 

Selecting this option prevents the application from running in a window 
(the application has exclusive access to the full screen) and prevents 
returning to MS-Windows with AIt/Tab. If you are uncertain, do not 
select this option. 

• COM! 

Select this box if your application accesses serial communications port 
! (COM!). If you select this option, MS-Windows reserves COM! for 
the application. When the application is running, MS-Windows cannot 
run any other application using COM! until you stop running the first 
application. Generally, you select this option only if you are running a 
communications application. 

Selecting this option prevents two applications from trying to access the 
same communications port at the same time. Because only one applica
tion with the COM! option selected can be running at a time, only one 
application attempts to access COM!. 

Selecting this option also prevents the application from being swapped 
to a disk. This type of application must remain in memory at all times. 
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• COM2 

Select this box if your application accesses serial communications port 
2 (COM2). If you select this option, MS-Windows reserves COM2 for 
the application. When the application is running, MS-Windows cannot 
run any other appiicationusing COM2until you stop running the first 
application. Generally, you select this option only if you are running a 
communications application. 

Selecting this option prevents two applications from trying to access the 
same communications port at the same time. Since only one application 
with the COM2 option selected can be running at a time, only one 
application attempts to access COM2. 

Selecting this option also prevents the application from being swapped 
to a disk. This type of application can remain in memory at all times. 

• Memory 

Select this box only if your application loads and remains resident 
(using a Terminate and Stay Resident system call). Many pop-up applica
tions do this. These applications generally load and remain in memory, 
and are activated while other applications are running. Generally, this 
type of application must be loaded before MS-Windows. In this case, 
you do not need a PIF for the application. If you are uncertain, do not 
select this option. 

C-IO 



Program Information Files 11111 

Program Switch 

If your application uses the entire screen, these options determine whether 
you can switch back to MS-Windows with Ait/Tab. If you are uncertain which 
option to select, select Text. 

• Prevent 

Select this option to conserve memory for the application, or if you find 
that the application does not switch to MS-Windows correctly. Selecting 
this option means you can stop running the application only by execut
ing its Exit command, or the equivalent command, to return to 
MS-Windows. You cannot use the Alt/Tab procedure to return to 

MS-Windows. 

• Text 

Select this option if your application works in text mode only, or if it 
runs in text and graphics modes, and you want to conserve memory. 
When you select this option, MS-Windows reserves 4K bytes to save the 
screen. 

If you select this option, you can switch back to MS-Windows only 
when your application is in text mode. If the application is in graphics 
mode, MS-Windows beeps when you press the Ait/Tab keys, to let you 
know it is not a valid action; you must execute the Exit command of the 
application to return to MS-Windows. 

• Graphics/Multiple Text 

Select this option if your application works in graphics mode. If you 
select this option, MS-Windows allocates extra memory (64K bytes) for 
you to switch back to MS-Windows when the application is in text or 
graphics mode. 

Due to extensive memory requirements, program switching is not sup
ported for applications using IBM EGA high-resolution color modes. 
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Screen Exchange 

These options let you specify the kind of data exchange between applications 
that require exclusive access to the screen. 

You press Alt/Prt Sc to copy information into the Clipboard. This requires 
MS-Windows to allocate memory to save the screen image in the Clipboard. 
Text screens generally do not require much memory (2K bytes). However, 
graphics screens can require up to 64K bytes of memory. You should select 
options with this in mind. 

If you are uncertain which option to select, select Text. 

• None 

Select this option to prevent screen exchange and conserve memory. 

• Text 

Select this option to allocate memory to copy text screens. If your 
application runs in a window, you can select this option. 

• Graphics/Text 

Select this option to allocate memory to copy text and graphics screens. 

Close Window On Exit 

Select this option to close the standard application window when you exe
cute the application's Exit command, or its equivalent. 

When you exit from some standard applications, they display information in 
the window for you to look at or copy. Do not select this option, because the 
window closes automatically, and the information is not displayed on the 
screen long enough for you to read it. 
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Using Default Settings 

If you run an application, and MS-Windows cannot find a PIF, MS-Windows 
uses the following settings: 

• Program Title: The application file name is displayed in the title bar. 

• Initial Directory: You stay in your current directory. 

• Memory Required: S2K bytes 

• Memory Desired: All available memory 

• Directly Modifies: Screen 

• Program Switch: Prevent 

• Screen Exchange: Text 

Deciding What to Put in a PIF 

How an application is displayed on the screen depends on: 

• How the application uses workstation resources and hardware 

• How the application is configured 

• The amount of memory reserved for the application 

If MS-Windows cannot run a standard application in a window, it runs the 
application outside a window, and the application uses the entire screen. 

Use the following guidelines to help determine whether your standard appli
cation can run in a window: 

• Does the application write directly to the screen (video buffer)? 

Many standard applications write directly to the screen instead of using 
DOS or other system conventions to display information (such as ANSI 
calls). These applications cannot run in a window. You must select the 
Directly Modifies screen option if your application writes to the screen. 

• Does the application display graphics? 

Standard applications that display bit-mapped graphiCS (not character
based) write directly to the screen and cannot run in a window. 
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• Does the application provide an installation option for running under 
different screen conventions? 

Standard applications that support ANSI screen drivers can run in a win
dow. 

• How much memory does the application require? 

If the memory requirements of the standard application and 
MS-Windows together exceed the amount of available memory, the 
application cannot run in a window. MS-Windows "steps aside" and 
gives the application the maximum amount of memory available. 

• Does the application use the alarm? 

Applications that use the alarm function of the real-time clock must run 
outside MS-Windows. At the minimum, you should select the Directly 
Modifies keyboard option. 

For standard applications that run in a window, MS-Windows does not 
support the following ANSI escape sequences: 

Cursor Position Report 

Set Mode 

- Keyboard Reassignment 

Set Graphics Renditions subsets: 

Faint on 
Italic on 
Rapid blink on 
Subscript 
Su perscri pt 

Select the Directly Modifies screen option in the PIF for any application 
that uses these. 

To experiment, run the application without setting the Directly Modifies 
screen option. If the application writes information outside its window, or 
you see unexpected results on the screen, edit the PIF and select the Directly 
Modifies screen option. 
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Changing PIFs 

Generally, you do not have to change the information in the PIFs. However, 
to change any parameters for a particular application by editing a PIF, you 
can tailor the performance characteristics of its application. 

For example, to give Lotus 1-2-3 the maximum amount of available memory 
in your workstation, change the amount in the KB Required and KB Desired 
options to 640K bytes and select None for the Screen Exchange option and 
Prevent for the Program Switch option. Close all other applications except 
for the MS-DOS Executive, then run the application. 

Some applications provide an option to install and run the application with 
an ANSI device driver (ANSI.SYS). If the application offers this option, you 
can usually run it in a window. 

Since the application can now run in a window, you must alter the PIF. You 
should cancel the Directly Modifies Screen option. (Do this for all related 
.COM or .EXE files included in the application.) 

If you run an application, and it does not load properly or is not operating as 
expected, check your PIF settings. You may need to increase the memory 
requirements of the application. 

Giving Applications More Memory 

When you run a standard application, MS-Windows allocates memory based 
on the settings in the PIF of the application. MS-Windows allocates memory 
for screen exchange (copying the screen) and for program switching (switch
ing between the application and MS-Windows). 

You can reduce the memory requirements for an application by selecting 
options that require less memory: 

• The Screen Exchange Text option 

• The Screen Exchange None and the Program Switch Prevent options 
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Using a Keyboard With 

the VT220 Emulator 

This appendix covers in table format the keys that can be used with the 
VT220 emulator. It is assumed that you know: 

• How to use MS-Windows keyboard techniques 

• The purpose of the actions you want to take as explained in the VT220 
emulator chapters 

Table D-I lists the keys used with the VT220 emulator and their functions. 

NOTE 
To access and use the arrow keys with the VT220 emulator you 
must press the Alt/spacebar keys. The first time you press this key 
combination, you get the Set-Up System menu. To access the arrow 
keys, type this key combination a second time. 

Table D-I Keys and Their VT220 Emulator Functions 

Key VT220 Emulator Function 

AIt/right arrow 
AIt/left arrow 

Alt/spacebar 

AIt/up arrow 
AIt/down arrow 

Next 

When used after pressing Alt/spacebar, it moves the high
light right or left to the next Set-Up settings. 

The first time you use this key combination, you get the 
Set-Up System menu. To access the arrow keys, type the 
key combination a second time. 

Moves the highlight up or down within a Set-Up drop
down menu. 

Used in Set-Up to display the next Set-Up screen from the 
menu at the top of the screen. 
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Table D-l Keys and Their VT220 Emulator Functions (cont.) 

Key VT220 Emulator Function 

Prev Used in Set-Up to display the previous Set-Up screen from 
the menu at the top of (he screen. 

Right arrow Moves the cursor right or left in the tab column display. 
Left arrow 

F3 (Set-Up) Enters or exits Set-Up. 

Up arrow Sets or resets a tab stop in Set-Up. 
Down arrow 
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Special Key 

Actions for MS-Paint 

This appendix describes how to use the Ctrl and Shift keys with the mouse to 
enhance or restrict some of MS-Paint's functions. 

Using the Ctrl Key: Copying a Selection 

To copy a selection with the Ctrl key: 

1. Hold down the Ctrl key. 

2. Drag the selection. 

MS-Paint creates a copy of the selection; the original remains in place. 

Using the Shift Key: Creating Multiple Copies 

To make multiple copies with the Shift key: 

1. Hold down the Shift key. 

2. Drag a selection. 

MS-Paint makes copies of the selection where the mouse cursor was dragged. 

Using the Shift Key: Scrolling a Zoomed-In Canvas 

To scroll a zoomed-in canvas with the Shift key: 

1. Hold down the Shift key in the zoomed-in drawing window. 

2. Drag. 

MS-Paint scrolls the canvas. 
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Using MS-Paint 

With the Keyboard 

This appendix describes how you can use the keyboard to: 

• Select tools and shapes 

• Draw lines and shapes 

• Draw curves 

• Draw polygons 

• Use the fill tool 

• Make selections 

• Move selections 

• Copy and move selections 

• Make multiple copies of a selection 

• Scroll 

• Zoom in, zoom out, and erase by using the Return key 

You must select the proper tool before performing the sequence. 
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Selecting Tools and Shapes 

To select from the tools and shapes palette, press (Tab/Shilt/Tab ) . 

To move the highlight and select a tool or shape, you can also hold down the 
Shift/etr! keys and press an arrow key. 

Drawing Lines and Shapes 

To draw with the Pencil, Line, Freehand Polygon, Brush, Air Brush, 3-D, and 
Shapes tools: 

1. Hold down the spacebar. 

2. Press an arrow key in the direction you want to draw. 

3. Release the spacebar to finish drawing. 

Drawing Curves 

To draw a curve: 

1. Hold down the spacebar. 

2. Press an arrow key in the direction you want to draw. 

3. Move the cursor to one side of the line, and press the spacebar to mark 
the peak of the curve. 

4. Release the spacebar to draw the curve. 

Drawing Polygons 

To draw a polygon: 

1. Mark each corner with the spacebar and the arrow keys. 

MS·Paint draws the lines, connecting each corner. 

2. Press the Return key at the final corner to close the polygon. 
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Using the Fill Tool 

To fill a shape: 

1. Press an arrow key to move the cursor over the shape. 

2. Press the spacebar. 

The interior is filled. 

Making a Selection 

To select an area of the canvas: 

1. Hold down the spacebar. 

2. Press the arrow keys to indicate the area to be selected. 

3. Release the spacebar. 

Moving a Selection 

To move a selection: 

1. Press an arrow key to move the cursor into the Selection Rectangle or 
netted area. 

2. Hold down the spacebar. 

3. Press an arrow key until the selection is moved where you want it. 

Copying and Moving a Selection 

To move a copy of a selection: 

1. Hold down Ctrl/spacebar. 

2. Press an arrow key. 
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11111 Using MS-Paint With the Keyboard 

Making Multiple Copies 

To make multiple copies of a selection: 

1. Hold down Shift/spacebar. 

2. Press an arrow key to move the selection. 

Multiple copies are made where the arrow key moves. 

Scrolling 

To scroll the screen: 

1. Hold down the spacebar. 

2. Press an arrow key. 

To scroll a zoomed-out canvas: 

1. Hold down the spacebar. 

2. Press an arrow key to move the outline of the drawing window. 

When you return to the regular drawing window, the outlined selection 
of canvas is displayed. 

To scroll the canvas under a zoomed-in drawing window: 

1. Hold down Shift/spacebar. 

The Scroll cursor replaces the Pencil cursor during the scrolling action. 

2. To scroll the canvas, move the Scroll cursor by pressing the arrow keys. 
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Using MS·Paint With the Keyboard IIIII 

Using the Return Key 

You can use the Return key to zoom in, zoom out, and erase. 

Zooming In 

To zoom in: 

I. Select the Pencil tooL 

2. Press the spacebar to mark the target area lor editing. 

3. Press the Return key to zoom in for editing. 
, 

4. Press the Return key again to return to the regular drawing window. 

Zooming Out 

To zoom out: 

1. Follow the procedures for scrolling and press the Return key. 

2. Press the Return key again to return to the regular drawing window. 

Erasing 

To erase the entire drawing window: 

1. Select the Eraser tooL 

2. Press the Return key. 
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Reader's Comments 

VAXmate 
User's Guide Volume 1 

M-HD91A-TK 

Your comments on this manual will help improve our product quality and usefulness. 

Please indicate the type of reader you most closely represent. 

o First-time user 0 Programmer 0 Experienced user 

o Application user 0 Other (please specify) ____________ _ 

How would you rate this manual for: 

Completeness of Information 
Accuracy of Information 
Easy to Read/Use 
Usefulness of Examples 
Number of Examples 
Illustrations 
Table of Contents 
Index 
Format 
Binding Style 
Print Quality 

Excellent 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 

Good 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 

Fair 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 

Poor 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 
o 

Did you find any errors in this manual? Please specify by page and paragraph. 

Incorrect information: 

Information left out: 

Hard to understand: 

What suggestions do you have for improving this manual? Attach a second sheet if 
necessary. 

Name _______________ ~Title ______________ ~ 

Company Dept. _____________ _ 

Street City 
State/Country Postal/Zip Code _________ ~ 
Telephone Date ______________ ~ 
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